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1. Understanding Switch

1.1. About Enfocus Switch

Enfocus Switch is a modular software solution that allows you to automate tasks, such as
receiving files or folders, sorting them and routing them to a particular process or folder.

Modules
Switch consists of different modules:

« A core engine module, which offers the basic functionalities, and
« A number of additional modules that you can purchase if you need more advanced
functionality.

The table below gives an overview of the different modules.

Module Description

Switch Core Engine |, provides the basic functionality for receiving, sorting, routing and
tracking of files.
« Enables PDF-specific handling like splitting and merging of PDF files.

Database Module . Automates the communication between databases and Switch,

without the need for additional scripting.

- If you have purchased the Database Module, the Database connect
flow element becomes available and allows you to integrate a
database into your Switch flow, i.e.:

« Use values from a database.
» Read, write, update and delete information in a database.
- View database values through the Switch Web Portal.

Metadata Module . Allows you to use metadata information stored in XML, JSON or JDF

tickets, stored as XMP data, or stored as a dataset in some custom file
format (opaque dataset).

« If you have purchased the Metadata Module, the Metadata flow
elements become available, allowing you to:

- Use metadata wherever Switch uses variables, for example to
route files or process jobs dynamically.

« Update or add information in XMP packages.

Scripting Module .+ Allows you to use scripts and script expressions in Switch.

« Scripts can be developed with SwitchScripter, a Switch application
component that comes with the Switch core engine. You don't need
an active license for the Scripting Module to develop scripts; however,
to use them in Switch (using the Script element), you do need such a
license.
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Module Description

- If you want to write scripts for the integration of third-party
applications in Switch or to add specific functionality to Switch, and
make these scripts available to other Switch users, you can consider
becoming an app creator. For more information, refer to https.//
www.enfocus.com/en/about-appstore.

SwitchClient Module |, aAjlows you to access the Switch Server remotely. You can:

« Submit jobs to Switch flows (via Submit points)
« Review and route jobs (via Checkpoints)

« You can either use this functionality through the Switch Web Portal, or
through your own custom job client.

. The SwitchClient Module comes with 5 concurrent user licenses,
meaning that 5 users can access Switch through a web interface
at the same time. Additional client licenses can be purchased if
necessary.

Switch Web Services | . Allows you to design custom Switch client interfaces with existing

Module applications or web-based interfaces. For example, you could build
an interface to allow your customers to submit files straight from your
company website.

« Allows you to submit and check jobs through the Switch Web Portal.

« The APl is well-documented and can be found on the Enfocus
website.

Performance . The Performance Module offers additional processing capabilities, i.e.

Module an unlimited number of concurrent processes as well as advanced
performance tuning.

Note: The Switch Core Engine allows up to 4 concurrent
processes; you can also buy a specific product

key for additional concurrent processes. For more
information, please contact your local Enfocus reseller or
sales@enfocus.com.

Reporting Module . The Reporting Module allows you to create and display dashboards

on the Switch Web Portal. You can configure the data you want to use
(by defining job boards) and choose from different widgets to display
live data or historical data (to get statistics).

Proxy Module . The Proxy Module allows you to create a gateway, facilitating secure
and controlled access between Switch and the Enfocus Appstore
while holding Switch offline.

« The Proxy Module can only be installed on a Windows server. See
also Installation of the Proxy Service on page 12.



https://www.enfocus.com/en/about-appstore
https://www.enfocus.com/en/about-appstore
https://www.enfocus.com/en/support/manuals/switch-manuals
https://www.enfocus.com/en/support/manuals/switch-manuals
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Module Description

Enfocus Internet connection

APPSTORE

)

- € 7
Internal network

N
Production Proxy Module

Note: When you install Switch, all modules are installed by default (except for the Proxy
Module), but you have only access to those for which you have entered a product key.

1.2. Switch application components

Switch consists of 4 applications components that are all installed at once when running the
Switch installer.

Switch Server

The Switch Server is the core engine of Switch. It runs in the background to execute all processes
and does not have its own interface.

Switch Server is started and terminated by the Switch Watchdog, an application designed to
monitor Switch Server. The Switch Watchdog doesn't have an interface either and is started and
terminated by the Designer, unless the Switch Watchdog is set up as a Windows service. In that
case, the Switch Server is started automatically when a user logs in, and Switch can continue
processing even if the Switch Designer is closed.

Switch Designer

The Switch Designer is the Switch user interface. It allows you to design, activate, and monitor
Switch workflows. The Designer communicates with and manages the Switch Server.

The Designer and the Server can run on the same computer to establish a one-on-one
communication, but this is not mandatory.

If you install Switch on multiple computers, you can launch the Designer from another computer
and manage the flows remotely. In that case, do not forget to define which users have the right to
connect to a given Switch Server by means of the Remote Designer (See Setting up Switch users
on page 64).

For a detailed overview, refer to the chapter about the Switch graphical user interface.

Switch Web Portal

The Switch Web Portal allows you to connect to the Switch Server through a web browser
interface, for example to view log messages and active jobs or to submit and check jobs without
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having to use a Switch Designer. You can also create job boards to keep an eye on your
production and dashboards with counters and different kinds of graphs.

Note that submitting and checking jobs through the Web Portal requires a SwitchClient or a Web
Services license; creating dashboards requires a license for the Reporting Module.

Access rights for individual users or user groups can be set through the Users pane.

For more information, refer to Using the Switch Web Portal on page 267.

SwitchScripter

SwitchScripter offers a scripting development environment, that is, it allows creating and testing
scripts for use with Switch.

The Switch installer automatically installs SwitchScripter. Although there is no technical
requirement, SwitchScripter usually runs on the same computer as the Designer.

For more information, see Scripting Module on page 417.

1.3. Getting started

Switch Quick Start Guide
If you are new to Switch, we recommend reading the Switch Quick Start Guide.

This Guide explains the basic concepts of Switch and helps you to create and design your first
flows. It also contains a number of exercises: you can try to make them yourself, and afterwards
check the sample solution or watch a video about the topic concerned.

The Switch Quick Start Guide is available on the Manuals section of the Enfocus website.

Training

You can also take an eLearning course (with interactive exercises), or watch a product movie or a
recorded webinar.

All training material can be found on the Learn section of the Enfocus website. Make sure to
select "Switch" and "Beginner".

A good start are the "Getting Started with Switch" eLearning modules (available in English,
German, French, Italian and Spanish):

- Module 1: Installation, activation and configuration
«  Module 2: Creating your first flow

« Module 3: Exercise

« Module 4: Metadata

« Module 5: Working with folders and subfolders

« Module 6: Tips and tricks


https://www.enfocus.com/en/support/manuals/switch-manuals
http://www.enfocus.com/en/learn
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2. Installing, activating and starting Switch

This section contains all you need to know about installing, activating and starting Switch.

2.1. Before you start the installation

General setup
Before you can use Switch, you must:

1. Install the application, by running the Switch Installer. The Switch Installer installs Switch
Designer and the other Switch components (Switch Server) with all the different Switch
modules (Core Engine, Metadata Module, Database Module ...).

2. Install the components that should run on a different system (optional). All components can
perfectly run on one system. However, for performance reasons, you may want to run the
Dashboard Service (needed to create job boards and dashboards on the Switch Portal) on a
different server. Or you may want to use Remote Designer (to be able to access the Switch
Server remotely). In that case, some extra steps are required.

If you purchased the Switch Proxy Module to access the Enfocus Appstore through a secure
gateway, you should install the Switch Proxy Service on a Windows server. See Installation of
the Proxy Service on page 12.

3. Activate the modules on the server that is running Switch Server, by entering a valid product
key.

Note: Afterwards, you can still activate additional Switch modules.

System requirements

Before installing Switch, make sure to check the system requirements on the Enfocus website.

Security measures
For security reasons, we highly recommend to...

« Use a firewall to block inbound traffic by default as Switch uses a bunch of network daemons
for its operation. For more information on which ports should be made available and in which
cases, check Configuring Switch user preferences on page 34.

« Always install all latest supported OS security updates.

Some tips to optimize the performance of Switch
Use multiple processors

As Switch is a multi-threaded application, it takes full advantage of multiple processor systems.
Also, if you're working with third-party applications, they too will require processing time (cycles).
More processors can help improve the overall performance.

The number of concurrent processing tasks is however limited by default in Switch Core Engine
(see the preference 'Concurrent processing tasks'). If you have a multi-core powerful system, you
may want to buy additional concurrent processes licenses or even the Performance module to
have an unlimited number of concurrent tasks.


http://www.enfocus.com/en/support/system-requirements/switch-system-requirements
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Ensure sufficient disk space and speed

Switch will be managing many files in and out of the Switch workflow. As well, 3rd-party
applications will need to open and work with files on the local Switch Server. To increase
performance of the system, selecting faster access (read/write) disk drives will help speed up the
performance of each application. Also ensure to allow for enough disk space to accommodate
your highest possible workload.

Provide sufficent system memory (RAM)

Although Switch is not RAM intensive, be sure to take into account third-party application
requirements as well. In general, the more RAM available, the better and it will help improve the
overall system performance.

Make sure to meet all network requirements

Given Switch will work with files from all over your network as well may be receiving or sending
information or jobs to other systems within your workflow, be sure the Switch Server can easily
access to all your shared systems.

2.2. Installing Switch

Prerequisites: You must have administrator rights on your local computer to install and run
Switch.

Note: If you have already installed an older version of Switch, refer to Upgrading to a
new version of Switch on page 29.

To install Switch

1. Download Switch using the link you received from your local reseller.

Switch is only sold via local resellers. Note that you can also download the installer through
My Enfocus, our customer portal.

2. If necessary, double-click the Switch installer.

3. Follow the onscreen installation instructions.

Important: It's important to pay attention to all messages shown during the
installation.

At some point Windows users will be asked to disable UAC. For more information, refer to
Disabling UAC (Windows only) on page 11.

4. During the 'Installation Type' step, select Switch Service.

This component installs the Switch Server, the Designer, the Dashboard Service and the
Switch Processor. This is the default setup, required for the system that will run the main
Switch processes. Do not clear this checkbox, unless you're installing a Remote Designer or a
Dashboard Service on a different system (see further).

If relevant, now install the components that should run on a different system.

10
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Once you have finished the installation, Switch is started automatically (unless you have turned
off the Start Switch Server automatically at login preference). Remember that you still have to
activate your Switch license(s) before you can start using Switch.

2.2.1. Disabling UAC (Windows only)

User Account Control (UAC) is a security feature in Windows. It allows you to determine whether
or not you want to be notified if changes that require administrator permission are made to your
system.

During the installation of Switch, you are asked to disable UAC. If you don't, you will not be able
to install Switch, nor will you be able to work with it. You must leave UAC disabled, also after you
have finished the installation.

Note: This warning may pop up even if you have already disabled UAC. In that case, just
ignore the warning and click Next to proceed.

To disable UAC

1. Open the User Account Control Settings panel.

If you don't know where to find it, open the Windows start screen and search for 'User
Account Control'.

2. Drag the slider to the bottom, to the option Never notify.
3. Click OK.

4, Restart the computer.

2.3. Installing Switch components on a different server

2.3.1. Remote installation of the Dashboard Service

The Dashboard Service is the Switch service that is needed to create job boards and dashboards
on the Switch Portal. It is possible to install this service on a different system than Switch Server.
For more info concerning the dashboard functionality, refer to Finding Switch jobs through the
Switch Web Portal on page 279.

Installation

1. Start the Switch installer on the system where you want to install the Dashboard Service.
2. During the 'Installation Type' step, clear the Switch Service checkbox and select the
Dashboard Service checkbox.

After installation, the Dashboard Service is started automatically.

Configuration

1. On the system where you installed the Dashboard Service, the PortsSettings.prefs file
contains the port for communication between Switch Server and the Dashboard Service. If
necessary, you can change the default port (55092).

1"
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Location of PortsSettings.prefs:

- Windows: C:\Users\<Username>\AppData\Roaming\Enfocus\Switch\

« Mac: /Users/<Username>/Library/Application Support/Enfocus/Switch/).

2. On the system where Switch Server is installed, configure the Dashboard Service Location in
the Switch User preferences (Reporting preference).

2.3.2. Remote installation of Switch Designer

Local Designer versus Remote Designer

By default, Switch is installed and activated on one system, and this one system will be used to
configure Switch flows (with Switch Designer) and to run processes (with Switch Server).

However, it's also possible to access Switch Server remotely, so you can configure flows and
administer Switch on another computer than the one that is running the processes. This is called
a Remote Designer.

You can have several Remote Designers managing one particular Switch Server; just make sure
that you're using the same version of Switch on all systems.

Installation

1. Start the Switch installer on the system on which you want to install a Remote Designer.

2. Follow the installation instructions; during the 'Installation Type' step, clear the Switch Service
checkbox and select the Designer checkbox.

When starting Switch, you will be asked if you want to connect to a local or a remote Switch
Server.

See also Starting Switch on page 30.

Configuration

Do not forget to configure the users and/or users groups that will have the right to use Remote
Designer. This must be done on the system that runs Switch Server.

2.3.3. Installation of the Proxy Service

The Proxy Service allows you to keep your Switch installations offline for security reasons. Just
install the Switch Proxy Service on a separate server, and this server will serve as a gateway,
facilitating secure and controlled access to the Enfocus Appstore.

Note:

«  You need a subscription license for the Switch Proxy Module. For more information,
contact your local reseller.

« The Proxy Service can only be installed on a Windows server. For more information,
refer to the Switch system requirements.
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Enfocus Internet connection

APPSTORE <

< g
Internal network

—
Production Proxy Module

Installation

1. Start the Switch Proxy installer on the Windows server that will host the Proxy Service.
2. Follow the instructions. You will have to enter:

« The port number to be used for the connection between the Proxy Service and Switch, for
example: 8089.

Note: Port 51069 is reserved by the Switch Proxy Service for internal use, hence
should not be used.

- The IP address of the Switch Server (which is offline), for example: 127.0.0.1, or a list of
multiple IP addresses separated by a space, for example: 127.0.0.1192.168.1.1

- Optionally, the DNS servers for resolving the host names, separated by a space. For
example: 10.31.231.35 10.31.231.36. See also How to find the DNS servers on page 15.

« The credentials (username and password) to be used to log in from Switch Server to
Switch Proxy.

The Proxy Service is installed as a Windows Service. It is started automatically.

Configuration

1. Start Switch Designer on the machine where you have installed Switch. See also Starting
Switch on page 30. Switch will automatically dectect that you're connecting the Switch
Server from an offline machine and display the Sign in tab.

2. Onthe Signin tab, proceed as follows:

1. Inthe bottom right corner, click Edit Proxy Settings.

2. In the dialog that pops up, enter the same port number, IP address and credentials as
entered during the installation of Switch Proxy.
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3. Click OK.

3. Make sure to also configure the HTTP Proxy Preferences.

a. Enter the same port number, IP address and credentials as entered during the installation

of Switch Proxy and in the Sign tab (see previous step).

b. Add localhost to the list of servers defined in the Bypass proxy for these servers
preference. This will make sure that all locally hosted services like Switch Web Service

and Switch Web Portal will bypass the Proxy.

Activation

In Switch Designer, make sure to activate your Proxy Module license key. For more info, refer to

Activating additional Switch modules (offline method) on page 24.

Troubleshooting

The Proxy Service is installed as a Windows Service. To check if the Enfocus Switch Proxy

Service is running properly, proceed as follows:

1. Press the Windows + R key on your keyboard. This will bring up the Run dialog.

2. Enter services.msc and click OK. This will open the Services window.

3. Check if you can find Enfocus Switch Proxy Service and if it's running. You can stop and

(re)start the service as required.

| 1 Services (Local)
Enfocus Switch Proxy Service Mame Desaription Status Startup Type Log On As
df;': Embedded Mode The Embedded Mode senvi. Manual (Tigg-  Local System
I';'QE thf:.?:_:“ D) Emerypting File System (EFS)  Provides the core file encry  Running  Manual (Tigg-  Local System
#3 Enfocus Seatch Proxy Service  Enfocus Switch Proxy Service  Runining Automatic Local System
{?:Enmpn-sc App Managerne..  Enables enterprise applicat_. Banual Local System
EDT"P";: - 15, Extensible Authentication P The Extensible Authenticat. Manaal Local System
ncus Switch Proxy Service 1T Function Discovery Provide_  The FOPHOST senvice host_ Manual Local Service
I.}': Fundtion Discovery Resourc..  Publishes this computer a- Manual (Tigg-  Local Service
Sl Geolocation Service This service meniters the & Dhsabled Loeal System
&}';Graph icsPerfSec Graphics performance mo. Dhsabled Local System
Eh Group Pedicy Clignt The service is respangible I Running  Automatic (Tri.  Local System

You can also check the Task Manager. The following processes should be running:
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« nginx.exe (2 processes)
« node.exe (2 processes)

] Mendtcringt 6935  Running SYSTEM L1 552K “ChProgeam Files\Microsoft Monitoring AgentiAgent| MoritomngHedtexe” <Embeddil
l'(-m':dt.( e 2124 Running METNORE... [i1] 224K CAWiIndows\System3Tumsdtcexe
(MsMpEnge 3080  Running SYSTEM 00 M4 TRK
[ ngin g 4280 Running SYETEM L] LESEK  “Ci\Progeam Files\Enfocus\Enfocus Seitch Proay Senvic €\ Winngine- 1. 24 ngire et
& ngiro_ee 2L Running SYSTEM 00 278K "CAProgram Filed\ Enfocus\ Enfocus Seatch Proay Senaice Winungine - 1. 240 ngiro e e
ElMgSree 633 Running LOCAL 5E... L] EAE
nodecae 6160  Running SYSTEM i} 13.500K  “CA\Program Files\Enfocus\Enfocus Sestch Promy Senaceinode.exe” [--harmeorny “C:\Pn
B}mﬂme """ 2518 Running SYSTEM 00 112K “C\Program Files\Enfocus\Enfocus Switch Proay Senvicelnode.sxe” | -hamony “CiPrd
Inotepadexe 135885 Runaing abeny 00 200K “CAWindows\system 3D NOTEPAD. EXE® CAWindows\ System3Tconfighsystempeodile. 4
(WrapidT_endp 4148 Running SYSTEM 00 420K  “CAProgram Files RapidMinsight Agent components! endpoint_broke, 1.7.1.0/rapidT
|[Wlrdpchipexe 6716 Running SUMN L] 208K rdpelip

You can find the log files in the following locations:

« The Proxy Service Event logs: Users/<user>/AppData/Roaming/Enfocus/SwitchProxyService

« The Proxy Service logs on the Windows server where Switch Proxy is installed: C:\Windows
\System32\config\systemprofile\AppData\Roaming\Enfocus\SwitchProxyService.

- If Switch cannot reach the Proxy Server, this will be logged in the default Web Services
logs on the computer that runs Switch: Users/<user>/AppData/Roaming/Enfocus/

SwitchWebService/Logs

In case you want to change the credentials, we recommend running the Proxy Service installer
again, using the Repair option.

In case you want to change the IP address of the computer that is running Switch Server, you
must first uninstall Proxy Service and then run the installer again.

2.3.4. How to find the DNS servers

When installing Switch Proxy Service, you can optionally enter the DNS servers for resolving the
host names. Note that they should be separated by a space.

To find the DNS servers, proceed as follows

1. Open a command prompt as an administrator.

2. Enter the following command:

ipconfig -all

3. Identify the correct DNS server address from the list.
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Ethernet Adapter #2

Ethernet adapter Ethernet:

Co ion-specific DNS Suffix

2.4. Activating Switch

Once you have installed Switch, you must activate the application on the system that runs Switch
Server.

Trial version

If you want to try the application before you buy it, you can activate a trial version. A trial version
remains active for 30 days.

The Switch Core Engine doesn't have a built-in trial version; contact your local Enfocus reseller
and request a trial version. You will receive a product key which can be activated in the same way
as a purchased license (see further).

The Switch additional modules do have a built-in trial version. Once you have activated the
Switch Core Engine, you can activate trial versions of the other modules, without having to
contact a reseller. Refer to Activating a Switch trial for additional modules (online method) on
page 21 or Activating a Switch trial for additional modules (offline method) on page 22.

Licensed version
If you have bought the application, you can activate the modules for which you have a license:

« If you installed Switch on a computer with internet access, refer to Activating Switch (online
method) on page 17.

- If you installed Switch on a computer without internet access, refer to Activating Switch (offline
method) on page 17.

Note: In this case, you need another computer with internet access to communicate
with the Enfocus web server.

Remember that you can only activate licenses with a local Designer. When using Remote
Designer, you can view the license information, but you cannot change it.
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2.4.1. Activating Switch (online method)

Once you have installed Switch, you must activate the modules for which you have a license.

Note:

« You need at least a license for the Switch Core Engine. Other modules are optional.

- If you’re using a firewall, make sure to allow Switch to communicate with https.//
licensingservices.esko.com using ports 80 and 443.

This procedure describes how to activate Switch on a computer with internet access.

To activate Switch

1. Start Switch and connect to the local Switch Server.
Activation is only possible on a local Switch Server.
The About Enfocus Switch dialog appears.

2. Enter your Enfocus ID and password.

If you don't have an Enfocus ID yet, click the Create Enfocus ID link and enter the required
information. Your account is created immediately, so you can proceed with the activation
procedure.

Note: If your system environment requires HTTP connections to pass through a proxy
server, Switch will ask you to enter the details of your proxy server. Note that, to be
able to use external services with Switch, you will also have to turn on the HTTP proxy
user preferences.

3. Click Sign In.
A dialog pops up. Here you should enter your product key(s) or your product key license file.

4. To supply your product key(s), do one of the following:

« Enter the product keys in the text area.
« Drop the product key file into the text area.
« Click Browse to select the product key license file from a location on your local system.

A green check mark next to the product key indicates that the key is valid.

5. Click Activate.
The Manage licenses dialog appears, providing you with an overview of the Switch modules
and their current activation status. If you have activated a time-limited license, you'll see

a yellow icon
concerned.

~; a permanent license results in a green icon next to the module

6. Click Close.

2.4.2. Activating Switch (offline method)

This procedure describes how to activate Switch on a computer without internet access.
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Prerequisites:

You must have an additional computer with internet access to communicate with the Enfocus
web server.

You need an Enfocus ID.

To create an Enfocus ID (on a computer with internet access), go to https.//
wwwO.enfocus.com/en/user/register and follow the on-screen instructions. Your account is
created immediately, so you can proceed with the activation procedure.

How it works:

Activating Switch offline consists of three steps:

1.
2.

3.

Create an activation request on the computer on which you installed Switch.

Save this file on another computer with internet access and upload it to the Enfocus activation
website. Enfocus will check your licenses and, if the license is valid, provide you with a
response file.

Upload the response file to the computer on which you installed Switch and activate it.

Each of these steps is explained below.

To activate Switch

1.

3.

On the computer on which you installed Switch:

a. Start Switch and connect to the local Switch Server.
Activation is only possible on a local Switch Server.
The Enfocus Software Activation dialog appears.
Enter your Enfocus ID and password.

Enter your product key by doing one of the following:

- Type or copy-paste your product key in the Product key field.

«  Browse to your product key license file or drag and drop it into the Product key field.
Select the Off-Line Mode checkbox.

Click Activate.

f. Inthe Off-Line Activation dialog, click Save and save the activation request file
requestactivate.xml on your local computer.

On a computer with internet access:

a. Make requestactivate.xml available.

Tip: You can copy requestactivate.xml to a USB stick, and connect the USB stick
to your online system.

Go to http://www.enfocus.com/products/activation?lang=en
Select Offline Product Activation, and click Continue.
Upload requestactivate.xml, and click Continue.

Fill in your Enfocus ID password, and click Continue.

Click Continue to confirm.
The Enfocus web server creates a file: response.xml.

0 Q0T

g. Download the file.

On the computer on which you installed Switch:
a. Make response.xml available on this computer.
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In the Off-Line Activation dialog (see step 1f), in the right part, click Load and upload

response.xml.

Click Activate.

You have activated Switch.
Click Close.

2.5. Managing your Switch licenses

Once you have installed Switch, you can manage your licenses from within the application.
You can for example check the status of your licenses, activate additional modules, deactivate
modules, export license information, and so on.

2.5.1. About the Switch licenses

Switch modules are activated via licenses or product keys. For each module you want to use, you
need a separate license.

Note: An overview of your licenses can be found in the Manage licenses pane (Help >

Manage Licenses).

[ ] [ ]
Licenses:
Product Status

Switch Core Engine Active
Performance Module 2 Need Repair
Configurator Module i Active
Database Module L Active
Metadata Module 2 Active
Scripting Module . Active
SwitchClient Module i Active
Switch Web Services i Active
Additional SwitchClient Licenses .. Need Repair
Reporting Module 2 Active

Deactivate...

Trial licenses

Manage licenses

Type
Permanent

Time Limited
Time Limited
Time Limited
Time Limited
Time Limited
Time Limited

Time Limited

Details:

Product Name:

Product Key:

Enfocus ID:

License Status:

License Period:
Maintenance Status:
Maintenance End Date:
Application Creation Date:

Switch Core Engine
SW1ws0-BABAAV-58RR58-BKg...
annc@enfocus.com
& Active
Permanent
Active
2023-02-28
2022-05-07

Allowed Concurrent Processes: 4 [12 total

Activate New...

Export License Info...

Close

If you are new to Switch, you can try the software for a period of 30 days. Request a trial key via
the form on the Enfocus website.

You will receive a key for the Switch Core Engine. The other modules can be activated separately
via the Trial button in the Manage Licenses panel (see Activating a Switch trial for additional
modules (online method) on page 21).
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Module licenses

At the time of the purchase, you receive an HTML file with a key for each module you have
bought.

The Switch Core Engine license is mandatory. The other modules are optional and can be
activated afterwards when you need them. If the Switch Core Engine license expires before a
module's trial period or time limit, then the modules will stop working too.

License Status versus Maintenance Status

The License Status indicates the validity of the license; if the license status is active, you have the
right to use the Switch module.

The Maintenance Status (only shown in the details of the Core Engine) indicates if your
maintenance contract for Switch is expired or about to expire. Maintenance is mandatory during
the first year and includes free updates of the software and priority tech support.

The Maintenance End Date indicates the end of the maintenance period (not of the licensel):
after that date, the software will continue to work, but you will no longer be entitled to free
updates and support. The Maintenance End Status will be "Expired" and the Maintenance End
Date will be a date in the past.

If you renew your maintenance contract, you will receive a Switch Maintenance key. This key will
have a new Maintenance End Date that will be taken into account to determine whether or not
you have the right to upgrade. Do not forget to activate this new maintenance key, so the details
and the new Maintenance End Date become visible in the Manage Licenses panel.

Upgrading to a new Switch version

To determine whether or not you are entitled to a new Switch version, the Application Creation
Date is used.

The Application Creation Date is the release date of the Switch version installed on your
computer. This date is compared to the Maintenance End Date: if that version of Switch was
released before the Maintenance End Date, you're entitled to use it.

For example, if your maintenance expired on 28/06/2020, you have the right to upgrade to
Switch 2020 (released on 23/06/2020), no matter what the current date is and although the
Maintenance Status is "Expired".

However, if your maintenance expired on 28/05/2020, you do not have the right to upgrade to
Switch 2020 (released on 23/06/2020); if you want to upgrade (from Switch 2018 or 2019), you
must renew your maintenance contract.

For more information, refer to Upgrading to a new version of Switch on page 29.

Note: The Switch 2021 license is backward compatible to Switch 2019, meaning that you
can use the Switch 2021 key to run previous versions of Switch if required.

Additional concurrent processes
The Switch Core Engine allows for up to 4 concurrent processes. If that's not sufficient, you can
buy a number of additional concurrent processes through a license of the Performance Module.

To know how many concurrent processes have been licensed, check the value of the "Allowed
Concurrent Processes" field in the details of the Core Engine or the Performance Module license.

The first number represents the number of allowed concurrent processes based on the selected
module, the second number represents the total number of concurrent processes for the whole
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Switch installation. In the below example, 1 additional license for the Performance Module has
been purchased (in addition to the 4 included in the Core Engine).

Licenses: Details:
Product Status Type Product Name: Perfermance Medule
Product Key: SWMgll-BACAAV-1jkHDE-BKg6...
Switch Core Engine Active Permanent | | oo 4 / 4
Enfocus ID: c@enfocus.com
Performance Madule . Active Licenze Status: Active
License Period: Permanent
Allowed Concurrent Processes: 1 /5 total

2.5.2. Checking the status of your Switch licenses

Check the status of your licenses, if you want to know which Switch modules are activated, when
your licenses expire or when your maintenance contract ends. The end of your maintenance
contract is important, because it determines whether or not you can upgrade to a new version of
Switch.

To check the status of your Switch licenses
1. Open Switch.
2. On the Help menu, click Manage licenses.

3. Inthe left part of the Manage licenses dialog, select the module of which you want to see the
status.
The details of the selected module are shown in the Details pane on the right. For more
information, refer to About the Switch licenses on page 19.

The table below explains the icons that represent the License Status.

Icon |Meaning

The license is time-limited. You can use the module concerned during a certain period of
time. Check the License Period in the right part of the dialog.

The license is permanent.

The license has expired. You will not be able to use the module concerned.

2.5.3. Activating a Switch trial for additional modules (online
method)

You can activate a 30-day trial for one or more additional modules.

Note: Contact your local reseller if you want to try the Switch Core Engine.

21



ENF@CUS Switeh

Trial versions cannot be deactivated; they become inactive once the trial period has expired.
This procedure describes how to activate Switch on a computer with internet access.

To activate a Switch trial for additional Switch modules

1. Start Switch and connect to the local Switch Server.

Activation is only possible on a local Switch Server.

2. On the Help menu, click Manage licenses.
The Manage licenses dialog appears.

3. Select the module(s) you want to activate.
4. Click Trial.

5. Ifyou're not signed in in Switch yet, a dialog will pop-up. Enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you don't
remember your password, click the Forgot Password? link.

6. In the dialog that appears, click Activate.
You have activated a Switch trial version. All information about the activated version (for
example the validity period) is displayed in the right part of the Manage licenses dialog.

7. Click Close.

2.5.4. Activating a Switch trial for additional modules (offline
method)

You can activate a 30-day trial for one or more additional modules.

Note: Contact your local reseller if you want to try the Switch Core Engine.

Trial versions cannot be deactivated; they become inactive once the trial period has been
expired.

This procedure describes how to activate Switch on a computer without internet access.
Prerequisites:

« You must have an additional computer with internet access to communicate with the Enfocus
web server.

How it works:
Activating Switch modules offline consists of three steps:

1. Create an activation request on the computer on which you installed Switch.

2. Save this file on another computer with internet access and upload it to the Enfocus activation
website. Enfocus will provide you with a response file.

3. Upload the response file to the computer on which you installed Switch and activate it.
Each of these steps is explained in detail below.

To activate a Switch trial for additional Switch modules

1. On the computer on which you installed Switch:
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Start Switch and connect to the local Switch Server.

Activation is only possible on a local Switch Server.

On the Help menu, click Manage licenses.

The Manage licenses dialog appears.

Select the module(s) for which you want to activate a trial.

Click Trial.

In the Enfocus Software Activation dialog, select the Off-Line Mode checkbox.

Enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you

don't remember your password, on your computer with internet access, go to https.//
my.enfocus.com/en/user/password.

Click Activate.

In the Off-Line Activation dialog, click Save and save the activation request file
requestactivate.xml on your local computer.

2. On a computer with internet access:

a.

o 200

f.

Make requestactivate.xml available.

Tip: You can copy requestactivate.xml to a USB stick, and connect the USB stick
to your online system.

Go to http://www.enfocus.com/products/activation?lang=en
Upload requestactivate.xml, and click Continue.

Fill in your Enfocus ID password, and click Continue.

Click Continue to confirm.

The Enfocus web server creates a file: response.xml.
Download the file.

3. On the computer on which you installed Switch:

a.
b.

d.

Make response.xml available on this computer.

In the Off-Line Activation dialog (see step 1h), in the right part, click Load and upload
response.xml.

Click Activate.

You have activated a Switch trial version. All information about the activated version (for
example the validity period) is displayed in the right part of the Manage licenses dialog.
Click Close.

After updating the license keys, you must restart the application.

2.5.5. Activating additional Switch modules (online method)

If you have purchased one or more additional modules, you have to activate them by entering the
product keys you received from your local reseller.

This procedure describes how to activate additional modules on a computer with internet access.

To activate additional modules

1. Start Switch and connect to a local Switch Server.

Activation is only possible on a local Switch Server.
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7.

On the Help menu, click Manage licenses.
The Manage licenses dialog appears.

Click Activate New.

If you're not signed in in Switch yet, a dialog appears. Enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you don't
remember your password, click the Forgot Password? link.

To supply your product key(s), do one of the following:

« Enter the product keys in the text area.
- Drag and drop the product key license file into the text area.
« Click Browse to select the product file from a location on your local system.

A green check mark next to the product key indicates that the key is valid.

Click Activate.
In the right part of the dialog, a green icon (in case of a permanent license) or a yellow

icon © (in case of a time-limited license) appears next to the activated module(s).

Click Close.

After updating the license keys, you must restart the application.

2.5.6. Activating additional Switch modules (offline method)

This procedure describes how to activate additional modules on a computer without internet
access.

Prerequisites: You must have an additional computer with internet access to communicate with
the Enfocus web server.

If you have purchased one or more additional modules, you have to activate them by entering the
product keys you received from your local reseller.

Activating Switch modules offline consists of three steps:

1.
2.

3.

Create an activation request on the computer on which you installed Switch.

Save this file on another computer with internet access and upload it to the Enfocus activation
website. Enfocus will check your licenses and, if the license is valid, provide you with a
response file.

Upload the response file to the computer on which you installed Switch and activate it.

Each of these steps is explained in detail below.

To activate additional modules

1.

On the computer on which you installed Switch:
a. Start Switch and connect to a local Switch Server.

Activation is only possible on a local Switch Server.
b. On the Help menu, click Manage licenses.

The Manage licenses dialog appears.
c. Click Activate New.
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Enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you
don't remember your password, on your computer with internet access, go to https://
my.enfocus.com/en/user/password.

Enter your product key(s) by doing one of the following:

« Type or copy-paste your product key in the Product key field.

- Browse to your product key license file or drag and drop it to the Product key field.
Select the Off-Line Mode checkbox.

Click Activate.

In the Off-Line Activation dialog, click Save and save the activation request file
requestactivate.xml on your local computer.

2. On a computer with internet access:

a.

P a0vU

f.

Make requestactivate.xml available.

Tip: You can copy requestactivate.xml to a USB stick, and connect the USB stick
to your online system.

Go to http://www.enfocus.com/products/activation?lang=en
Upload requestactivate.xml, and click Continue.
Fill in your Enfocus ID password, and click Continue.

Click Continue to confirm.
The Enfocus web server creates a file: response.xml.

Download the file.

3. On the computer on which you installed Switch:

a.
b.

d.

Make response.xml available on this computer.

In the Off-Line Activation dialog (see step 1h), in the right part, click Load and upload
response.xml.

Click Activate.

You have activated the requested Switch modules.

Click Close.

After updating the license keys, you must restart the application.

2.5.7. Deactivating Switch modules (online method)

Deactivate a Switch module if you want to move the license for this module to another computer,
or if for any reason you don't need it anymore.

This procedure describes how to deactivate additional modules on a computer with internet

access.

To deactivate Switch modules

1. Start Switch and connect to the local Switch Server.

Deactivation is only possible on a local Switch Server.

2. On the Help menu, click Manage licenses.

3. Inthe left part of the Manage licenses dialog, select the module(s) you want to deactivate.
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To select multiple modules, hold down the Ctrl key while clicking the modules concerned.

The details of the selected module are shown in the Details pane on the right. For more
information, refer to About the Switch licenses on page 19.

Click Deactivate.
Make sure the Off-Line Mode checkbox is cleared.

If you want to export the license file (with the key being deactivated), so that you can
reactivate it on another system, proceed as follows:

a. Select the Export license information during deactivation checkbox.
b. Save the product key license file on your computer.

Click Deactivate.
The selected license is deactivated.

Click Close.

2.5.8. Deactivating Switch modules (offline method)

This procedure describes how to deactivate additional modules on a computer without internet
access.

You must have an additional computer with internet access to communicate with the Enfocus
web server.

Deactivate a Switch module if you want to move the license for this module to another computer,
or if for any reason you don't need it anymore.

Deactivating Switch offline consists of three steps:

1.
2.

3.

Create a deactivation request on the computer on which you installed Switch.

Save this file on another computer with internet access and upload it to the Enfocus activation
website. Enfocus will provide you with a deactivation response file.

Upload the response file to the computer on which you installed Switch and deactivate it.

These steps are explained in detail below.

To deactivate Switch modules

1.

On the computer on which you installed Switch:

a. Open Switch

b. On the Help menu, click Manage licenses.

c. Inthe left part of the Manage licenses dialog, select the module(s) you want to deactivate.
To select multiple modules, hold down the Ctrl key while clicking the modules concerned.

d. Click Deactivate.
In the Enfocus Software Activation dialog, select the Off-Line Mode checkbox.

f. Select the Export license information during deactivation checkbox.
This enables you to export the license file (with the key being deactivated), so that you
can reactivate it on another system.

g. Click Deactivate.
A dialog pops up, allowing you to select a download location and a name for the license
backup file (LicensesBackup.html).
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h. Browse to a download location, and click Save.
The Off-Line Deactivation dialog appears. It allows you to download a deactivation
request file.

i. Inthe left part of the dialog, click Save and save the deactivation request file
requestdeactivate.xml on your computer.

2. On a computer with internet access:
a. Make requestdeactivate.xml available.

Tip: You can copy derequestactivate.xml to a USB stick, and connect the USB
stick to your online system.

Go to http://www.enfocus.com/products/activation?lang=en
Upload requestdeactivate.xml, and click Continue.
Fill in your Enfocus ID password, and click Continue.

o 200

Click Continue to confirm.
The Enfocus web server creates a file: response.xml.
f. Download the file.

3. On the computer on which you installed Switch:

a. Make response.xml available on this computer.

b. Inthe Off-Line Deactivation dialog (see step 1i), in the right part, click Load and upload
response.xml.

c. Click Deactivate.
You have deactivated the selected Switch module(s).

d. Click Close.

2.5.9. Repairing Switch (online method)

Licenses are linked to the hardware characteristics of your computer. If the hardware
characteristics change (for example: you added memory or a new network card), the license is
not valid anymore and you must repair it.

This procedure describes how to repair Switch on a computer with internet access.

To repair Switch

1. Start Switch and connect to a local Switch Server.

Repairing licenses is only possible on a local Switch Server.

2. On the Help menu, click Manage licenses.
The Manage licenses dialog appears.

3. Select the module(s) that need to be repaired.

If a module needs to be repaired, the Repair button is activated.

4. Click Repair.
The Enfocus Software Repair dialog is opened.

5. Make sure that the Off-Line Mode checkbox is cleared.

6. Click Repair.
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Your system communicates with the Enfocus web server and repairs your license. In case of
problems, please contact Enfocus:

« activation@enfocus.com
« https://enfocus.my.site.com/customers/s/

7. Click Close.

2.5.10. Repairing Switch (offline method)

This procedure describes how to repair Switch on a computer without internet access.

Prerequisite: You must have an additional computer with internet access to communicate with the
Enfocus web server.

Licenses are linked to the hardware characteristics of your computer. If the hardware
characteristics change (for example: you added memory or a new network card), the license is
not valid anymore and you must repair it.

Repairing Switch offline consists of three steps:

1. Create a repair request on the computer on which you installed Switch.

2. Save this file on another computer with internet access and upload it to the Enfocus activation
website. Enfocus will provide you with a deactivation response file.

3. Upload the response file to the computer on which you installed Switch and repair it.
These steps are explained in detail below.

To repair Switch

1. On the computer on which you installed Switch:
a. Start Switch and connect to a local Switch Server.

Repairing licenses is only possible on a local Switch Server.
b. On the Help menu, click Manage licenses.
The Manage licenses dialog appears.
c. Select the module(s) that need to be repaired.
If a module needs to be repaired, the Repair button is activated.
d. Click Repair.
The Enfocus Software Repair dialog is opened.
e. Select the Off-Line Mode checkbox.
Click Repair.

d. Inthe Off-Line Repair dialog, click Save and save the repair request file requestrepair.xml
on your local computer.

2. On a computer with internet access:
a. Make requestrepair.xml available.

Tip: You can copy requestrepair.xml to a USB stick, and connect the USB stick to
your online system.

Go to http://www.enfocus.com/products/activation?lang=en
Upload requestrepair.xml, and click Continue.
Fill in your Enfocus ID password, and click Continue.

P 20U

Click Continue to confirm.
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The Enfocus web server creates a file: response.xml.
f. Download the file.

3. On the computer on which you installed Switch:

a. Make response.xml available on this computer.

b. Inthe Off-Line Repair dialog (see step 1f), in the right part, click Load and upload
response.xml.

c. Click Repair.
You have repaired Switch. In case of problems, please contact Enfocus:

« activation@enfocus.com
- https://enfocus.my.site.com/customers/s/
d. Click Close.

2.5.11. Upgrading to a new version of Switch

Upgrading to a new Switch version will replace your current version. As soon as you launch
Switch, all your flows will be upgraded as well.

Important: Before you start, check your maintenance status (by selecting Help > Manage
licenses). You can only upgrade if the Switch Maintenance End Date is more recent than
the Application Creation date (i.e. the creation date of the new Switch version). If this is
not the case, please contact your local reseller and request a maintenance key.

To upgrade your current version to a new version of Switch

1.

Quit all Switch processes (Designer, Server, Watchdog, Scripter) (using File > Stop Switch
Server).

If the preference Start Server automatically at login is set to No and if there are no active
flows, quitting the Designer will stop the Switch Server and the Watchdog automatically.

If the preference Start Server automatically at login is set to Yes, you can stop the server
manually. Refer to Stopping the Switch Server on page 433.

Tip: To ensure that there are no Switch processes running, you can use the Activity
Monitor on Mac or the Task Manager on Windows.

Install the new version of Switch.

We strongly recommend making a backup of the Switch data root (after installing) but before
starting Switch Designer. On Windows, you can immediately start making a backup by
clicking the Yes button in the dialog that appears at the end of the installation process. On
Mac, you should locate and start the backup tool yourself. Refer to Making a backup of your
Switch installation on page 437.

Launch Switch.
After installing a new version of Switch, when it is launched for the first time, Switch detects
the version change and presents a warning dialog.

Note: Important note for Switch 2022 Spring! As of this version, the flow elements
are deployed as Switch apps. They are downloaded and installed automatically on
condition that you are signed in with your Enfocus ID. You can sign in via the Switch
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menu: Switch > About Switch > Sign in. If you are not signed in, you will still find
the old flow elements (with old icons) in the Flow elements pane. Note that both the
old flow elements and the new ones can be used, there is currently no difference in
functionality, but in the future that will change.

4. Click the Proceed button.

If you click the Cancel button, Switch quits without making any changes to the flows. In that
case, you will not be able to work with these flows in the new version.

Switch makes a backup of existing flows and then re-imports them. While re-importing the
flows, Switch adjusts all flow elements and properties so that they comply with the current
version of Switch. If there are any problems, a warning appears. For more information, refer to
Importing and exporting flows on page 230.

2.6. Starting Switch

Prerequisites: You must have administrator rights on your computer to run Switch.

When starting Switch, you are actually starting the Switch Designer. With Switch Designer you
can then connect to a local Switch Server, or to a Switch Server installed (and already running) on
another computer.

Note: Switch Server allows only one connection at a time, from either a local or a remote
Designer. The same holds for Switch Designer: Switch Designer can only be connected to
one single (local or remote) Switch Server at a time.

To start Switch

1.

Do one of the following:

« Select Switch in the Start menu (Windows)
- Locate the application (Switch.exe or Switch.app) and double-click to start Switch.

Switch is installed by default in the following directory:

- Windows: C:\Program Files\Enfocus\Enfocus Switch

« Mac OS: /Applications/Enfocus/Enfocus Switch

In the Connect to Switch Server dialog, do one of the following:

« To connect to the Switch Server installed on your local computer, select the Connect to
local Switch Server checkbox.

« To connect remotely, i.e. to connect to a Switch Server installed on another computer,
enter the required details:

« [P address or host name of the computer on which you have installed Switch Server.

Note: The previously used IP address (if any) is stored.

« Port number
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Note: You can set a default value for the port number. See Switch preferences:
Internal communication on page 52.

« User name and password as required.

Note: This depends on the setup in the Users pane.

Note: To be able to connect remotely, the Switch Server must be running on the
remote computer. For more information, refer to Starting/restarting Switch Server on
page 32.

Tip: You can automatically start the Switch Server every time you log in to
the operating system, by enabling the corresponding user preference (Start
Switch Server automatically at login). See Switch preferences: User interface
on page 35. Note that when this preference is enabled, Switch Server will
remain running even if you exit Switch Designer.

If you connect to a local Switch Server, the Switch Server is started automatically
when starting Switch.

3. To hide this dialog next time when you start Switch, clear the Show dialog at startup
checkbox.

Note: If you hide this dialog, the selected connection (local or remote connection

to a particular computer) is considered the default connection. You can afterwards
still change the connection from within Switch, by selecting File > Connect to Switch
Server.

4. Click OK.
If you're signed in with your Enfocus ID already, Switch Designer is opened. You can ignore
the remaining steps of this procedure. If you're not signed in yet, the About Switch dialog
appears and you should continue with the next step of this procedure.

5. On the Sign In tab, enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you don't
remember your password, click the Forgot Password? link.

Note:

« This step is not obligatory (but highly recommended), unless you want to activate
licenses or buy apps in the Enfocus Appstore. See Working with apps in Switch on
page 259. You must also be signed in to be able to download the default apps (=
the flow elements that are part of your standard installation). If you're not signed in,
on a new installation, you won't have the flow elements in the Flow elements pane.
In case of an existing installation, you will still have the old flow elements (with the
old icons).

- You remain signed in (until you sign out explicitly), so next time you start Switch,
you won't see this dialog anymore.
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6. Click Close.

Switch Designer is opened. In the title bar of the Switch Designer, you can see:

« If you're connected with Remote Designer: Your user name followed by "@" and the IP
address or host name (as entered in step 2) of the computer you are connected to, for
example: "user@Switch Server MAC (10.33.133.213)"

- If you're connected with a local Designer: The name of the Switch Server followed by
"(localhost)".

Note: Remember that your access rights depend on the settings in the Users pane.
Users having read-only access (this is indicated in the title bar), will not be able to edit
flows or to change settings.

If you're launching Switch for the first time, the Switch Insight Dashboard dialog pops up.
Read the text carefully and click Yes, I'd like my Dashboard to get your own personal
dashboard.

You can change your mind any time. For more info, refer to The Switch Insight Dashboard on
page 434.

2.7. Starting/restarting Switch Server

Starting Switch Server

The Switch Server must be running in order to process tasks.

However, you do not have to start the Switch Server manually:

If the Switch Server is configured to start automatically at login (see Switch preferences: User
interface on page 35), it starts when you log in to your operating system.

On Windows, if the Switch Watchdog is configured as a Windows service, Switch Server starts
when you log in to your operating system.

If Switch Server is not running when logging in to your operating system, the Switch Server is
started when you open Switch and connect to the local Designer.

Note: If the Switch Server is not yet running, connecting to the Switch Server with
Remote Designer is not possible! You must first connect to a local Designer (which
starts the Switch Server), before you can use the local Designer.

Restarting Switch Server

Restarting the Switch Server is only necessary if there are changes in the preferences or licenses
which require a Server restart.

To restart Switch Server

In Switch /ocal Designer, select File > Restart Switch Server.

2.8. Troubleshooting

When installing or activating Switch, you may encounter one of the following problems.
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Activation license failed
If activating the license failed, check the following:

- If you copy-pasted the product key, double-check the product key pasted in the text field. You
may have forgotten part of the key, or you may have added redundant spaces by accident.

- If you uploaded a file, try with a new copy of the file. It may have been corrupted.
« If this doesn't solve the problem, contact your local reseller and ask for a new activation file.

Activation license expired

If your license has expired, contact your dealer to resolve this issue.

Not all modules are activated

If one of the modules you purchased for Switch is not activated, double-check whether you
received multiple activation files, and whether you have uploaded all of them.

If that does not resolve your problem, contact your local reseller and ask for the missing licenses.

Need more help?

Contact the Enfocus support team using our Support Portal: https://enfocus.my.site.com/
customers/s/cases.
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3. Configuring Switch

Once you have installed and activated Switch, we recommend setting up:

User preferences

Provide Switch with the required data to send e-mails and notifications, to use Active Directory
settings etc. Furthermore, you may want to change the language of the interface, to set the
preferences for error messages etc.

Users

If you have licensed the SwitchClient Module, you should define which users are allowed
to access Switch through Submit points and/or Checkpoints, and assign these users the
appropriate access rights.

If you want to allow certain users to view messages and/or jobs via the Switch Web Portal, you
should explicitly do so via the Users pane.

If you want to allow certain users to rush jobs, i.e. to process jobs before other jobs that are
waiting in the queue, you should do so via the Users pane.

If you want to allow certain users to view or create job boards and/or dashboards on the
Switch Web Portal, you should also do so via the Users pane.

If you are using Remote Designer, you should define who has the right to access the Switch
Server remotely.

Switch Watchdog (Windows only) as a Windows Service

Set up Switch Watchdog as a Windows Service, to allow Switch to continue processing after
you have logged off from the computer.

Setting up custom icons for job boards on page 74

If you're using job boards on the Switch Portal, you may consider replacing the standard icons
for file types with your own images.

3.1. Configuring Switch user preferences

Switch user preferences allow you to:

Customize Switch to your needs.

You can for example choose the language of the interface, determine how many processes
are allowed to run in parallel etc.

Provide Switch with data it needs for sending e-mail notifications, setting up FTP connections,
connecting to databases etc.

Note: Note that, when launching Switch using Remote Designer, a number of user
preferences are hidden. Furthermore, if you have limited access (read-only access), you
will only be able to view the preferences; you will not be able to change them. For more
information, refer to Configuring Switch users on page 63.
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3.1.1. Setting your Switch preferences

After you have installed and activated Switch, we recommend going over the user preferences
and setting them as required. Note that a number of settings are required, in order to run Switch,
for example the name of the Switch Server and, if you want to use Active Directory in Switch, the
Active Directory settings.

To set your Switch user preferences

1. Navigate to:

«  On Windows OS : Edit > Preferences.
« On Mac OS: Enfocus Switch > Preferences.

The User preferences dialog appears.

2. Inthe left part of the dialog, click a category, for example User interface.
The corresponding properties are shown in the right part of the dialog. The meaning of the
different options is explained further in this manual.

3. Enter the required values.

3.1.2. Switch preferences: User interface

These preferences allow you to configure some aspects of the Switch user interface.

Property

Description

Designer
Language

The language of the user interface of the Switch Designer. You can select
one of the following languages:

« English

« German

« French

« Spanish

« Portuguese
« Chinese

. Japanese

Note:

« Restart the Switch Designer to apply your changes.

« You can also configure the language of the Switch Server. For
more information, refer to Switch preferences: Processing on
page 43.

Large icons in
elements pane

If set to Yes, the Flow elements pane displays large icons; otherwise it
displays small icons.

Save flows
automatically

. If setto Yes, flows are saved automatically before they are processed
(activated, imported, exported).
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Property Description

. If setto No, you're explicitly asked if you want to save the changes
before activating, importing or exporting the flow

Note: This preference can also be set to Yes by selecting the Save
flows automatically checkbox in the Modified flows dialog. That is
the dialog that pops up when you want to activate, import or export
a modified flow.

Start Switch . If setto Yes, (default) the Switch Server is started automatically when
Server the user logs in, and it remains running, even if the user exits Switch
automatically at Designer.

login

. If set to No, the Switch Server will be started automatically when the local
Designer is started. If the local Designer exits, the behavior depends on
the currently active flows:

- If no flows are active, Switch Server is stopped automatically.

- If at least one flow is active, the preference below (When exiting the
flow designer) will determine what happens.

When exiting the | This option is only available if Start Switch Server automatically at login is
flow designer set to No. It determines what happens to the Switch Server when the user
quits Switch Designer:

Note: This preference is taken into account only in case there
are currently active flows; otherwise Switch Server always exits
disregarding the preference value.

Options:

- Ensure processing is started: When quitting Switch Designer, Switch
Server remains running in the background and continues processing the
flows that are currently active.

- Ensure processing is stopped: When quitting Switch Designer, all active
flows are stopped and Switch Server exits.

« Ask the user (default option): When quitting Switch Designer, Switch
displays a dialog so the user can decide what to do. The user can
choose either to continue processing the active flows in the background
or stop all active flows and exit.

Ren.cler HTMLin | The Log Messages overview and the Script expression editor are HTML-
Designer (beta) based interfaces. They can be rendered in two ways:

. If this option is set to Yes, the HTML-based user interface will be shown
inside Switch Designer.

- If this option is set to No, the HTML-based user interface will be shown in
a separate browser window, outside the Switch Designer user interface.
Your default browser will be used.

In both cases, the displayed content is the same.
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Property

Description

In case of the Messages overview, this setting is applied when clicking
the Messages button or View > Messages option or when pressing F6 in
the Switch Designer. In case of the Script expression editor, this setting is
applied whenever you click Define script expression to define a property.
See also Associating a script expression with a property on page 417.

Note: This feature is not yet supported on all systems. If it doesn't
work on a your system, you'll get an empty window instead of the
Messages view or the Script expression editor.

Ignore Switch
Web Service
certificate errors

If set to Yes, server certificate errors will be ignored when connecting to a
remote Switch Web Service via HTTPS.

Examples of certificate errors:

« Self-signed certificate
« Invalid host name
« Expired certificate

Note: Enabling this setting makes your connection vulnerable

to Man-in-the-Middle Attacks, so it should only be used as a last
resort. For a more secure solution, refer to HTTPS with self-signed
certificates on page 445.

3.1.3. Switch preferences: Mail send

These preferences allow you to configure the settings for the Mail send and the Checkpoint
via mail tool. If you do not configure them, you will not be able to send e-mail notifications. You
can check if the settings are configured correctly by clicking the Test connection button at the
bottom of the dialog.

Property

Description

SMTP server address | The URL or IP address of the SMTP email relay server.

Example: smtp.gmail.com

SMTP port

The port used by the SMTP server.

authentication

SMTP server requires | Defines whether the SMTP server requires authentication.

If set to Yes, following additional fields appear:
« User name: The login name for the SMTP server, for example:
user@gmail.com. Leave empty if none is required.

« Password: The password for the SMTP server. Leave empty if none
required.

- Use secure password verification: Defines whether or not to use
secure password verification.
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Property Description

If set to Yes, the Authentication method property appears.

- Authentication method: The authentication method used to
establish the connection to the mail server. The following secure
authentication schemes are supported:

- Automatic (The element will try the different methods one by
one until the connection can be established)

« Password

« NTLM
+ CRAM-MD5
- KERBEROS

Encrypt connection Defines whether or not the mail server requires an encrypted connection
(TLS1, 1.1, 1.2).

Options: Yes/No.

Sender name The sender's name for outgoing email messages.
Sender address The sender's address for outgoing email messages.
Note:

« The sender name and email address are used in the _From _SMTP header that is
normally shown by email client applications as 'From' field of an email. If the 'Reply to'
field of an email is not defined, the content of the 'From' field is used to send a reply.

« ltis also possible to use a different sender name and address for a particular flow. To
do so, you can specify the new name, email address and authentication parameters
(i.e. the user name and password linked to this email address) in the flow element
concerned. Refer to Mail send on page 121 and Checkpoint via mail on page 129.

Example: The screenshot below is an example of the Mail send preferences required for sending
e-mails using Gmail.

Property Value

SMTP server address smtp.gmail.com

SMTP port 587

SMTP server reqguires authentication Yec
User name examplesend @ gmail.com
Passm FrdrdrdhR
Use secure password verification Ma

Encrypt connection Yes

Sender name Test User

Sender address examplereceive@gmail.com
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3.1.4. Switch preferences: FTP proxy

Switch

If your system environment requires FTP connections to pass through a proxy server, you must
fill in the configuration details for the proxy server. Otherwise, you will not be able to use the FTP
receive and FTP send tools.

Property

Description

Type of proxy

The type of proxy:

« No proxy: no proxy is required for FTP connections
« Tunneling proxy: uses the HTTP protocol
+ SOCKSA4 proxy: uses the SOCKS4 protocol

+  SOCKSS5 proxy: uses the SOCKS5 protocol

Name or IP address of
host

Name or IP address of the proxy server on your local network.

Proxy user name

The user name for logging in to the proxy server.

Proxy password

The password for logging in to the proxy server.

Proxy port

The port number for communicating with the proxy server.

Note: If you are using the FTP proxy protocol (type of proxy = No proxy), do not forget to

enter the appropriate proxy information in the FTP receive and FTP send properties:

- Inthe FTP server address property, enter the name or IP address of the proxy server
(instead of the FTP site being targeted).

- In the user name property, append an @ sign and the target FTP site address (domain
or IP address) to the regular user name ( "<ftpserverusername>@<ftpserveraddress>").

« The other properties, including the password, remain unchanged.

See also: FTP receive on page 120 and FTP send on page 120.

3.1.5. Switch preferences: HTTP proxy

If your system environment requires HTTP connections to pass through a proxy server, you must
fill in the configuration details for the proxy server. Otherwise, you will not be able to access the
internet or external services (e.g. upload files to DropBox using the HTTP request flow element or
download apps from the Enfocus Appstore).

Property

Description

Use HTTP proxy

Turn on or off HTTP proxy support.
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Property Description

If set to Yes, an HTTP proxy connection will be estabilished for all
HTTP(S) operations in Switch.

The depending properties are shown and filled in automatically if
they are present in the system settings.

Proxy server Name or IP address of the proxy server on your local network.

Note: If you're using the Proxy Service, this should be the
IP address of the Windows server on which you installed the
Switch Proxy Service.

Proxy port Port number for communication with the proxy server.

Note: If you're using the Proxy Service, this should be the
port entered during the installation of the Proxy Service.

Authenticate If set to Yes, credentials are required for logging on to the proxy
server. The following dependent properties pop up:

« Proxy user name
« Proxy password

Note: If you're using the Proxy Service, the requested
credentials are the credentials entered during the installation
of the Proxy Service.

The type of authentication is always Basic Authentication.

Bypass proxy for these | Define the servers for which the proxy settings should NOT be used,
servers for example for local communication between different internal
servers or between the Switch Server and the Dashboard Service.
You can enter the IP addresses (one per line) or the host name.
Note that you can use the wildcards "*" and "?" to denote a range of
servers.

Note: If you're using the Proxy Service, make sure to add

a bypass for localhost (to make sure that all locally hosted
services like Web Service and Switch Web Portal will bypass
the Proxy).

Example: 192.166.4.14?

3.1.6. Switch preferences: Mac file types

Mac files not always have a filename extension. Still, filename extensions are useful, to avoid
confusion and to make it possible to exchange files with other operating systems (Windows,
Unix). That's why Switch offers the possibility to automatically add filename extensions to all files
(without filename extension) arriving in Switch. This filename extension is based on Mac file type
information associated with the file (i.e. the file type and file creator codes).

For more information, refer to to About Mac file types on page 41.
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Property Description
Add filename If set to Yes, Switch automatically adds a filename extension to arriving Mac
extension files; if set to No (default value), the filename is left unchanged.

3.1.6.1. About Mac file types

Background information
Microsoft Windows uses the filename extension (which is required) to determine a file's type.

Apple's Mac OS X uses the filename extension (if present) and in addition uses the file type and
creator codes (if present) stored in the catalog entry for the file. This allows Mac OS X to be
compatible with the external world (i.e. Windows and Unix, which use filename extensions) and
with Mac Classic (which exclusively used Mac file types).

Successfully exchanging files in a mixed platform environment requires performing a mapping
between Mac file types and filename extensions, and since the catalog entries for file type
and creator codes are supported only by Mac-specific file systems (such as HFS), they must be
emulated on foreign file systems (such as FAT).

Mac OS X (and Mac Classic) also allows files to have a resource fork (a second stream of
information in addition to the main data). In its most extreme form, a file may store all of its
information in the resource fork and have zero data bytes (as is the case for certain types of
Classic font files). Modern applications tend to rely less on the contents of the resource fork than
Classic applications, but in general the resource fork cannot be ignored.

Again resource forks are directly supported only by Mac-specific file systems, and thus must be
emulated on foreign file systems.

Emulation with dot-underscore file (AppleDouble)

When a Mac OS X user copies a file from a Mac-specific volume to a foreign volume, the system
splits out any information that is not located in the data fork of the file and writes it to a hidden
file on the destination volume. The name of this file is the same as the original file except that it
has a dot-underscore prefix. For example, if the user copies a file named MyMug.jpg to a foreign
volume, there will be a file named ._MyMug.jpg in addition to the MyMug.jpg file in the same
location.

When a Mac OS X user copies a file from a foreign volume to a Mac-specific volume, the system
looks for a matching "dot-underscore" file. If one exists, the system uses the information in the
dot-underscore file to recreate the resource fork and file type attributes. If the hidden file does
not exist, these attributes are not recreated.

Emulation using NTFS alternate data streams

Although this feature is not widely known, the NTFS file system (used by most modern

Microsoft Windows systems) supports alternate data streams in a file. In a way this feature is a
generalization of the Mac resource fork concept. Each individual stream can be opened for input
or output, but otherwise the file (with all its associated streams) is managed as a single unit. The
Windows user interface provides no interface to alternate data streams, and regular Windows
applications never use alternate data streams.

Several AppleTalk file sharing protocol (AFP) implementations for Windows servers, including
Microsoft's own implementation, emulate Mac file types and resource forks on the Windows NTFS
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file system using alternate data streams. Note that these AFP implementations do not support the
FAT file system since it doesn't offer alternate data streams.

This mechanism has the benefit of storing the emulated information in one single file with the
regular data. However the presence of this extra data is extremely hard to detect for a Windows
user (i.e. only through specialized shareware utilities).

Furthermore, while the Windows file system correctly copies any alternate data streams with
a file, the extra information is lost when the file is attached to an e-mail message or when it is
stored in an archive such as a ZIP.

Automatically adding filename extensions

On Windows a file must have a filename extension to be correctly recognized by the applications
operating on it; so there is almost never a reason for not including the extension that is
appropriate for the file's type.

Even on Mac OS X, while it is not a requirement, there seem to be several factors in favor of
including filename extensions when working with automated processes:

- It makes an implicit attribute explicit for the human operator, avoiding confusion (i.e. the
operator and the system might interpret the file type differently if it was not made explicit).

« It allows files to be more easily interchanged with foreign systems (which may happen even if
it is not currently planned).

Therefore Switch offers a function to automatically add an appropriate flename extension to
arriving files, based on Mac file type information associated with the file. This feature is turned on
by default (recommended), and it can be turned off in the Preferences dialog.

Specifically, when Switch detects that a new file has arrived (and the "Add filename extension"
feature is enabled), Switch looks for Mac file type information in the following way:

« On Mac OS X, it looks in the file system catalog.

- On Windows, it looks for an appropriate alternate data stream attached to the file, and it looks
for a dot-underscore file with the same name as the file (in other words, Switch supports both
emulations discussed above).

If Switch finds meaningful Mac file type information, and if it can locate the corresponding
filename extension in its built-in table, and if the file doesn't already have the appropriate
filename extension, Switch will add the filename extension to the file's name. Otherwise the
filename is left unchanged.

Copying files

When Switch copies or moves a file under its own control (for example, between two folders), it
ensures that all available Mac file type information and resource fork data is copied along with
the file. (On Mac OS X this means using the native file operations; on Windows this involves
supporting the emulations discussed above).

This preserves Mac file type information (which may be superfluous if a flename extension is
also present), but more importantly it also preserves any resource fork data - which allows, for
example, to process Classic Mac fonts through Switch on a Windows system.

Note however that other processes and third-party applications may not carry along Mac file
types and resource forks. On Windows this is almost never the case, and even on Mac some
modern applications no longer support these Classic features.

42



ENF@CUS

Switch

Changing the file type

The file type tool allows setting a file's filename extension and/or Mac file and creator types
to a specified value. This is handy if you know the correct type of a file (for example, because
it was created by an application under your control) but you suspect that it may not have the
appropriate filename extension or Mac file type information.

Filtering on file type

Several Switch tools offer the possibility to sort files based on file type; see Specifying file filters

on page 200.

3.1.7. Switch preferences: Processing

These preferences allow you to configure the way jobs are processed in Switch.

A number of these preferences affect the performance of Switch. For more information, refer to
Switch performance tuning on page 443.

Property

Description

Server language

Language used by the Switch Server for alert e-mails.You can select one
of the following languages:

- English

« German

« French

« Portuguese
« Spanish

« Chinese

. Japanese

Note:
« Restart the Switch Server to apply your changes.
- You can also configure the language of the Switch Designer.

For more information, refer to Switch preferences: User
interface on page 35.

Language
environment

Indicates the overall language environment in which Switch is installed:
Western or Japanese.

This setting affects the text encoding defaults for email and ZIP
compression to match the legacy standards used in the selected language
environment (that is, for interacting with software that does not use
Unicode).

Concurrent network
transfer tasks

The number of FTP and e-mail file transfers (counting both send and
receive) allowed to occur in parallel.

Concurrent
transfers to the
same site

The number of file transfers to the same FTP site allowed to occur in
parallel (counting both send and receive).
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processing tasks

Property Description
If there is no limit other than the overall maximum number of concurrent
file transfers (as determined by the previous preference), select Automatic
; otherwise select Inline value and enter a value between 1 and 100.
Concurrent The number of job processing tasks allowed to run in parallel.

Note: Recommended value = the number of CPUs of the server +
1.

"Processing tasks" are tasks performed by the following flow elements:
« The following elements in the Basics section:

« Set hierarchy path
« Ungroup job

« Split multi-job

« Assemble job

« Execute command

« The following elements in the Tools section:

. Sort by preflight state
« Compress
« Uncompress

« Split PDF
« Merge PDF
« Hold job

« Inject job

«  Rename job

. Sortjob

« Logjob info

« Sortfilesin job

« The Script element in the Scripting section:

Heavy scripts affect the number of concurrent processing tasks. For
more details about light and heavy scripts, see Execution slots on page
255.

« The following elements in the Communication section:
« Packjob
« Unpack job
« Monitor confirmation
« Remote process

- The Database connect element in the Database section.

Concurrent PitStop
Server tasks

The number of PitStop Server tasks allowed to run in parallel.

Note: This property is only available, if you have installed PitStop
Server.
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Property

Description

The default is Automatic, which is the optimal value based on the
hardware configuration of the server. If you want to change it manually,
select Inline value and enter a value between 1and 99.

Default number of
slots for concurrent
elements

The number of slots available for scripts and tools working in concurrent
mode:

« 0 =Tasks will be executed in concurrent mode and all available slots
will be used.

« 1 (default) = Tasks will be executed one after the other (serialized
execution mode).

« 2 ormore = Tasks will be performed in concurrent mode.

In Switch, the default value set in the Preferences can be overruled for a
particular flow. Proceed as follows:

1. Set the the flow property Show advanced element properties to Yes.

2. For all flow elements (in that particular flow) that support concurrent
processing, change the element property Number of slots from
Default to any other value.

Note: Be cautious when tuning performance properties; unwary
use may slow down performance!

Scan user-managed
folders every
(seconds)

The frequency with which the user-managed folders (i.e. the folders with
a path defined by the user) and Submit hierarchies (i.e. by default user-
managed) are scanned for newly arrived jobs.

Process file only
after (seconds)

The time for which newly arrived jobs must be stable before they are
processed; to avoid picking up an input job before it has been completely
written to disk, Switch ensures that the size of the file (or the total size

of a job folder) has not changed for at least this amount of time before
processing the job.

Reactivate flows
upon startup

When starting up, if this property is set to Yes, Switch automatically
reactivates flows that were active when Switch was closed; otherwise all
flows are inactive after startup.

Stop processing if
free disk space is
less than (MB)

If the amount of free disk space for application data is lower than the
entered amount, processing will stop, avoiding "Disk Full" processing
errors.

Release acquired
slots after (minutes)

When a flow is stopped, this option will determine when the acquired slots
are released. The default value is 20 minutes.

Note: In Switch 2019 Spring, so before this preference was
added, acquired slots were released immediately. If you want this,
set this preference to O.

This preference is relevant for flows with remote processing (that is, flows
that contain the Remote process flow element or scripts that directly
acquire and release slots). In the time period between the flow stop and
the release of the acquired slots, processing continues, so that jobs that

45




ENF@CUS

Switch

Property

Description

are being processed can be finished. After that time, all jobs that are still in
the flow are aborted.

3.1.8. Switch preferences: Error handling

These preferences allow you to configure the way problems are handled in Switch.

Property

Description

Abort file transfers after
(minutes)

Time in minutes. If an FTP or e-mail file transfer takes longer than
this, it is considered crashed or locked up and it is aborted.

If the value is set to O, the transfer will never be aborted.

Abort FTP scanning after
(minutes)

If an FTP directory scanning takes longer than this time, it is
considered crashed or locked-up and it is aborted. The default
value is 30 minutes.

If the value is set to O, the scanning operation will never be aborted.

Abort processes after
(minutes)

Time in minutes. If a process other than a file transfer takes longer
than this, it is considered crashed or locked-up and it is aborted.

If the value is set to O, the process will never be aborted.

Note that, if Generic application's property Abort application is
enabled, the third-party application will be aborted after the time
specified by this user preference.

Note: This preference is not compatible with debug mode.
If Enable debug mode is turned on, Switch will ignore the
value of this preference. See also Flow properties on page
223.

Abort FTP transfers on
stopping flow

Determines whether or not ongoing FTP transfers are aborted
immediately when a flow is stopped:

« Yes: The flow is stopped immediately. FTP transfers in progress
are aborted. This may result in partially uploaded and corrupt
files.

« No (default setting): The flow is stopped after the FTP transfer
has been finished.

Retry mail transfers after
(minutes)

Time interval in minutes. If a mail transfer fails, Switch tries again
after the specified number of minutes.

If the value is set to O, Switch stops trying. (not recommended)

Retry FTP transfers after
(minutes)

Time interval in minutes. If an FTP transfer fails, Switch tries again
after the specified number of minutes.

If the value is set to O, Switch stops trying. (not recommended)
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Property

Description

Retry unreachable folder
after (minutes)

Time interval in minutes. If a folder cannot be reached, Switch tries
again after the specified number of minutes.

If the value is set to O, Switch stops trying. (not recommended)

Retry failed external
processes after (minutes)

Time interval in minutes. If an external process fails, Switch tries
again after the specified number of minutes.

If the value is set to O, Switch stops trying. (in this case: the
recommended value!)

Send crash reports

If Switch crashes, a detailed crash report is generated automatically.
This information is useful for Enfocus to improve its software. You
can choose to:

« Not send this information to Enfocus (Never).
« Automatically send the crash reports to Enfocus (Always).

« Have the user decide whether or not to send a crash report (Ask
user).

3.1.9. Switch preferences: Problem alerts

These preferences allow you to configure the way system administrators are notified of problems.

Property

Description

Send problem alerts to

Enter the destination e-mail addresses (one per line) and the body text
for your alert message; information about the error will be appended
to the body text.

If at least one email address is entered, two extra properties appear:
« Retry count: If sending an alert fails, this property determines how

many times Switch will retry sending it.

« Retry delay (in minutes): If sending an alert fails, this property
determines after how much time Switch will try again.

Problem job arrives

If set to Yes, an alert is sent whenever Switch moves a job to the
Problem jobs folder.

Processing takes more
than (minutes)

Send an alert if a process, other than the file transfer process, takes
longer than the time set (in minutes) here.

If set to O, no alert will be sent.

Mail server is down for
more than (minutes)

Send an alert when an email server cannot be accessed for the time
(in minutes) indicated here.

If set to O, no alert will be sent.

47




ENF@CUS

Switch

Property

Description

FTP site is down for
more than (minutes)

Send an alert when an FTP site cannot be accessed for the time (in
minutes) indicated here.

If set to O, no alert will be sent.

Folder is unreachable
for more than (minutes)

Send an alert when a backing folder is unreachable for more than x
minutes.

If set to O, no alert will be sent.

Folder scan is taking
more time than
(minutes)

Send an alert when scanning takes more than x minutes.

If set to O, no alert will be sent.

External process fails

If set to Yes, an alert is sent when a process other than folder, fails
(that is, its process is put in the "problem process" state).

Switch Server quit
unexpectedly

If set to Yes an alert is sent when upon startup, Switch detects that
the Switch Server quit unexpectedly (due to a hardware or software
failure).

Free disk space is less
than, MB

Send an alert when the amount of free disk space for application data
is less than the defined amount.

When the flow is
automatically stopped

Send an alert when flows are automatically stopped by Switch, for
example in case of a licensing issue.

Enfocus Appstore
connection fails

Send an alert when the connection between Switch and the Enfocus
Appstore fails.

This triggers the Number of attempts property: Number of failed
attempts after which a notification is sent.

Note: The connection is checked every 8 hours.

Example: If Number of attempts is set to 5, you will get a notification
40 hours after the first failed connection attempt. Details about the
failed attempts can be found in the Switch messages.

3.1.10. Switch preferences: Application data

These preferences configure the cleanup mechanism for Switch's application data, which is
stored in a nested folder hierarchy under a single root folder, which is called the Application data

root.

Some temporary application data cannot be removed automatically. To ensure that the amount of
data does not grow indefinitely, Switch performs a cleanup process at regular intervals.

Property

Description

Application data root

The location of the application data, i.e. the root folder for the
hierarchy in which the Switch application data is stored.

Default location:
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Property

Description

- Windows: C:\Users\<user>\AppData\Roaming\Enfocus\Switch
Server

« Mac OS: /Users/<user>/Library/Application Support/Enfocus/
Switch Server/

Note: For testing purposes, you can change the location
of the application data root tool using the Application Data
Root Tool. Note that changing data in the application data
folder is NOT allowed, unless explicitly requested by the
Enfocus Support team!

Keep internal job tickets
for (hours)

The time period (in hours) after which internal job tickets may be
deleted for jobs that left the flow; Switch will not delete internal job
tickets for jobs that are still active.

Note: A job is considered inactive, if it is located in a flow
output folder (i.e. a folder without outgoing connections)
disregarding if the job's unique prefix has been stripped

or not. This means its job ticket will be cleaned up after
some time. If your workflow configuration assumes handing
over jobs between flows (like described in the section on
unique name prefixes), please, make sure the time difference
between the moment a job reaches the end of the previous
flow and the moment the job is picked up by the next flow is
less than the value of this preference.

Keep log messages for
(hours)

The time period (in hours) after which log messages will be deleted.

Run cleanup starting at
(hh:mm)

The time offset from midnight at which to run the cleanup process for
application data.

Run cleanup every
(hours)

The period or frequency with which to run the cleanup process for
application data.

Cleanup process: how it works

To determine the exact time of the cleanup, three elements play a role:

- Time of the last cleanup since Switch startup, for example: 12:00. If there hasn't been a
cleanup yet, this is the Switch startup time.

- The Run cleanup every (hours) preference, for example: every 5 hours, starting from the time
of the last cleanup. In this example, the first cleanup will be at 17:00 (12:00 + 5 hours). This
resets the time of the last cleanup (which becomes 17:00), so the next cleanup will be at 22:00
(17:00 + 5 hours), and so on.

« The Run cleanup starting at (time) preference, for example: 02:00, forces Switch to perform
a daily cleanup at a particular time. This preference takes priority over Run cleanup every
(hours). When the set time is reached (02:00), the cleanup is performed. The time of this
cleanup (02:00) again determines the next cleanup (02:00 + 5 hours).

Schedule in this example:
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« 02:00 (instead of 03:00, because 'Run cleanup starting at' has priority)

. 12:00
.« 17:00
. 22:00
. 07:00
« 12:00

Note: Starting the cleanup from Designer (File > Cleanup application data) also resets
the 'time of the last cleanup' and affects the schedule. Suppose you start the cleanup at
08:00, the next runs will be at 13:00 (08:00 + 5 hours), at 18:00 (13:00 + 5 hours), at 23:00
(18:00 + 5 hours), at 2:00 (because of Run cleanup starting at), ...

3.1.11. Switch preferences: Logging

These preferences allow you to configure the way (log) messages are handled in Switch.

For more information about the log messages, refer to The Messages overview on page 241.

Property

Description

Log to CSV file

If set to Yes, all execution log messages are written to a CSV file
in addition to the regular log database.

A new log file is created when the size of the log file has reached
2.5 MB. The name of the log file includes the date and the time
(YYYYMM-DDHHmMmss).

Note: Enable this option only on request of the Enfocus
technical support team or if you're debugging a script
that issues debug messages.

The following options are only available if Log to CSV file is set
to Yes.

CSV file delimiter

The delimiter separating the records in the generated CSV log
file, for example a comma or a semicolon.

Log files folder
Folder where the CSV log files will be stored.

If set to Default, the log files are stored in the "Logs" folder of the
Application data root (see Switch preferences: Application data
on page 48).

Log debug messages

If set to Yes, assert and debug messages are logged. They are
shown in the Messages overview and written to a CSV file.

If set to No, the assert and debug messages are discarded.

Note:
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Property Description

- Enable this option only on request of the Enfocus
technical support team or if you're debugging a script
that issues debug messages.

« Changes require a Switch restart.

Refer to The Messages overview on page 241.
Remark about debug messages for Node.js scripts and apps

If you only want to log debug messages for a particular script
or app written in Node.js, you can do so without enabling this
preference (hence without having to restart Switch). To do so:

1. Inthe properties of the flow, enable Show advanced
element properties. See Flow properties.

2. Inthe properties of the Node.js script or app, enable Log
debug messages. See also Script element.

Log FTP interaction If set to Yes, problems with failed FTP transfers are logged and
saved in:

« FtpSendTrace.log for FTP send

+ FtpWatchFolderTrace.log and FtpReceiveTrace.log for FTP
receive

These files can be found in the logs folder of the Switch
Application Data Root (as set in the Application data
preferences).

The following option is only available if Log FTP interaction is
setto Yes.

Clean the log when flow is activated

If set to Yes, the FTP interaction logs will be deleted when the
flow is activated.

Note: When logs are stored for a long time, Switch
may become slow and sometimes non-responsive.
Therefore, we recommend clearing logs regularly.

3.1.12. Switch preferences: Flows backup

When upgrading to a new version of Switch, the existing flows are updated automatically to that
version. That's also the case, when you're installing a new version of an app: in that case, the
flows in which the updated app is used, are updated as well.

The preferences in this category allow you to make an automatic safety backup (at a location of
your choice) before updating the flows.
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Property Description

Flows backup folder By default, this is a subfolder ('Backup ') of the application data
root, but you can choose a different location as required.

The flows are placed in a subfolder that refers to the date and
time of the export.

Backup flows before When set to Yes, a backup is made whenever an upgrade takes
updating place.

Note: Group information is not preserved. The flows are
saved as separate flow files (*.sflow).

3.1.13. Switch preferences: Internal communication

These preferences configure advanced settings related to the communication between Switch
application components. Do not change these settings unless you understand why you need to
change them.

Note: The ports in the range O to 1023 are often managed by the IANA and should only
be used by privileged users.

Property Description

Switch Server name The name of the instance of the Switch Server as it is displayed to
users of the client application.

Note: Changing the server name requires a restart of
Switch.

Port for Switch Designer | The port used for communication between Switch Server and
Switch Designer, in the range of 1to 65535.

Note:

- If you intend to use Remote Designer, try to make the
port accessible for trusted networks and/or addresses
only.

« If you don't intend to use Remote Designer, inbound
connections on this TCP port should be blocked by your
firewall for security reasons.

Port for Watchdog - Switch | The port used for communication between Switch Server and
Server Switch Watchdog, in the range of 1to 65535.

Note: This port is used for local communications only, so
no firewall tweaks are required.

Port for Watchdog The port used for communication between Switch Designer and
Switch Watchdog, in the range of 1to 65535.
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Property Description

Note: This port is used for local communications only, so
no firewall tweaks are required.

Note: To allow outbound traffic for Switch (like HTTP, email, FTP, etc.), firewall exceptions
should be set for all executables located in the Switch installation folder. This is in case
you want to block outbound traffic by default on the system.

3.1.14. Switch preferences: ODBC data sources

This section of the Preferences dialog is only relevant if you have an active license for the
Databases module.

It allows you to configure the ODBC database connection you want to use with Switch.

Property Description

ODBC data [:]

source Click to set up the database connections. See Setting up an ODBC
information database connection on page 54.

3.1.14.1. About ODBC data sources in Switch

Guidelines
Please take into account the following guidelines when accessing ODBC data sources in Switch:

Before you set up the connection to the data source, you should have defined your database
(i.e. the Database Source Name (DSN)) in the DSN settings of your operating system. Read the
documentation of your database to learn how to set up the DSN.

Windows users can find more information on the Microsoft website: http.//msdn.microsoft.com/en-
us/library/ms710252%28v=VS.85%29.aspx

Mac users should install an ODBC Administrator, for example http.//www.odbcmanager.net/, to
be able to set up ODBC connections on Mac.

Note: Switch allows you to use both User and System DSN on Windows and Mac
platforms.

Make sure to install a 64-bit ODBC driver.

- Example Windows OS: In case of MySQL database, the ODBC driver installer mysq|l-
connector-odbc-5.1.8-winx64.msi is used. When you launch this installer and choose the
Custom installation, you will see that two drivers are available: 32-bit and 64-bit. Install the
64-bit driver and preferably disable the 32-bit driver, to avoid mix-up of driver versions in the
future. This will guarantee that Switch uses the correct driver.

For more information on ODBC drivers and data sources, refer to http://msdn.microsoft.com/en-
us/library/ms710285%28v=VS.85%29.aspx .
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- Example Mac OS X: In the MySQL database, two versions of Mac OS X ODBC drivers are
available: 32-bit and 64-bit. You must use the 64-bit version (mysql-connector-odbc-5.2.7-
0sx10.7-x86-64bit.dmg).

Make sure to use the 64-bit version of the ODBC Administrator tool to configure your data
sources (DSNs).

On 64-bit Windows computers, two ODBC Administrator tools are available:

. 32-bit version: ..\windows\sysWwOW&64\odbcad32.exe

« 64-bit version: ..\windows\system32\odbcad32.exe

Use the 64-bit version from \windows\system32\odbcad32.exe to configure your DSNs for Switch.

« If you install only the 64-bit ODBC driver and then launch the 32-bit version of the tool, you will
not be able to configure any DSNs, because the 32-bit version of the tool does not show the
64-bit ODBC drivers.

« If you have installed the 32-bit ODBC drivers, then in the 32-bit version of the tool you will see
the 32-bit driver and you will be able to configure DSNs for that driver. However, Switch will
not work with these DSNs and you will get the error message The specified DSN contains an
architecture mismatch between the Driver and Application".

For more information on managing data sources, refer to http://msdn.microsoft.com/en-us/library/
ms712362%28v=VS.85%29.aspx .

Using the INGRES database in combination with Switch?
You should set the following flag (in the INGRES database):

return NULL for SCHEMA columns in ODBC catalog function result sets

Otherwise, you will get an error ("invalid table") when setting up SQL statements.

3.1.14.2. Setting up an ODBC database connection

If you want to use Switch with an ODBC data source (and you have licensed the Database
module), you must set up a connection to the preferred database.

Note:

- If you have more than one database, you can configure different database
connections as required.

« The database engine can run on a different computer than Switch.

To configure an ODBC database connection
1. In Switch, navigate to Edit > User Preferences > ODBC data sources.

2. Do one of the following:

Select the ODBC data source information field and click [:]
« Double-click the ODBC data source information field.

The ODBC data sources dialog appears.

To add and configure an ODBC data source, click ':II}'
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The ODBC sources field now contains one data source, temporarily called Data Source. You
can rename it in the next step of this procedure.

L ] @ ODBC data sources
QDBC sources Properties
i Data_source

Data source Data_source

Description  dsdsadas

DS dBase Files

Username

Password

Query codec  UTF-8 [
Data codec UTF-8 [

Test connection
® 9
Cancel QK

4. In the Properties pane, in the Data Source text field, provide a name for the data source.

5. Inthe Description text field, provide a small definition for the data source.

To select the DSN (Database Source Name) from the library, click E]

The DSN must be defined in the DSN settings of your operating system. For more
information, refer to About ODBC data sources in Switch on page 53.

7. Provide a Username and Password.

These two fields can also be left blank if username and password are not required, or if they
have already been defined for the DSN.

8. From the drop-down menus, select the appropriate Query codec and Data codec, if required.

9. To test the database connection, click Check connection.
If the connection succeeded, a message box appears displaying the message Connection
successful.

Note: In case of problems, you will see an error message generated by the ODBC
tool of your operating system.

10. To close the message, click OK.

If you have more than one database, repeat step 3 to 10 and add as many data sources as
you have databases.
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11. To close the ODBC data sources dialog, click OK once more.

3.1.15. Switch preferences: Remount volumes

Note: Remount volumes is available only when Switch Server is running on Mac OS X.

The backing folders used by flow elements may be located on mounted volumes. On Mac OSX,
if the network connection is interrupted, Switch automatically remounts the volumes that are
used by the elements in active flows. By default, when remounting, Switch uses the volume
information from the backing folder path. However it is also possible to define the additional
remount information in the Switch preferences.

Property Description

Volume remount | List of volume paths with corresponding user name and password.

information The specified user name and password is used to mount these volumes.
To edit the volume remount information, double-click the property. See
Setting up remount volume information on page 57.

Property editor

This preference uses a new property editor which offers the following three columns:

Column header Description

Volume path The complete network path identifying a volume that may
have to be remounted by Switch.

User name The user name to be used for remounting the volume
(required field).

Password The password to be used for remounting the volume.

Leaving the user name empty is equivalent to not listing the volume at all. When user closes the
property editor all items with empty user names are automatically removed. This is relevant to the
suggestion feature described in the next section.

Show volume paths used by active flows

When editing the Volume list, the Show volume paths used by active flows can be used to list
all volume paths currently in use by active flows at the end of the list. By default this checkbox

is turned on. Its state is remembered between uses of the property editor and across Switch
sessions. If the volume path contains a user name, this will be entered in the User name field. The
password is NOT added automatically.
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3.1.15.1.

When turning the option off, all volume paths with an empty user name will be removed from the

list.

Setting up remount volume information

If your Switch is running on Mac OS X, you can make sure that volumes will be remounted if the
network connection is interrupted.

To configure remount volume information

1.

2.

In Switch, navigate to Edit > User Preferences > Remount volumes.

Do one of the following:

Select the Volume remount information field and click [:]
« Double-click the Volume remount information field.

The property editor appears.
Enter the following details:

+  Volume path: The complete network path identifying a volume that may have to be
remounted by Switch.

« User name: The user name to be used for remounting the volume (required field).

Note: Do not leave the user name empty! When closing the dialog, volumes
without a user name are automatically removed if Show volume paths used by
active flows is disabled (see step 4 of this procedure).

« Password: The password to be used for remounting the volume.

Select or clear the Show volume paths used by active flows checkbox as required:

. If selected (default value), all volume paths currently in used by active flows will be added
to the list of volumes to be remounted. If the volume path contains a user name, it is
added automatically as well, but this is NOT the case for the password. You must add the
password manually.

« If cleared, all volume paths with an empty user name will be removed from the list.

Note that the state of this checkbox (enabled/disabled) is remembered between uses of
the property editor and across Switch sessions.

Click OK.

3.1.16. Switch preferences: Active Directory settings

Active Directory Settings are only relevant if you want to use your existing Active Directory user

accounts to define access rights for the Switch Web Portal and/or Remote Designer. For more
information, refer to Setting up Switch users on page 64.

Double-clicking Active Directory information, displays a dialog with the following fields:
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Property Description

Server address | Address of the Active Directory server.

Example: SERVEROO1.enfocus.com

Server port Port number of the Active Directory server.
Example: 389
Remark:

The default port for an LDAP connection is 389, and for LDAPS it is 636.
When you configure an LDAP connection to use port 389/636, you search
for objects from the local domain controller only (replicated between domain
controllers in the same domain).

Alternatively, when you use the environment with multiple domains in the
forest, it is often required to use the Global Catalog in order to return objects
from all domains in the forest. The default port for this is 3268 for LDAP and
3269 for LDAPS.

Secure ) If selected, Switch will set up a secure TLS/SSL connection to the Active
connection Directory server.
Remark:

- If server port 636 is used, the SSL negotiation will start immediately after
the connection has been established.

- If a different port is used, Switch connects in plain text to the AD server,
then explicitly starts the SSL negotiation through the StartLS command.

LDAP version The version of the LDAP protocol used on your Active Directory server.

Example: 2 or 3 (default)

Base DN Distinguished name to be used as the search base.
Example:

Usually, users and user groups are located under the domain name. If users
are stored in the folder enfocus.com, the base DN is: DC=enfocus; DC=com.

Note: If you don't know the base DN, you can leave it empty.
Once you have executed an AD directory query, it will be filled in
automatically.

Use pre- This option defines how user names are generated when Active Directory
Windows 2000 |users are added in the Users pane:
logins

«  When selected, the name of an Active Directory user added in the Users
pane will have the format "domain\user" (also known as pre-Windows
2000 domain name), e.g. Netbios\sAMAccountName. Make sure to also
use this format for the user to be used to log on to the Active Directory
server (next field).

«  When cleared, the name of an Active Directory user added in the Users
pane will have the format "user@domain" (also known as the User
Principal Name), e.g. user@example.com. Make sure to also use this
format for the user to be used to log on to the Active Directory server
(next field).
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Property Description

Note: Changing this option has no impact on the users already
present in the Users pane. However, if needed, you can manually
adjust the User names in the Users pane.

User User name to log on to the Active Directory server.

If Use pre-Windows 2000 logins is selected, the required format is "domain
\user", for example: enfocus\user1

If Use pre-Windows 2000 logins is cleared, the required format is
"user@domain", for example: useri@enfocus.com

Password Password to log on to the Active Directory server.

Note: To verify the connection to the Active Directory server, click the Test connection
button.

3.1.17. Switch preferences: Web services

These preferences configure the settings related to the communication between Switch and its
client applications.

Property Description

Port for the The port in the range of 1to 65535 used for:

Switch Web

Service « Communication between the Switch Web Service and a client application

+ Receiving webhooks on the URL <http or https>://<Switch host name or IP
address>:< Port for the Switch WebService >/scripting/<custom path>.

Default value: 51088

Important:

- If you intend to use Designer or Switch Web Portal remotely, try
to make the port accessible only for trusted networks and/or
addresses.

« If you don'tintend to use Remote Designer or Switch Web Portal
remotely, inbound connections on this TCP port should be
blocked by your firewall for security reasons.

Note:

« The port for the Switch Web Service is only used for elements and
scripts based on Node.js. For the Webhooks flow element (up to
version 6) and other legacy scripts, see the Webhooks (legacy)
preferences.

« The size of the incoming webhook request is limited to 1IMB. HTTP
error 413 will be returned to the webhook caller in case of bigger
incoming requests.
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Property Description

Por.t for the The port used for communication between the SwitchClient WebServer and a
Switch Web client application, in the range of 1to 65535.

Portal

Default value: 51089

Important:

- If you intend to use Switch Web Portal remotely, try to make the
port accessible only for trusted networks and/or addresses.

« If you don'tintend to use Switch Web Portal remotely, inbound
connections on this TCP port should be blocked by your firewall
for security reasons.

Protocol The protocol used for the communication between the Switch WebServer and
the browser. Choices:

« HTTP (default value)

« HTTPS (secured, encrypted communication for which you need a
certificate) You must set the HTTPS settings in the corresponding Switch
preferences category: Switch preferences: HTTPS services settings on
page 63.

Note: If your browser does not recognize the used certificate, it
may block the Log messages overview. In that case, you must add
it as an exception in your browser settings.

Privacy policy URL (starting with "http" or "https") of the privacy policy of your company. This
page URL is used to make the privacy policy of your company available to users of
the Switch Web Portal.

Example URL: http://www.enfocus.com/en/privacy-policy/

If this property is empty, no privacy policy is displayed.

Note: Changing this property requires a restart of Switch.

A privacy policy contains the guidelines a company uses to protect the
information provided by its customers. It's a legal requirement to have such a
privacy policy if you're collecting data from your customers. As in Switch the
language preference of the users is stored (using cookies) when they launch
messages in a web browser, we recommend entering the link to your privacy
policy.

The privacy policy is made available as follows:

« On the login page of the Switch Web Portal, there's a 'Privacy policy'
button; when a user clicks this button, the web page concerned is
displayed.
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Property Description

« Once signed in to the Switch Web Portal, the Info menu in the bottom left
corner gives access to the Privacy policy.

3.1.18. Switch preferences: Reporting

These preferences relate to the Dashboard Service that enables the creation of dashboards and
job boards on the Switch Web Portal.

Property Description

Dashboard Indicates where the Dashboard Service was installed.
Service location
« Local (default): The Dashboard Service was installed on the same system

as the Switch Server.

Note: For security reasons, make sure that the 55091 TCP
(MongoDB) and 55092 TCP ports are not available for inbound
connections from network in your firewall settings.

« Remote: The Dashboard Service was installed on a different system (for
example to avoid overload of the server), so the connection between
Switch and the Dashboard Service is remote. If this option is chosen, the
following additional properties appear:

« Address: IP address of the system on which the Dashboard Service
was installed.
« Port: Port used for the communication between the Switch Server and

the Dashboard Service.

Default value: 55092

Important: For security reasons, make sure that the remote
server that is running the Dashboard Service, only accepts
inbound connections on the 55091 TCP port (MongoDB) and
the TCP port (specified in the settings) from the system that is
running Switch Server.

Keep historical | |ndicates how long historical data (= data about jobs that left a flow) should
data for (days) | pe kept. During this period of time, the historical data can be used in history
graphs in dashboards on the Switch Web Portal.

The default value is 120 days.

This preference is only available if the Reporting Module is licensed.
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Note: To verify the connection to the Dashboard Service, click the Test connection
button.

3.1.19. Switch preferences: Webhooks (legacy)

These preferences relate to the webhooks, a mechanism that allows external applications to
request information from Switch.

Note: The preferences in this category apply to the Webhooks flow element in Switch
Designer (up to version 6) and to legacy scripts that use webhooks. For use in Node.js
scripting, refer to the Web Services category.

Property Description
Enable HTTP If set to Yes, Switch accepts requests from external applications/third-party
listener services via HTTP. This triggers a new property:

+ Port for HTTP listener: Port used for the communication between the
Switch HTTP listener and the third-party service. The default value is
51080.

Important: If you know the IP addresses, from which webhooks
will be sent, in advance, try to limit access to this TCP port by only
allowing inbound connections from those specific addresses for
additional security.

Enable HTTPS If set to Yes, Switch accepts requests from external applications/third-party
listener services via HTTPS (secured, encrypted communication for which you need a

certificate).

You must set the HTTPS settings in the corresponding Switch preferences
category: Switch preferences: HTTPS services settings on page 63.

Important: If you know the IP addresses, from which webhooks
will be sent, in advance, try to limit access to this TCP port by only
allowing inbound connections from those specific addresses for
additional security.

Reguests. Indicates how long (in minutes) a request that is not received remains valid.
delivery timeout | After this period of time, the request is removed.
(in minutes)

3.1.20. Switch preferences: Remote processing

These preferences relate to the tools for remote processing.

Property Description

HTTP port Port used for communication with external applications/third-party services
via HTTP. The default value is 57120.
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Property Description

Important: If you know your remote processor IP addresses in
advance, for additional security, try to limit access to this TCP port by
only allowing inbound connections from those specific addresses.

Enable HTTPS If set to Yes, Switch accepts requests from external applications/third-party
services via HTTPS (secured, encrypted communication for which you need a
certificate).

You must set the HTTPS settings in the corresponding Switch preferences
category: Switch preferences: HTTPS services settings on page 63.

Important: If you know your remote processor IP addresses in
advance, for additional security, try to limit access to this TCP port by
only allowing inbound connections from those specific addresses.

3.1.21. Switch preferences: HTTPS services settings

These preferences hold the settings for external communication via HTTPS (secured, encrypted
communication). These settings are used whenever HTTPS is enabled, for example for remote
processing (see Switch preferences: Remote processing on page 62) or for webhooks Switch
preferences: Webhooks (legacy) on page 62.

Property Description
Certificate Path to the certificate file.
Private key Path to the private key file.

Password for
private key

Corresponding password.

Note: If you intend to use self-signed certificates for HTTPS, see HTTPS with self-signed
certificates on page 445 for more info on the client setup.

3.2. Configuring Switch users

When do you need to set up users?
Switch user configuration is only relevant if you want to allow users to:

« Submit or check jobs using Submit points and Checkpoints (which requires a SwitchClient
license).

« View log messages through the Switch Web Portal.
« Rush jobs through the Switch Web Portal.

« View and/or create job boards and dashboards on the Switch Web Portal.
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« Launch Switch Server using Remote Designer.

Procedure

1. Set up the users and/or groups that should get access.
2. Assign access to particular Submit and Checkpoints (as required).

3.2.1. Setting up Switch users

How does it work?

If a user connects to the Switch Server through the Switch Web Portal or through Remote
Designer, he must enter a user name and a password. The user name identifies the user to the
server and grants him access based on his permissions. For example, if a Remote Designer user
has read-only access, he will be able to view all flows and settings, but he will not be able to
change anything.

Users or groups?

If several users should have the same permissions (for example because they have the same
role), you may consider to group them and define their (access) rights at group (or "role") level.
This will save you time if something changes. For example, if a new employee with a particular
role enters the company, you can simply add the new user to the appropriate group.

Example:

« Group 1: Administrators having access to all Submit points and Checkpoints. Only this group
has full access to Remote Designer.

« Group 2: Operators having access to all Submit points and Checkpoints, but with limited
access to Remote Designer.

«  Group 3: Customers having access to particular Submit points and Checkpoints (so they can
only see their own jobs), but with no access to Remote Designer.

With this setup, you have to configure the permissions and access rights only three times, instead
of e.g. x times (with x being the number of users).

Groups are also required if you want to allow users to share their job boards and dashboards on
the Switch Web Portal. Sharing of boards is only possible among group members.

Note: In case of conflicting permissions, the highest permission level is taken into
account. For example, if a user has no access to Remote Designer, but the group(s) he
belongs to does have access, he will have access as well.

If you have configured a group, you can define a group manager for that group. Group managers
can view jobs of their group members, whereas regular group members can only see their own
jobs (unless otherwise configured).

How to configure users?
There are different ways to set up users:

« You can create new users and groups in Switch.

« You can import users and groups that you exported from a previous Switch version or from a
Switch copy installed on another computer.

«  You can import existing Active Directory users and user groups from your Active Directory
domain.
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3.2.1.1. Configuring a user

Note: You can set up new users and groups for use in Switch only, or you can re-use
your Active Directory users and user groups. This topic explains how to set up users for
use in Switch only.

To configure a user

1.

x]

In the toolbar at the top of the application, click the Users button

Under Users & Groups, select the Users category Users

Click the Add user button I—’-}, at the bottom of the pane.

A new user (New User <number>) is added to the Users category.

Enter the required details:

« User name

« Full name

. Password

- Email address. The email address is used to send messages to users (if configured as

such in a flow).
If the user belongs to a group, proceed as follows:

8. Click the plus icon i"‘: at the bottom of the Member of field.

b. Select the group(s) the user belongs to.

To select several user groups in one go, hold down the Ctrl key while selecting them.
c. Click OK.

To remove groups from the list as required (for example if you made a mistake, or if the user
does no longer belong to the group), select the group(s) concerned and click the minus icon

Assign the appropriate permissions for the Switch Web Portal:

« In case of an active SwitchClient license, to allow the user to submit and check jobs
through the Switch Web Portal, select the Submit and check jobs checkbox and
determine which jobs the user is allowed to handle:

« All jobs (also the ones submitted by other users)
« Own jobs (only the ones submitted by the user) or Own jobs and group members'
jobs (this option is only available for group managers)

Note that this only applies to jobs in Checkpoints the user has access to.

. To allow the user to view error messages through the Web Portal, select the View
messages checkbox.
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« To allow the user to process certain jobs before other jobs in the queue, select the Rush
jobs checkbox. This can be useful for urgent jobs. For more information, refer to Rushing
jobs on page 288.

« To configure the permissions for boards on the Web Portal, select the appropriate option:
« To allow the user to view and create dashboards, select Full access.

- To allow the user to only view shared boards, but not create them themselves, select
Read-only.

« To hide all boards from the user, select No access.

7. Configure the appropriate permissions for Remote Designer (as required):

« To grant the user the same permissions as if he were working locally, select Full access.
« To allow the user to only view data, but not change them, select Read-only.
« To not allow the user to launch Switch using Remote Designer, select No access.

If the user has the right to submit and check jobs (step 6), next thing to do is: assign access to
particular Submit and Checkpoints.

3.2.1.2. Configuring a user group

Note:

« You can set up new users and groups for use in Switch only, or you can re-use your
Active Directory users and user groups. This topic explains how to set up groups for
use in Switch only.

« The Administrators group is available by default and cannot be removed. Members
of this group have full access to the Switch Web Portal (including the Admin view)
and to Remote Designer. Do not forget to add users to this group (see step 6 of this
procedure). Note that administrators can unlock jobs of all users on the Switch Server.

To configure Switch user groups

1 .
In the toolbar at the top of the application, click the Users button. -

Under Users & Groups, select the Groups category. && Groups

Click the Add user group button ‘L’ at the bottom of the pane.
A new user group (New Group <number>) is added to the Groups category.

4. Enter the group name.

5. Select the group manager(s) (as required):

a . CP .
* Click “I¥ at the bottom of the Group manager field.
b. Select the user(s) that need(s) group manager rights.

To select several user groups in one go, hold down the Ctrl key while selecting them.
c. Click OK.
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Tip: Alternatively, you can select a member in the Group members field and drag it to
the Group manager field.

« Group managers have more rights than the other group members. They can for example
unlock the jobs of their group members (in addition to their own jobs) on the Web Portal.
« To remove users from the Group manager list as required, select the user(s) concerned

and click ':S'

6. To select the group members that belong to the group

8- Click 3‘3 at the bottom of the Grou
1 p members field.
b. Select the user(s) belonging to the group.
To select several users in one go, hold down the Ctrl key while selecting them.
c. Click OK.
To remove users from the list (for example, if you made a mistake), select the user(s)

concerned and click @

7. Assign the appropriate permissions for the Switch Web Portal:

« In case of an active SwitchClient license, to allow the users of the group to submit and
check jobs through the Switch Web Portal, select the Submit and check jobs checkbox
and determine which jobs the group members are allowed to handle:

« All jobs (the user's jobs and the jobs of other users, not limited to the other group
members' jobs)

« Own jobs (the users of this group can only see their own jobs, the group manager can
see all the jobs of the group he belongs to)

Note that this only applies to jobs in Checkpoints the user has access to.

« To allow the members of this group to view error messages through the Web Portal, select
the View messages checkbox.

- To allow the members of this group to process certain jobs before other jobs in the queue,
select the Rush jobs checkbox. This can be useful for urgent jobs. For more information,
refer to Rushing jobs on page 288.

- To configure the group permissions with regard to boards on the Web Portal, select the
appropriate option:

- To allow the users of the group to view and create dashboards, select Full access.

« To allow the users of the group to only view shared boards, but not create them
themselves, select Read-only.

- To hide all boards from the user of the group, select No access.

8. Determine whether or not the members of this user group are allowed to launch Switch using
Remote Designer:

« To grant the users the same permissions as if they were working locally, select Full
access.

- To allow the users to only view data, but not to change them, select Read only.
« To not allow the user to launch Switch remotely, select No access.
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3.2.1.3.

If the group members have the right to submit and check jobs (step 7), next thing to do is: assign
access to particular Submit and Checkpoints.

Importing users and user groups from Active Directory

An Active Directory domain controller manages and authenticates all users in a company
network. If you import Active Directory users and user groups in Switch, the user names and
passwords used in Switch will be checked against your Active Directory server and not against
the local Switch user database. As a consequence, users can use the name and password they
use to log in on their work computers.

Note: You must have configured your Active Directory settings (such as server address,
user name and password) in the User Preferences pane. For more information, refer to
Switch preferences: Active Directory settings on page 57.

To import users and user groups from LDAP directory

1. -

In the toolbar at the top of the application, click the Users button.

In the Users pane, click the Select AD user or group button ‘# at the bottom of
the pane.

3. Inthe dialog that pops up, enter (part of) the AD (user) name or email address.

Note: The search function is case-insensitive.

4. Click Search.

5. Select the user or user group you want to use in Switch.

Tip: You can sort the search results alphabetically, by clicking the column headers.

6. Click OK.

- If you selected an Active Directory group, the group name and the group members are
displayed in the Groups category in the Switch Users pane. Subgroups (if any) are not
preserved; all users are presented in one flat list.

« If you selected an Active Directory user, the user name, full name and email address are
displayed in the Users category in the Switch Users pane. Note that these details are read-
only.

7. If you selected an Active Directory user, you can optionally add the user to an existing group:

a @R
* Click "I’ at the bottom of the Member of field.
b. Select the group(s) the user belongs to.

To select several user groups in one go, hold down the Ctrl key while selecting them.
c. Click OK.

To remove user groups from the list as required, select the group(s) concerned and click @
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8. If you selected an Active Directory user group, you can select a group manager (as required):

-

8- Click CB at the bottom of the Group manager field.
b. Select the user(s) that need(s) group manager rights.

To select several user groups in one go, hold down the Ctrl key while selecting them.
c. Click OK.

Tip: Alternatively, you can select a member in the Group members field and drag it to
the Group manager field.

- Group managers have more permissions than the regular group members. Refer to step 9
of this procedure.

« Toremove users from the Group manager list as required, select the user(s) concerned
and click @

9. Assign the appropriate permissions for the Switch Web Portal:

« In case of an active SwitchClient license, to allow the users (or the members of the user
group) to submit and check jobs through the Switch Web Portal, select the Submit and
check jobs checkbox and determine which jobs the users are allowed to handle:

« All jobs

« Own jobs (users can see their own jobs; if they are a group manager, they can also see
the jobs of the other group members)

Note that this only applies to jobs in Checkpoints the group or the user has access to.

- To allow the users (or members of this user group) to view error messages through the
Web Portal, select the View messages checkbox.

« To allow the users (or members of this user group) to process certain jobs before other
jobs in the queue, select the Rush jobs checkbox. This can be useful for urgent jobs.

« To configure the permissions for boards on the Web Portal, select the appropriate option:
« To allow the users (or members of this group) to view and create dashboards, select

Full access.

« To allow the user (or members of this group) to only view shared boards, but not create
them themselves, select Read-only.

« To hide all boards from the users (or members of this group), select No access.

10. Determine whether or not the users (or members of a user group) are allowed to launch
Switch using Remote Designer:

- To grant the user the same permissions as if he were working locally, select Full access.
« To allow the user to only view data, but not to change them, select Read only.
« To not allow the user to launch Switch using Remote Designer, select No access.

3.2.1.4. Importing users and user groups

If you have installed different copies of Switch, it can be useful to export the user information from
one copy and import it into the other. This topic describes how to import user information.
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To import users and user groups

. =

In the toolbar at the top of the application, click the Import button. ™MPert

2. Inthe Import users and groups dialog, select the user information file exported from Switch.

This can be a text file or an XML file.

3. Click Open.

In case of conflicts (for example if a user already exists in Switch), a warning is displayed. You
are asked which user (or user group) you want to keep (i.e. the imported user or the one that
already exists in Switch).

The imported users and user groups are displayed in the Users and Groups panel in Switch.

Note: When you're importing Switch 18 /18 update 1 users or user groups, all users that
had the right to create boards will have full access to boards in later Switch versions.
Users that did not have the right to create boards, will have no access. You can change
this setting manually if required.

3.2.1.5. Exporting users and user groups

If you have installed different copies of Switch, it can be useful to export the user information from
one copy and import it into the other. This topic describes how to export user information.

To export users and user groups

. =

In the toolbar at the top of the application, click the Export button. Export
2. Inthe Export users and groups dialog, type a name for the exported file.

3. Select the preferred file type:

- To save the exported file as an XML file, select: Switch users and groups (*.xml).
« To save the exported file as a text file, select Switch users and groups (*.txt).

4. Click Save.

3.2.2. Assigning access rights

If you have designed flows with Submit points and Checkpoints, you can indicate who has the
right to use them. This is done in the right part of the Users pane.

What users can do in Submit and Checkpoints depends on:

« The permissions assigned to the group they belong to (if applicable)
« Their permissions on user level (View messages/Submit and check jobs).
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Their role in the group (group manager or regular group member). For example, group
members can see, edit, route and unlock other group members' jobs, whereas regular group
members can only do this for their own jobs (unless otherwise configured).

3.2.2.1. Assigning access to Submit points and Checkpoints

For each Submit point and Checkpoint used in your Switch flows, you can define which users or
user groups have the right to access it.

To assign access to Submit points and Checkpoints

1.

22
In the toolbar at the top of the application, click the Users button.

In the right part of the Users pane, under Submit points, all flow groups and flows with a
Submit point configured in Switch are shown. Under Checkpoints, flow groups and flows with
a Checkpoint are shown.

To assign access to one or more Submit points, under Submit points, select:

All, to give access to all Submit points in all flows on the Server.

A flow group ( ), to give access to all underlying Submit points (i.e. all Submit points
configured for all flows in the selected group).

A flow (=), to give access to all Submit points configured for that flow.

A Submit point ( '5), to give access to this particular Submit point.

Note: The users or groups that have access to the selected level are listed on the
right; users for whom the access has been set on a higher level (e.g. on group level
iso flow level) are also shown but grayed out. Note that you must select the correct
level to remove a user or user group.

Click @.

Note: Alternatively, if (earlier selected) users or groups are listed in the right part of
the panel, you can simply select them and drag and drop them (one by one) to the
appropriate Submit point.

Select the appropriate user or group.

Click OK.
The name of the selected user or group is shown.

Proceed in the same to way to give access to Checkpoints £
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3.3. Running Switch Watchdog as a service

Note: This section is only relevant if your operating system is Microsoft Windows.

3.3.1. Switch Server and Switch Watchdog

Switch offers its functionality through a number of separate applications. See Switch application
components on page 7.

The Switch Server runs in the background (without user interface) to execute flows, monitored
and managed by the Switch Watchdog. In normal circumstances it is automatically started and
terminated as needed by the Switch Designer.

3.3.2. Setting up Switch Watchdog as a Windows service

On Microsoft Windows, the Switch Watchdog can be operated as a Windows service. This allows
Switch to continue processing after you have logged off from the computer. In addition, you can
specify that Switch should be restarted automatically after a system failure. Running the Switch
Watchdog as a Windows Service will also restart Switch when it quit unexpectedly.

Note: Are you using third-party apps in Switch? In that case it is not recommended to
set up Switch Watchdog as a Windows service. Most third-party and desktop applications
do not support this. Refer to Switch Service not compatible with (apps for) desktop
applications on page 74.

To set up Switch Watchdog as a Windows service, proceed as follows:

1. In Switch, navigate to Edit > Preferences > User Interface and configure the following
preferences:

. Start Switch Server automatically at login = No

«  When exiting the flow designer = Ensure processing is started.

This avoids that Switch is started when a user logs in to Windows. For more information, refer
to Switch preferences: User interface on page 35.

2. Inthe Windows operating system, navigate to Start > Control Panel > Administrative Tools >
Services.

If necessary, switch to "Classic View".
3. Inthe list of services, locate Enfocus Switch Watchdog.
4. Right-click this service and choose Properties.

5. On the General tab, choose the startup type you prefer:

- Automatic will make sure the service is started when booting your computer.
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(Note that configuring this setting does not start the service; Switch Watchdog will start as
soon as you reboot your computer.)

« Manual means you will have to start the service explicitly from this dialog box.

6. On the Log On tab, enter the information for the user account that should be used to run the
service.
This allows Switch to get access to information saved in a specific user's preferences (such as
Photoshop actions) and to use Switch data stored in the application data root (which is linked
to a specific user and looks like this: C:\Users\<user>\AppData\Roaming\Enfocus\Switch
Server). If you want to keep using the same application data, after switching to Windows
service mode, make sure to use the same user.

Also, if Switch should get access to the network (e.g. to save files), make sure the chosen
user has the appropriate access rights.

7. Back on the General tab, click the Start button to launch the Switch Watchdog as a service.

Note: When shutting down or rebooting the operating system, the operating system will
wait for maximum 30 minutes before terminating the Switch Watchdog service and all

its child processes. Therefore, to make sure that the Switch Watchdog service is able to
shut down gracefully, we advise stopping all flows before shutting down or rebooting the
operating system.

3.3.3. Operating Switch as a Windows service

After you install the Switch Watchdog as a service in the installer, the Server need not to be
installed as a service anymore.

At startup, the Designer checks if the watchdog is running. If the Watchdog is not running, the
Designer starts the Watchdog as a background application. The Watchdog starts the Server
almost immediately and the Designer connects to the Server.

Be careful though:

«  When you quit the Switch Designer, you will be asked whether you want the server to keep
running. If you choose No, the server will terminate.

« The Switch Designer next sends a message to the Switch Watchdog to quit.

3.3.4. Switch service and mapped drives

Microsoft Windows allows assigning a drive letter to a network computer or folder, creating a
mapped drive. A mapped drive letter (such as Z) can be used in a file or folder path just like a
local drive letter (such as C). But there is a catch: the drive mappings are established when a user
logs in to the system - and a service is not logged in (even if it is associated with a user account).

Thus while Switch Server is running without any user logged in, it cannot access mapped drives.
You must ensure that all folders and file paths in the flow definitions are local drive paths or UNC
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paths (of the form \\server\volume\directory\file) rather than mapped drive paths. This holds for all
paths including user-managed folders and references to files in app properties.

3.3.5. Switch Service not compatible with (apps for) desktop
applications

Apps that communicate with a desktop application won't work when running Switch as Windows
service. This is due to a Windows limitation. Desktop applications cannot be started by a
Windows Service, hence their apps cannot be used either.

Apps concerned

« Adobe Photoshop

« Adobe lllustrator

« Adobe InDesign

« Adobe Acrobat Professional/Distiller

« Microsoft Office apps (Microsoft Word, Microsoft Excel, Microsoft Powerpoint)

Some background information

Since the introduction of Windows Vista, Microsoft no longer allows applications that run as a
Service to interact with the desktop. This means for example that these applications cannot show
any Ul to the user. As desktop applications cannot function with this limitation, their apps do not
work either.

Note: This problem does not affect Switch itself, because the Switch Watchdog (which
has no Ul) - and not the Switch Designer - is set up as a Windows Service.

Remark

If you want to use the apps for desktop applications, you must run Switch as a regular process
and not as a Windows service. However, in that case, you may want Switch to start processing
automatically when a user logs in. To do so, ensure that the preference Start Switch Server
automatically at login is set to Yes (See Switch preferences: User interface on page 35).
Remember that a user has to log in in order to start Switch, which is not necessary when running
Switch as a Windows service.

3.4. Setting up custom icons for job boards

Job boards can be created on the Switch Portal; these virtual boards enable users to view Switch
jobs remotely. The jobs can be filtered by flow and/or job stage.

The jobs on the job boards are represented by an icon that refers to the file type of the job. For
the most common file types Enfocus provides the standard icon. However, if you're working
with different file types for which there is no icon yet, or if you prefer other icons, you can easily
replace (some of) the standard icons with your own images.

The icons must be supplied as PNG files. The file name must refer to the file extension, for
example psd.png (icon for Photoshop files), txt.png (icon to be used for text files), ... Best size is
128x128 (but the icons are scaled automatically).

To set up custom file type icons
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1. On the system that runs the Switch Server, go to:

«  On Windows: AppData\Roaming\Enfocus\SwitchSite
« On Mac: \Users\<user>\library\Application Support\Enfocus\SwitchSite\

2. Create a subfolder named 'icons'.
3. Copy the images to this folder.

4. Restart the Switch Server.
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4. Working with Switch

This section gives a detailed overview of the graphical interface of the application and explains
how to use the different Switch modules.

4.1. Switch Graphical User Interface

This section gives a detailed overview of all elements of the Graphical User Interface.

4.1.1. Workspace overview

When the Switch Designer is launched, it displays the main window called the workspace, shown
here in its default configuration (design view):

[ ] [ ] Enfocus Switch - Switch Server (localhost) - Using hierarchy tools 2 - Archive by date
= My s Ty 1%
pu »
@ v g & uf ud 3} e o
Workspace Messages Statistics Save fiow Revert flow inspect jobs
a0 Flows. ~a [ ] Flow elements
-
Q. add partial o — \ - Q- i &
Name Input Archive ) Basics
Check if attachement was correctly ad... Problem jobs Connection
PitStop2Switch sample 3
Sort Jobs based on JOF information ] o Folder
Using hierarchy tools 2 - Archive by dat... .
- Problem jobs
LY
B Submit hierarc
\ ™ ie "
54 | Archive hierarchy
Set hierarchy path Output M R
G, Sethierarchy path
= '
_:‘_ Job dismantier
.. .\
-'$ Ungroup job
(%] 5] Proporties (x]5] Jobs |;~..‘c_. Split multi-job
Property Value Name Y
Name Using hierarchy tools 2 ... L& Problem jobs [0] Enfocus Appstore
Description The Set hierarchy tool i...
Background image MNone
Header image None
Marker image None
Show advanced eleme... Mo
Time-of -day window No

Day-of-week window Na

[ S R et g —

Registerad in the Enfocus Appstore

Toolbar

The toolbar is the strip at the top of the workspace offering a number of tool buttons.

See Toolbar on page 79 for more details.
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Panes and views

The workspace contains a number of panes which can be manipulated as distinct entities (show,
hide, resize, move, ...). Examples include the Flows pane, the Flow elements pane, and the
Properties pane.

The central area that displays a flow design is called the canvas; it is a special pane because it
has no title bar and it can't be moved from its central position.

One or more panes (optionally including the canvas) combine to make up a workspace
configuration called a view. The currently displayed view is selected by pressing one of the
buttons in the leftmost section of the toolbar.

Configuring the workspace

The workspace offers a number of panes that are displayed in a number of pre-configured views.
Each of the views can be configured at will to display an arbitrary combination of panes. The
contents of a pane persists across views (i.e. the different views display the same instance of the
pane rather than different copies).

Panes can be shown or hidden by choosing the corresponding item in the View > Show panes
menu. Panes can be resized by dragging the separators between them, they can be rearranged
next to one another or overlaid as tabs by dragging their title bar, and they can be undocked as a
floating pane. All configuration settings are persistent across sessions.

The currently displayed view can be returned to its pre-configured settings by selecting View >
Show panes > Reset view.

Views

The Workspace offers the following views. The intended function is only a recommendation,
since the user can re-configure the views at will.

Tool button View name Intended function
Design Design a flow
Test Test-run a flow
Run Run a flow in production
Messages View and export log
messages

ol
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Tool button View name Intended function

Statistics View statistics

=]

Users Manage users/groups and
their access rights

d.

Web Portal Manage Switch Server
remotely (see Using the
Switch Web Portal on page
267)

@)

Panes

The workspace offers the following panes, which can be combined at will in the different views.

Pane Description

Dashboard Displays status information on problem jobs or

processes, as reported by the Switch Server

Flow elements Lists the icons representing flow elements that
can be dragged onto the canvas

Jobs Serves to view and explore the contents of
flow element backing folders (i.e. mostly jobs)

Can also be used to view the contents of an
arbitrary folder in the file system, but this is not
a primary function

Flows Lists all flows

Progress Displays progress information for tasks
currently being executed by the Switch Server

Properties Displays the properties of the currently
selected flow or flow element

Statistics Displays statistics about job execution by the
Switch Server

Statistics 2, 3 Extra statistics panes that may be configured
to display a different set of statistics.

Job Information Displays the number of jobs waiting to be
processed by each flow element.
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Pane

Description

Health Indicator

Monitors the internal communication
processes within Switch.

Users pane

Allows managing user names, passwords and
access rights

4111. Toolbar

The toolbar is the strip located at the top of the workspace window; it contains a number of tool
buttons to accomplish common tasks.

Tool sets

The tool buttons are grouped in tool sets, which are shown or hidden depending on which panes
are currently shown or hidden. The following table provides an overview of the tool sets and their

function.

Tool set

Function

—
v

Waorkspace

« Always shown

Messages

| r— |
il
Statistics Users

« Select a view (Workspace,
Messages, Statistics,
Users, Web Portal).

See Configuring the
workspace in Workspace
overview on page 76

£

Web Fortal

@ ] |

News flowe Import flow Delets flow

« Shown with the Flows pane
«  New Flow, Import Flow,
Delete Flow

See Importing and
exporting flows on page
230

J |d

Save flow Rewvert flow

« Shown with the Canvas and
Flows pane
. Save Flow, Revert Flow

See Saving and reverting
flows on page 226

e

Activate flow Stop flov

« Shown with the Canvas and
Flows pane
« Activate Flow, Stop Flow

See Activating and
deactivating flows on page
229

« Shown with the Canvas and
Flows pane
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Tool set Function
Iy « Generate HTML
E documentation
Document flow See Generating flow
documentation on page
233.

« Shown with the Canvas and

G Dashboard pane
+ Retry Flow, e.g. in case of
Retry flov a problem job or problem
process.

See Viewing flow problems
in the Dashboard pane on
page 247 and Manual
retry on page 254

- Shown with the Users pane

2d [20 e

Import  Export « Allows export and import of
user information.

See also Setting up
Switch users on page 64,
Importing users and user
groups on page 69 and
Exporting users and user
groups on page 70.

« Allows to inspect metadata.

M I
See Working with sample
L0 jobs on page 356

Inspect jobs

41.1.2. Canvas

The canvas is the central workspace area that allows viewing and editing flows. Here's an
example of a simple flow displayed in the canvas:
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%]

FTP drop box PDF files
L P | J
| »
( Input folder 1
Mail drop bo all okher Files

To display a flow in the canvas, select it in the Flows pane.
To make changes to a flow, ensure that it is inactive and unlocked.
You can also:

- drag new flow elements from the elements pane onto the canvas,
« create connections between flow elements,

. configure flow elements using the properties pane, and

- drag flow elements around to adjust the layout of the design.

4.1.1.3. Dashboard pane

The Dashboard pane gives an overview of problems found during flow execution. The
information is updated dynamically: a problem item appears as soon as it is detected and
disappears as soon as the problem is solved or handled.

Be Dashboard
Time stamp ~  Module Flow Flow object Job prefix Job

" [ Jobs - 145 ) ) ) ) )
| 16/05/2022 1... | Folder | Recelve and ... | All files | 00OMM | Switch |
16/05/2022 1... | Folder | Receive and ... | All files | DOOML | Switch |
| 16/05/2022 1... | Folder | Receive and ... | All files | DOOMK | Switch|
16/05/2022 1... | Folder | Receive and ... | All files | 000MI | Links
| 16/05/2022 1... | Folder | Receive and ... | All files | GoOMI | Documt
16/05/2022 1... | Folder | Receive and ... | All files | DOOMH | PitStop
| 16/05/2022 1... | Folder | Receive and ... | All files | boOMG | PitStop
16/05/2022 1... Folder | Receive and ... | All files | DOOMF | FitStop
| 16/05/2022 1... | Folder | Recelve and ... | All files | DOOME | Links
16/05/2022 1... | Folder | Receive and ... | All files | 000MD | Documi
| 16/05/2022 1... | Folder | Recelve and ... | All files | booMC | Links
| 16/05/2022 1...  Folder | Receive and ... | All files | 00OMB | Diocumi
RINRIZNIZ 1 | Faldar Racaivn and | All filas | nnnma Raardin

progress

For more information, refer to Viewing flow problems in the Dashboard pane on page 247.

4.1.1.4. Flow elements pane

The Flow elements pane lists the icons representing flow elements (such as folders, connections,

tools and apps) that can be dragged onto the canvas and become part of a flow design.
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Filtering

You can use the Search field on top to filter the flow elements. See Filtering lists on page 95

Favorites

The Favorites section can contain shortcuts to elements in other sections. It looks and functions
like other section headers, but its content is managed by the user.

You can

« Select Add to Favorites from the context menu of a flow element to add a shortcut to the
Favorites section.

Note: Add to Favorites menu is disabled for flow elements, which have already been
added to the Favorites section.

- Drag a flow element into the Favorites section to add a shortcut to the Favorites section.

« Select Move up or Move down from the context menu of a shortcut in the Favorites section, to
change the order.

« Drag and drop shortcuts in the favorites section to change the order.

. Select Remove from Favorites from the context menu of a shortcut in the Favorites section, to
remove it from the Favorites section.

Note: You can use keyboard shortcuts to add your favorite flow elements to the canvas.
Just click ctrl+<number 1-9> (Windows) or cmd+<number 1-9> (Mac). The <number> refers
to the position of the flow element in the Favorites category (first element =1, second = 2,
etc.).

Sections

The Flow elements pane groups the flow elements in sections. Click on a section header to open
or close the sections, showing or hiding the flow elements in the section.

The flow elements in all categories except for the 'Apps' category are part of the standard
installation, depending on your licenses. For example, the flow elements in the Basics category
are included in the Core Engine, whereas the flow elements in the Metadata category require a
license of the Medata Module. See Flow elements matrix.

The flow elements in the 'Apps' category must be installed explicitly through the Enfocus
Appstore. Some are free, some are paying. See also Working with apps in Switch on page 259.

Section Description

Basics Basic flow elements that form the fabric of a flow design, including
folder and connection

Tools Tools such as compress and rename, mostly for file handling
Scripting Tool for using scripts (script folders and script packages).
Communication Tools for communication including email and FTP

Metadata Tols for working with metadata, including XML

Database Tools for using ODBC data sources

Apps Small applications that can be used in Switch and that are made

avavailable through the Enfocus Appstore. This category becomes
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Section Description
available as soon as you have installed at least one app. See also
Working with apps in Switch on page 259.

Flow elements

The list of flow elements displayed in the Flow elements pane depends on the Switch modules
you have licensed. See the Flow elements matrix on page 168 for an overview.

The flow elements that are included in the standard installation (see higher) are called default
apps. They are installed automatically with a new release. They cannot be removed. However, if a
new version is available, you'll be able to switch to this new version. See Installing a new version

of an app on page 264.

If you want to know more about a flow element, you can open the documentation from within
Switch, using the flow element's context menu. Choose Check the app details. This will bring you
to an app page on the Enfocus Appstore where you can find detailed information. Want to switch
to a different version? Click the Manage button in the top right corner of the screen and choose

a new version in your account section ("My Enfocus"). You can easily find the default apps, thanks

to a new filter, 'Default App'.

Note: A small number of flow elements are not converted to default apps. For those flow
elements (Connection, Folder, Problem job, Refresh info, Submit point and Checkpoint),
you can find the documentation in the Switch Reference Guide.

Detailed information

Refer to: Flow elements: overview on page 97.

4.1.1.5. Jobs pane

The Jobs pane serves to view and explore the contents of flow element backing folders (that is,

mostly jobs).
Marme
£ Submit hierarchy 7 [0]
£+ Others Folder [0]

1 Problem jobs [0]
=" ¢t Input Folder [2]

2| DITA_101.pdf

£ Success and Sign-off ..

£ Errar [0]
& Archive hierarchy 3 [0]
£ Warning [0]

Use the Jobs pane to:

- EGIEXTM Update...

Jobs

Size Type

File Folder
File Folder
File Folder
File Folder

65.3 KB pdf File

365 KB pdf File
File Folder
File Folder
File Folder
File Folder

Modified

742011 G431 .
742011 Ti57:42 ..
FHEZ011 1:13:25 ..
FHS/2011 1:13:25 ..
1/25/2011 10:35:1 ...
10192010 6:32:1...
714/2011 T:57:42 ..
714/2011 T:57:42 ..
714/2011 T:57:42 ..
714/2011 T:57:42 ..

5 X
Job Prefix
o001l
00011
>
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- View the contents of the backing folder for one of more flow elements by selecting the flow
elements in the canvas.

. Drop files and folders in a flow using copy and paste or drag and drop.

« Delete files and folders (permanently) by pressing the delete key or by choosing the Delete
context menu item.

Row types

Each row in the Jobs pane represents a file or folder as described in the following table. Folder
rows offer a triangle button to show/hide the rows representing the contents of the folder.

Icon Row represents Information displayed
The backing folder of a flow Flow element name and backing
{;i element folder path
A job folder Folder info; Job info
L
A job file File info; Job info

A regular folder Folder info

A regular file File info

Jobs pane columns

The rows in the Jobs pane have multiple columns as listed in the following table. Individual
columns can be shown or hidden through the "Show columns" context menu item. By default,
only a subset of the columns is shown.

The visible columns can be resized and reordered by dragging. Clicking on a column header
selects that column as the key for sorting the rows in the Jobs pane, and toggles between
ascending and descending order. Rows that have the same parent (and thus are on the same
hierarchical level in the tree) are sorted according to this specification. Root rows are always
sorted on the name column (ascending or descending depending on the last setting).

Column Description

Name Name of the file or folder represented by the row

For a job file or folder the unique name prefix is removed

Size The file size in bytes for job files and regular files; blank for folders
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Column Description

Type The file type as retrieved from the operating system

Modified The date/time the folder or file was last modified

Job Prefix The unique name prefix for job files and job folders; blank otherwise

This field is shown in red color if there is no corresponding valid internal job
ticket (i.e. the job ticket doesn't exist or its file path doesn't point to this job)

The following columns are not shown by default

Waiting since | The date/time the job arrived in this backing folder (more precisely, when it was
detected by the server)

State The name of the state currently attached to the job, or blank if there is none.

A state can be attached to a job through the "Attach job state" property of the
folder flow element; for more information, see the Folder element and Viewing
statistics on page 250.

Entered state | The date/time the job entered the state currently attached to it, or blank if there
is none. A state can be attached to a job through the "Attach job state" property
of the folder flow element; for more information, see the Folder element and
Viewing statistics on page 250.

Submit point The name of the Submit point through which the job was submitted, or blank if
it wasn't submitted through a Submit point

Submitted The date/time the job was submitted through a Submit point, or blank if it
wasn't submitted through a Submit point

User name The name of the user associated with the job, or blank if there is none (a user
is automatically associated with the job when it is submitted through a Submit
point)

Custom 1 A user-configurable value calculated through variables or a script expression

Both the column header and the column value can be configured through the
context menu items "Set column header" and "Set column value (first make the

Custom 5 column visible with the "Show columns" context menu item)

Initially the values for these columns are blank

Example of custom columns

In the following example, two custom columns were configured to display the date when the
picture was taken and the camera model (see defining text with variables).

A third custom column was configured to display whether the flash fired when taking the picture
(see defining a condition with variables).
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Marne Size

Iﬂ IMa_2820. PG 1 MB
IE] P1000031. PG 3MB
d P1000094, PG 3 ME
.ﬂ P1000095, PG 3MB
Iﬂ IMG_3459, PG 40z KB
Iﬂ IMa_G8584. PG 245 KB

Switch
Jobs & ox
Type Job prefix Pickure kaken Cameta Flash fired
w o Output {CifDocuments and Settings/all UsersiApplication Data/Gradual Software/Power3WITCH Serverfbacking/Mew Flowfautomanaged, Qukput) |
JPia File oooLy 28-Apr-2007 21:23 Canon Canon DIGITAL IXUS 400 €3 False
PG File Q0o1R 02-Jul-2007 23:51 Panasanic DMC-FZ5 [ true
PG File aoois 03-Jul-2007 23:03 Panasanic DMC-FZ5 ) true
PG File oooiT 03-Jul-2007 23:03 Panasonic DMC-FZ5 ) true
JPG File 001w 19-May-2007 12:12  Canon Zanon PowerShot 200 9 False
JPia File ooy 03-Jun-2007 16:45 Canon anon Powershak 5200 9 False
1P File onoiu 03-Jun-2007 16:43  Canon Canon PowerShot 5200 9 False

d IMG_5581. PG 713 KB

4.1.1.6. Flows pane

The Flows pane lists all flows known to Switch at the present time. It allows you to organize these
flows in a hierarchy of groups and subgroups, and provides a context menu for managing flows in

various ways.

Note: If a flow is not saved yet, it is displayed in italics, followed by an asterisk.

Filtering

Flows

Mame

¥ Demo flow 1
Demg fow 2 *
Demo flow 3
Archive By Date
hd Flows Customer X
Assemble files and sort sort job
Chedk attachments
- Flows Customer ¥
Receive and send =
b Test
Testflow

You can use the search field on top to filter the flows. See Filtering lists on page 95.
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Actions

If you click the Actions icon (‘_'/ ), a list appears with all the items that are available in the Flow
menu on the menu bar.

Flows and groups

Each row in the flows pane represents a flow or a group. A group can contain flows and other
groups, up to any nesting level. When you select a group, all the flows in the group (and in any
subgroups) are automatically selected as well. You can open/close a group by clicking the arrow
at the left. You can reorganize the order and nesting structure in the flows pane by dragging the
rows.

When you select a flow in the flows pane, it is displayed in the canvas and you can see its
properties in the properties pane.

When you select two or more flows in the flows pane, a scaled-down representation of all the
selected flows is shown in the canvas. You can perform many operations (such as activate/
deactive) on multiple flows at the same time; however you can't make changes to the flow design
while two or more flows are selected.

For more information, refer to the chapter Organizing flows on page 217.

State

An icon is displayed at the left of each row to indicate its flow state, as described in the following
table. The flow state for a group row is equal to the "highest" flow state for any of the flows in the
group (the table lists the flow states from high to low). For more information, refer to the chapter
Activating and deactivating flows on page 229.

Icon |Description

The flow can't be activated because it contains a design error.

i The flow is being activated.

The flow is active, that is, it is being executed by Switch.

The flow is active, that is, it is being executed by Switch, but one or more of the
connections are put on hold.

i The flow is being deactivated.

The flow is inactive and it is locked for editing.

® The flow is scheduled and will become active during the time specified in the Flow
properties (See Flow properties on page 223).

© The flow is scheduled, but one or more of the connections are put on hold.

Name and description

You can rename a row by clicking on the name field and entering the new name. You can also
change the value of the "Name" property in the properties pane. You can add a longer (possibly
multi-line) description of the flow or group in the "Description" property.

87



ENF@CUS Switch

Marker

The rightmost column in the flows pane can display a marker icon selected from a predefined
list of icons (including colored flags, priorities, and level of completeness indicators). You can

set these markers at your discretion to help organize your flows (for example, indicate work in
progress). The markers have no meaning to Switch.

If you do not want to use markers, you can hide the marker column with the "Marker column"
context menu item.

For more information, refer to the chapter Setting flow markers on page 220.

4.1.1.7. Progress pane

The Progress pane displays a list of currently executing processes (for all active flows) with their
progress information.

0 @ Progress
Number Flow Element v Task type Task category Job prefix Job
1 Submitpeoint...  Joband... File system Maonitor
2 Submitpoint... Joband.. File system Monitor
3 Submitpeoint... JobOnl.. File system Monitor
4 Submitpeint... JobOnl... File system Meonitor
5 Submitpeoint... JobOnl.. File system Monitor
] Submitpeoint... JobOnl... File system Monitor
7 Submitpoint...  Artwork File system Monitor
8 Submitpoint...  All sour... File system Monitor
Dashboard

Examples of processes include internal processes (such as downloading a file from an FTP site),
external processes controlled by Switch (such as distilling a PostScript file) and remote processes
(triggered by the Remote process element). Processes are dynamically added to and removed
from the list as they occur.

The columns can be reordered as usual in Switch. Following columns are displayed:

«  Flow: flow concerned
« Element: name of the flow element in the flow
- Task type and task category:
« Task types include file handling tasks (such as copying and moving jobs), file processing
tasks executed by apps, network transfer tasks, ...

. Task categories include "disk" (disk operations, mainly related to copying and moving jobs),
"light" (quick tasks executed by scripts used in the Script element), "processor”, ...

Note: Task type and task category are taken into account to calculate the
maximum number of concurrent slots. Refer to Execution slots on page 255.

- Job prefix and job: unique prefix and name of the job
. Status: current status
- Progress: current progress

« Process ID: process ID, may be useful for troubleshooting. For example, when executing a
Node.js script, you can see the process ID of the Node.js executor in this column. This can be
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useful to kill the process when the executor is hanging, or to find out which script is using a lot
of CPU or memory.

For more information, see Viewing processes in the Progress pane on page 247.

4.1.1.8. Properties pane

The Properties pane shows the properties of a flow or a flow element, depending on what's
selected on the canvas:

If a single flow element is selected on the canvas, the Properties pane shows the properties of
that flow element.

To learn how you can edit the values in the Properties pane, refer to Changing flow element
properties on page 181.

If multiple flow elements are selected, the Properties pane shows all mutual properties, i.e.
the properties that can be set for every selected flow element. This allows you to change the
(same) property for multiple flow elements at once.

Note: The Name and Description of a flow element must be changed one by one.

If no flow elements are selected, the Properties pane shows the flow properties.

For more information, refer to Changing flow properties on page 222.
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4.1.1.9.

006

Property

Name
Description
Path
Leave originals in place
Minimum file size (KB)
Scan every (seconds)
Time-of-day window
Day-of-week window
Day-of-month window
Subfolder levels
Process these folders
Adjusted by (rule 1)
Folder name
On levels
Restriction
Nesting
Adjusted by (rule 2)
Adjusted by (rule 3)
Adjusted by (rule 4)
Adjusted by (rule 5)
Attach hierarchy info
Include hierarchy name
Include subfolder lavels
Save top subfolders
Attach email info
Allow subfolder cleanup

Statistics pane

Switch

Properties

Value

Submit hierarchy

[Users/anncoupe/DATA Testfiles
Mo

None

Default

MNo

Mo

MNo

1

All Folders

Excluding folders not named
Reqular expression defined

Mone

Exclude nested subfolders as well
Mone

MNone

Mone

MNone

Yes

Mo

1

Yes

Mo

The Statistics pane allows you to display the average time jobs reside in a particular folder or

state while being moved along a flow.

You can open this pane, by clicking stz in the Switch toolbar, or by selecting View > Statistics

from the menu at the top of the application.

Important: Do not forget to refresh the statistics ( by selecting View > Refresh Statistics
), to make sure the most recent information is displayed.

The chart gives an overview of the folders or states (on the y-axis) and the average time in

seconds (on the x-axis) jobs spent in each of them.
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You can determine what is shown by changing the options in the Show time spent per and Sort
results on sections:

- Show time spent per Folder/State determines what's shown in the chart below; either the
average time spent in a particular (statistics-enabled) Folder or the time spent in a particular
State.

« Sort results on determines how the information in the chart is sorted: based on the Name of
the folder/state (alphabetically), or the Time (decreasing).

In the top right corner of the pane, you can see the number of files that have been processed,
and the date and time the first and last file were processed.

Show time spent per Sort results on Mumber of Files: 40
First File: FriMow 7 13:21:43 2014

) Folder @ State ) Mame @ Time
Last File: Mon Mov 10 10:03:26 2014

Average filetime in folder

Dawnloaded

F5 files

Folder name

Input

Single pages El

File time [seconds]

For more information, see Viewing statistics on page 250.

4.1.1.10. Job Information pane

The Job Information pane displays current job distribution in the flows, that is, the number of jobs
waiting to be processed by each flow element. Here elements are grouped by flows.
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4.1.1.11.

4.1.1.12.

Job Information H X

s

Elerment Mame Element Type lobs Before Element

Archive By Date
Assemnble files and sort sort job
Check attachments
Demo flow 2
Demeo flow 3
4 |2 Flowl
oy Held job Held job 2
Flow2
4 |2 Flow3
~ Acrobat Professional Acrobat 0

4 [ New flow

m

Rename job Rename job 0

This pane requires presence of responsive Server process as it is updated constantly when
visible.

Health indicator pane

The Health indicator monitors the internal communication processes within Switch. Under normal
operation, the Health Indicator will show a green status bar.

Health Indicataor B X

If Switch begins to experience problems communicating with internal processes due to delayed
or excessive internal communication requests, the indicator bar will change to orange or red in
extreme cases. However, the Health Indicator does not change due to number of jobs or the
heavy processing as this does not typically threaten the stability of Switch.

In most cases when an internal process becomes unavailable or communication is lost, the Switch
Watchdog will automatically restart the failed service. If the Health Indicator frequently shows
orange or red, it is recommended that you review the Statistics pane for details on which Switch
services are experiencing problems and may require corrective action. See Statistics pane on
page 90.

Users pane

The Users pane allows you to manage the access rights of users accessing the Switch Server
from another computer, i.e.:

« Through the Switch Web Portal via Submit points and Checkpoints (requires a SwitchClient
license) or to view log messages.
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« From another computer than the one on which the Switch Server is installed, via Remote
Designer.

You can open this pane, by clicking the Users button in the toolbar, or by selecting View > Users
from the menu at the top of the application.

The Users pane consists of two parts:

« In the left part of the pane, you can configure users and user groups, and assign them
permissions for the Switch Web Portal and/or for Remote Designer.

Users & Groups

g& Groups

Administrators User name Anne

Operators Full name Jones
Users
Administrator Password S

.
Operator 1 Email ann@jones.com
Operator 2 Member of Administrators
SwitchUser

@

Permissions
Web portal Submit and check jobs
Accessible jobs  All jobs %]
View messages
Rush jobs
Boards Read-only (4]
Remote Designer Mo access a

« In the right part of the pane, you can grant users and user groups access to particular Submit
points and Checkpoints. This part is only visible, if you have activated the SwitchClient and/or
the Web Services module.
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Submit points
All 2 Anne
Sandbox ; SwitchUser
Production ﬁ Administrators
PrepressQualityCheck k Operatars
| o Quality
Checkpoints
All || ;2 Operators
Sandbox ; SwitchUser
Production
PrepressQualityCheck
|21 Checkpoint 1

The buttons in the toolbar allow you to import and export user information.

[

Import Export
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4.1.1.13.

For more information, see Configuring Switch users on page 63 and Assigning access to Submit
points and Checkpoints on page 71.

Filtering lists

Filtering restricts the set of items shown in the list by comparing search terms (entered in the
search field) with one or more search targets associated with the items.

Filtering is available for Flow elements and Flows.

In the Flow elements pane, items are not only filtered, but also searched for in the Enfocus
Appstore. If the search term matches an app, you will see the app appear in the bottom part of
the Flow elements pane, under "Enfocus Appstore results" and, if it is installed already on your
system, you will also see it in the Apps category. See also Working with apps in Switch on page
259.

Using the search field

The search field is located above the list of items being managed.

Flow elements B X
(Q. poF )| || &
t~ Ndobe Acrobat Professional -

ﬁu MadeToPrint lllustrator

ﬁ. MadeToPrint InDesign

4;., MadeToPrint InDesign Server
A;, MadeToPrint QuarkkPress
. ColorLogic ZePrd

o CorelDRAW

. If the search field is empty, all items are shown in the list.

If the search field is not empty, a clear button appears at the right side of the field, to clear
the search field and show all elements.

Refresh button (Flow elements pane only)

If an app you recently purchased is not in the list, you may have to click the Refresh button ‘g/
This will install the app concerned on your local computer.

Using the search menu

You can open the search menu by clicking the Search button q' on the left side of the search
field.
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Flows B X Flow Elements & X

%" Customery ) _, %ﬂp ) ‘__/ ‘i/

Customery ftp

Archive script

Demel recyc

lohs held

Job split

Flow sort by

Send sort on

Search flow names v Search keywords

Search flow description

Search flow element names

RN

Search flow element property description
Search flow elernent property names

Search flow element property values

Sort alphabetically

The search menu contains:

The last 7 strings entered in the field. Selecting one will reapply this filter.

A number of search options.

This controls the search targets included in the search. Each menu item has a checkbox which
can be turned on or off by choosing the menu item.

For Elements, the name of the elements is always included in the search. You can also search
for keywords, which are associated with the elements. For example searching for "PDF" will
include Adobe Acrobat Distiller, although "PDF" is not a part of the Element name. For an
overview of all elements and their keywords, see the Flow elements: overview on page 97.

For Flows, you can search in the flow names, the flow descriptions, the elements used in

the flows, or even the properties or values in the flow's elements. This allows for example to
search for Flows containing the "Adobe Acrobat Distiller" element. If found, the flow element
or connection is highlighted in green (see example below).

Sort options, allowing to sort the search result alphabetically, or in the order they were found.

Example of a search result found in the name of a flow element
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Flows B X
i "
Q. al DI
Marne =
| pemofowzc /PDF Fies
Demo flow 3
Archive By Date \
Inout folder D
Al other files
1|
Properties
Property
Name All ather files
Description

4.1.2. Flow elements: overview

This section gives a detailed overview of all flow elements available in the Flow elements pane.
They are sorted by category (Basics, Tools, Scripting...) just like in the application.

Note that you can change the way the flow elements are displayed (show/hide unavailable flow
elements, open or collapse categories etc.), by clicking the button next to the search field.

If you think that flow elements are missing, check your licenses (some flow elements require a
license of an additional module!).
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Switch

00

Flow elements

Q.

Y

Favorites

‘_% Webhook

C@ Remote process

Basics

" Connection

)| |K<3|

Collapse all categories
Expand all categories
+/ Allow multiple categories open

Show as small icons
Hide unavailable flow elements

Open and install...

Folder

Problem jobs
Submit hierarchy
Archive hierarchy
Set hierarchy path
Job dismantler
Ungroup job

Split multi-job
Assemble job
Generic application

Execute command

Enfocus Appstore

Go to the Enfocus App

Registered in the Enfocus Appstore

41.2.1. Basics

Connection

Connection is a special flow element that serves to interconnect other flow elements. The
network of connections in a flow determines how jobs can travel between the flow elements.

To connect two flow elements that are already present on the canvas, do one of the following:

« Drag the connection icon from the Elements pane and drop it onto the first flow element; then

click on the second flow element.

- Double-click the first flow element to start a connection and drop it on the second flow
element to connect it with the first flow element.

« Select "Start connection" in the context menu of the first flow element and drop the extension
on the second flow element.




ENF@CUS Switch

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Connection element will be shown in the list:

+ move
- filter
« traffic light

Flow element types

In terms of connectivity, there are four types of flow elements (other than connection itself):

Flow element type Description

Folder Represents a folder on disk that can hold jobs before, after or in
between processing steps; folder has a central role in Switch (see
below).

Processor Processes jobs and thus accepts incoming and outgoing

connections.

Producer Injects jobs into a flow from an outside source (such as an email
inbox); a producer does not accept incoming connections.

Consumer Consumes jobs from a flow and possibly transports them to an
outside target (such as an FTP site); a consumer does not allow
outgoing connections.

The central role of the Folder element

At least one of the two flow elements being connected must be a folder. In other words, a flow
element other than a folder can be connected only to a folder.

A simple rule of thumb is "there must always be a folder in between".

Connection types

There are several types of connections, each with a slightly different set of properties. The type
of a connection is determined by the flow element from which the connection originates. All
connections originating at a particular flow element have the same type. Some flow elements also
restrict the number of outgoing connections.

Connection Description
type

Move Simply moves jobs along (under the control of Switch); a flow element with

outgoing move connections often produces only a single output along one of
the outgoing connections (for example, file balancer), or it may allow just one
outgoing connection

Filter Offers properties for file filtering in addition to the move properties; a flow
element with multiple outgoing filter connections (for example, folder) usually
sends identical copies of its output along these connections (assuming a
connection's filter allow the output to pass)
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Connection Description
type
Traffic light Offers data and log subtypes and allows to set success-, warning- and error-

filters; this connection type is used by flow elements that produce a report
for human consumption and/or validate jobs against some specified rules (for
example, preflight); multiple connections of the same subtype carry identical
copies of the output

No-options Jobs are moved under the control of a third-party application; this connection
type is used only in conjunction with generic application; it offers only the
most basic set of properties

Properties

The following table lists the properties for all connection types (i.e. no single connection offers all
of these properties). Some flow elements "inject" extra properties in their outgoing connections.
These properties are described with the flow element that injects them.

Property Description

Name The name of the connection displayed in the canvas; most connections have
a blank name (the default) but the user can add a name if so desired; some
flow elements use the name of their connections for special purposes (these
rare cases are described for each flow element where applicable)

Description A description of the connection displayed in the canvas. This description
is also shown in the tooltip that appears when moving your cursor over the
connection.

Corner angle Determines the layout of a connection as it is drawn on the canvas

Consider the rectangle formed by drawing horizontal and vertical line
segments through the center of the two flow elements being connected;
the breakpoint in the connection line can be positioned anywhere on the
diagonal of this rectangle

The corner angle is an integer number in the range [-90, 90] inclusive; the
value is a measure for how much the corner formed at the breakpoint differs
from a straight line; thus a zero value means a straight line (the default) and a
value of £90 means a rectangular corner (the breakpoint is positioned at one
of its extremes).

Color The color of the connection displayed in the canvas. The default is Gray,
but you can select another color from the list (Yellow, Green, Cyan, Blue, or
Magenta). Alternatively, you can change the color via the context menu, by
selecting the Choose color option.

Note that connections can also have "conditional" colors:

« If a value is wrong in the properties, the connection can be displayed in
red.

« If the connection is put on hold, it's displayed as an orange dashed line.
See Putting a connection on hold on page 236.
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Property Description

» If a property of the connection matches a keyword entered in the search
field of the Flows pane, it's displayed in green. See Using the search
menu on page 95.

Note: The "conditional" colors take priority over the "custom"
colors set in this property. For example, even if you have chosen
Green for your connection, its color will change to orange when
the connection is set on hold. When the connection is released, the
chosen color (green) will be restored.

Hold jobs While set to yes, jobs are not allowed to move through the connection; this
is mostly used to temporarily hold jobs (perhaps because there is a problem
with a process downstream)

The value of this property can be modified while the flow is active (through a
canvas context menu item); see putting connections on hold.

Include these Jobs that match the specified filter are moved through this connection,
jobs unless they are explicitly excluded (see next property); refer to Specifying file
filters on page 200 for more details.

Note: If you're using a script expression, remember that the script
expression should return a boolean value (true or false), instead of a
string. For example, you could create a script expression to include
jobs smaller than 1 MB. If the checked job <1 MB (= matches), the
result of the script is "true" and the job is included.

Exclude these Jobs that match the specified filter are never moved through this connection;
jobs refer to Specifying file filters on page 200 for more details.

Note: If you're using a script expression, remember that the script
expression should return a boolean value (true or false), instead of a
string. For example, you could create a script expression to exclude
jobs smaller than 1 MB. If the checked job <1MB (= matches), the
result of the script is "true" and the job is excluded.

Include these Subfolders that match the specified filter are included for this connection;

folders injected by producers that retrieve jobs from an outside folder hierarchy,
such as FTP receive; refer to Specifying file filters on page 200 for more
details.

Note: If you're using a script expression, remember that the script
expression should return a boolean value (true or false), instead of a
string. For example, you could create a script expression to include
folders smaller than 1 MB. If the checked folder <1 MB (= matches),
the result of the script is "true" and the folder is included.

Exclude these Subfolders that match the specified filter are ignored for this connection;

folders injected by producers that retrieve jobs from an outside folder hierarchy,
such as FTP receive; refer to Specifying file filters on page 200 for more
details.
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Property

Description

Note: If you're using a script expression, remember that the script
expression should return a boolean value (true or false), instead of a
string. For example, you could create a script expression to exclude
folders smaller than 1 MB. If the checked job <1MB (= matches), the
result of the script is "true" and the folder is excluded.

Carry this type of
jobs

Determines the type of files carried by this connection:

. Data: data file (regular output)
« Log: log file (reports)

- Data with log: data file with the corresponding log file associated to it as
a metadata dataset; this is equivalent to picking up the log file with one
of the existing pickup tools; see Picking up metadata on page 398. The
data model that is used is determined by the element of the outgoing
traffic light connection.

Dataset name

If the previous property is set to "Data with log", this property defines the
name of the metadata dataset containing the log file attached to the data file;
see Picking up metadata on page 398

Success out

If set to yes, a file will move along the connection if the originating process
did not log any warnings or errors

Warning out

If set to yes, a file will move along the connection if the originating process
logged at least one warning and no errors

Error out

If set to yes, a file will move along the connection if the originating process
logged at least one error

Folder

Folder is a central flow element that serves as an intermediary for moving jobs between other
flow elements. Each folder flow element instance represents a backing folder on disk that can
hold jobs before, after or in between processing steps. The contents of the backing folder can
also be accessed by external processes or by users. For example, a folder may be used to submit
jobs into a flow or to retrieve the results of a flow.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Folder element will be shown in the list:

- backing
« input

« output

« hot
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. watched

Processing jobs

Switch

Any subfolders placed into a folder are treated as a job folder; that is, the subfolder and its
contents are moved along as a single entity.

If a folder has no outgoing connections (that is, it is a "dead-end" folder), a job placed in the folder
will stay there until it is removed by some external process that is not under the control of Switch.

If a folder has at least one outgoing connection, a job placed in the folder is removed after it was
processed by all outgoing connections. If none of the filters on the outgoing connection(s) match,
the job is moved to the problem jobs folder. Refer to Handling problem jobs on page 252 and
error handling preferences for more details.

User-managed versus auto-managed folders

The backing folder (on disk) for a folder on the canvas can be auto-managed (default) or user-
managed. The difference is explained in the following table:

Auto-managed

User-managed

Location on disk

Special area managed by Switch, i.e.
"the application data root" (see Switch
preferences: Application data on page 48)

Location selected by the user
(through the Path property)

Editable by the
user?

No, users should not manipulate auto-
managed folders!

Note: The Open in Explorer/Finder
option in the context menu is only
available if you hold down Shift
while right-clicking the folder on

the canvas. This is an advanced
preference that only should be used
for debugging purposes!

Yes, through the Open in
Explorer/Finder option in the
context menu.

Scanned?

No need to scan, as the contents is known
and managed by Switch.

Yes, at regular intervals as
defined in the Preferences
(See Switch preferences:
Processing on page 43)

Lock icon?

Yes

No

Remarks

External processes (not under control of
Switch) and users should not refer to auto-
managed folders since they can change the
name and/or location under the control of
Switch!

It is not allowed to point user
folders to auto-managed
folders (e.g. containing the
result of another flow). As
auto-managed folders are not
scanned, this will not work.

For more information on how to create an auto-managed or user-managed folder (or to switch
from one type to the other), refer to Using Folder elements in Switch on page 107.
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Properties

Switch

Note that certain properties are present only for folders that have at least one outgoing
connection, and certain other properties are present only for folders that have no outgoing
connections ("dead-end" folders)

Property

Description

Element type

The flow element type: Folder.

This property is useful to identify renamed flow elements. It cannot be
changed.

Name

The name of the folder displayed in the canvas. A newly created folder
receives a default name ("Folder 1", "Folder 2", ...), which you should replace
with a meaningful name.

Note: If you set up a user-managed backing folder while a "Folder
<number>" name is still in place, the flow element automatically
adopts the name of the backing folder. For example, if you drag "D:
\data\input" onto the canvas, the folder will be named "input".

Description

A description of the folder displayed in the canvas. This description is also
shown in the tooltip that appears when moving your cursor over the folder.

Path

The path of the folder's backing folder on disk, or auto-managed.

The following options in italics relate to the frequency of which the folders
are scanned for new files. As auto-managed folders are not scanned,
these options are only available for user-managed folders.

Leave originals in
place

If set to Yes, incoming jobs are left untouched in the folder. Switch never
writes to the folder, so read-only access rights suffice. For more details,
refer to Leaving originals in place on page 189.

If set to No (default), incoming jobs are moved out of the folder; Switch
needs full access rights to rename, create and remove files and folders.

Ignore updates (only available if Leave originals in place is set to Yes)

If set to Yes, a job will only be processed once, regardless of any changes
to the file size or modification date. This can be used for workflows where
the input job is replaced by the processing result, to avoid triggering
endless loops.

If set to No, the job will be reprocessed when its file size or modification
date is different. This allows processing jobs which have the same file
name as previously submitted jobs.

Minimum file size
(KB)

Used to set the minimum file size limit (in KB) before Switch picks up the
files or folders. To set no limits, leave it empty.

Scan every
(seconds)

The frequency with which this folder is scanned for newly arrived jobs.

If set to Default or zero, the global user preference is used instead; see
Switch preferences: Processing on page 43.
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Property

Description

Time-of-day
window

If set to Yes, the folder detects (and moves) newly arrived jobs only during
a certain time of the day (specified in the subordinate properties).

Allow from (hh:mm) and Allow to (hh:mm)

The time-of-day window during which to detect jobs. The values are
structured as "hh:mm" (hours, minutes) indicating a time of day on a 24 hour
clock; an empty value means midnight; two identical values mean the folder
always detects jobs.

Day-of-week
window

If set to Yes, the folder detects (and moves) newly arrived jobs only during
certain days of the week (specified in the subordinate properties).

Allow from and Allow to

The days of the week (Monday, Tuesday, Wednesday, Thursday, Friday,
Saturday, Sunday) during which to detect jobs. Two identical values mean
the folder only detects jobs on that specific day.

Day-of-month
window

If set to Yes, the folder detects (and moves) newly arrived jobs only during
a certain day of the month (specified in the subordinate properties).

Day

The day in the month during which to detect jobs, as a number in the range
[1..31]; the default value of one means the first or the last day of the month
(depending on the following property).

Relative to

Determines whether the day of the month is relative to "Start of the month"
or "End of the month".

Color

The color of the folder displayed in the canvas. The default is Yellow, but
you can select another color from the list (Orange, Green, Cyan, Blue,
Magenta). Alternatively, you can change the color via the context menu, by
selecting the Choose color option. Refer to Adjusting the colors of folders
and connections on page 185.

Attach hierarchy
info

If set to Yes, the folder's name is added to each job's hierarchy location
path as the job passes through the folder; see Using hierarchy info on page
190.

Add name at the top

If set to Yes, the folder name is added at the top of the hierarchy location
path; otherwise it is added at the bottom.

Attach email
addresses

The specified email addresses are added to each job's email info as the job
passes through the folder; see Using email info in Switch on page 192.

Attach email body
text

The specified email body text is added to each job's email info as the job
passes through the folder; see Using email info in Switch on page 192.

Attach job state

If the specified string is non-empty, the job state of each job is set to the
string as soon as the job arrives in the folder; the statistics view can display
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Property Description

the average time spent for each job state. For more information, see
Viewing statistics on page 250.

Flow stage Note: This property has been moved to the Refresh job info flow
element. It's no longer available as a property of the Folder flow
element, except in existing flows (set up in Switch 2021 Fall or
earlier) where its value is not empty, for backward compatibility
reasons.

About flow stages: Flow stages allow you to check where jobs are in a flow.
The flow stage of a job can be viewed on the job boards on the Switch
Portal. Refer to Working with flow stages on page 112.
Set job priority « If set to None (default), nothing happens.
« If set to any other value (including zero), the job priority of each job is
set to this new value as soon as the job arrives in the folder.
Note: The specified value is converted to a number and
rounded to the nearest integer; text strings that do not
represent a number are converted to zero.
To specify a negative value, use the Single-line text with variables
property editor or provide a script expression.
Safe move This option is only available for output folders and relevant for transferring

job files between folders on different volumes (drives/partitions).

If set to Yes (default value), Switch will first copy the job to a temporary file
before deleting the job from the original location. This is useful to avoid that
files get lost in case of network problems.

If set to No, Switch immediately moves the job files to the output folder.
This may be necessary in case of network permission issues.

Strip unique name | If set to Yes, the unique name prefix added to the filename by Switch is
removed before placing the job in the folder. the default is to strip the
prefixes from jobs deposited in a dead-end folder - leaving the prefixes in
place avoids overwriting a previously deposited job with the same name.

Duplicates

Determines what happens when Strip unique name is set to Yes and a job
arrives with the same name as a job already residing in the folder:

- Overwrite: replace the existing job with the new one — this is the default
behavior.

«  Keep unique name: preserve the new job's unique name prefix, leaving
the existing job untouched (without unique name prefix).

« Add version number: add an incrementing version number at the
end of the filename body for the new job ("2", "3", ... "9", "10", "11"),
leaving the existing job untouched. For example, "job.pdf" will become
"job1.pdf"," job2.pdf", ...
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Property Description

Optionally, you can add a separator between the filename body
and the version number, for example an underscore. In that case,
e.g. "job.pdf" will become "job_1.pdf"," job_2.pdf", ... By default, the
Separator property is empty.

You can also determine the width of the version number, i.e. the
number of digits used for the version number. For example, if Width

is set to "5", the version number will consist out of 5 digits (e.g.
job_00001.pdf), meaning that leading zeros will be added as required.

- Fail: move the new job to the problem jobs folder, leaving the existing
job untouched.

Ignore these All subfolders that match the specified folder filter are ignored for the
subfolders purpose of counting the number of jobs residing in this folder.

This property appears only when the folder's outgoing connection leads
to a generic application; if that application stores information in subfolders
inside its input folder, this property allows Switch to ignore these folders
and their contents.

Set job private Allows you to attach private data to the jobs arriving in the folder.
data (property not
present in dead

end folders) Example:

Format: key=value (one key per line)

Reference=[Job.NameProper]
Customer=[Email.From]

Note: The first instance of the equals sign ('=') separates the key
from its value. As a consequence,'='" is not allowed in the key, but it
can be used in the value of the key if required.

Set to Yes, if the average time that jobs reside in this folder should be
calculated and displayed in the Statistics pane. For more information, see
Viewing statistics on page 250.

Show in statistics

Using Folder elements in Switch
To create a Folder element in Switch
1. Do one of the following:

« To create an auto-managed folder, drag the Folder icon from the Elements pane onto the
canvas.

If you check the Path in the Folder properties, you will see that the value "auto-managed"
is filled in automatically.
« To create a user-managed folder, drag a folder from your system onto the canvas.

If you check the Path in the Folder properties, you will see that the path to the folder is
filled in automatically.
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Note: Submit hierarchy folders are always user-managed, as the hierarchy of the
folders must be determined by the user.

2. To convert a folder from auto-managed to user-managed as required, do one of the following:

1. Choose a folder path for the Folder's Path property
2. Drag a folder from the Folders pane onto the folder in the canvas.
3. Drag a folder from any location onto the Folder element on the canvas.

3. To convert a folder from user-managed to auto-managed, choose auto-managed for the
Folder's Path property.

Problem jobs

Problem jobs is a special flow element that represents the Switch problem jobs folder. When a
Switch process fails to handle a particular job, the "problem job" is moved to the problem jobs
folder.

Refer to Handling problem jobs on page 252 for more information.

Keywords
Keywords can be used with the search function above the Elements pane.

The keywords for the Problem jobs element are:

- error
« failure
Connection

The problem jobs tool can be placed in a flow on its own, without any connections. In that case

it serves simply as an easy way to access the problem jobs from the designer user interface (for
example, when you select the problem jobs tool, the Files pane shows its contents). See Handling
problem jobs on page 252 for more information.

If the problem jobs tool has an outgoing connection, it acts as a producer picking up any problem
jobs that arrive and injecting them into the flow (again). This allows providing automated error
handling. You can add a filter to the outgoing connection to select the jobs you want to handle,
leaving the others in the problem jobs folder. In any case be careful to avoid endless loops of
jobs that fail over and over again.

The problem jobs tool supports only one outgoing connection. To overcome this limitation,
connect it to a regular folder from which you can originate as many connections as you like.

Properties
Property Description
Element type The flow element type: Problem jobs.

This property is useful to identify renamed flow elements. It cannot be
changed.
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Property Description

Name The name of the flow element displayed in the canvas

Description A description of the problem jobs folder displayed in the canvas, for
example indicating if the flow contains all problem jobs of all flows or only
the current flow's problem jobs (see next property). The description is
also shown in the tooltip that appears when moving your cursor over the
connection.

Handle problem Determines the "scope" of this problem jobs tool:

Jobs for « This flow only: acts on problem jobs generated just by the flow

containing this flow element

« All flows: acts on all problem jobs generated in this copy of Switch

Send alerts to This property is only available if Handle problem jobs for is set to This
flow only.

Determines who will receive alert messages if a job arrives in a Problem
jobs folder.

Note: Alerts are only sent if enabled in the Problem alerts
preference, i.e. if the Problem job arrives preference is set to Yes!
Otherwise, no alerts are sent!

Options are:
«  None: No emails are sent for this specific flow.

- Default: Alerts are sent to the email addresses entered in the Send
problem alerts to preference.

« One or more email addresses, separated by a colon (if entered via
Inline Value) or a newline (if entered via the multi-line text editor):
alerts will be sent to all entered email addresses.

Retry count This property is only available if Send alerts to is NOT set to Default.

If sending an alert fails, this property determines how many times Switch
will retry sending it.

Retry delay (in This property is only available if Send alerts to is NOT set to Default.

minutes) If sending an alert fails, this property determines after how much time

Switch will try again.

Multiple problem jobs tools

A flow can have at most one problem jobs element; including more than one will keep the flow
from activating.

In addition, at any one time, the active flows in Switch can have at most one problem jobs
element with a scope set to "All flows".
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Submit hierarchy

io

Submit hierarchy is a default Switch app that enables you to submit job files and job folders that
are stored in a folder structure with different levels. The original location of each of the files is
remembered.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Archive hierarchy

Archive hierarchy is a default Switch app that creates a nested hierarchy with one or more levels
of subfolders. It is used to archive jobs into a structured hierarchy at the end of a flow.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Set hierarchy path

E

Set hierarchy path is a default Switch app that replaces or augments the hierarchy path in the
internal job ticket by constructing a fresh path from the segments specified as its properties.
There are five segment properties and thus a maximum of five path segments can be specified
(an empty value means "unused").

Since the segment properties support variables (and script expressions), this tool is a great help
when building custom archive hierarchies, for example organizing jobs in a folder hierarchy
based on today's year, month, and day.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Job dismantler

W
-
Job dismantler is a default Switch app that disassembles a job folder (which may have one or

more levels of subfolders) into separate files.

This tool is often used to dismantle job folders that really do not represent a single job. This
happens for example when a user submits a folder into the flow that contains a set of otherwise
unrelated files that need to be processed individually rather than as a single entity.

For more information about this app, refer to the app documentation on the Enfocus Appstore.
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Ungroup job

_"‘Lj

[ |

i

Ungroup job is a default Switch app that, in combination with assemble job, provides a way to

keep track of files that belong together while they are being processed separately.

Ungroup job injects all files from a job folder into the flow as separate jobs. After these files have
been processed through the flow (and possibly were renamed), assemble job can reassemble
them into a new job folder with a structure similar to the original one, with provisions for injecting
additional files and for dealing with incomplete jobs or orphaned files.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Split multi-job

@L

Related Adobe InDesign or QuarkXPress jobs are often stored in a single job folder with multiple
"main" files at the top level and shared resources (such as images and fonts) in subfolders. The
Switch apps for these applications however expect a single main file in each job folder, so these
"multi-job folders" cannot be processed without change.

The Split multi-job app splits a multi-job folder in separate job folders, one for each main file. Each
resulting job folder contains a single main file, and a full copy of all resources (in fact, everything
from the original job folder except for the other main files).

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Assembile job

&)

Assemble job is a default Switch app that offers various schemes for assembling a job folder from
individual job files.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Generic application

L ad |

Generic application is a default Switch app that functions as a stand-in for a third-party hot folder
application.

For more information about this app, refer to the app documentation on the Enfocus Appstore.
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4.1.2.2.

Execute command

>

Execute command is a default Switch app that executes a system command or a console
application with the specified command-line arguments and output mechanisms.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Tools

Refresh job info

B

Refresh job info is a processor that allows you to control the generation of thumbnails and job
info shown in the Check jobs view, on the job boards and in the job info dialog on the Switch
Web Portal.

Before Switch 2021 Fall, the job info and the thumbnails shown in the Check jobs view were
generated each time a new job was created from a job that came in through a Submit point or
Checkpoint, which in some cases could lead to a big performance hit. Thanks to the Refresh job
info element flow designers and Switch administrators can now force Switch to only generate the
thumbnails and job info (including custom job info) where they need it.

In Switch 2022 Spring, extra functionality was added: you can now set, change and remove flow
stages and create and/or remove custom fields through this flow element.

Note: Custom job info fields are not inherited for child jobs and are cleared in folders that
set the stage.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Working with flow stages

What are flow stages?

"Flow stage" is an optional property of certain flow elements* that indicates a logical stage in a
flow.

For example, if in the first part of the flow files are preflighted, in the second part they are
prepared for large format print and in the last part they are moved to the appropriate folder on
the server, you may split up your flow in three stages: Preflight, Prepare for print, and Distribute
(regardless of the number of folders in your flow).

* Currently Refresh job info, Submit points and Checkpoints have this property.
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For which flow elements a flow stage should or can be defined?

A job gets associated with a flow stage as soon as it arrives in the flow element. This means that
flow elements that mark the beginning of a stage should have a flow stage defined.

If a job arrives in a flow element that does not have a flow stage, the flow stage linked to the job
simply does not change.

If a job is moved to the Problem jobs folder, it gets the default "Problem jobs" stage assigned.
This stage is kept until the job is retried and is injected in the flow again; from that moment
onwards the job gets the previous job stage assigned (= the stage it should have if not moved to
the Problem jobs folder).

Note: Stages do not have to be unique, not on flow-level, not on Switch-level.

Where can you see the flow stage of a job?

The flow stage associated with a job is shown on the Switch Web Portal, on the job boards (in the
properties of the job). See Job fields on page 329 (flow stage = Stage).

What are flow stages typically used for ?

The flow stage of a job provides information about the status of the job; it indicates in what logical
stage of the flow a job currently is. It can be interesting for an operator to know which jobs are

in a particular stage, for example which jobs are problem jobs (= have the 'problem jobs' status),
which jobs are finished, etc.

For a quick overview of the jobs and the flow stage they are in, you can create virtual job boards
on the Switch Web Portal. Such a job board could for example only display jobs with a particular
flow stage.

For more information, refer to Finding Switch jobs through the Switch Web Portal on page 279

Sort by preflight state

L
0

Sort by preflight state is a default Switch app that sorts incoming Enfocus Certified PDF files
across its outgoing connections depending on their preflight state: Error, Success, Warning or
Sign-off.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Archive

s

Archive is a default Switch app that places the incoming file or a job folder into a compressed
ZIP archive (ZIP64-compliant). All files in a job folder are placed in a single archive. The archive is
named as the incoming file or job folder with a ".zip" extension.

For more information about this app, refer to the app documentation on the Enfocus Appstore.
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Unarchive

i

Unarchive is a default Switch app that extracts files from an archive in ZIP or RAR format (ZIP64-
compliant).

Any files that are not recognized as an archive are passed through the Problem jobs folder.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Split PDF

l
L

P

Split PDF is a default Switch app that produces a job folder containing a separate PDF file for
each page or range of pages in the incoming PDF file. The app does not require Adobe Acrobat
or any other external application to be installed.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Merge PDF
ll.

PLAF

Merge PDF is a default Switch app that produces a single PDF file containing all of the pages
provided by the PDF files in the incoming job folder. The app does not require Adobe Acrobat or
any other external application to be installed.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Hold job

_'I]I|
L

Hold job is a default Switch app that offers various time-based schemes for holding and releasing
jobs and for distributing jobs across multiple outgoing connections.

For more information about this app, refer to the app documentation on the Enfocus Appstore.
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Inject job

K
Inject job is a default Switch app that injects a job into the flow when triggered by an incoming job

or by various time-based events. The injected job can be selected dynamically from a repository
of jobs, it can be a fixed job, or it can be the incoming job itself.

The properties for each outgoing connection specify what needs to happen for that connection
(independently of other connections). For example, to inject a job from a repository based on the
metadata of some incoming job while keeping the original job around, setup one connection to
receive the incoming job, and a second connection to receive the job from the repository.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Rename job

o

Rename job is a processor that provides various mechanisms for renaming the incoming job and/
or the files inside a job folder.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

File type

LY
?

File type is a default Switch app that sets a filename extension for a file and if applicable its Mac
file type and creator type to a specified type.

Job folders are moved along without change.
See also About Mac file types on page 41 and Switch preferences: Mac file types on page 40.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Sort job

o]

Sort job is a default Switch app that offers various schemes for sorting incoming jobs across its
outgoing connections depending on metadata associated with the jobs.

For each job the tool determines the value of the specified metadata field and compares this
value with the names of the outgoing connections. If a match is found, the job is moved along that
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connection. Otherwise the job is moved along the outgoing data error connection, or if there is no
such connection, it is moved to the problem jobs folder.

Note: This flow element has become redundant and should only be used for
maintenance reasons. Sorting jobs can be done (much faster and easier) by defining a
condition with variables on a Connection.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Log job info

o

Log job info is a default Switch app that issues a (warning, debug or info) message to the Switch
execution log containing the value of the specified metadata field. It is intended mainly for use
while testing a flow.

For example, you could issue a warning message whenever a file arrives in a particular flow
element, or an info message that displays the size, the priority, the submission date, ... of each job
moving along the flow, ...

For further analysis of your messages, you could use a Switch app like Switch Logger or
Datalogger.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Sort files in job

ki
B
il

Sort files in job is a default Switch app that provides a mechanism for "sorting" the files inside a
job folder, in other words to perform the following two steps:

1. Determine the desired sorting order of the files based on their current filename.
2. Rename the files so that they alphabetically collate in the desired sorting order.

This is useful to prepare the job for tools that process files in alphabetical order, for example
merging pages into a single document.

Sort files in job ignores any nested subfolders and their contents (that is, it works only on the files
immediately inside the job folder). Individual job files are passed along unchanged.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

XSLT transform

)

XSLT transform is a default Switch app that performs an XSLT 1.0 transformation on the incoming
XML file and produces the resulting XML, HTML or text file.
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4.1.2.3.

Refer to the XSLT 1.0 specification and to widely available literature about XSLT for more
information.

See also External metadata on page 397.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Recycle bin
e

Recycle bin is a default Switch app that deletes incoming jobs either immediately or depending
on the jobs size, age etc...

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Scripting

Script element
L
_O

Script is a default Switch flow element that executes a script program specified by the user to
process, produce or consume jobs.

A script flow element can be a processor, producer or consumer depending on the specifications
in the attached script declaration. In addition, the script declaration may inject extra properties
into the script element and into its outgoing connections. These extra properties serve as
arguments to the script program.

For more information on scripting in Switch, refer to the Scripting documentation on the Enfocus
website.

Keywords
Keywords can be used with the search function above the Flow elements pane.

The keywords for the Script element are:

. package
« program
« custom
« plug-in

« plugin

« visual basic
« javascript

Script folders and script packages

A script can be represented by a script folder or a script package.
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- A script folder is a folder containing a number of encrypted files that describe the different
parts of a Switch script written in Node.js. For more information, refer to the Switch Scripting
Guide on the Enfocus website.

« A script package is an archive file (with flename extension "sscript") that contains all
information about a script. It includes a script declaration, a script program, and possibly an
icon to be displayed in the Switch flow designer instead of the standard script element icon. A
script package can be exchanged between users as a single entity.

To assign a new script folder or script package to a script element, right-click on the script
element in the canvas and select the "Choose script" menu item, or edit the "Script path" property
in the properties editor.

To edit the script folder selected in a script element, right-click on the script element in the
canvas and select the "Edit script code" menu item. The script package will be opened in the
default application (e.g. VSCode) for viewing or editing.

To edit the script package selected in a script element, right-click on the script element in
the canvas and select the "Edit in Scripter" menu item. The script package will be opened in
SwitchScripter for viewing or editing.

It's also possible to create a new script folder from within Switch Designer. To do so, right-click
on the script element in the canvas and select the "New script folder" menu item. In the dialog
that appears, you have to enter the script path and the script ID and indicate whether or not you
want to use TypeScript. The main.js or the main.ts file is opened in the default application (that is,
the application associated with the file extension; if none, a dialog will open allowing you to select
the preferred application).

Connections

The type and maximum number of outgoing connections for a script element are determined
by the script declaration attached to the script element. Furthermore, the script declaration may
cause the script element to inject extra properties into its outgoing connections.

Properties

Property Description

Element type The flow element type: Script element.

This property is useful to identify renamed flow elements. It cannot
be changed.

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element

Enable debug mode This property is only available if the script package includes a
Node js.script. For more information, refer to the Scripting Guide
available on our website.

If set to Yes, it is possible to debug the included Node.js script
using Chrome or Visual Studio Code editor.

Note: The script execution mode is set to ‘Serialized’
automatically, once the debug mode is enabled. This
prevents the flow element instance that uses the script
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Property Description

from executing entry points concurrently. The debugging
can be enabled for only one Node.js script at a time. The
flow designer must ensure that different Script elements

do not execute the entry points concurrently.

Port This property is only available if Enable debug mode is set to Yes.

Defines the port number a debugger can use to connect to a
Node.js process. The default port is 9229.

Debug entry points This property is only available if Enable debug mode is set to Yes.

Defines the list of script entry points to debug. By default,
all three possible entry points (jobArrived, timerFired and
httpRequestTriggeredAsync) can be selected (regardless of
whether or not they are used in the script).

Script path The Switch script to be attached to this script element

<Injected> The script declaration may define extra properties to be injected
into the script element as arguments for the script program

Log debug messages This option is only available if Show advanced element properties
is enabled in the properties of the flow!

This option allows you to log debug messages for a particular
Node.js script, without having to restart Switch to enable debug
messages for all flow elements (through the Switch Logging
preferences).

Note: This option doesn't switch on debug logging for
legacy script expressions used to define property values.

Options are:

« Default: Debug messages for this particular script element are
only logged if Log debug messages is enabled in the Switch
preferences.

«  Yes: Debug messages for this particular script element are
logged.

41.2.4. Communication

HTTP request

HTTH
ik
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HTTP request is a default Switch app that for each incoming job executes an HTTP or HTTPS
request. Thus the incoming job is a request trigger and it can be used to define the request
specification: URL, authentication data, request parameters, file to upload, etc. The protocol type
(HTTP or HTTPS) is automatically detected from the URL: if the URL starts with “https://”, HTTPS is
used, otherwise HTTP is used.

The server responds to the request by sending something back: an HTML source, JSON or
XML data, or a file that is downloaded. The tool provides properties to manipulate this server
response. The server response is always saved as a file and the tool can inject this file into the
flow as a new job, attach it as metadata dataset to the incoming job or assemble it into a job
folder together with the incoming job.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Webhook

&

Webhook is a default Switch app that subscribes to specific incoming HTTP requests and injects
the received request content as a new job in the flow. The job file name is 'payload' and the file
extension is automatically generated from the 'Content-Type' header.

You can add this tool to your flow to accept notifications via HTTP/HTTPS protocol.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

FTP receive

%]

FTP receive is a default Switch app that downloads jobs from an FTP site and injects them into
the flow. The syntax is similar to the syntax of a Submit hierarchy.

If your system environment requires FTP connections to pass through a proxy server, you need
to set up the FTP proxy preferences to provide Switch with the configuration details of the proxy
server. See Switch preferences: FTP proxy on page 39.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

FTP send

Lo

FTP send is a default Switch app that uploads any incoming jobs to an FTP site.

If your system environment requires FTP connections to pass through a proxy server, you need
to set up the FTP proxy preferences to provide Switch with the configuration details of the proxy
server. See Switch preferences: FTP proxy on page 39.

For more information about this app, refer to the app documentation on the Enfocus Appstore.
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Mail receive

¥

Mail receive is a default Switch app that retrieves email messages from a POP3 and IMAP email
server (so that users can access email accounts like Gmail, Hotmail etc) and injects any file
attachments into the flow. Please note that Switch only accepts MIME encoded attachments.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Mail send

D

Mail send is a default Switch app (although conceptually it is a consumer) that sends an e-mail
message to an SMTP e-mail relay server for each incoming job.

Some properties for this tool (such as the SMTP server details) must be set up in the global user
preferences, since these values are the same for all outgoing email. For more information, refer to
Switch preferences: Mail send on page 37.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Submit point

L d
Submit point is a default Switch app that serves to submit jobs into a flow through the Switch Web

Portal by a user with the appropriate access rights. See also Designing flows for use with the
Switch Web Portal on page 313.

The backing folder for a Submit point is always auto-managed.

Note: You can only use the Submit point flow element, if you have licensed the
SwitchClient and/or the Switch Web Services module.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Submit point element will be shown in the list:

. Internet

« web

« network

« communication
. transfer

« input
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« client
. user
« upload

« metadata
« workstation

Properties

Property Description

Element type The flow element type: Submit point.

This property is useful to identify renamed flow elements. It
cannot be changed.

Name The name of the flow element displayed in the canvas. By
default it is displayed as "Submit point".

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears when
moving your cursor over the flow element.

Note: The description entered here is not displayed
on the Web Portal (or client application): if you want a
description to be shown on the Web Portal (or client
application), use the 'Display description' field below.

Display name The name to be displayed on the Switch Web Portal (or a
different client application). If set to Default, the name entered in
the Name field is displayed.

Display description The description to be displayed on the Switch Web Portal (or a
different client application). If this field is empty, the description
will be: "No description available".

You can enter the description in (plain) multi-line text or in HTML
format, so that it will be rendered as HTML on the Switch Web
Portal. If defined as HTML, you can add images, links,.... For
guidelines and an example, refer to Display description defined
as HTML (below this table).

Note that there is no limitation to the number of characters used
in this field. If the text is not immediately visible because it's too
long, you can scroll down (using your mouse wheel) to see it.

Thumbnail The image to be used as thumbnail for this Submit point on the
Switch Web Portal (in the top left corner of the dialog). Allowed
image types are PNG, BMP and JPEG.

Flow stage The stage assigned to the Submit point. This allows you to check
where jobs are in a flow. The flow stage of a job can be viewed
on the job boards on the Switch Portal. Refer to Working with
flow stages on page 112.
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Property Description

Attach hierarchy info If set to Yes, part of a job's submit information (as configured
with the next two properties) is added to its hierarchy location
path as it is injected in the flow; see Using hierarchy info on
page 190 for more details.

Include Submit point name If set to Yes, the name of this flow element is included at the top
of the remembered location path.

Include user name If set to Yes, the name of the user submitting the job is included
in the remembered location path.

Attach user email address If set to Yes, the submitting user's e-mail address is added to
each job's email info as the job is injected in the flow; see Using
email info in Switch on page 192.

Attach extra email info E-mail addresses and body text specified with the editor for this
property are added to each job's email info as the job is injected
in the flow; the information added can vary depending on the
user submitting the job; see Using email info in Switch on page
192.

Submit Choices are:

« Job and metadata: The Submit point accepts both job files
and metadata associated with the job. This option triggers a
number of subordinate properties (see further).

« Job only: The Submit point only accepts job files. Metadata
cannot be supplied.

« Metadata only: The Submit point only accepts metadata.
Note that in this case, a dummy job (*.dummy) moves through
the Switch flow. This option triggers a number of subordinate
properties (see further).

- Trigger: The Submit point triggers an action. The Submit
point acts like a button: when a user clicks it, a dummy job
(*.dummy) moves through the Switch flow and (depending on
the flow) this job can start a process, call a database, ...

The following properties are only available if metadata
submission is enabled:

Metadata fields Definitions for the metadata fields to be entered; see Defining
metadata fields on page 406 for more information.

Dataset name A name for the set of metadata entered here; see Picking up
metadata on page 398 for more information.

Invalidate metadata cache Determines whether or not the dynamic metadata cache will be
on user login cleared when a user logs in. This property only applies to the
user cache; the common cache will not be cleared. For more
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Property Description

information, refer to the paragraph on 'Invalidating the metadata
cache' below this table.

Invalidate metadata cache Determines the condition on which the metadata cache will be
condition cleared, for example after a certain time. For more information,
refer to the paragraph on 'Invalidating the metadata cache'
below this table.

Accept these jobs This property is only available if "Submit" is set to "Job and
metadata"” or "Job only".

Determines which jobs are accepted. Options:

« Files and folders
« Files only
- Folders only

In case of the two first options, an extra option appears, which
allows you to determine which file types are allowed:

« File types: Enter a list of allowed file types, one per line, for
example pdfto allow PDF files. If you leave this field empty,
all file types are allowed.

Requires Switch Helper This property is only available if "Submit" is set to "Job and
metadata” or "Job only".

If set to Yes, extra metadata, such as job origin* and file creation
date* will be attached to the submitted jobs.

This requires Switch Helper, so the users of the Portal or the
client application must have installed Switch Helper. Without
Switch Helper, they will not be able to submit jobs. Note that
Submit points with this option enabled will not accept jobs via
'drag-and-drop'; users will have to upload them by clicking the
Upload file or Upload folder button.

Switch Helper is available on the Enfocus website.

* Without Switch Helper, Switch doesn't know the location of the
submitted job, hence the value of job origin will be the Submit
point's backing folder. If Switch Helper is enabled, the value of
job origin will be the folder on the user's computer.

** Without Switch Helper, the creation date is (incorrectly)
replaced with the modification date.

For more information about job origin and the file creation date,
refer to Job group on page 378.

Picking up client fields as metadata

If a Submit point is configured to accept metadata (Submit set to Job and metadata or Metadata
only), the Submit point:

« Creates a metadata dataset containing the contents of the metadata fields entered by the
user.

124


https://www.enfocus.com/en/support/downloads/switch-helper

ENF@CUS Switeh

« Associates this dataset with the job ticket for the submitted job under the dataset name
specified in the "Dataset name" property.

Refer to Client fields schema on page 411 for details on the format of the generated metadata.

Invalidating the metadata cache

In case of dynamic values, Switch can store the metadata in the user cache ("cache per user") or
in the common cache ("cache for all users"), so the values do not have to be recalculated each
time metadata is requested. For more information, refer to the "Cache dynamic values" property
in the topic on Defining metadata fields on page 406.

Note that by default, the cache is not cleared unless you explicitly enable "Invalidate metadata
cache on user login" or define a condition for "Invalidate metadata condition".

Display description defined as HTML
Guidelines
If defined as HTML, you can add images, links and other elements.

You can also use CSS styles, but make sure to only apply styles to unique IDs or classes for a
specific Submit point. See the table below.

WRONG RIGHT
body { #spl{
3. .;
div{ #spl > div{
3. .;
span { .spl{
3. .;
hl{ body .sp3 hl{
3. .;

Currently the following tags are not supported:

o <script>
«  <iframe>
. <audio>
«  <video>

<html> and <body> tags can be used but are not recommended.

Example

HTML code entered in the Display description property

<style>

#container sp2 {
background: #03e0da;
color: #D228d4;

}

#container wrapper {
padding:10px;

}

</style>

<div id="container sp2">
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<div id='container wrapper'>
<p>Requirements:</p>
<nav>
<ul>
<li>PDF or TIFF format</li>
<li>Resolution 600 dpi</1li>
<1i>3mm bleed</1i>
<1i>CMYK or greyscale</li>
</ul>
More info on <a href="https://www.enfocus.com" target=" blank"
title="Enfocus"/>our website</a>
<br><br>
<img alt="Enfocus" height="20px" src="https://www.enfocus.com/manuals/ elearning/
Enfocus-logo-black-horizontal 149x27.png" width="auto" />
</nav>
</div>

How it looks on the Web Portal

SUBMIT POINT

Active

no e

Checkpoint

Checkpoint is a default Switch flow element that holds jobs for human intervention. A user with
the appropriate access rights can review jobs in a Checkpoint through the Switch Web Portal and
redirect them along any of the Checkpoint's outgoing connections.

The name shown to the user for each outgoing connection is the name of the connection, or if it
is empty, the name of the target folder.
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The backing folder for a Checkpoint is always auto-managed.

See also Designing flows for use with the Switch Web Portal on page 313.

Note: You can only use the Checkpoint flow element, if you have licensed the
SwitchClient and/or the Switch Web Services module.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Checkpoint element will be shown in the list:

« Internet

« web

« network

« communication
. transfer

« interact

. client

. user

« route

« approve

. metadata

Connections

Checkpoint allows any number of outgoing move connections.

Properties

Property Description

Element type The flow element type: Checkpoint.

This property is useful to identify renamed flow elements. It cannot
be changed.

Name The name of the flow element displayed in the canvas. Default
value is "Checkpoint".

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Flow stage The stage assigned to the Checkpoint. This allows you to check
where jobs are in a flow. The flow stage of a job can be viewed
on the job boards on the Switch Portal. Refer to Working with flow
stages on page 112.

Allow multiple outputs If set to Yes, the user can send copies of a job along more than
one outgoing connection; otherwise the job is sent along exactly
one of the outgoing connections.
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Property

Description

Enable report viewing

If set to Yes, the user gets extra buttons to view or save a report
obtained by retrieving the metadata dataset named in the property
described below.

This feature is most often used with datasets picked up through a
traffic light connection by setting "Carry this type of files" to "Data
with log".

Report dataset name

The metadata dataset name for the report to be viewed by the
client.

Allow replacing or editing
job

If set to Yes, an extra button is available allowing the user to edit
and/or replace jobs with a new version (presumably edited on the
client user's computer) before moving it out of the Checkpoint; the
original job is lost, but its metadata is preserved.

Enter and display metadata

If set to Yes, you can specify or display optional or required
metadata fields a user needs to review, update or fill in before
allowing the job to go through this Checkpoint.

Metadata fields

Specify the metadata fields a user needs to review, update or fill

in. Click this [:] button to invoke the Define metadata fields
dialog box where you can specify the metadata fields. For a full
description, refer to Defining metadata fields on page 406.

Dataset name

The name of the dataset in which the specified metadata fields will
be stored is entered here; see Picking up metadata on page 398
for more information.

Invalidate metadata cache
on user login

Determines whether or not the dynamic metadata cache will be
cleared when a user logs in. This property only applies to the user
cache; the common cache will not be cleared.*

Attach user email address

If set to Yes, the handling user's e-mail address is added to each
job's e-mail info as the job is moved along the flow.

In addition, the Checkpoint updates the "user name" attribute in
the internal job ticket as follows:

- If this property is set to Yes, the "user name" attribute is always
set to the name of the Checkpoint client user moving the job
along, regardless of its previous value.

« If this property is set to No, the "user name" attribute is set to
the new name only if it was empty to begin with.

Update user info

Specifies if the user's info (hame, full name and email address)
associated with the job should be updated to contain the info of
the user who handles the job.

Options:
«  Ifempty
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Property Description
« Yes
« No
Fail jobs after timeout If set to Yes, jobs are failed after residing in the Checkpoint for a

certain period of time (specified in the subordinate properties).

Failed jobs are moved to the outgoing connection specified in the
subordinate properties or to the problem jobs folder.

Unit Selects the unit for the subsequent property: Minutes, Hours, Days

Timeout delay The timeout delay in the units indicated by the previous property.

0 means that the jobs are failed immediately.

Fail connection The name of the connection to which failed jobs must be moved.

If this property value is empty or if the specified name doesn't
match any of the outgoing connection names, failed jobs are
moved to the problem jobs folder.

Picking up client fields as metadata

The Checkpoint tool picks up metadata fields entered by the user when moving along a job.
Specifically, when a user moves along a job residing in a Checkpoint and the list of editable field
definitions in the Checkpoint's "Metadata fields" property is not empty, the Checkpoint creates a
metadata dataset and associates it with the job's job ticket under the specified dataset name.

Note that a Checkpoint always creates a completely new dataset, i.e. it does not update or
modify an existing dataset (even if the job was previously moved through the same or another
Checkpoint). If the job already has a dataset association with the same name, the reference to the
old dataset is removed and replaced by the new one.

Refer to Client fields schema on page 411 for details on the format of the generated metadata.

* In case of dynamic values, Switch can store the metadata in the user cache ("cache per user") or
in the common cache ("cache for all users"), so the values have not to be recalculated each time
metadata is requested. For more information, refer to the "Cache dynamic values" property in the
topic on Defining metadata fields on page 406.

Note that by default, the cache is not cleared, unless you explicitly enable "Invalidate metadata
cache on user login".

Checkpoint via mail

o]

Checkpoint via mail is a default Switch app that allows implementing a simple Checkpoint via e-
mail, performing the following main functions:

« For each arriving job, send out an e-mail message that includes the unique name prefix of the
job and a list of possible "Checkpoint actions" (the names of the outgoing connections, or, if
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no name is specified, the name of the target folders) — in addition to instructions on how to
operate the Checkpoint by return e-mail.

« Monitor e-mail messages coming back from users and parse those messages for the original
information about the job and for the Checkpoint action selected by the sender.

«  When a matching response comes in, move the corresponding job along the specified
outgoing connection or (if no name is specified for the connection) to the specified target
folder.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Pack job

Pack job is a default Switch app that packs a job and its associated metadata for transmission.
The result is always a single ZIP file that contains a globally unique identifier to identify it across
multiple Switch instances.

Pack job also stamps the internal job ticket of its output with the unique identifier so that
confirmations can be matched with the packed data without opening the ZIP file.

See Acknowledged job hand-off on page 199 for an example of how to use this tool.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Unpack job

Unpack job is a default Switch app that unpacks a job that was packed for transmission with Pack
job.

Outgoing data success connections receive the unpacked job, with restored metadata (if it
was included in the packed archive). Outgoing log success connections receive a checksum-
protected XML file that can serve as a formal confirmation of successful receipt of the job,
recognized by the Monitor confirmation element.

Incoming jobs that do not have the appropriate format (or that were corrupted during
transmission) are sent to the data error connection or if there is no such connection, these jobs
are moved to the problem jobs folder.

See Acknowledged job hand-off on page 199 for an example of how to use this tool.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Monitor confirmation

%)

——

Monitor confirmation is a default Switch app that monitors incoming receipt confirmations
(generated by Unpack job) and matches them against a copy of the packed data (generated by
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4.1.2.5.

4.1.2.6.

Pack job) waiting in its input folder. When no confirmation is received after a certain amount of
time, the tool can be setup to retry the communication (that is, send another copy of the packed
data).

See Acknowledged job hand-off on page 199 for an example of how to use this tool.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Remote process

O
0

Remote process is a default Switch app that allows you to take Switch jobs out of the flow,
process them remotely (using the service of your choice) and put them back in the flow after
processing.

The API to communicate with Switch is available on the Enfocus website.

Note: The Remote process element is only available if you have licensed the Scripting
module.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Apps

This category is only available if you have downloaded and installed at least one app from the
Enfocus Appstore. For more information about working with apps, refer to the dedicated chapter:
Working with apps in Switch on page 259.

For more information about a particular app, search for the app in Apps category of the Flow
elements pane, and from the context menu, select App details. This will bring you to a page
on the Enfocus Appstore. The documentation can be found in the bottom right corner, under
Resources.

Configurators

Enfocus PitStop Server

The PitStop Server configurator is an application that drives PitStop Server. It is a processor that
preflights and/or corrects a PDF file according to specifications. The resulting PDF file flows along
the "data" output connections, the Preflight Report flows along the "log" output connections. The
PitStop Server configurator can process only individual PDF files and not job folders.

Note:

« As of PitStop 24.11, the configurator also accepts images, on condition that the Enable
image input property (see further) is set to Yes. These images are converted to PDF
files first, before Preflight Profiles or Action Lists are executed.
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« As of PitStop 25.03, the configurator also supports resource syncing. That means that
Action Lists and Preflight Profiles can be stored in the Enfocus Cloud, and shared with
PitStop Pro users and with other PitStop Server instances. To make use of this new
feature, you need to enter an Enfocus Cloud Connection token in the properties of
the configurator. For more information on the setup, refer to the Resource syncing
documentation on our website.

Tip: Check out the eLearning course on this topic!

Licensing

The PitStop Server configurator is only available in the Flow elements pane (Configurators
category) if you have installed and licensed PitStop Server. It is not an app that can be
downloaded from the Enfocus Appstore.

Note: Ideally, you have installed PitStop Server before you installed Switch. That way,
Switch can automatically find the application, which is necessary for the configurator to
run. If PitStop Server is installed afterwards while Switch is running, make sure to restart
Switch.

Compatibility
PitStop Server

Keywords
PDF PDF/X preflight certified correct fix modify optimize convert color colour GWG profile
transparency flattening action list

Application discovery details

This configurator tries to locate the PitStopServerCLI executable in the PitStop Server installation
folder. It is also possible to set the path to the PitStop Server CLI manually through the
configurator's popup menu in the Flow elements pane.

Connections

This configurator uses traffic light connections. PDF files that generate one or more preflight
errors will be sent to the error connection; files that generate warnings but no errors will go to
the warning connection, and files that have neither errors nor warnings will go to the success
connection. Any nhumber of outgoing connections is supported, but at least one Data connection
is required.

Properties detailed information

Note: You can also find this information in Switch. Just go to the configurator in the
Flow elements pane, right-click the configurator to open the context menu and choose

'Documentation...".
Properties Description
Flattening If set to 'Yes' PitStop Server will flatten all transparencies. Color
management in this configurator must be enabled for images and other
objects.
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Properties Description

Subordinate properties:

« Raster/vector balance: A value from O to 100. This controls the
degree of rasterization of complex areas in the document. If set to
100, no areas in the document will get rasterized for performance
reasons (although some areas may still be rasterized for other
reasons).

- Vector resolution: Rasterizes all objects, including images, vector
artwork, text, and gradients, to the specified resolution. Allowed
values are between 1and 9600.

- Gradient resolution: Specifies the resolution for gradients and
[llustrator mesh objects after rasterization because of flattening.
Allowed values are between 1and 1200.

« Convert all text to outlines: If set to 'Yes', all text is converted to
outlines and all type glyph information is discarded.

« Convert all strokes to outlines: If set to 'Yes', all strokes are converted
to filled paths.

« Clip complex regions: If set to 'Yes', the boundaries between vector
artwork and rasterized artwork will fall along object paths. This option
reduces stitching artifacts as a result of a part of an object being
rasterized while another part of the object remains in vector form.

« Preserve overprint: If set to 'Yes', preserves overprint where possible.
If this option is disabled all overprint in the document will be
simulated by blending the colors of overprinted objects.

- Blending color space: Specifies the page level transparency blending
color space.

. If 'Current' is selected, the blending color space is left untouched.

« If'ICC profile' is selected, you must select a color profile from the
library stored inside PitStop Server or browse to a standard ICC
profile file.

«  Remove ICC profiles: If set to 'Yes', ICC profiles are removeed after
flattening.

« Recompress images: If set to 'Yes', the post flattening image
recompression is enabled. Otherwise the compression that is the
result of the flattening will be kept. Extra options are:

« Color bitmap images: Specifies the type of compression to be
used on color bitmap images after flattening.

« Gray scale bitmap images: Specifies the type of compression to
be used on gray scale bitmap images after flattening.

« One bit images: Specifies the type of compression to be used on
one bit images after flattening.
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Properties Description
- ASCII filter: Specifies the ASCI! filter to be applied.

« Resolve transparency: This property is no longer supported and
should be set to 'Yes'.

Enable image input If set to Yes, the configurator accepts JPEG and PNG images.
This option triggers the following subordinate properties:

+ Use embedded dimensions if available: If the submitted image
contains embedded resolution metadata you may want to override
the page dimensions specified in the Default page dimensions
property below. If so, set this option to Yes, otherwise select No.

- Default page dimensions: Specify the dimensions of the pages of the
target PDF. These can be based on:

- A fixed width and/or height that you can enter in the subordinate
properties. Automatic means that the aspect ratio is kept. For
example, if only the width is specified, the height will be calculated
based on the aspect ratio of the input image.

« A specific resolution (in ppi).

Note that this setting will be ignored if the image contains embedded
resolution metadata AND Use embedded dimensions if available is
set to Yes.

Note: The options for resolution, height and width only change
the print resolution or the print size, not the pixel count of

the image. Resampling the image in the PDF, changing its
compression, etc., can be done afterwards with a PitStop Action.

Enfocus Cloud If you want to use Preflight Profiles or Action Lists that are shared
Connection through the Enfocus Cloud, generate a token and copy-paste it into this
field. You'll find the Cloud resources in a pink folder. For more details,
refer to the Resource syncing documentation on our website.

Preflight Profile The Enfocus Preflight Profile to be used to preflight and possibly correct
the file. The Preflight Profile can be omitted in case one or more Action
Lists are specified.

Manage Preflight Manage the Preflight Profile database for the PitStop Server configurator.
Profiles
Action List(s) A sequence of Action Lists to be executed on the file.

Note: This property can be empty in case a Preflight Profile is
specified.

Manage Action Lists | Manage the Action List database for the PitStop Server configurator.

Variable Set Select a variable Set for Smart Preflight. A Variable Set is required only
if dynamic Preflight Profile is used. For more info, refer to the chapter on
Smart Preflight.

134


https://www.enfocus.com/en/support/manuals/pitstop-server-manuals

ENF@CUS Switeh

Properties Description

Certified PDF Determines Certified PDF-related behavior while processing the file as
one of these choices:

« Unchanged: The certify status of the document will not be changed

« Save as uncertified: The result file will not be certified. If the incoming
document was certified all certify information will be deleted.

« Start certified: The result will be saved as a certified PDF document

If you've chosen 'Unchanged' or 'Start certified', following subordinate
properties become available:

- Allow rollback: If set to 'Yes', the output file preserves the Certified
PDF history information allowing rollback to previous Certified PDF
sessions.

« Keep original profile: If Certified PDF is set to 'Unchanged' or 'Start
Certified', and Keep Original Profile is set to 'Yes', the original profile
will be kept, even if the incoming file is already Certified with a profile
other than the defined Preflight Profile.

. Set personal info: If set to 'Yes', a number of extra properties appear
for defining the personal information listed on the Preflight Report
and used for the Certified PDF session created by processing the file.

More info on Certified PDF can be found in the PitStop Pro Reference
Guide on our website.

Enable Color Determines whether PitStop Server uses color management to process
management the file.

If set to 'Yes', the configurator shows a series of extra properties to
specify color profiles and rendering intent:

« Color management for images: Specifies the color management
mode for image objects. If set to Yes, a number of extra properties
are displayed, such as Gray/RGB/CMYK and Lab source, where
you must specify the Gray/RGN/CMYK and Lab target color profile
respectively.

« Color management for other objects: Specifies the color
management mode for objects other than images; choices are:

« Same as images: Color management for all objects is specified by
'Color management for images' property and its subordinates.

- Different: Color management for other objects than images is
turned on and defined by the subordinate properties, such as
Gray/RGB/CMYK and Lab source, where you must specify the
Gray/RGN/CMYK and Lab target color profile respectively.

« No: Color management for other objects is turned off.
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Properties Description

« BPC: Set BPC to 'Yes' to enable black point compensation in the color
management engine.

Use system fonts Specifies if the fonts in the system folder are available for handling fonts
during processing.

Extra font folder Path to a folder that contains extra fonts for use while processing files (in
addition to the system fonts).

Skip font license Set this to 'Yes' if you comply with the font license restrictions imposed
checks by any font used in the input files.

Some fonts may be licensed for View and Print only. By setting 'l comply
with the font license restrictions' to 'Yes', you agree that you have
checked the licensing conditions of the print vendor of these fonts

and that you are allowed to manipulate these fonts according to the
configuration of this flow element. Enfocus disclaims any liability for any
use of the fonts which is not in accordance with the licensing agreement
between yourself and the print vendor. Choose 'No' if you do not agree.

Optimization The optimization performed:

« For web: Optimized for web download
- File size only: Optimized for file size only

« None: Not optimized

Report type The format of the Preflight Report:

« None: No Report will be generated.

« PDF: Regular PDF Preflight Report format (generated by PitStop
Server).

«  PDF minimum: Minimum PDF Preflight Report format PDF minimum
(generated by PitStop Server).

«  PDF continuous: Continuous PDF Preflight Report format (generated
by PitStop Server).

« PDF annotated: Annotated PDF Preflight Report format (generated by
PitStop Server).

« PDF annotated low res: Low resolution annotated PDF Preflight
Report format (generated by PitStop Server).

« PDF annotated scaled: Scaled annotated PDF Preflight Report format
(maximum A4; generated by PitStop Server).

« Custom PDF Report template: A highly customizable PDF Report.

«  XML: XML Preflight Report format PitStop Server (generated by
PitStop Server).
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Properties

Description

«  JSON: JSON Preflight Report format.

Depending on the chosen option, a number of extra properties are
displayed:

- Report template: Select a Report template (.prefs file) to be used for
the PDF Report. A Report template can be used to greatly customize
the appearance of PDF Reports.

« Hyperlinks include unique name prefix: A PDF Report contains
hyperlinks to the file being processed; this property determines
whether the filename in those hyperlinks includes the Switch unique
name prefix or not. In both cases the hyperlinks are relative to the
file's position, so the preflight Report and the file being processed
must remain in the same folder for the hyperlinks to work.

- Additional XML Report dataset name: The name of an additional
dataset where an XML Report will be stored. Subordinate properties
are:

«  Type: Choose the XML Report type. The version of the XML
defines the schema used for the XML Report. v3 is the current
version and is strongly recommended. v2 Reports are still
supported but may be removed in the future.

- Maximum number of items: It is possible to truncate the number
of Reported items per category. Reducing this number imposes a
limit on the xml Report file size but might results in an incomplete
Report. Default is 100.

«  Maximum number of objects: It is possible to truncate the number
of Reported objects per item. Reducing this number imposes a
limit on the xml Report file size but might results in an incomplete
Report. Default is 100.

« Report language: The language of the Preflight Report.

« Measurement units: The measurement units used in the Report;
choices are: Points, Picas, Inches, Feet, Millimeters, Centimeters,
Meters.

«  XSLT Transformation (if Report type = XML): Use this property to
define an additional XSLT transformation for the XML Report. This
property only works for version 3 XML Reports. Choices are:

« Preflight results: A summary of the errors, warnings and fixes of
the preflight.

« Page boxes: Information about the page boxes of each page.

« Page color type: Information about each page's color type:
black and white, color, or empty.

« Layers: The layer structure of the document.

« Fonts: Information about the fonts in the document.

« Images: Information about the images in the document.

« Ink usage: A list of used inks in the document and per page,
including their total areas.

« Output intents: Document output intent information.

« Text summary: a CSV with preflight result information.
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Properties Description

« XML summary: an XML with preflight result information.

Add troubleshooting | petermines whether or not troubleshooting datasets are created. This
datasets has an impact on the speed of Switch.

« Yes (default): Troubleshooting datasets are created at /Users/<User>/
Library/Application Support/Enfocus/Switch Server/datasets.

« No: No troubleshooting datasets are generated. This will result in
some processing speed improvement as this reduces memory usage

Note: This option was added in PitStop Server 2023 update 1.

Enfocus PitStop Server PDF2Image

The PitStop Server PDF2Image configurator is an application that drives the PDF2Image
functionality of Enfocus PitStop Server. It renders the pages of a PDF to images, either as a whole
or split into separations. The PitStop Server PDF2Image configurator can process only individual
PDF files and not job folders.

Note: As of PitStop 25.03, the configurator also supports resource syncing. That means
that Action Lists can be stored in the Enfocus Cloud, and shared with PitStop Pro users
and with other PitStop Server instances. To make use of this new feature, you need to
enter an Enfocus Cloud Connection token in the properties of the configurator. For more
information on the setup, refer to the Resource syncing documentation on our website.

Tip: Check out the eLearning course on this topic!

Licensing

The PitStop Server PDF2Image configurator is only available in the Flow elements pane
(Configurators category) if you have installed and licensed PitStop Server. It is not an app that can
be downloaded from the Enfocus Appstore.

Note: Ideally, you have installed PitStop Server before you installed Switch. That way,
Switch can automatically find the application, which is necessary for the configurator to
run. If PitStop Server is installed afterwards while Switch is running, make sure to restart
Switch.

Compatibility
PitStop Server

Keywords
PDF export render image png jpg jpeg
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Application discovery details

This configurator tries to locate the PitStopServerCLI executable in the PitStop Server installation
folder. It is also possible to set the path to the PitStop Server CLI manually through the
configurator's popup menu in the Flow elements pane.

Connections

The configurator uses a "Move" connection. The PDF that is used as input is exported as an
image, and this image is sent to the connection.

Properties detailed information

Note: You can also find this information in Switch. Just go to the configurator in the
Flow elements pane, right-click the configurator to open the context menu and choose

'Documentation...".

Properties

Description

Image type

The output image type. Options are:

PNG
JPEG

Subordinate properties if PNG is chosen:

Interlaced: If set to Yes, Adam 7 interlaced PNG is created.

Output color space: Output color space to be used: DeviceGray or
DeviceRGB. The subordinate property Background color is used to
specify the background color during rendering. If none is specified,
the rendered image may contain transparency. In case of DeviceGray,
the background color should be a gray value between 0 and 100.

In case of DeviceRGB, the background color is a RGB based color,
defined by a red, green and blue value between O en 255.

Embed ICC profile: Embed the ICC profile used as target for images in
the image. This requires that color management is used, and that the
full page is rendered.

Subordinate properties if JPEG is chosen:

Quality: The quality of the JPEG compression.
Progressive: Generate a progressive JPEG.

Output color space: This element specifies the output color space

to be used. Choices are DeviceGray, DeviceRGB and DeviceCMYK.
Background colors have to be defined as well; in case Gray, Cyan,
Magenta, Yellow and Black, values between O and 100 are valid. Red,
Green and Blue expect values between 0 and 255.

Embed ICC profile: Embed the ICC profile used as target for images in
the image. This requires that color management is used, and that the
full page is rendered.

139




ENF@CUS Switch

Properties Description

Append page Appends the page number from which the image was generated to the

number file name. If set to yes, you should also specify the Page number width.
Note that page numbers are padded with zeroes until given width if
necessary.

Include empty pages | |fset to 'Yes', images without (selected) contents will be generated as
well.

Image export option | options are:

« Composite: The page will be exported as one image.

« Separations: An image will be generated for each separation present
on the page. In that case, you must also set the Append separation
name option. If enabled, the separation name is appended to the
output file name. Note that some characters in the separation name
may be replaced in order to create a valid file name.

Enfocus Cloud If you want to use Action Lists that are shared through the Enfocus
Connection Cloud, generate a token and copy-paste it into this field. You'll find the
Cloud resources in a pink folder. For more details, refer to the Resource
syncing documentation on our website.

Prerender Action List | The Action List to be executed before the page is rendered.

R.estricting Action The Action List to restrict the contents of pages. If no Action List is
List defined, all visible contents is considered selected. If a page does not
contain any selection, it is not exported to an image.

Variable Set Select a variable Set for Smart Preflight. A Variable Set is required only if
dynamic Action Lists are used.

Render area This element specifies which area to be rendered, based on the page
box.

Image dimensions Choices are:

« Resolution: The page will be rendered at the given resolution.

« Fixed with and/or height. The page is rendered at the given width
and/or height. At least one of Height or Width must be defined. If both
are defined, the aspect ratio is not maintained.

Anti-aliasing If set to 'Yes', the rendering engine will use anti-aliasing.
Enable Color Determines whether PitStop Server uses color management to process
management the file.

If set to 'Yes', the configurator shows a series of extra properties to
specify color profiles and rendering intent:

« Color management for images: Specifies the color management
mode for image objects. If set to Yes, a number of extra properties
are displayed, such as Gray/RGB/CMYK and Lab source, where
you must specify the Gray/RGN/CMYK and Lab target color profile
respectively.
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Properties Description

- Color management for other objects: Specifies the color management
mode for objects other than images; choices are:

- Same as images: Color management for all objects is specified by
'Color management for images' property and its subordinates.

- Different: Color management for other objects than images is
turned on and defined by the subordinate properties, such as
Gray/RGB/CMYK and Lab source, where you must specify the
Gray/RGN/CMYK and Lab target color profile respectively.

« No: Color management for other objects is turned off.

« BPC: Set BPC to 'Yes' to enable black point compensation in the color
management engine.

Use system fonts Specifies if the fonts in the system folder are available for handling fonts
during processing.

Extra font folder Path to a folder that contains extra fonts for use while processing files (in
addition to the system fonts).

Smart Preflight

The following topics are only relevant if you're using the Enfocus PitStop Server configurators,
as only these configurators support Smart Preflight. It's explained further in this document what
Smart Preflight is and how it can be used in the Enfocus products in general and in Switch in
particular.

About Smart Preflight

Smart Preflight is a functionality that allows you to handle many different job types and
specifications by using only one Preflight Profile. This is possible, thanks to the use of variables.

For example, if one of your preflight settings checks the page size, it is sufficient to define one
Profile using a variable with the most commonly used page size (e.g. A4) as the default. If a
document type with a different page size comes in (e.g. a leaflet or a newspaper), you can select
the required page size from a pre-defined list or type the appropriate value (depending on how
the variable is defined) in the dialog that pops up when running the preflight check.

There are three types of variables:

- Constant variables are variables that get their value from user input (in PitStop Pro, as in the
example above) or from a Job Ticket or a database (in PitStop Server and Connect):

« In PitStop Pro, a dialog pops up just before running the preflight check. You can manually
enter the required values.

« In PitStop Server, you must send an XML/JDF Job Ticket along with the PDF. The
information in this Job Ticket (e.g. the page size) is used to determine the value of the
variables.
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« In the PitStop Server Configurator (for use with Switch), the information can be taken
either from a Job Ticket or from a database.

« In Connect, you can create Job Tickets that collect job information for each document
processed by a Connector. The metadata in these Job Tickets will be used to determine
the value of the variables.

Calculation-based variables are variables of which the value is calculated by multiplying,

dividing, subtracting, adding up, ... certain values (fixed values or variables).

For example, in large format printing, the required resolution depends on the viewing
distance; the bigger the distance, the lower the required resolution. The optimal resolution can
be calculated with a calculation variable.

Another example is point size: if a large poster will be viewed on a small display, the point size
should be smaller; the optimal point size can be calculated by dividing the regular value (a
fixed value) by the scaling factor (stored in a variable).

Rule-based variables are variables of which the value is based on other variables (possible in
all Enfocus products)

For example, suppose you want to check the ink coverage using a Preflight Profile. The
optimal ink coverage depends on several different factors, just like the paper type and the
printing method. Without variables, you must define different Profiles for each combination

of paper and printing method, each with fixed total ink coverage values (e.g. Profile 1 for
Uncoated + Sheetfed Litho and Profile 2 for coated + Sheetfed Litho, ...). However, using
variables, you can define one Profile and enter the required information for the job (paper type
and printing method) to calculate the optimal ink coverage at run-time.

The different types of variables can be combined (e.g. rule-based variables calculated based on a
drop-down of constant variables), making it possible to configure multiple checks and fixes based
on a single user input (PitStop Pro) or on only one value in a Job Ticket or database.

Constants |Constants |Constants |Rule-based | Calculation-
User input | Job Tickets | Databases based
PitStop Pro v v v
PitStop Server Y v v
PitStop Server with v v v v
Enfocus Switch*
Enfocus Connect/ Y Y v v
Connectors

* The PitStop Server Configurator also supports the Switch variables. Refer to Smart Preflight
Variables: types on page 146.

Note: Variables can be used in Action Lists as well, in a similar way as in Preflight.

Getting started with Smart Preflight

Variables and Variable Sets

Before you can start working with Smart Preflight, you need to define the variables you want to
use and save them within a Variable Set (a file format which can be exported and imported).
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When defining your Preflight Profile, you can then select the variables you need from this
Variable Set. Note that you can create different Variable Sets (e.g. if you would like to define
different Variable Sets for different document types or different Enfocus products) and that

a Variable Set can contain as many variables as required. However, you can apply only one
Variable Set at a time (e.g. one per hot folder in PitStop Server, one active Variable Set in PitStop
Pro) and it should match the Variable Set used in the Preflight Profile concerned.

Note: PitStop Pro and PitStop Server can share the same Smart Preflight Variable Sets,
much like they can share Preflight Profiles or Action Lists. However, some variable
types (see further) are useful in PitStop Pro only and others work only in PitStop Server.
Unsupported variables will use a default value or will generate a failure.

How to decide which preflight settings could be configured as variables?
Good candidates are preflight settings that can change from job to job, for example:

« Trim page size
. Total ink coverage
«  Number of colors defined

Preflight settings that are often the same can better be configured as fixed values. Some
examples:

+ Embedded fonts
« Security settings
- Document contains pre-separated pages

Getting started

The following topics explain step by step how to configure a Variable Set and how to use the
variables in your Preflight Profiles.

Setting up Smart Preflight

Smart Preflight setup: overview

This topic describes the steps required to set up and use Smart Preflight.

1. Configure a Variable Set:

a. Create a Variable Set.
b. Define the Variables to be used.

2. Apply the variables to the appropriate checks in your Preflight Profile.

3. Run the Preflight Profile with the variables enabled.

Configuring a Variable Set

Creating or editing a Variable Set

You need a Variable Set (which contains the variables you need) in order to use variables in a
Preflight Profile or Action List. You can create a new one or re-use an existing one (i.e. add any
new variables as required).
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Important:

« Although you can create more than one Variable Set, we recommend that you keep
all your variables in one Set. Only if you are working with both PitStop Pro and PitStop
Server, you might consider using different sets. However, if you use variables of
different Variable Sets within a single Preflight Profile, only the "active" (applied)
Variable Set variables will contain values. Variables used from inactive Variable Sets
will be blank!

- Do you want to use a Variable Set with the PitStop Configurator in Switch? To get
access to the Switch Variables (see Smart Preflight Variables: types on page 146),
you should edit the Variable Set in Switch (not in PitStop Server).

To create or edit a Variable Set

1. Inthe Properties pane of the PitStop Server Configurator
a. Locate the Variable Set property.

b- Click .

c. Click Select Variable Set.
The Select variable set: Variable Set Panel appears, displaying all the installed Variable Sets
as well as any local and Cloud Variable Sets that have been defined.

2. Do one of the following:

- To edit an existing Variable Set, double-click the Set concerned.

To create a new Variable Set, from the actions menu ( S ), select New > New.

The Enfocus Variable Set Editor appears.
3. Enter the appropriate details (a meaningful name and a description) and lock the Variable Set
if required.

See Locking a Variable Set (optional) on page 144

4. Define the Variables you need.

See Defining Smart Preflight variables on page 145

5. To change the order of the variables in the set, do one of the following:

- Drag and drop the variables to the position of your choice.
« Select a variable and use the up and down arrows to move it to another position.

6. Click Save.
The Variable Set is saved in the folder where you created it. In case of a read-only folder, you
can select the location of your choice (either a local folder or a Cloud folder, if applicable).

Note: This folder is shared with any other Enfocus applications that you may have
installed.

Locking a Variable Set (optional)

You can lock a Variable Set with a password, to prevent other users from editing the Variable Set
and viewing details when they open it in the Enfocus Variable Set Editor.

To lock a Variable Set
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1. Open the Variable Set.
See Creating or editing a Variable Set on page 143

2. Inthe Enfocus Variable Set Editor, click SETUP > General.
3. From the Permissions list, select Locked.

4. Enter a password and repeat it.

Note that you can change the password at any point of time if required, by clicking the
Change Password button.

5. Click OK.

6. Click Save.
The Variable Set is locked. Users wanting to edit or view the details of the Variable Set must click
=l
the Lock icon ™ and enter the correct password.
Defining Smart Preflight variables

The Smart Preflight variables for use in Preflight Profiles must be defined before you can use
them. This topic explains how you can create and define new variables.

To define Smart Preflight variables

1. Open the dialog with the Variable Set that will contain the new variable.

See step 1 of Creating or editing a Variable Set on page 143.
2. Inthe left part of the Enfocus Variable Set Editor, under Variables, click [+,

3. Enter the required details for the new variable:

Field Meaning

Name Choose a meaningful name, for example, the check the variable is
intended for.

This name will be visible in the Preflight Profile editor or in the
Action List editor, when applying a variable to a check or fix (see
Applying variables to a check in a Preflight Profile on page 156).
For this reason, it is advisable to keep this name as short as
possible.

User Readable Name Use this field if the variable name is too technical or too short to be
clear enough.

Type (First list) Choose the appropriate type. Refer to Smart Preflight Variables:
types on page 146.

Type (Second list) The type of the values produced by this variable. For example,
if a variable for a trim page size is to be created, then it must
have a "Length" variable type. If a variable is needed to select
or deselect a check box (such as to turn on a correction), then a
Boolean variable type needs to be defined. Some examples for
each option:

«  Number - Page count, Number of separations, etc
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Field Meaning

« Length (i.e. a number of measurement fields) - Page trim size,
bleed amount, etc

« Text - Any text, for example Document author, Font name, Spot
color name, Substrate type, etc.

+ Boolean - Selection for any checkboxes

Note: Make sure that this value type matches the
preflight check setting it is intended for. When applying
variables to a preflight check setting, only the variables
that match that type of entry will be displayed.

Type (Third list) In case of a Job Ticket in combination with value type "Length", a
third list is available, allowing you to choose the appropriate unit,
for example "Points", "Inches", ...

Note: The unit displayed in the Default Value field (lower)
depends on the application Preferences.

Description Optionally, provide a brief description.

4. Proceed with the fields in the lower part of the dialog.

This part of the procedure depends on the chosen variable type:

« Constant variable definition on page 147.

« Calculation-based variable definition on page 149.

« Rule based variable definition on page 151.

- Variable definition: Text with variables on page 153.

« Variable definition: Script expression on page 155.

Note: For example variables, have a look at the Smart Preflight Variable Set - PitStop
Pro - v1.4. (available under Standard > Smart Preflight).

5. Click Save.
Smart Preflight Variables: types

When defining a variable, you must choose a type. The table below gives an overview of the
available variable types per application and explains their meaning.

Type Meaning Application

Constant In PitStop Pro, when a Constant variable is applied to PitStop Pro/Server

a preflight check, a default value will be displayed to PitStop Server

the operator, allowing him to override it before running | configurator in Switch
that preflight check. Constants can be a text string, a
number, a length (i.e. a measurement) or a boolean Enfocus Connect
(yes/no or on/off) value.
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Type

Meaning

Application

Constant variables are available in PitStop Server to
stay compatible with PitStop Pro. Only their default
value is used when processing. No choice to override
their value is given at the time of processing, since
PitStop Server is intended to process files completely
"hands-off".

Rule Based

A Rule Based variable allows you to take values from
other variables and use them to create a new value,
based on different conditions. For example, variables
representing paper type and printing method could
both be used to define the value for the necessary Total
Ink Coverage.

PitStop Pro/Server

PitStop Server
Configurator in Switch

Calculation
Based

A Calculation Based variable allows you to make
calculations. You can divide, multiply, subtract, add
up, ... fixed and variable values as required.

PitStop Pro/Server

PitStop Server
Configurator in Switch

Enfocus Connect

Job Ticket

Job Ticket variable values are extracted from an XML/
JDF file submitted to PitStop Server or a Connector

in conjunction with the PDF job file. These variables
can either change a single setting or be linked to Rule
Based variables for more complex processing.

Note: The Job Ticket variables of PitStop
Server cannot be used in Switch. However, you
can change the Job Ticket variables to either
Text with Variables or Script Expression and
modify them to correspond to the behavior of
Switch.

PitStop Server

Enfocus Connect

Text with
variables

Variable values are defined using the Switch variables.
Note that this type is only available if you open the
Variable Set via the PitStop Server Configurator in
Switch.

PitStop Server
Configurator in Switch

Script
expressions

Variable values are defined using JavaScript. Note that
this type is only available if you open the Variable Set
via the PitStop Server Configurator in Switch.

Note: Node.js Script expressions are not
supported yet.

PitStop Server
Configurator in Switch

Constant variable definition

Options

The following table gives an overview of the constant-specific options.
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Option Description

Default Value | Fixed value, which will be used when Switch runs a Preflight Profile that needs
this variable.

Note: Constant variables used in PitStop Server cannot be
manipulated by the user. Hence, PitStop Server will only use the
default value.

Allow manual Enables users to type values when they run the Preflight Profile.

input

Show a Enables users to select a predefined value from a list of values.

fi li . . —
predefined list If the value type is Number or Length, you will have the possibility to mask the
of values .
value and provide an alternate name for the user.

Tip: You can change the order of the items in the list by just selecting
a value and dragging it up or down and dropping it in the desired
position.

Example

Below you can see an example of a constant variable definition (left) and the resulting list the
users will see when running the Preflight Profile (right).

Variable Value
Default Value:  Brown

CD|DF Brllen el ﬂ
Interactive Smart Preflight EH

Allow manual input Green
Red
Show a predefined list of values ElLIIIE- .
{one item per line, empty line for separator) Sllow
Green -~ Black
Red White
Blue
fellow E
Black
White a

Combining options

Allow manual input and Show a predefined list can be combined. The following table explains
what this means.

Selected options Meaning

Both enabled Users can either select a value from the predefined list but
or manually enter a value.
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Selected options Meaning

Both disabled Users will see the default value in a read-only text box.
They cannot change it.

Only Allow manual input enabled | Users can manually enter a value. There is no list to choose

from.
Only Show a predefined list Users can select a value from the predefined list. They
enabled cannot enter a value themselves.

Calculation-based variable definition

Calculation-based variables allow you to calculate a value by multiplying, dividing, subtracting,
adding up, ... certain values (both fixed and variable values).

You can build your calculation (in the Variable Value entry field) as follows:

«  You can type it directly into the Variable Value field.

- Toinsert the digits and operators, you can also use the calculator beneath the entry field.
Note that 'Clear' clears the whole entry field.

« Toinsert variables:

1. Click the Add variable button or enter a square bracket ([) in the entry field. This will open
a drop-down list with all variables defined in the current Variable Set.
2. Click the variable you want to insert.

Example

This is an example of a calculation variable that is used to check the resolution of images in large
formatting. This is the value that triggers an error.

The first screenshot shows the variable definition. The value is calculated by dividing and
multiplying fixed values and variable values (the viewing distance and the scaling factor), which
both have an impact on the allowed image resolution. Note that the variable definitions for
viewing distance and scaling factor must be defined as variables in the same Variable Set.
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¥ Variable Definition
Name: GWG_Digital_Large_Format_2015 4_28 Resolution (Error)

User Readable Name: Single Bit Image Resolution (Error)

Type: Calculation Based MNumber

Description: | Ghent Workgroup POF Specification - GWG2015 - Digital
(PDF/X-4:2010 compliant)
Digital Printing|

Preflight Profile version October 3, 2018

Variable Value

549 [ [GWG_Digital_Large_Format_2015 Viewing Distance] / 2834.645669 * [GWG_Digital_Large_Format_2015 Scaling Factor]

{ : wod | | coar Add Variable
7 8 a /
4 5 & .
1 2 a -
0 3

The second screenshot shows how the variable is used in an Action List to check the image
resolution of grayscale and color images.

[ ] (O] Enfocus Action List Editor - GWG 2015 Digital 4.28 Check Image Resolution for 1-bit Images
Properties Attributes for Check resolution:
General Infarmation .
Locking Information Effective resolution of = any image Actions ¥
Actions should not be | less than or equal to [GWG_Digit..] ) ppi

Select 1-Bit images

Select objects inside region
AND

Select if image width or height is less than ...
NOT

AND

Check resolution

Duplicate top of selection stack
Select by image resolution
NOT

AND

Check resolution

Remove top of selection stack

(11 Ignore soft-masks

Log Log as error

| - AV

Ing;

<< - <

A

Cancel OK

More examples can be found in Variable Set 1.4 (under Preferences > Variable Sets). These
variables were configured for use with the GWG Profiles for Packaging (2015 Specifications).

Remark
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Calculation Based
Length
Text
Boclean

The most common value type of calculation variables will be Number. However, if your Preflight
check or Action expects a different type, this is also possible. For example, in case of a "Boolean"
variable, the result of the calculation will be converted to false (if it's 0) or true (if not 0). In case

of "Length", the result of the calculation will be converted to a value in the unit chosen in the
Preferences (so x points will be converted to the corresponding value in cm, mm, feet, etc).

Rule based variable definition

About rule based variables

The concept of a rule based variable is to build a variable that will change based on the state of
another setting. For example:

Rule based variable "Image Resolution" is defined as follows:

IF "Job type" is "Offset" THEN set "Image Resolution" to 300 ppi
ELSE
IF "Job type" is "Digital", THEN set "Image Resolution" to 150 ppi

Rule based variables get their values based on one or more rules. Each rule has two parts: a
condition to trigger the rule (IF) and the value to be used when that condition is triggered (THEN).

The condition contains one or more comparisons of a variable with a value. In the above
example, the variable "Job type" is compared with the value "Digital". These comparisons can be
combined with "AND" and "OR" to create complex conditions.

If a rule is not triggered, the next rule is tried. There must be an ELSE rule at the very end, that is
triggered if none of the conditions are met.

Because a rule based variable always needs to be compared with one or more other variables,
you will always need to create at least one other variable to make a rule based variable work. In
the above example, you need to know the value of the "Job type" variable in order to determine
the value of "Image Resolution". In PitStop Server, the variable to compare with will usually be a
Job Ticket variable. In PitStop Pro, this will usually be a constant variable which offers the user a
list of predefined constant values to choose from.

How to proceed

Proceed as follows:

Note: Before starting the configuration in the software, we recommend writing down the
rule for yourself (using IF/ELSE statements). This will make clear which variables you need.

1. Define the variable(s) you need.
2. Define the rule based variable itself:

« Choose Rule Based as Type and determine the value type, for example "Number".

« Build the rules:

« The first list (preceded by "IF") allows you to select any earlier defined variable.
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- Choose "is", "is not", "begins with", ... as required and enter or select the appropriate
value. Options depend on the variable chosen in the previous step.

« Click the appropriate operator (AND/OR). (The chosen operator is added to the rule.)

AND/OR statements will add a condition to the selected rule, making the rule
dependent on two or more conditions.

- Enter/Select the resulting value (the type depends on the chosen value type).

- If required, click ELSE to add an alternative rule to the overall variable (=IF) and
proceed in the same way.

« Determine what should happen in case none of the conditions are met. You can either
generate a failure (so the preflight check will generate a preflight error) or enter a
default value.

3. Save the Variable Set.

Example 1

Below you can see the definition of the "Image Resolution" rule based variable (value type =
Number). It makes use of an earlier defined variable: "Job type", which is a constant (text) variable
with "Offset" and "Digital" as possible values.

Depending on the value of "Job type", the Image Resolution will be different (300 or 150). If the
Job type is different from the ones for which a rule has been configured, a preflight error will be
generated.

-1 Variable Definition

MName: Image Resolution

User Readable Mame:  Image Resolution

Type: Rule Based T] INumber -
Description:
Variable Value
IF IJub type 'I Iis "I Offset -

THEM use this number: 300

IF IJuI:: type 'I Iis TI Digital -

THEM use this number: 150
ELSE IF none of the above conditions are met:

@ Generate a failure
Use this number: |0
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Example 2

Below you can see the definition of the "Convert to grayscale" rule based variable (value type =
Boolean). It makes use of an earlier defined variable: "Color conversion", which is a constant (text)
variable with "Grayscale" as one of the possible values.

If the value of the "Color conversion" variable is "Grayscale", the value of "Convert to grayscale"
will be "Yes". If this is not the case (e.g. Color conversion is "CMYK"), the value of "Convert to
grayscale" will be "No" (=default value).

-1 Variable Definition

Marme: Convert to grayscale

IUser Readable Mame: Convert to grayscale

Type: Rule Based ~ | |Boolean -

Description:

Variable value

IF |Color conversion - | |i5 - | Grayscale -

THEM use this value: |Tes - |

ELSE IF naone of the above conditions are met:

Generate a failure

@ Use this value: |Mo -

Variable definition: Text with variables

About Text with variables

This type of variable provides access to run-time information about the Switch flow environment
and about the job, including embedded metadata fields and external metadata fields, without the
need for scripting.

Note that you need an active license for the Switch Databases Module, if you want to use
database information, and active license for the Switch Metadata Module, to use metadata fields.

Length/Unit

When you select "Length" as the value type for this variable, an additional dropdown menu called
Unit appears, allowing you to choose the appropriate measuring unit.

Note: Make sure to use the same unit in the Variable Value text box below. Otherwise,
the chosen value from the Unit list will be ignored. For example, if you choose
"Centimeters" in the Unit dropdown and enter "20 mm" in the Variable Value text box,
then Smart Preflight will consider millimeter as the unit and centimeter will be ignored.
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How to proceed
To define a variable using the text with variables option, proceed as follows:

1. To determine the Variable Value, click the ... button.

2. Inthe Define text with variables dialog, select the appropriate Variable Group (first column),
Variable (2nd column) and attributes (3rd column).

3. Click Insert variable.

Tip: Use a sample job to see the actual value of the inserted variable.

For more details, refer to Defining text with variables on page 350

Example 1

Below you can see the definition of the "JobName" variable (Text). The value returned from the
sample Job is "Duotone".

This is a basic example. For more complex cases, refer to the chapter Metadata on page 349
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[=I variable Definition
Mame: JobMame

|Iser Readable Mame:

Type: [Text with variables ] [Text -

Description: B ]
- B Define text with varniables

L1 -
q Sample jobs

MName Size Type
'E] Ductone.pdf 181 KB pdf File

Connection variables

| Connection | | Ernail
Database FullUserMame
Doc IP

Ernail UserMame
Image

Variable Value

Value: § [Job.MNameProper]

Iptc

Job
Metadata
Office
Photo
Stats
Switch

Text with variables
[Job.MameProper]

Sample value

Variable definition: Script expression

About script expressions

A script expression is a JavaScript program that gets evaluated in the context of a job (file or
jobfolder) to determine the value of a particular property of a flow element or connection. This
allows the property value to depend on the job or its associated metadata.

Note that you need an active license for the Scripting Module in order to configure and use this
type of variable.
Length/Unit

When you select "Length" as the value type for this variable, an additional dropdown menu called
Unit appears, allowing you to choose the appropriate measuring unit.

ﬂ Note: Make sure to use the same unit in the Variable Value text box below. Otherwise,
the chosen value from the Unit list will be ignored. For example, if you choose
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"Centimeters" in the Unit dropdown and enter "20 mm" in the Variable Value text box,
then Smart Preflight will consider millimeter as the unit and centimeter will be ignored.

How to proceed
To define a variable using a script expression, do one of the following:

- Type the JavaScript source code in the Variable Value box and click Save to save the code to
a file.

« Click Open and select an existing script (*,js). The content of the selected script will be
shown in the Variable Value box. If you make any changes, makes sure to save them to a file
(Save/Save as).

Applying a Variable Set

Once you have defined your Variable Set, you must "apply" or activate the Variable Set you
want to use. This is extremely important if you have defined more than one Variable Set; if
the variables used in your Preflight Profile are taken from a different Set than the one that is
activated, the variable values in the Profile will remain blank.

To apply a Variable Set

In the properties of the PitStop Server Configurator, click |i|

2. Select the Variable Set that contains the variables used in a Preflight Profile.

Applying variables to a check in a Preflight Profile

Variables allow you to process different jobs and job types with one Preflight Profile; instead of
using multiple Profiles with different, fixed values, you enter a variable which is defined when
running the Preflight Profile.

Note that you need to have defined a Variable Set with Smart Preflight variables before you can
use variables in a Preflight Profile.

To use variables in a Preflight Profile

1. Click (Plugins) > PitStop Pro > Preflight Profiles and double-click the Preflight Profile
concerned.

2. In your Preflight Profile, open the CHECK ON: category for which you want to use a variable.

3. Do one of the following:

If a variable should be used for enabling or disabling all checks on the tab, click "'\ A

button ' appears next to the checkbox of Enable checks without restriction/Enable
checks of <restriction>.

- If a variable should be used for one particular check, in the attributes of the check

concerned, click the Enable Variable Names button '''/. A button '/ appears next to each
property where it is relevant.

4. Click '/ next to the property for which you want to use a variable.

Note that this button is only shown when the check can have a variable applied.

5. Inthe Select a Variable dialog, make sure Use a Variable from the selected Variable Set is
selected and select a Variable Set as required.
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6. Double-click the variable you want to use for the property concerned.

Only the variables that match the type required for the property concerned are shown. For
example, if you want to define the page width, you need a variable of the type Length.

The name of the variable is shown in the Preflight Profile.

Running a Smart Preflight check

If you want to preflight PDF files in Switch using the PitStop Server Configurator, you must build
a flow with the PitStop Server Configurator and set all properties correctly. As PitStop Server is an
automated system, there is no manual intervention, so the values cannot be entered by the user.
Instead, the values are taken from a Job Ticket - at least if the variable type is "Job Ticket". If this
is not the case (i.e. if the variable type is "rule based" or "constant"), the default values are used.
See also Smart Preflight Variables: types on page 146.

Note that all PDF files moved to the PitStop Server Configurator will be preflighted. No additional
setup is required.

To learn more about the PitStop Server Configurator, search for the configurator in the Flow
Elements pane and select Documentation from the context menu.

Using variables in embedded Action Lists

Action Lists can be embedded in Preflight Profiles. You can find them at the bottom of the
Enfocus Preflight Profile Editor, under 'EXTRA'. See also the chapter on 'Adding Actions to the
Preflight Profile' in the PitStop Pro reference guide.

By default, all embedded Actions will be executed when the Preflight Profile is run. You can
manually turn off an Action List (if you don't need it), by clearing the On/Off checkbox in the
Preflight Profile. In that case, it will not be used. However, it's also possible to use variables to
control the use of the embedded Action Lists. In that case, the value of the variable determines
whether or not the Action List is executed.

To do so, proceed as follows:

1. Click the Actions menu in the top right corner of the Preflight Profile Editor, just above the
Action Lists.

2. Click Enable Variable Names.
The variable button @ appears between the On/Off checkbox and the name of the Action
Lists.

3. Click @ next to the Action List for which you want to use a variable.

4. Select a Variable Set (if the default one is not the desired one) and a variable, and click OK.
The Variable's User Readable Name is displayed within the square brackets of the variable
button. Only variables that can be used to enable or disable Action Lists, i.e. boolean
variables, can be selected.

At run-time, the value of the selected variable is calculated. If the value of the variable is Yes, the
Action List will be executed. If the value is No, the Action List will not be executed.

Example:

Note: You can test this yourself using the Smart Preflight Variable Set - PitStop Pro - v1.1
and the Smart Preflight Profile - PitStop Pro - v1.1, available by default in PitStop Pro.
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Your Variable Set contains a variable ('Color conversion') to check which color conversion is
needed: conversion to gray, CMYK or RGB. When starting the Preflight check, the PitStop user
needs to make a choice and select the appropriate option.

The Color conversion variable triggers three rule-based variables ('Convert to grayscale',
'Convert to CMYK', 'Convert to RGB'); based on the choice of the PitStop user, these variables
are set to either Yes or No.

The value of these last three variables determine which Action List in the Preflight Profile is
executed. For example, if the user selects 'Color conversion is RGB', the Conversion to RGB
variable is set to Yes, so the Convert Color to RGB Action List will be executed.

Changes

o Smart Action List - Add Text to Page

Onfoit Action List Marmde

Crutline Fonts) Convirt all 1axt 1o oullings

= [ [Corvart to CMYE Convert Color to CMYK

= [ [Cervert to ROB Convert Color to RGB

s et Coanmvert Color to Gray and keep black toxt

— St i and bHeedbiox j0 marks Set Tnm and Bleed Box 1o Marks

= | [Enlarge page to the specified size) Enlarge to requested Page Size

£ +

Using Smart Preflight variables in Action Lists

Smart Preflight variables can also be used in Action Lists.

Using variables instead of fixed values in Action Lists

You can also use Smart Preflight variables to define attributes of your Actions contained in your
Action Lists. The advantages are the same as for Preflight Profiles, i.e. you don't need different
Action Lists but you can dynamically modify the values just before running the Action or by taking
them from a Job Ticket or database.

This topic explains how you can configure an Action to use variables instead of fixed values.

To define your Actions using variables instead of fixed values

1.

2
3.
4

Click (Plugins) > PitStop Pro > Action Lists and double-click the Action List concerned.
Select the Actions you want to define using a Smart Preflight variable.
Click the Actions link (in the top right corner of the attributes for the Action concerned).

Select Enable Variable Names.
This option is only available if it is relevant for the Action concerned.

The icon @ appears where it is possible to use a variable.
Click @,
Do one of the following:

- If the Select a variable dialog appears, you can directly select the variable you want to use.
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Note: You will only see the variables that can be used in the field concerned.

Note that you can choose a different Variable Set if necessary.

- If the Variable Mapping dialog appears (triggered by a dropdown list), at the top, click the
icon @ and select the variable you want to use. Next, you must manually copy the variable
values that are defined in your Variable Set to the column on the left. In case of PitStop
Pro, these will be presented to the user. The variable values should be mapped to the

Action values (in the column on the right), which cannot be changed.

Note:

« The dropdown list will look like a blank list. It will no longer be possible to

select values.

- It's not required to have a variable value for each Action value.

7. Click OK.

Example of a dropdown list with variables. The 'Orientation’' variable in the TST Variable Set
is selected. Its values ('Vertical' and 'Horizontal') are mapped to the values of the Change page
orientation Action ("Portrait" and "Landscape").

s Variable Set Editer - TST

Crientation

Constant 8 T a

@ Show a predefined list of values (one item per line, empty line for separator)

Vertical
Horizontal

[ XX Enfocus
¥ Variable Definition
General
Name:
User Readable Mame:
Orientation
Type:
Description:
Variable Value
Default Value: vertical
Interactive Smart Preflight
Allow manual input
N A v ||+ —

Attributes for Change page orientation:

Change the orientation of all pages to 2 | ([Orientation]

Page orlentatll |jsing this variable: ([Orientation]

Variable Value
Vertical
Horizontal

il Onlya @ Variable Mapping

Action Value

portrait

landscape

the most prevalent orientation

Running an Action List with Smart Preflight variables enabled

Cancel

If you want to run an Action List with variables enabled on your PDFs using the PitStop Server
Configurator or the PitStop Server PDF2Image Configurator, you must build a flow with this
Configurator and set all properties correctly. As PitStop Server is an automated system, there
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is no manual intervention, so the values cannot be entered by the user. Instead, the values are
taken from a Job Ticket - at least if the variable type is "Job Ticket". If this is not the case (i.e. if the
variable type is "rule based" or "constant"), the default values are used. See also Smart Preflight
Variables: types on page 146.

Note that all PDF files moved to the PitStop Server (PDF2Image) Configurator will be processed
with the selected Action List. No additional setup is required.

To learn more about the PitStop Server and PitStop Server PDF2Image Configurator, search for
the configurator in the Flow elements pane and select Documentation from the context menu.

Troubleshooting for Smart Preflight

Following topics explain how to fix some issues you may run across while working with Smart
Preflight.

Variable not available to apply a preflight check

Issue

Although the variable is present in the Variable Set, you are not able to select it for a particular
preflight check.

Cause/Context

When configuring a preflight check, you must first select the Variable Set concerned. Only
variables that belong to this set can be applied.

Variables are (among others) defined using a particular type (Constant, Rule Based, Job Ticket)
and value/measurement type (Number, Length, String, Boolean). This value type must match the
preflight check settings it is intended for, otherwise it is not displayed when you try to select it.

Fix
Make sure the correct Variable Set is selected. If the variable you want to use is present in a

different Variable Set, you may decide to switch Variable Sets or add the variable to the currently
selected Variable Set.

Next, review the variable and ensure it's defined as the right "value type" (Number, Length, String
or Boolean) to match the preflight check.

Variable Set not supported

Issue
While importing a Variable Set, you get one of the following errors:

« This Variable Set has settings not supported by this version of software. These may be
changed or removed when editing the Variable Set.

« The selected Variable Set has been created with a more recent application and cannot be
used.

Cause/Context

Variable Sets created with earlier versions of the software are always compatible with new
versions. You can import them and use any new features of the software as required. No error
messages will be shown.
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41.2.7.

Variable Sets created with newer versions of the software than the one you're using can be used
as long as no new settings were used (as they are not supported by the software). If there is a
version mismatch, one of the above mentioned error messages appears.

Fix
If you can import the Variable Set, remove or change the variables containing settings that are

not supported.

If you cannot import the new Variable Set, you can either upgrade the software (recommended)
or re-create the Variable Set using the older version of the software.

Note that, while saving Variable Sets, Enfocus PitStop Pro will automatically choose the lowest
possible Variable Set version number to ensure maximum portability.

Red exclamation mark in front of a variable

Issue

When opening your Variable Set in the Variable Set Editor, you notice that one or more variables
in the Variable Set have a red exclamation mark in front of them. Possible warnings:

« The variable uses the unkown variable type ... and cannot be edited.
« Variables from ... are not supported because ... Module is not licensed.

Cause/Context

Not all variable types are compatible with all Enfocus products. For example, "Text with Variables"
can only be used with Switch. If a variable is "unknown" to an Enfocus product, it cannot be used
or edited, but it won't harm either.

In Switch, some variable types are linked to a particular Switch module. For example, the "text
with variables" variable using database fields is only supported if you have an active license for
the Switch Database module.

The problem can also be linked to a rule-based variable; if the variable is based on another
variable that has been removed or is invalid, the rule-based variable becomes invalid as well and
gets a red exclamation mark in front of it.

Fix
If you want to use "unknown" variables, you must change the variable type to a type supported by

the product you're using.

If you don't want to use it, just leave it in there; it won't do any harm. You can use (or edit) it again
when working with other Enfocus products.

If you want to use variables that require a license that you don't have, please contact Enfocus to
buy a license.

In case of invalid rule-based variables, review the rule(s) and correct or re-define the dependent
variable(s) as required.

Metadata

The flow elements in the Metadata category of the Flow elements pane are only available if you
have licensed the Metadata Module.
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JSON pickup

JRON

JSON pickup is a default Switch app that allows associating a JSON string with a job as metadata.
It supports the following pickup mechanisms:

. Metadata alongside asset

+ Metadata in job folder asset
« Metadata refers to asset

« Metadata is asset

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Remark

This is a default app (included in the Metadata module) as of Switch 2022 Spring. Its functionality
is identical to the paying JSON pickup app that is available on the Enfocus Appstore.

The app has become part of the Metadata module, because support for the JSON metadata
model was added in Switch 2022 Spring. So it's no longer necessary to convert JSON strings to
XML (as was done by the paying JSON pickup app).

If you want to switch to this default app, you can cancel your subscription for the paying app and
replace the old app with the new app in all your workflows. You can copy-paste the properties
via the context menu of the app (see screenshot below). The new app has a different icon, so it's
easy to see which version (the paying or the default app) you have!

Copy
Delete
Reset property values

F'asfe .prupert.',r values

XML pickup
|

WL

v

XML pickup is a default Switch app that allows associating an arbitrary XML file with a job as
metadata. It supports the following pickup mechanisms:

« Metadata alongside asset

« Metadata in job folder asset

« Metadata refers to asset

« Metadata is asset
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For more info see Pickup modes on page 400.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

JDF pickup

Jna

JDF pickup is a default Switch app that allows associating an JDF file (that is, a JDF job ticket)
with a job as metadata. It supports the following pickup mechanisms:

« Metadata alongside asset

- Metadata in job folder asset
« Metadata refers to asset

« Metadata is asset

For more information about this app, refer to the app documentation on the Enfocus Appstore.

XMP pickup
|

KMP

L

XMP pickup is a default Switch app that allows associating an XMP packet with a job as metadata.
It supports the following pickup mechanisms:

. Metadata embedded in asset (the default location for an XMP packet)
« Metadata alongside asset

- Metadata in job folder asset

. Metadata is asset

For more information about this app, refer to the app documentation on the Enfocus Appstore.

XMP inject

XMP
!

The XMP inject default Switch app can be used for two main purposes:

« Inject an external dataset into the job

The data to be injected is linked to the incoming job as an external dataset and corresponds
to the XMP schema which is listed in the Switch jobticket.

For example, the dataset could have been created by the export metadata mechanism which
extracts information from a PDF.

A scenario where we can use this feature is when merging information from multiple PDFs into
a single PDF.
- Insert or update data to an existing XMP dataset

All kinds of Switch variables can be injected as data. For example, we can use this feature in a
GWG Ad Ticket to update the missing values.
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For more information about this app, refer to the app documentation on the Enfocus Appstore.

Opaque pickup
N
i

Opaque pickup is a default Switch app that allows associating an arbitrary file with a job as
metadata. It supports the following pickup mechanisms:

« Metadata alongside asset
+ Metadata in job folder asset

. Metadata is asset

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Export metadata

?3

Export metadata is a default Switch app that allows saving a metadata dataset associated with
the incoming job to a standalone file. The tool merely copies the dataset's backing file to the
output location without any transformations. The XSLT transform on page 116 tool can be used
to transform the exported metadata if needed.

The outgoing log connections carry the exported metadata; the outgoing data connections carry
the incoming job without change. If the incoming job has no dataset with the specified name, no
log output is generated.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

41.2.8. Database

Database connect

g

This default Switch app helps in configuring certain settings in the databases (like selecting
Datasource, adding SQL statement etc) without the use of scripting. It is only available if you have
licensed the Database module.

Drag and drop the Database Connect to the workspace.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

41.2.9. Legacy
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Compress (legacy)

M I

"
Compress is a default Switch app that places the incoming file or a job folder into a compressed
ZIP archive. All files in a job folder are placed in a single archive. The archive is named as the
incoming file or job folder with a ".zip" extension.

Note: This tool is outdated and should only be used for maintenance reasons. Please use
the new Archive on page 113 tool, which provides proper support for Unicode based on
zip file format specification.

Keywords
Keywords can be used with the search function above the Flow elements pane.

The keywords for the Compress element are:

. ZIP
« archive
Connections

Compress allows only a single outgoing connection.

Properties
Property Description
Element type The flow element type: Compress.
This property is useful to identify renamed flow elements. It cannot be
changed.
Name The name of the flow element displayed in the canvas
Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving your
cursor over the flow element
Compress If set to yes, the files in the ZIP archive are compressed (the default
behavior)
If set to no, the files are stored in the ZIP archive without compression,
dramatically reducing processing time; this can be meaningful when
speed is more important than size, or when the files will not compress
well anyway (example: JPEG images) — but you still want a single
archive containing all files
Use password If set to yes, all created archives are password-protected
Password The password used for protecting archives
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Note: Switch uses zlib which does not support the AES encryption, therefore Switch
cannot read passwords which use the AES encryption. Hence, the Uncompress tool
cannot read passwords which have been encrypted using the AES encryption. As a
workaround, users can try using a third-party archiver as a command line application from
Switch.

Uncompress (legacy)
—
b

Uncompress is a processor that extracts files from an archive in one of the following formats:

.« ZIP
+ RAR
- MIME

Any files that are not recognized as an archive are passed through the Uncompress tool without
change.

Note: This tool is outdated and should only be used for maintenance reasons. Please use
the new Unarchive on page 114 tool, which provides proper support for Unicode based
on the zip file format specification.

Keywords
Keywords can be used with the search function above the elements pane.

The keywords for the Uncompress element are:

« ZIP

« RAR

« MIME

« archive

« compress
« decompress
. unzip

Filenames and folder structure

The following table describes the resulting file or folder structure and the corresponding naming
conventions.

Multiple files from the same archive are always placed in a job folder. If the intention is to inject
these files into the flow as separate jobs, a job dismantler should be placed directly after the
uncompress flow element.

Archive contents Uncompress result

Single file The file (named as specified in the archive).

Multiple files or folders with a A job folder (named as the nearest common root folder)

common root folder containing all files and folders (named as specified in the
archive).
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Archive contents

Uncompress result

Multiple files or folders without a
common root folder

A job folder (named as the archive after stripping the
extension) containing all files and folders (hamed as specified

in the archive).

Connections

Uncompress allows only a single outgoing connection

Properties

Property Description

Element type The flow element type: Uncompress.

This property is useful to identify renamed flow elements. It cannot be
changed.

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Passwords A list of passwords for opening password-protected archives; each of
the passwords in the list will be tried in turn.

The script expression can be used to determine a password
dynamically, for example based on the sender of the packed data.

Note: The result of the script expression evaluation must
be a string containing one password or a list of passwords
separated by a newline character (\n').

Example:

var thePasswords = new Array();
thePasswords.push( "password" );
thePasswords.push( "password2" );
thePasswords.join( '"\n' );

Remove redundant If set to Yes, for archives where the files or job folders are contained
folders in deeply nested subfolder structures, removes all but the deepest
subfolder level while uncompressing

Example: A PDF file that is compressed as "Folder 1\Folder 2\Folder
3\Test.pdf" is uncompressed as "\Folder3\Test.pdf", if this option is
enabled.

Note: The Uncompress tool cannot read passwords which have been encrypted using

the AES encryption. Switch uses zlib which does not support the AES encryption. As a
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workaround, users can try using a third-party archiver as a command line application from
Switch.

4.1.2.10. Flow elements matrix

The following table provides an overview of the flow elements offered by each module.

Flow element Switch Config Meta Data Scripting | Switch
Core module |data base module Client
engine module module module

Basics

Connection

v

Folder

v
Problem jobs

v
Submit hierarchy

v
Archive hierarchy

v
Set hierarchy path

v
Job dismantler

v
Ungroup job

v
Split multi-job

v
Assemble job

v
Generic application

v

168



ENF@CUS Switch
Flow element Switch Config Meta Data Scripting | Switch
Core module |data base module Client
engine module module module
Execute command
v
Tools
Refresh job info
v
Sort by preflight state
v
Archive
v
Unarchive
v
Split PDF
v
Merge PDF
v
Hold job
v
Inject job
v
Rename job
v
File type
v
Sort job
v
Log job info
v

169



ENF@CUS

Switch

Flow element Switch Config Meta Data Scripting | Switch
Core module data base module Client
engine module module module

Sort files in job

v
XSLT transform

v
Recycle bin

v
Scripting
Script element

v

Communication
HTTP request

v
Remote process

v

Webhook

v
FTP receive

v
FTP send

v
Mail receive

v
Mail send

v
Submit point

v
Checkpoint
v
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Flow element Switch Config Meta Data Scripting | Switch
Core module |data base module Client
engine module module module

Checkpoint via mail

v

Pack job

v
Unpack job

v
Monitor confirmation

v

Apps

Various apps purchased

through the Enfocus v

Appstore

See also Working with

apps in Switch on page

259.

Metadata

JSON pickup

v

XML pickup

v
JDF pickup

v
XMP pickup

v
XMP inject

v
Opaque pickup

v
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Flow element Switch Config Meta Data Scripting | Switch
Core module |data base module Client
engine module module module

Export metadata

v
Database
Database connect
v

Legacy
Compress

v
Uncompress

v

4.2. Working with flows

Working with Switch means creating, designing and running flows for the processes you want to

automate.

4.2.1. About working with flows in Switch

Working with flows consists of the following steps:

1. First you have to create a new flow. You can start from scratch (blank flow) or from a sample

flow.

2. Next, you have to design your flow, by dragging the required flow elements to the canvas.

You must configure the properties of the different flow elements and connectors.

3. Finally, you must activate the flow, and test it, using test files, until you are happy with the

result.

For a step by step explanation, refer to the Switch Quick Start Guide on the Enfocus website.

For a detailed description of everything you can do with Switch flows, refer to the topics below.

4.2.2. Creating a new blank flow

Use this procedure, if you want to create a blank flow with an empty canvas. You'll have to add all

flow elements yourself.

To create a blank flow

172



https://www.enfocus.com/en/support/manuals/switch-manuals

ENF@CUS Switeh

1. Do one of the following:

| o

In the toolbar at the top of the screen, click =" flow
« From the menu, select Flow > New Flow....
- In the Flows pane, right-click and select New Flow.

A new flow is created. By default it is called "New flow" (followed by a humber if it's not your
first "New flow").

2. Enter a meaningful new name for your flow.

Your cursor will automatically focus on the flow name in the Flows pane, so you can
immediately type a new name. If you click outside the name field, the name will be displayed
in italics and it will have an asterisk next to it, to indicate that the flow hasn't been saved yet.

You can now add flow elements as required.

4.2.3. Creating a new flow based on a sample flow

Use this procedure, if you want to start from one of the Switch sample flows. These flows come
with the default Switch installation and are available through the Flows menu.

To create a flow starting from a sample flow
1. From the menu, select Flow > Import sample flows....

2. Select the flow(s) you want to start from.

« To select all flows in one go, click Select all.
. To clear the checkboxes of all already selected flows, click Clear selection.
« To select one or more flows, select the corresponding checkbox(es).

Note:

« For a description of the available flows, click a flow name. The description appears
in the lower part of the dialog.

« You can select more than one flow, for example to have a look at the differences
or to see if they are similar to what you need. All the flows you select will become
available in the Flows pane.

3. To import the selected flow(s), click OK.
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The Flows pane shows the imported sample flow(s). You can modify and expand the flow(s)
as required. See Designing flows on page 174.

4.2.4. Designing flows

4.2.4.1. Working with the canvas

The canvas is the central workspace area that allows viewing and editing flows. The canvas
always displays the flows selected in the Flows pane.

Single flow at full size

]

FTP

FTP drop bo PDF files

Input fFalder

Mail drop bo all okher Files

When a single flow is selected, the canvas displays it at full size and scroll bars appear if the flow
design is larger than the visible area. In this mode the flow is editable (assuming that it is inactive
and unlocked); see Editing a flow on page 176.

Multiple flows as tiles
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Unarchive

Firsk Flaww Secand Flow

When two or more flows are selected, the canvas displays a tile for each flow. A tile is a scaled-
down version of the flow design similar to a thumbnail. Tiles can't be edited. However you can
select a particular tile and edit its flow properties in the Properties pane.

In tile mode the canvas never shows horizontal scroll bars. Instead the size of the tiles is adjusted
so that a predefined number of tiles fit on a row. The maximum number of tiles shown can be set
as well.

To adjust the number of tiles in a row, choose the "Tiles in a row" menu item in the canvas
context menu and select one of the choices 1through 9 in its submenu (this context menu
item is present only while the canvas displays tiles).

To return one of the displayed flows to full size:

« Double-click the tile in the canvas; or

« Select the tile in the canvas and choose the "Show at full size" menu item in the canvas
context menu; or

« Select the flow in the Flows pane (without selecting any other flows).

To change the maximum tiles shown, select the "Maximum tiles" menu item in the context

menu and select the desired value. If more flows are selected than this maximum number, the

canvas will show a message instead of the tiles.

Single flow scaled to fit

To display a large flow design (that doesn't fit the current Canvas pane) as a tile that fits the
visible area of the canvas:

« Select the flow and choose the "Scale to fit" menu item in the canvas context menu (this
context menu item is present only if the canvas shows a scroll bar).
To return the scaled-down flow to full size, perform one of these steps:

« Double click the tile in the canvas; or

« Select the tile in the canvas and choose the "Show at full size" menu item in the canvas
context menu.

You can also zoom in and zoom out the canvas area to enlarge or minimize the selected flow:

«  On Windows OS, press the Ctrl button and scroll with your mouse.
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«  On Mac OS, press the Command button and scroll with your mouse.

Editing a flow
Before making changes to a flow:

« Ensure that the flow is inactive and unlocked; an active or locked flow is displayed with a
darkened background and cannot be edited.

Note: Are you viewing the flow with a Remote Designer? In that case, a darkened
background may indicate that you don't have the right to edit the flow (read-only
access). Refer to the section about user configuration for Remote Designer, for
example: Configuring a user on page 65 (last step).

. Select the flow in the Flows pane without selecting any other flows; when multiple flows are
selected the canvas shows tiles which cannot be edited.

4.2.4.2. Working with flow elements

A flow design (as displayed in the canvas) consists of a number of interconnected flow elements.
Switch offers a range of flow elements, including:

« Connection: a special flow element used to connect other flow elements; connections

determine how jobs can travel along a flow.

- Folder: a central flow element used to (temporarily) store or modify jobs in between
processes.

« Various flow elements types to produce, process and consume jobs.

Adding new flow elements

To add a new flow element to the canvas

Do one of the following:

« Drag the icon for the desired flow element type from the Flow elements pane onto the
canvas in the desired location.

- Right-click a blank area of the canvas and select Add > <category> > <desired flow
element>.

For flow elements that are used often, you can use the following shortcuts:
« To add a Folder flow element, you only need to double-click in the canvas where you

want the Folder to be added.

- To add a favorite flow element, you can use the following keyboard shortcuts: ctr/
+<number> (Windows) or cmd+<number> (Mac). The number (1-9) refers to the position of
the flow element in the Favorites category (first in the list =1, second = 2, etc). The flow
element is placed in the middle of the canvas.
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Connecting flow elements
To connect two flow elements that are already present on the canvas
Do one of the following:

- Drag the Connection icon from the Flow elements pane and drop it onto the first flow
element; then click the second flow element.

« Double-click the first flow element; then click the second flow element.

- Right-click the first flow element and select Start connection; then click the second flow
element.

A connection line connects the two flow elements.

Inserting a folder between two non-folder flow elements

In Switch, you cannot make a connection between two non-folder flow elements, without having a
folder in between.

For this reason and to save time, when dragging a connection between two non-folder flow
elements, Switch automatically adds a folder in between and creates a double connection (from
the first flow element to the folder, and from the folder to the second flow element).

You can see that a folder is added upon creating the connection as the drag line includes the
outline of a folder between source and destination, and the cursor changes to "allowed".

This insertion of a folder does not take place if,

« There is not enough room in between the two flow elements to insert a folder.

« Inserting a folder does not result in valid connections.

Inserting a flow element on an existing connection

You can insert a flow element on an existing connection by dragging and dropping the new flow
element on the connection between two other elements.

The flow element that you insert can be dragged from the Flow elements pane, or you can drag
and drop an existing flow element from the canvas, if it does not have any connections yet.

The connection from the original "source" flow element will go to the newly inserted flow element
and a new connection from the newly inserted element to the "original" target element will be
established.

If necessary, a folder will be added in between, just as when connecting two flow elements. See
Inserting a folder between two non-folder flow elements on page 177.

You can see that the flow element will be added on the existing connection as the outline of the
element is shown between source and destination.

This insertion on a connection will not take place if:

« There is not enough room in between the two flow elements to insert the flow element (and a
folder if necessary).

« Inserting the element doesn't result in a valid connection.
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Manually changing connections

You can manually change connections by clicking and dragging the start or end of a connection
from one flow element onto another one.

To manually change connections
1. Select the connection you want to change.

2. Hover the cursor over the source or target end of the connection you want to change. A grab
handle (red circle) appears, similar to the grab handle for the corner point, as shown below:

— @

Input Folder Checkpoint 1

3. Click and drag the connection on another flow element, for which the new configuration is
allowed:

- For the target of the connection, this is similar to creating a new connection.
« For the source, the new source flow element must accept outgoing connection of the
same type and with the same injected properties.

Note: To copy the connection instead of moving it, press the Ctrl key (for
Windows) or Alt key (for Mac OS).

Warnings when adding new flow elements
After adding a new flow element to the canvas, the flow element may display an alert icon (£%)
indicating a problem with the flow design.

This usually refers to missing connections, since many flow elements require at least one
incoming and/or outgoing connection. For more information, hover your cursor over the icon to
display a tooltip.

Example:

After adding a "Submit hierarchy" and a "Folder" the flow design looks as follows:

R

Submit hierarchy 1 Folder 1

The tooltip for the Submit hierarchy 1 element states: The flow element requires at least one
outgoing connection.

After adding a Connection element, the warning will be gone.
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te—

Submit hierarchy 1 Folder 1

Selecting flow elements

Note: You can select multiple flow elements as required. However, a connection and
other flow elements cannot be combined in one selection.

To select flow elements

1. To select one flow element at a time, click the flow element in the canvas.
In the canvas, you can see which element is selected:

- Selected flow elements are surrounded by a gray rectangle.
« Selected connections have a darker color.

2. To select multiple flow elements at the same time, do one of the following:

- Drag a selection rectangle around the flow elements in the canvas.
« Click a first flow element, and then expand the selection by clicking other flow elements,
while holding down the Ctrl key (on Windows) or Command key (on Mac OS).

Example of a selected flow element and a selected connection.

[

Submit hierarchy 1
cg—

Submit hierarchy 1 Folder 1

Moving flow elements
To move flow elements on the canvas

1. Select one or more flow element as required.

See Selecting flow elements on page 179.
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2. Use the arrow keys or drag and drop the selected flow element to the preferred place on the
canvas.

Note: If you're about to place two elements on top of each other, a warning icon
appears. Move the element a little bit, to avoid that one of the two gets hidden.

5

Folder 20

Configuring flow elements

Each flow element (including the Connection flow element) offers one or more properties that
help determine the flow element's behavior. You should set an appropriate value for each
property (or use the default value) to fully configure a flow.

For a detailed description of the properties offered by each flow element, refer to Flow elements:
overview on page 97.

Editing the name of a flow element

All flow elements (including the Connection flow element) offer at least two properties: the
element type and the name of the flow element as displayed in the canvas. When you add a new
flow element, Switch provides it with a default name inspired by the flow element type. By default,
a connection does not contain a name.

You can edit the Name property in the Properties pane, just like other properties (See Changing
flow element properties on page 181), or you can edit the name directly on the canvas, as
explained below.

Tip: For a better overview, we recommend using meaningful names!

To edit the name of a flow element directly on the canvas

1. On the canvas, select the flow element.

Ensure only one flow element is selected.
2. Click the name of the flow element (on the canvas).

3. Enter the new name or adjust the existing name.
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Changing flow element properties

Switch provides you with default values for the flow elements, but you can change the defaults as
required.

Note: You can only change the properties if the flow is not active and not locked.

To change the properties of flow elements

1. Select the flow element of which you want to change the properties.

Note: If you select multiple (similar) flow elements at the same time, you can change
the common properties.

The properties of the selected flow element(s) are displayed in the Properties pane.

Click the property you want to change.
Depending on the selected property, a text box, a button, or a drop-down menu appears.

Make the required changes:

If ... appears

Do the following:

A text box Type the text in the displayed text field.
A drop-down Select the appropriate option.
menu

(]

1. In the the property editor dialog that pops up, update the field(s)
as required.

2. Click OK.

1. From the pop-up list, select one of the options.

Auko-managed
Inline value
Zhoose Folder
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If ... appears Do the following:

Depending on the selected option, an inline editor or a dialog
appears.

2. Configure the desired values.

For an overview of the properties and their meaning, see Flow elements: overview on page
97.

Your changes are applied immediately.

Resetting flow element properties

You can reset the property values to the factory defaults, as when creating a new flow element
on the canvas.

To reset property values
1. Select the flow element.

2. Right-click the flow element, and select Reset property values.

Copying flow element properties

For all flow elements, including connections, you can copy and paste the property values.

Note: Property values can only be pasted to flow element(s) of the same (or a similar)
type.

To copy flow element properties

1. Right-click the flow element, from which you want to copy the property values.
2. From the contextual menu, choose Copy property values.

3. Select the flow element(s) you want to paste the property values on.

4. Right-click the flow element(s), and select Paste property values.

Warnings when editing flow element properties
If property values are invalid or missing, you are informed in two ways:

The flow element is displayed with an alert icon (£1%).

For more information, hover your cursor over the icon to display a tooltip.

« The invalid property is displayed in red in the Properties pane.
Example:

After adding and connecting an FTP receive flow element, the canvas and the Properties pane
look as follows:
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Properties [
Property Yalue o]
Mame FTF receive
Server type ETP
;'“: FTP server address
| FTP Port 1
@_ Folder 1 Passive mode Yes
Transfer as binary Yes
User name
Password
FTP directory /

Leave originals on server [

The tooltip for the FTP receive element states: Required fields are not valid: FTP server address,
User name, Password.

After entering the missing information, the warning will be gone and the properties will be
displayed in black again.

Adjusting the layout of the flow design

To adjust the layout of the flows design, select one or more flow elements (other than connection)
and drag the selection around, or use the arrow keys to "nudge" the selection to the indicated
direction in small steps. Connections automatically adjust to the new layout.

Aligning flow elements horizontally
To align flow elements horizontally
1. Select the flow elements to be aligned.
2. Do one of the following:
+  On Windows OS:

Select Edit > Align Horizontally, or press Ctrl + Shift + H.
+ On Mac OS:

Select Enfocus Switch > Align Horizontally, or press Command + Shift + H.

Aligning flow elements vertically
To align flow elements vertically
1. Select the flow elements to be aligned.

2. Do one of the following:
«  On Windows OS:

Select Edit > Align Vertically, or press Ctrl + Shift + V.
« On Mac OS:

Select Enfocus Switch > Align Vertically, or press Command + Shift + V.
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Adjusting the layout of a connection

By default, connections are drawn as straight lines between two flow elements. You can however
adjust these lines to make a well-arranged design.
1. To draw the connection along the sides of a rectangle (with a rounded corner)

a. Select the connection.
b. Do one of the following:

« Right-click the connection and select Vertical, then horizontal or Horizontal, then
vertical.

« Inthe Properties pane, set the connection's Corner angle to -90 or +90.

2. To draw the connection along a route somewhere in between these extremes
a. Select the connection.
b. Do one of the following:

« Move your cursor over the connections's corner until a drag handle (blue circle)
appears, and drag the handle to the desired direction.

« Inthe Properties pane, set the connection's Corner angle to a value between -90 or

+90.
Frarm Frarm
To To
Frarm Frarm
To To
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Adjusting the colors of folders and connections

To make it easy to distinguish between different folder or connection types, for example between
network and input folders, you can change the default color for folders (yellow) and connections
(gray).

To adjust the colors of folders and connections

1. Select one or more connections or folders.

Note: You cannot combine connections and folders in one selection.

2. Right-click to open the context menu.

3. Click Choose color and select the appropriate color from the list of predefined colors.
You can choose one of the following colors:

« Gray (default), Yellow, Green, Cyan, Blue, Magenta for connections.
+ Yellow (default), Orange, Green, Cyan, Blue, Magenta for folders.

« Orclick "Custom" and select the color of your choice using the color picker.
Alternatively, you can set the color via the Properties pane.

Keep in mind that "conditional" colors (e.g. orange for connections on hold) will take priority over
custom colors.

For example, even if you have chosen green for a particular connection, its color will change to
orange when the connection is set on hold. When the connection is released, the chosen color
(green) will be restored.

Copying and deleting flow elements

You can copy and paste flow elements within the same flow or to another flow. The copy includes
all selected flow elements plus any connections between them. Connections to flow elements
outside of the selection are not included. It is not possible to copy a connection on its own.

When pasting flow elements into a flow, Switch renames the new flow elements if needed to
avoid name clashes between backing folders.

- To copy one or more flow elements to the pasteboard, select the flow elements and

« Choose the Edit > Copy menu item, or
« Choose the Copy menu item in the canvas context menu.

- To paste previously copied flow elements from the pasteboard into a flow, select the target
flow and

« Choose the Edit > Paste menu item, or
« Choose the Paste menu item in the canvas context menu.
« To delete one or more flow elements from a flow, select the flow elements and

« Choose the Edit > Delete menu item, or
« Choose the Delete menu item in the canvas context menu, or
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« Press the Delete key.

Undoing flow editing operations

Switch remembers flow editing operations (including changes to flow element properties) since it
was last started, and allows undoing these operations in reverse order.

There is a separate undo stack for each flow.
« To undo the most recent edit operation for a flow, select the flow and perform this step:

« Choose the Edit > Undo menu item.

. To redo the most recently undone edit operation for a flow, select the flow and perform this
step:

« Choose the Edit > Redo menu item.

4.2.4.3. Advanced topics for designing flows

Working with folders

Working with individual files in Switch is quite straightforward. When files are grouped into folders
(and sometimes in nested folder structures), you need to take the following information into
consideration.

Switch distinguishes between two important concepts related to (and implemented by) folders:

« Subfolder hierarchies provide structure to file submissions and to final processing results by
placing files in appropriately named subfolders (for example, a subfolder for each customer).

« Job folders represent file sets that move along the flow as a single entity, for example a page

layout with its accompanying images and fonts, or the individual pages in a book.

Since both concepts are implemented with regular file system folders, Switch needs a way to
know what it is looking at when it sees a folder. This is accomplished as follows:

- Subfolders in a regular folder are always treated as a job folder; i.e. the subfolder and its
contents are moved along as a single entity.

« Certain flow elements (such as Submit Hierarchy and Archive Hierarchy) have special
provisions to support a mixture of subfolder hierarchies and job folders; these provisions are
configured through the flow element's properties.

Thus the complexity of dealing with both concepts at the same time is limited to those special
flow elements.

Working with subfolders

Submit hierarchy

The "Submit hierarchy" tool (and its sibling FTP receive) can be used to fetch files that are
delivered in a hierarchy of subfolders. The tool looks for files in the nested subfolder structure
up to a certain level (specified in a property), and injects those files into the flow along its output
connection(s). The injected files are placed in the output folder(s) at the highest level, in effect
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flattening the subfolder hierarchy. However, if so requested, the original location in the hierarchy
is stored with the file (in its internal job ticket) so that it can be retrieved later to recreate the
hierarchy. See Using hierarchy info on page 190 for more details.

If a subfolder occurs in the hierarchy on a deeper nesting level than what is specified in the
"Subfolder levels" property, it is treated as a job folder (i.e. it is moved along as a single entity).
Thus, in effect, the "Subfolder levels" property determines which subfolders in the hierarchy
should be treated as "hierarchy folders" and which should be treated as job folders.

In the example below you can see the input folder and the corresponding output folder, using
Subfolder levels set at 2.

v [ Input folder
v [l Adds
v [ Customer A
v [ Add002345

%] Add122985.Al v [ output folder

» [ Images » [ Add002345
(% Add52399.eps 2o Add11218.pdf
v [ Customer B K} Add356255.pdf
ZE Add11218.pdf |% Pl22085.pdf
K} Add356255.pdf |® P122087.pdf
v [ Pages
v [ Editorial
|& P122085.pdf
v [l sports

|= P122087.pdf

If you do not want to support job folders, set the "subfolder levels" property to a very high value
(for example, 999). This will cause all files to be processed separately, regardless of their nesting
level in the hierarchy.

Using the Submit Hierarchy function eliminates the need to set up individual input folders on a
user by user basis. In the example above, by just adding another sub folder for "Customer C",
any job files or folders put in that folder would be seen and processed by Switch without any
additional changes to that workflow.

Archive hierarchy

When archiving files (or job folders), you might want to recreate the subfolder hierarchy that was
used to deliver them, or you may want to create a different subfolder hierarchy based on which
route files took in a flow. Even though the files have been retrieved from different locations and
have been moved along the flow through various processing steps, the internal job ticket for
each file can remember the information needed to place the file in its appropriate location in the
hierarchy.

The archive hierarchy tool extracts this information and creates the corresponding hierarchy (you
can still limit the number of subfolder levels to be recreated regardless of the information stored
in the internal job ticket). See Using hierarchy info on page 190 for more details.
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Working with job folders

Any folder (and its contents) that should be processed as one entity is considered to be a job
folder. A job folder usually contains files and/or subfolders (which can contain other files and
folders, recursively). Examples include a page layout with its accompanying images and fonts,
and the individual pages in a book.

To inject a job folder in a flow, you need an active flow. Otherwise it will take the folder path of
this folder as its new input folder and will treat all files as single jobs. The job folder will be moved
along the flow and processed as a single entity.

It is also possible to submit job folders through a "Submit hierarchy". In that case you need to
make sure that the "Subfolder levels" property is set correctly, as explained in working with
subfolders above. For example, if you have a subfolder for each of your customers and these
subfolders contain the jobs, the "Subfolder levels" property should be set to 1. If you would set
this property to 2, the job folder would be treated as yet another subfolder level and the files in
the job will be processed as separate files.

Job dismantler

In some situations you need to dismantle a job folder and continue with the job's files as separate
entities. Often this is because the files arrived inside a folder, but in reality they are not part of a
single logical entity. Sometimes you just want to deal with (some of) the components of a job.

For example:

« Customers submit a "job folder" that contains a number of related PDF files, but you really
want to preflight each of them separately.

«  You use the uncompress tool to unzip a zip archive, resulting in a job folder that contains all of
the files from the ZIP archive.

- You want to review each of the images inside a page layout job (outside of the job's context).

In these situations you can use the job dismantler to retrieve the individual files from the job
folder.

When you dismantle a job, you need to set the "Subfolder levels" property correctly. This property
behaves in the same way as what is explained above for Submit hierarchies i.e. it determines how
many levels Switch will search for individual files from the job.

Job assembler

Vice versa, sometimes you need to gather a number of files and keep them together through the
rest of the flow.

For example:

« You need to group individual PDF files that will have to be merged into a single document.
«  You want to send out an email for every 10 files that arrived in some input folder.
«  You would like to insert a file (for example, a preflight report) into an existing job folder.

The job assembler supports various ways of determining which files go together in a job:

« Merge by file name: the file names must contain a numbering scheme (e.g. "page X of Y")
«  Complete job every N files: a job is created when N files are collected.
«  Complete job every N minutes: a job is created every N minutes.

By default all newly created job folders are named "Job" followed by a running count.
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To create a job with (nested) subfolders, you can use the same mechanisms as described above
for archive hierarchies. See Using hierarchy info on page 190 for more details.

Leaving originals in place

By default, Switch moves incoming jobs out of the input folder when injecting them into a flow.
Therefore, Switch needs full access rights to rename, create and remove files and folders in the
input folder.

However, a number of key flow elements (Folder (user-managed input), Submit hierarchy, FTP
receive and Mail receive) also support a read-only mode, activated by setting the Leave originals
in place property for the flow element to Yes. In that case, Switch does not write anything to the
input folder, so read-only access rights suffice.

Properties 5 X

Property Value
Name input

Description

ChUsershancuh\Downloadsh...
es
Mo

Leave originals in place
gnore updates

Ignore updates
Leave originals in place has "Ignore updates" as subordinate option.

If Ignore Updates is set to Yes, Switch processes a job only once, ignoring any changes to the
job's file size or modification date after it was initially processed. This can be used in workflows
where Switch replaces the input job by a processing result, without triggering an endless loop.

If set to No, Switch will reprocess a job when its file size or modification date changes. This can
be useful when submitting a job with the same name of a previously submitted job. In this case,
Switch will use the list of already processed jobs (see below).

How it works

For each flow element operating in read-only mode, Switch maintains a list of all files/ folders in
the input folder that were already processed (i.e. actually injected in the flow or skipped due to
filters).

Switch automatically updates the list at regular intervals as follows:

. ltems that are updated or replaced in the input folder are reprocessed if "Ilgnore Updates"
is set to "No"; changes are detected by looking at the byte count and at the most recent of
creation date and modification date.

« Items that disappear from the input folder are removed from the list (to keep its size down).
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Reprocessing originals
The user can manually clear the list of jobs already processed as follows:

« Choose the Reprocess originals context menu for the relevant flow element. This causes all
remaining original items to be reprocessed when the flow is next activated.

- Certain flow design changes (e.g. set Leave originals in place to No; change backing folder)
automatically clear the list when the flow is next activated.

Folder 2

C: Start connection
it

Autoc-managed

Recreate folder
Reprocess Drigﬁgls

Copy
Delete

Using hierarchy info
A key feature of Switch is its ability to

« Remember a job's origin and routing information, and

« Use this information when placing the job in a folder hierarchy (Example: for archiving).

This information is called hierarchy info. It is stored in the job's internal job ticket under the form
of a hierarchy location path, as described below.

See also Working with folders on page 186.

Hierarchy location path

The hierarchy location path (stored in a job's internal job ticket) consists of zero or more
segments, and each segment represents the name of a (sub)folder in a nested folder structure.
The first segment represents the top-level folder.

For example, the hierarchy location path consisting of the segments "CustomerA", "Input" and
"PDF", in that order, represents the following folder structure:

= ) Customers,
= ) Input
3 POF
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Remembering hierarchy info

Most producers allow remembering hierarchy info depending on a job's origin, and provide
properties to configure what's remembered. For example, a "Submit hierarchy" element
allows remembering its own name and/or the relative path to the subfolder where the job was
submitted.

A folder allows adding the folder name to the location path (at the top or at the bottom). This can
be used to create additional hierarchy levels. For example, separating input and output jobs for
each customer.

Using hierarchy info

Some elements, and most notably the archive hierarchy, use the hierarchy information
remembered for each job to place the job in an appropriate nested folder structure.

Switch automatically creates any folders needed for the (nested) hierarchy.

Example

For example, consider this flow:

B! 1 ¥

Submit Imput Downsample Proof Mail Send
Crriginal Archive

And the following configuration details:

« Submit is configured to remember one level of subfolders, and those subfolders are named for
different customers.

« Downsample is configured to produce a JPEG thumbnail of the incoming image file.

« Proof and Original are configured to add their own folder name at the bottom of the hierarchy
location path.

« Archive is configured to accept two subfolder levels.

Then the following Submit hierarchy:

= ) Submit
| Customera
|2 CustomerB

Will result in this Archive hierarchy:
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= ) Archive
= ) Customers,
|0 Original
|20 Proof
= |J) CustomerB

|0 Original
|20 Proof

Specifically, submitting a file named "File.tif" in folder Submit/CustomerA will result in two
archived files (in addition to the proof being mailed out):

- The original "File.tif" will be placed in Archive/CustomerA/Original.
. The downsampled copy "File.jpg" will be placed in Archive/CustomerA/Proof.

And naturally submitting a file in folder Submit/CustomerB will result in two archived files under
the Archive/CustomerB/... structure.

Using email info in Switch

A key feature of Switch is the ability to attach email information to the jobs that are being
processed and use this info to send notifications or receipts.

For example:

« If jobs are submitted through e-mail, Switch can use the sender's email address to send him/
her a receipt.

- Additional email info (email addresses or body text) may be attached to a job, e.g. to also
inform customer sales representatives or operators of new jobs that were injected in the flow.

. If jobs are submitted in a folder hierarchy, notifications can be sent based on the folder the
job is in. This is useful if the folders have the name of the customers or refer to the type of job
being submitted.

"Email info" in Switch refers to both (a list of) email addresses and body text. This information is
stored in the job's internal job ticket, so it can move along the Switch flows as metadata and be
retrieved through variables ([Job.EmailBody] and [Job.EmailAddress)).

Note that Switch combines new email information with any email information already present.
Email addresses are added to the list, and body text is appended to what's there (inserting a line
break if needed). Existing email info is never removed.

The following topics explain how you can attach email info to a job in Switch and how this info
can be used to send the appropriate email message to the appropriate recipient. This is also
illustrated in the following example flow:

1 9 not ok 3 Mail send
Submit paint PDF only Enfocus PitStop Server ok
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1. Email info is attached when the job comes in. In this example, jobs are submitted via a Submit
point and for example the email address of the user submitting the job is attached.

2. Extra email info is attached when the job is moving along the flow. In this example, the
preflight status is added as email info.

3. The attached email info is used when (part of the) processing is finished to notify operators,
customers or sales representatives. The Mail send tool is needed to send the notifications.

Attaching email info to a job - flow elements

Associating email information with jobs submitted to Switch is possible through the configuration
of the relevant flow element properties. Not all flow elements support email information;

only the ones that have properties related to email info. These properties must be configured
appropriately as described further in this document.

Note: Remember that the (email) info attached to the job can be used by other flow
elements that support variables.

The following table gives an overview of the flow elements that allow you to attach email info to
the job's internal job ticket.

Flow element Properties

Mail receive (submitted jobs) |. Attach email info: if enabled, the sender's email address

(not the body text!) is copied to the job's metadata.

- Attach extra email info: allows you to add extra email
addresses or body text to the job's metadata. You can
define different email info depending on who's the sender
(email address or email account name), or what's in the
message subject line. For example, you could attach mail X
to jobs from customer X and mail Y to jobs from customer
Y. How to do this is explained in Attaching email info - the
email info map on page 194.

FTP receive (submitted jobs) | Attach email info: allows you to associate email addresses and
body text based on the name of the folder on the FTP server
that holds the job. This is useful if the folder name reflects the
type of job, or if it refers to the customer.

Submit hierarchy (submitted Attach email info: allows you to associate email addresses and
jobs) body text based on the name of the folder the job resides in.
This is useful if the folder name reflects the type of job, or if it
refers to the customer.

Folder (submitted jobs +jobs  |.  Attach email addresses: allows you to add one or more
moving along the flow) email addresses.

- Attach email body text: allows you to add an email
message.

Note that here it is not possible to differentiate between jobs;
all jobs will get associated with the same list of addresses and
with the same body text.
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Flow element Properties

Some use cases:

« Accumulate an audit trail of status messages in the email
body text as a job moves along a flow, and email the audit
trail to a supervisor at the end of the flow.

+ Associate a different email address with a job depending on
its status in the flow (e.g. passed preflight test or not).

- Sort jobs based on filename (or any other criteria) and then
associate a different email address with a job depending in
how it was sorted.

Job Dismantler (jobs moving Attach email info: allows you to associate email addresses and
along the flow) body text based on the folder name the job belongs to. This is
useful if the folder name reflects the type of job, or if it refers to
the customer.

Flow elements that become available if you have licensed the SwitchClient Module also allow
attaching email info, as shown in the table below. For more info, refer to the SwitchClient Module

on page 432.

Flow element Properties

Submit point . Attach user email address: allows you to add the email
address of the user that submits the job to Switch.

« Attach extra email info: allows you to add extra email
information. The information added can vary depending on
the user submitting the job.

Checkpoint Attach user email address: allows you to add the email
address of the user that handles the job.

Attaching email info - the email info map

How it works

In order to differentiate between the different jobs and the email addresses/messages that have
to be associated with them, you must build a mapping table (called email info map).

Each entry in that map consists out of three elements:

« A key, used to identify the job and to determine which message/address(es) must be
attached.

« In case of FTP receive, Submit hierarchy, Folder and Job dismantler, this is a folder name.
« In case of a Submit point, this is the name of the Switch user that submits the job.

« In case of Mail receive, this is the sender's email address or email account or a key word
that must be present in the mail subject line (depending on what you select in the Base
map key on property (subordinate property of Attach extra email info).

By default, the mapping table contains an entry for the special key <all>. This entry allows you
to specify email info that should be added to all jobs, regardless of their key. If this key is left
empty, however, it will be ignored.
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«  One or more email addresses that will be attached to the job. Make sure to use semicolons
(not surrounded by spaces) to separate the email addresses.

- An email message consisting of one or more paragraphs. You can use Switch variables in
your body text, for example to refer to the name of the job.

The email info map can contain as many entries as you need. Note that the order of the entries in
the map is not important.

Example 1: Attaching email info through FTP receive

Let's say that you've set up an FTP site where your customers submit jobs.There is a separate
subfolder for each of your customers (with the appropriate access rights) and you want to make
sure that the responsible account manager is informed.

To achieve this:

1. Configure an FTP receive flow element. Make sure to check all the relevant subfolders (see
"Subfolder levels" property).

2. Click Attach email info and create an email info map, mapping the name of the customer's
subfolder (the "key") to the responsible account manager's email address, as shown below.
Note that you could enter the customer's email address as well, as required.

3. Furtherin the flow, configure a Mail send flow element (see Using attached email info on
page 197).
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B Define email info map: Attach email info I&
<gll= Map key customer1
customerl Enter one or more email addresses, semicolon separated
customer?
frank@enfocus.com
"
Body text: enter ane or more paragraphs.
Hi Franik;,
We processed another job for one of your customers:
Location gn the server + iob name:[Job, Origin]
Date: [Switch.Date:TimeZone ="UTC"]
Kind Regards,
The Switch team
Add ] [ Remove Define variables
Ok ] [ Cancel
Note:

« FTP receive always uses subfolder names as the key, whereas as Mail receive allows
selecting the basis for the key ("base map key on").

« ltis possible to have multiple key matches for the same job. For example, if a job
is submitted in a nested subfolder some levels deep, FTP receive uses each of the
subfolder names in the nested subfolder path as a key in the mapping table. The email
information for all matches is combined and associated with the job. This is also the
case for the <all> key.

Example 2: Attaching email info through Mail receive

Suppose the jobs in your flows are submitted through mail. You want to attach the sender's email
address (for future reference) as well as the account manager's email address.

In order to achieve this:

1. Configure a Mail receive flow element.
2. Set Attach email info to Yes, to make sure the sender's email address is stored.
3. Set Attach extra email info to Yes and configure the subordinate properties:
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- Base map key on Sender's email address.

« Create an email info map, making sure the keys are your customer's email addresses.
Note that the email address in the map key can be either the complete email address or
only the part in front of/following the @ sign.

Mail receive

Attach email info Veo
Attach extra email info Yes
Base map key on Sender's email address
Email info map Email info map defined [:J
B Define email info map: Email info map I
custemer@companyf.com Map key customer@companyA.com

custemer@companyB.com

custemer@companyC.com
zall> Frank@enfocus.com

Enter one or more email addresses, semicolon

Body text: enter one or more paragraphs.

Hi Frank,

Note: In the above example, jobs from customers that are NOT in the list will match the
<all> key. Jobs from customers that are listed, will be associated with the corresponding
email address info AND with the info behind the <all> key.

Using attached email info
There are two ways to use email info attached to jobs in Switch:

« You can use the variables related to email, such as [Job.EmailAddress] and [Job.Emailbody],
at any stage in the flow.

« You can use the attached info email in the Mail send flow element, using the following
properties:

« Include attached addresses

« Include attached body text

Example

Properties:
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Properties

Property Yalue

Name Mail send

Description Send notification to account manager and customer
Subject lobs completed

To addresses guality@enfocus.com
IIncIudE attached addresses Ve I

CC addresses

BCC addresses

Reply address Default

Message format Plain text

Body template Built-in

Body text This is an automatically generated message.

| Indude attached body text Yes |

Attach files Yes

Strip unigue name Yes

Below is an example of a mail sent via a Mail send flow element with the properties shown

higher:

« The email address in the From field is the address specified in the Switch Mail send

preferences (User name property).

« The To field contains the email address(es) entered in the To addresses property (of Mail
send) and the addresses attached to the job concerned.

« The Subject is the one specified in Mail send - Subject.

« The jobfile is attached.

« The body text contains the phrase "This is an automatically generated message" followed by
the email message that was attached to the job earlier in the Switch flow.
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= e g

From: Switch <jo@gmail. com = Sent: Mon 9/21/2015 3:59
Tao: quality @enfocus. com; || frank@enfocus.com

Cc

Subject: Jobs completed

] Message Cover.pdf [0 KE)

_E---|---1---|---2---|---E---|---4---|---E---|--

= 0 0 0 0 0 0 0 0 0 0 0

This is an automatically generated message.

Hi Frank,
We processed another job for your customer:

Location on the server + job name:ftp://ga:ts@enf.gent.esko.com:2/customerl/Cover.pdf
Date: 20153-09-21T13:58:40.8747F

Kind Regards,
The Switch team

Attached file :
Cover.pdf

Note that this message contains two variables that were selected when configuring the email
message: [Job.Origin] and [Switch.Date:TimeZone="UTC"].

Note: Users of the Switch Web Portal can use the attached email info in a similar way
with Checkpoint via mail on page 129 to send reply messages for jobs arriving in the
Checkpoint.

Acknowledged job hand-off

The Pack job, Unpack job, and Monitor confirmation tools can be used to implement
acknowledged hand-off of jobs between instances of Switch running on separate computers,
regardless of the communication channel used to transfer the data. The involved instances of
Switch may reside on the same local network, or they may be in remote locations connected
through the Internet (or any other communications channel).

Furthermore, Pack job and Unpack job can carry over any Switch metadata associated with

the job, including internal job ticket information (such as email and hierarchy information),
external metadata and (of course) embedded metadata. This feature can be used with or without
acknowledged hand-off.

Example flow on sender's side
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B &

Jobs ta send Pack job After packing FTP send

¥

Mail receive
Waiting For confirmation [N | Confirmations
Monitor confirmation
A
F
Confirmed Rejected
Example flow on receiver's side
FTP | |$| .
FTP receive Before unpacking Unpack job : Iobs received

Mail send

Confirmations

Specifying file filters
Several Switch tools offer file or folder filter properties, including for example:

- the "Include/exclude these jobs" properties on connections leaving a folder.

« the "Include/exclude these folders" properties on connections leaving an FTP receive
instance.

Each of these properties can be set to a particular file or folder filter that "matches" a certain
category of jobs based on the filter's characteristics.
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File filters

A file filter is applied to a job (file or job folder) being submitted to or moving along a flow. The
following table lists the various supported filter types.

Filter type Description

All jobs Matches all files and job folders; is used as the default for
"Include" properties

No jobs Matches no files or job folders; is used as the default for
"Exclude" properties

All other jobs Matches all files and job folders not moved by any other
connection (see All other files for more details)

Define file types A predefined list of cross-platform file types.

A file matches the filter if its Mac file and creator types and/or its
filename extension match any of the specified types

A job folder matches the filter if any of the files at the topmost
level inside the folder match any of the specified types (or if the
list of types contains the special "Folder" type)

Define file patterns A list of filename pattern strings entered in a dialog; a pattern
includes one or more of the following wildcard characters (in
addition to regular characters that must match exactly):

. *(asterisk): matches zero or more arbitrary consecutive
characters
« ?(question mark): matches exactly one arbitrary character

A file matches the filter if its filename matches any of the patterns
in the list.

A job folder matches the filter if its folder name matches any of
the patterns in the list.

Define regular expression A regular expression (i.e. a more complex pattern; see Regular
Expressions on page 207 for more details)

A file matches the filter if its filename completely matches the
regular expression.

A job folder matches the filter if its folder name completely
matches the regular expression.

Define condition with A condition expressed through variables; see Defining a
variables condition with variables on page 353
Define script expression A script expression that returns a Boolean result (true or false)
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All other files

A common problem while creating connections from a flow element is how to capture those
files or job folders not matched by any other connection. The "All other jobs" filter addresses
this problem; all files or job folders that do not match one of the connections with another filter
(example: file type, file pattern, regular expression) are matched by this filter.

For example: imagine a flow element with one connection that matches all PDF files and a
second connection that matches all PostScript files. Adding a third connection where the "Include
these jobs" property is set to "All other jobs" causes all files that are not PDF or PostScript to be
matched (i.e. moved through this third connection).

A flow element can have more than one outgoing connection that uses the "All other jobs"
filter. In that case all of these connections match the same set of files and job folders: those not
matched by other connections using e.g. file type, file pattern or regular expression filters.

Folder filters

A folder filter is applied to a subfolder of the folder hierarchy from which files are being retrieved.

Filter type Description

All folders Matches all folders; is used as the default for "Include" properties
No folders Matches no folders; is used as the default for "Exclude" properties
All other folders Matches all folders not matched by any other connection; the

semantics are similar to the "All other jobs" file filter (see All other
jobs for more details)

Folder patterns A list of folder name pattern strings entered in a dialog; a pattern
includes one or more of the following wildcard characters (in
addition to regular characters that must match exactly):

« *(asterisk): matches zero or more arbitrary consecutive
characters
« 7 (question mark): matches exactly one arbitrary character

A folder matches the filter if its folder name matches any of the
patterns in the list

Regular expression A regular expression (i.e. a more complex pattern; see the
separate topic for more details)

A folder matches the filter if its folder name completely matches
the regular expression

Script expression A script expression that returns a Boolean result (true or false)

Process these folders

The objective is to offer more flexibility for defining the subset of the folder hierarchy to be
processed. This is accomplished by offering a variable list of powerful rules.
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Properties

The tool offers the following new properties:

Switch

Property name

Description

Editors

Default

Process these folders

Defines the ‘initial' set

of folders that should be
processed by the submit
hierarchy tool; this set can
be adjusted by defining
one or more rules in
subsequent properties

Possible values are:

. All folders
« No folders

Dropdown list

All folders

Adjusted by (rule 1)

Defines a rule for adjusting
the set of folders that
should be processed by
including or excluding
folders

Possible values are:

+ Including folders
named

« Including folders not
named

« Excluding folders
named

+ Excluding folders not
named

Dropdown list

None

.. Folder name

A pattern for the folder
name to be included or
excluded

Folder patterns
Regular expression
Script expression

Empty

.. On levels

The level or range of levels
to which this rule applies,
in the same format as

the old "Subfolder range"

property

Single-line text

Empty

.. Restriction

Defines an optional
restriction on the parent or
ancestors for the folder in
this rule

Possile values are:

« None

- With immediate parent
named

« With no immediate
parent named

Dropdown list

None
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Property name Description Editors Default
« With any ancestor
named
«  With no ancestor
named
.... Parent name or A pattern for the folder Folder patterns Empty
name of the parent or Regular expression
.... Ancestor name - .
ancestor Script expression
.. Nesting Defines whether this rule Dropdown list "Don't
operates on subfolders of include..." or
the target folder, which are Exclude...

deeper in the hierarchy
than the defined level
range. The matching rule
is also applied on these
subfolders.

Possible values for
"including" rule are:

+ Include nested
subfolders as well

« Don'tinclude nested
subfolders

Possible values for
"excluding" rule are:

« Exclude nested
subfolders as well

- Dont exclude nested
subfolders

Adjusted by (rule 2) Same as rule 1 with an
identical set of dependent
properties

Adjusted by (rule 5)

Applying rules

The rules are applied in the same order as they are specified. It is perfectly possible for a rule to
exclude folders that were included by a previous rule, or vice versa.

For example, consider a hierarchy with two levels (in addition to the root folder) and where each
level has three folders called A, B, C. Now, consider the following rules:

- Start with no folders
+ Include folders named C on level 2 (with or without nesting)
« Exclude folders named C on level 1 (with nesting)

These rules will process all jobs in folders A/C and A/B, but not in folder C/C (because it was
excluded in the second rule), and not in any of the other folders (because they were never
included to begin with).
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Reversing the order of the rules would change the result (files in folder C/C will be processed as
well), because excluding something from an empty set has no effect.

Upgrading
When upgrading from a previous version of Switch, the new properties are initialized as follows:

« The new "Process these folders" property is set to "All folders"

« Ifthe old "Process only these folders" property is not set to "All folders", a rule is created as
indicated in the following table

- If the old "Skip these folders" property is not set to "No folders", a rule is created as indicated
in the following table

If both old properties are present, the rules are listed in the order presented above (although the

order is not important).

Property name

Value for "Process only these
folders"

Value for "Skip these folders"

Adjusted by

.. Folder name

..On levels

.. Restriction

.. Nesting

"Excluding folders not named"
The value of the "Process only
these folders" property

The value of the
corresponding dependent
property

"NOI’le"

"Exclude nested subfolders as
well"

"Excluding folders named"

The value of the "Skip these
folders" property

The value of the
corresponding dependent
property

"NOI’]e"

"Exclude nested subfolders as
well"

These values should produce the same behavior as in the previous Switch version.

Unique name prefixes

Internal job tickets

A key feature of Switch is its ability to remember information about a job (file or job folder) while it
is being processed through a flow. This information is stored in an internal job ticket managed by

Switch.

The internal job ticket for each job contains housekeeping information (such as where the job
was last located) in addition to information about the job's origin and routing.

For example, a job's hierarchy info and email info (attached by specific tools) are stored in its

internal job ticket.

Switch needs a way to associate a particular internal job ticket with its corresponding job, and
vice versa. To maximize flexibility and transparency for the user, Switch uses the filename as

the basis for this mechanism rather than hiding jobs in some database. However Switch may be
handed two or more jobs with the same name (in different input folders, or even in the same input
folder after the first job was moved along).

Thus Switch employs a "trick" to keep similarly named jobs apart: unique name prefixes.
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Unique name prefixes

A job is associated with its internal job ticket by prefixing the file or folder name with a unique
identifier that consists of five letters or digits preceded and followed by an underscore.

For example: "myjob.txt" may become "_0G63D_myjob.txt".

Note that the files inside a job folder are not renamed; only the job folder name receives the
unique name prefix. When a job folder is disassembled into separate files, each of the files of
course receives its own unique name prefix.

For the technically-minded: each of the five characters in the unique name prefix can be a digit
(0-9) or an uppercase letter (A-Z). This allows 36”5 or about 60 million combinations. A different
unique name prefix can be generated every second for about 23 months.

Switch generates a new unique name prefix (and a corresponding internal job ticket) when:

. It detects a job in a folder or in a submit hierarchy.
- It makes a copy of a job.
« A producer (such as email receive) injects a new job in the flow.

- A processor produces a secondary output job that is injected in the flow.

The primary output of a processor (i.e. the incoming job with any changes applied by the
processor) retains the same unique name prefix as the incoming job.

When a job loses its unique name prefix (for example because the "strip unique name" property is
set for an archive or a final folder), it also loses the association with its internal job ticket.

Handing over jobs between flows

Switch can pass along a job from one flow to another without loosing the job's association with its
internal job ticket (assuming both flows are being executed by the same instance of Switch; hand-
over between different instances of Switch does not preserve the internal job ticket information at
this time).

This feature enables splitting up a complex flow in smaller segments without losing any
information.

To hand over jobs from flow A to flow B:
« Inflow A, create a user-managed folder with no outgoing connections and make sure its "strip

unique name" property is set to No.

« Inflow B, create a user-managed folder with the same backing folder (the folder in flow B may
or may not have incoming connections).
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Remark:
The following configuration is currently not supported:

« Inflow A, the "strip unique name" property of the user-managed folder set to No.
- Inflow B, the "leave originals in place" property of the user-managed folder with the same
backing folder set to Yes.

Note: Switch cleans up job tickets in end folders at a regular interval as set in the
Application Data preference. Make sure that the job ticket is handed over to the second
flow in a timely manner.

Regular Expressions

Note: The contents of this topic is adapted from documentation provided by Trolltech.

Introduction

Regular expressions, or "regexps", provide a way to find patterns within text. This is useful in
many contexts, for example a regexp can be used to check whether a piece of text meets some
criteria. In Switch a regular expression can be used to sort files based on some naming scheme:
only files with a name that matches the regular expression are allowed to pass through a certain
connection.

While this is almost surely of no concern for the use of regexps in Switch, it is good to know that
not all regexp implementations are created equal. Most implementations provide identical results
for basic expressions, but the results for more advanced expressions and matches may differ in
subtle ways.

The Switch regexp language is modeled on Perl's regexp language, A good reference on
regexps is Mastering Regular Expressions: Powerful Techniques for Perl and Other Tools by
Jeffrey E. Friedl, ISBN 1565922573. Several web sites offer tools for working with regexps or
provide libraries with examples for matching all sorts of patterns. One simple tool to start playing
with regexps can be found at https.//www.regexpal.com/ or https.//regex101.com/.
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Note: Starting from Switch 25.07, the regular expression engine has been upgraded and
it now enforces stricter syntax rules than before. As a result:

« Curly braces are needed to use a hexadecimal escape like \xHHHH with more than
2 digits. A pattern like \x2022 needs to be ported to \x{2022}, or it will match a space
(0x20) followed by the string "22". In general, it is highly recommended to always use
curly braces with the \x escape, no matter the number of digits specified.

« A O-to-n quantification like {,n} needs to be ported to {0,n} to preserve semantics.
Otherwise, a pattern such as \d{,3} would match a digit followed by the exact string

"{,3}".

« The order of alternatives in a regular expression affects how matches are evaluated.
For example, in a pattern like /hello|helloworld/, the shorter alternative “hello” is
matched first, so replacing “helloworld” with “abcd” results in “abcdworld” instead of a
full replacement. Reversing the order to /helloworld|hello/ ensures the correct output
“abcd”. The same principle applies to numeric groups like ([0-5][0-9]|[0-9]), where
placing the broader range first ensures complete and consistent matching.

This change ensures more consistent and standards-compliant behaviour across
platforms.

Brief tutorial

Regexps are built up from expressions, quantifiers, and assertions. The simplest form of
expression is simply a character, example, x or 5. An expression can also be a set of characters.
For example, [ABCD] will match an A or a B or a C or a D. As a shorthand we could write this as
[A-D]. If we want to match any of the capital letters in the English alphabet we can write [A-Z]. A
quantifier tells the regexp engine how many occurrences of the expression we want, e.g. x{1,1}
means match an x which occurs at least once and at most once. We will look at assertions and
more complex expressions later.

We will start by writing a regexp to match integers in the range 0 to 99. We will require at least
one digit so we will start with [0-9]{1,1} which means match a digit exactly once. This regexp alone
will match integers in the range 0 to 9. To match one or two digits we can increase the maximum
number of occurrences so the regexp becomes [0-9](1,2} meaning match a digit at least once and
at most twice. However, this regexp as it stands will not match correctly. This regexp will match
one or two digits within a string. To ensure that we match against the whole string we must use
the anchor assertions. We need # (caret) which when it is the first character in the regexp means
that the regexp must match from the beginning of the string. And we also need $ (dollar) which
when it is the last character in the regexp means that the regexp must match until the end of the
string. So now our regexp is "[0-9]{1,2}$. Note that assertions, such as * and $, do not match any
characters.

If you have seen regexps elsewhere, they may have looked different from the ones above.

This is because some sets of characters and some quantifiers are so common that they have
special symbols to represent them. [0-9] can be replaced with the symbol \d.

The quantifier to match exactly one occurrence, {1,1}, can be replaced with the expression itself.
This means that x{1,1} is exactly the same as x alone. So our O to 99 matcher could be written
Md{1,2)$. Another way of writing it would be "\d\d{0,1}$, i.e. from the start of the string match

a digit followed by zero or one digits. In practice most people would write it \d\d?$. The ?is

a shorthand for the quantifier {0,1}, i.e. a minimum of no occurrences and a maximum of one
occurrence. This is used to make an expression optional. The regexp "\d\d?$ means "from the
beginning of the string match one digit followed by zero or one digits and then the end of the
string".
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Our second example is matching the words 'mail', 'letter' or 'correspondence' but without
matching 'email’, 'mailman’, 'mailer’, 'letterbox' etc. We will start by just matching 'mail'. In full the
regexp is m{1,1}a{1,1}i{1,1}{1,1}, but since each expression itself is automatically quantified by {1,1}
we can simply write this as mail; an m followed by an a followed by an i followed by an I. The
symbol | (bar) is used for alternation, so our regexp now becomes mailllettericorrespondence
which means match 'mail' or 'letter' or 'correspondence'. Whilst this regexp will find the words we
want it will also find words we do not want such as 'email'.

We will start by putting our regexp in parentheses, (maillletterlcorrespondence).

Parentheses have two effects, firstly they group expressions together and secondly they identify
parts of the regexp that we wish to capture for reuse later on. Our regexp still matches any of
the three words but now they are grouped together as a unit. This is useful for building up more
complex regexps. It is also useful because it allows us to examine which of the words actually
matched.

We need to use another assertion, this time \b "word boundary": \b(maillletterl
correspondence)\b.

This regexp means "match a word boundary followed by the expression in parentheses followed
by another word boundary". The \b assertion matches at a position in the regexp not a character
in the regexp. A word boundary is any non-word character such as a space, a newline or the
beginning or end of the string.

Characters and abbreviations for sets of characters

Element Meaning

C Any character represents itself unless it has a special regexp meaning. Thus c
matches the character c.

\c A character that follows a backslash matches the character itself except where
mentioned below. For example if you wished to match a literal caret at the
beginning of a stringyou would write \".

\a This matches the ASCII bell character (BEL, 0x07).

\f This matches the ASCII form feed character (FF, OxOC).

\n This matches the ASCII line feed character (LF, OxOA, Unix newline).

\r This matches the ASCII carriage return character (CR, OxOD).

\t This matches the ASCII horizontal tab character (HT, Ox09).

\v This matches the ASCII vertical tab character (VT, OxOB).

\xhhhh This matches the Unicode character corresponding to the hexadecimal

number hhhh (between Ox0000 and OxFFFF).

\Qooo (i.e. zero 000) This matches the ASCIl/Latin1 character corresponding to the
octal number ooo (between 0 and 0377).

(i.e. period) This matches any character (including newline).
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Element Meaning

\d This matches a digit.

\D This matches a non-digit.

\s This matches a whitespace.

\S This matches a non-whitespace.

\w This matches a word character (letter or number or underscore).
\W This matches a non-word character.

\n This matches the n-th backreference, e.g. \1, \2, etc.

Sets of characters

Square brackets are used to match any character in the set of characters contained within

the square brackets. All the character set abbreviations described above can be used within
square brackets. Apart from the character set abbreviations and the following two exceptions no
characters have special meanings in square brackets.

Character Meaning

A The caret negates the character set if it occurs as the first
character, that is immediately after the opening square bracket.
For example, [abc] matches 'a' or 'b' or 'c', but [*abc] matches
anything except 'a' or 'b' or 'c'.

- The dash is used to indicate a range of characters, for example,
[W-Z] matches 'W' or 'X' or "Y' or 'Z'.

Using the predefined character set abbreviations is more portable than using character ranges
across platforms and languages. For example, [0-9] matches a digit in Western alphabets but \d
matches a digit in any alphabet.

Note that in most regexp literature sets of characters are called "character classes".

Quantifiers

By default an expression is automatically quantified by {1,1}, i.e. it should occur exactly once. In
the following list E stands for any expression. An expression is a character or an abbreviation for
a set of characters or a set of characters in square brackets or any parenthesized expression.

Quantifier Meaning

E? Matches zero or one occurrence of E. This quantifier means "the
previous expression is optional" since it will match whether or not the
expression occurs in the string. It is the same as E{0,1}. For example
dents? will match 'dent' and 'dents'.

210



ENF@CUS Switch

Quantifier Meaning

E+ Matches one or more occurrences of E. This is the same as E{1,}. For
example, 0+ will match '0', '00', '000', etc.

E* Matches zero or more occurrences of E. This is the same as E{0,}. The
* quantifier is often used by mistake. Since it matches zero or more
occurrences it will match no occurrences at all. For example if we want
to match strings that end in whitespace and use the regexp \s*$ we
would get a match on every string. This is because we have said find
zero or more whitespace followed by the end of string, so even strings
that don't end in whitespace will match. The regexp we want in this
case is \s+$ to match strings that have at least one whitespace at the
end.

E{n} Matches exactly n occurrences of E. This is the same as repeating the
expression n times. For example, x{5} is the same as xxxxx. It is also
the same as E{n,n}, e.g. x{5,5}.

E{n,} Matches at least n occurrences of E.
E{O,m} Matches at most m occurrences of E.
E{n,m} Matches at least n occurrences of E and at most m occurrences of E.

If we wish to apply a quantifier to more than just the preceding character we can use parentheses
to group characters together in an expression. For example, tag+ matches a 't' followed by an 'a'
followed by at least one 'g', whereas (tag)+ matches at least one occurrence of 'tag'.

Note that quantifiers are "greedy". They will match as much text as they can. For example, O+ will
match as many zeros as it can from the first zero it finds, e.g. '2.0005".

Capturing text

Parentheses allow us to group elements together so that we can quantify and capture them. For
example if we have the expression mailllettericorrespondence that matches a string we know
that one of the words matched but not which one. Using parentheses allows us to "capture"
whatever is matched within their bounds, so if we used (maillletterlcorrespondence) and
matched this regexp against the string "l sent you some email" we would capture 'mail'.

We can use captured text within the regexp itself. To refer to the captured text we use
backreferences which are indexed from 1. For example we could search for duplicate words in a
string using \b(\w+)\W+\1\b which means match a word boundary followed by one or more word
characters followed by one or more non-word characters followed by the same text as the first
parenthesized expression followed by a word boundary.

If we want to use parentheses purely for grouping and not for capturing we can use the non-
capturing syntax, e.g. (?:greenlblue). Non-capturing parentheses begin '(?:' and end ')". In

this example we match either 'green’ or 'blue' but we do not capture the match so we only
know whether or not we matched but not which color we actually found. Using non-capturing
parentheses is more efficient than using capturing parentheses since the regexp engine has to
do less book-keeping.

Both capturing and non-capturing parentheses may be nested.
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Anchors match the beginning or end of the string but they do not match any characters.

Regular expressions entered in the Switch user interface always match the complete string. In
other words the regexp is automatically anchored at the beginning and at the end of the string,
and you shouldn't specify explicit anchors. (Regular expressions specified in a Switch JavaScript
program should include explicit anchors as needed).

Anchor

Meaning

The caret signifies the beginning of the string. If you wish to match
a literal * you must escape it by writing \. For example, *#include
will only match strings which begin with the characters '#include'.
(When the caret is the first character of a character set it has a
special meaning, see Sets of Characters.)

The dollar signifies the end of the string. For example \d\s*$

will match strings which end with a digit optionally followed by
whitespace. If you wish to match a literal $ you must escape it by
writing \$.

Assertions

Assertions make some statement about the text at the point where they occur in the regexp but
they do not match any characters. In the following list E stands for any expression.

Assertion

Meaning

\b

A word boundary. For example, the regexp \bOK\b means match
immediately after a word boundary (example: start of string or whitespace)
the letter 'O' then the letter 'K' immediately before another word boundary
(example: end of string or whitespace). But note that the assertion does
not actually match any whitespace so if we write \bOK\b) and we have a
match it will only contain 'OK' even if the string is "It's OK now".

\B

A non-word boundary. This assertion is true wherever \b is false. For
example, if we searched for \Bon\B in "Left on" the match would fail
(space and end of string are not non-word boundaries), but it would match
in "tonne".

(?=E)

Positive lookahead. This assertion is true if the expression matches at
this point in the regexp. For example, const(?=\s+char) matches 'const'
whenever it is followed by 'char', as in 'static const char *'. (Compare with
const\s+char, which matches 'static const char *'.)

(?IE)

Negative lookahead. This assertion is true if the expression does not
match at this point in the regexp. For example, const(?!\s+char) matches
‘const' except when it is followed by 'char'.

Note: Positive and negative lookbehind are currently not supported.
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Case insensitive matching

You can make the complete regexp case insensitive by surrounding it by the /.../i constuct. More
precisely, if the regexp starts with a forward slash and ends with a forward slash followed by the
letter i, then matching for the complete regexp is case insensitive.

For example:

Regexp Matches these strings
ABC ABC

abc abc

/ABC/i ABC, abc, Abc

/ABC/ /ABC/

JavaScript for applications

Introduction

The Adobe Creative Suite applications (Acrobat, Photoshop, lllustrator and InDesign) can be
extensively scripted through JavaScript (a scripting language interpreted and executed by the
application). All four applications offer a similar overall interface for working with JavaScript,
although each application offers a different set of JavaScript functions to actually control the
application's functionality

The JavaScript programming interface for each application is documented in the application's
software development toolkit which can be found on the Adobe web site. The Adobe Creative
Suite bundle includes the "ExtendScript Toolkit" application which is extremely useful for
developing and debugging JavaScript scripts for Adobe Creative Suite applications.

The Switch apps for the four applications mentioned above allow posting a JavaScript script to
the application for execution. Combined with Switch's built-in capabilities this provides powerful
control of the Adobe Creative Suite applications.

Note: In the remainder of this topic "application" means one of the four Adobe Creative
Suite applications mentioned above, and "app" means the Switch app that controls the
application under consideration.

Stages

An app defines the action to be executed by its corresponding application in the form of three
consecutive stages:

« Open the file and make it the currently active document.
« Perform a command on the currently active document.

- Save the currently active document and close it.
The desired action for each stage is defined independently, and can be selected from:

« One of the built-in actions listed by name.

« A user-provided script (which is specified by browsing to a JavaScript text file).
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Depending on the selected action a number of subordinate properties are shown to further
configure the action. In other words, each choice has its own set of properties.

The properties for the "Use script" choice are described below; those for built-in choices are
described for each app separately.

Properties for specifying a user script

The following set of properties is shown for an action stage if the "Use script" option is selected

for the stage.

Property Description

Script file The text file that contains the JavaScript script to be executed by
the application for this stage

Argument 1 The first argument to be passed to the script (or empty)

Argument 2 The second argument to be passed to the script (or empty)

Argument 3 The third argument to be passed to the script (or empty)

Argument 4 The fourth argument to be passed to the script (or empty)

Argument 5 The fifth argument to be passed to the script (or empty)

There are always five arguments because there is no mechanism to determine how many
arguments are actually needed by the script.

Writing a user script

To write a user script, simply provide the JavaScript statements that should be executed in the
main body of the script file. If your script encounters an error, it should set the $error variable to
the appropriate error message; otherwise it should leave the $error variable alone. See below for

a typical coding pattern.

The following special global variables are defined before your script executes, and thus their
value can be used in your script; in some cases (noted in the variable's description) your script
should also set or update the contents of the variable.

Variable Description

$arg1 The first argument passed to the script (or the empty string if there is
none)

$arg2 The second argument passed to the script (or the empty string if
there is none)

$arg3 The third argument passed to the script (or the empty string if there
is none)

$argd The fourth argument passed to the script (or the empty string if there
is none)
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Variable Description

$arg5 The fifth argument passed to the script (or the empty string if there is
none)

$infile The absolute path of the input file, including name and extension;

this is used mostly in a script attached to an "open" action

$doc The currently active document, that is, the document that was

y
opened by the "open" action; $doc is null for a script attached to an
"open" action (or when the "open" action failed)

Note:

« Use $doc instead of "this" to refer to the currently active
document.

« If you're using a custom 'open' script for the InDesign
or InDesign Server App to open or to create more than
one document, the script must explicitly set the value for
$doc. This is necessary to make sure the app processes
the right document. For other Adobe applications, the
$doc variable is automatically set to contain the active
document.

$outfolder The absolute path of the folder in which to place the output; this is
used mostly in a script attached to a "save" action

$filename The filename (without extension) of the input (and output) file

$extension The filename extension of the input file, or if it does not have one,
the filename extension corresponding to the Mac file types of the
input file

$outfiles The incoming value of this variable is irrelevant

If your script is attached to a "save" action, it should set the contents
of this array variable to the absolute paths of the output files
generated by the script

$jobfolder The incoming value of this variable is irrelevant

If your script is attached to a "save" action, it should set the contents
of this variable as follows:

« The empty string: each output file is moved along the outgoing
connection as a separate job

« The desired name of the job folder: all output files are placed
inside a single job folder with the specified name

$error If an error occurred during the execution of an earlier stage, or
while preparing for the execution of this stage, this variable contains
an appropriate error message: otherwise its value is null (NOT
the empty string; an empty string signifies that an error indeed
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Variable

Description

occurred but no meaningful error message was generated -- this is
considered bad practice but it may happen)

If your script encounters an error, it should set the $error variable
to the appropriate error message (that is, a non-empty string);
otherwise it should leave the $error variable alone.

Note: If $error is set, the script will fail the job and move

it to the 'Error' level data output connections. If there is no
error connection, the job will be moved to the Problem jobs
folder.

Note however that it's possible to explicitly determine
where the job should go to (either to the Error connection or
to the Problems jobs folder) by setting the $status variable.
For more information, refer to the explanation below.

$status

$status allows you to control the output behavior of the error jobs,
by specifying where the error out job must be moved to. You can
also specify to stop the script from further processing in case of a
critical failure.

Note: The value of $status is ignored if $error is ‘null’.

$status is a string and must have one of the following values:

. error (default value): Failed jobs will be moved to the Error
connection; if no Error connection is found, the jobs are moved to
the Problems folder.

- failJob: Failed jobs are sent to the Problems folder.

« failProcess: In case of problems, all processing is stopped.

Error handling

Here's a typical coding pattern to correctly handle errors in a user script attached to the
command action:

if (Serror

{

null)

try

{
// statements to be executed by this script
// S$doc.ApplicationDependentFunction () ;

}

catch( e )

{

Serror = e.description || e.message;

$status = failJob;

// This will move the failed job to Problem Jobs folder. If not set, the
default is the “Error” level data connection.

$doc.closeDoc( Application Specific Parameters );

// close any other resources used in the try block
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The InDesign and lllustrator app produce an XML log file. This is an example:

<AdobeConfiguratorLog>
<FlowElementName>ConfiguratorFlowElementName</FlowElementName>
<Job>
<Name>NoFontPackage</Name>
<Status>Error</Status>
<StatusMessage>Error Message String</StatusMessage>
<MissingFonts>
<Font>Somora</Font>
<Font>XBAND Rough</Font>
</MissingFonts>
<Job>
</AdobeConfiguratorLog>

Note: The log is an XML file named after the incoming job name.

Here's a typical coding pattern to correctly handle errors for Adobe Acrobat application:

// Acrobat is used to make a summary of the annotations resulting in a file that shows
you the page

// content and the annotations per page.

// No arguments are required.

if (Serror == null)

{

try
{
var title = $doc.documentFileName + " summary"
$Soutfile = Soutfolder + '/' + $filename + " summary.pdf";
$doc.ANsummarize ($doc, title, ANSB Page, null, Soutfile, null, false, true, false,
false, false, false);
Soutfiles.push (Soutfile);
}
catch (theError)
{
Serror = theError;
$doc.closeDoc( {bNoSave : true} );
}
}

Serror

More info needed?

For more information about scripting, refer to the documentation on the Enfocus website.

4.2.5. Managing flows

4.2.5.1. Organizing flows

The Flows pane

The Flows pane lists all flows currently known to Switch. It allows organizing these flows in a
hierarchy of groups and subgroups, and provides a context menu for managing flows in various

ways.
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Flows B X
'.\'.:l' J {E}v]

Mame i

¥+ Demo flow 1
. Demofowz<
Demo flow 3
Archive By Date
hd Flows Customer X
Assemble files and sort sort job @
Check attachments
- Flows Customer ¥
Receive and send =
- Test
Testflow

Groups and subgroups

Groups and subgroups are marked with small icons, indicating whether or not the group is
collapsed (so you don't see the flows) and/or the flows are activated.

Icon Meaning

» This group is collapsed.

- This group is expanded.

L - If preceding a group: at least one of the flows of this group is activated.
« If preceding a flow: this flow is activated.

Example:
In the example below, one group with 2 subgroups has been defined.
Group1 and Subgroup1 are expanded; you can see the flows belonging to those groups.
Subgroup? is collapsed.
Only Flow1 is activated.
¥ ¥ Groupl

¥ Flowl

Flow2
- Subgroupl

Flow3
b Subgroup?
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Selecting flows

You can select any number of flows in the Flows pane at the same time.

Note: When you select a group, all flows and groups in that group are automatically
selected as well, regardless of whether the group is displayed open or closed.

To select one or more flows:

1. To select one flow, in the Flows pane, click it.
The selected flow is shown in the canvas.

2. To select more than one flow at a time, in the Flows pane, click the preferred flows while
holding down the Ctrl or the Shift key.

The selected flows do not have to be consecutive.

All selected flows are shown as tiles in the canvas. Tiles cannot be edited. However, you
can select a particular tile and edit its flow properties in the Properties pane. For more
information, refer to Multiple flows as tiles on page 174.

Adding a group in the Flows pane

You can use groups to organize your flows into a tree-like structure, much like files in a folder
tree. A group can contain flows and other groups, up to any nesting level.

To add a new group in the Flows pane:
1. Inthe Flows pane

« To add a new group, select the flow after which the new group should be inserted.
- To add a new subgroup, select the group in which the new group should be inserted.

2. Right-click and select New group.

3. Inthe Properties of the newly inserted group, click the Name field and type an appropriate
name for the group.

The new group is empty. You can move existing flows to the group (see Organizing flows on
page 217) or create new flows for that group.

Reorganizing flows in the Flows pane

You can reorganize the order and nesting structure in the Flows pane by dragging the flows
around.

Note: You can move flows as well as groups; when moving groups, all flows belonging to
that group are moved to the new location.

To move flows to a different location in the Flows pane

1. Select the flow(s) you want to move.

To select multiple flows, hold down the Ctrl key while selecting the flows.
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2. Drag the selected flows to the target location. You can:

« Drop them in between two flows to move them between those flows, or
- Drop them on top of a group to place them inside that group. This works, even if the group
is collapsed.

Ordering flows in the Flows pane
The Flows pane supports three row ordering modes, i.e. three ways to sort the flows:

« Manual ordering: The flows are ordered by manually dragging them into the appropriate
position.

- Sorted by name: At each level in the tree, flows are sorted on the name column (case
insensitive, and regardless of whether they are groups or flows).

- Sorted by marker: At each level in the tree, flows are sorted on the marker column (see
Setting flow markers on page 220), and then on the name column (so that the order is
predictable when rows have the same marker).

To change the sort order in the Flows pane

1. Do one of the following

« To order the flows manually, drag them into the appropriate position.
« To sort by name, click the column header of the Name column.
« To sort by marker, click the column header of the Marker column (small flag icon).

Note: If the Marker column is not visible, right-click the column header of the
Name column and select Marker column.

2. Totoggle between ascending and descending order, click the column header (of the column
you're sorting by).

Setting flow markers

The rightmost column in the Flows pane can display a marker icon selected from a pre-defined
list of icons (including colored flags, priorities, and level of completeness indicators).

The markers have no meaning to Switch. They can be useful to sort flows, for example by priority
or by level of completion.

Flow markers are preserved when exporting and importing flows.

Example Flows pane with markers

Flows g X
@ 3
Mame @ o

Flow 1
Flow 2
Log job info in Excel @
Log job info to Excel
- Mew Client Preflight pages
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Pricrity 1
Pricrity 2
Pricrity 3
Pricrity 4

25% complete
50% complete
75% complete
100% complete
Up arrow
Down arrow
Left arrow
Right arrow
Red flag
Green flag
Blue flag
Black flag

Custom image

You can also upload your own custom image and use it as a flow marker.

Groups

Groups only have a marker if all flows belonging to that group have the same marker. For

Switch

example, if all flows in a group are marked as Priority 1, the group will be marked as Priority 1 as

well.

In all other cases (if none of the flows have a marker, or they have different markers), no marker is

displayed at group level.

Setting a marker for a flow

To set the marker for one or more flows
1. Select the flows you want to mark (with one particular marker).
2. Right-click and select Mark flow.

3. Select the appropriate marker or upload a custom image.
The selected marker icon is displayed next to the flow, in the Marker column. In the

properties of the flow, the Marker image property holds the name of the marker (e.g. Priority

4) or the name (and path) of the custom image (e.g. /Users/<userX>/my_image.png).

Note: If the Marker column is not visible, right-click the column header of the Name

column and select Marker column.

221



ENF@CUS Switeh

Clearing a marker for a flow

To clear the marker for one or more flows

1. Select the flow(s) for which you want to clear the marker.
2. Right-click to open the context menu.

3. Select Mark flow.

4. Select No marker.
The marker is removed from the Flows pane. In the flow properties, the Marker image
property is set to None.

4.2.5.2. Changing flow properties

After you have created a flow, you can still make a number of changes. You can for example:

«  Rename the flow.
. Add a background and/or a header image.

« Tune the performance of Switch, by overruling a number of default settings for concurrent job
processing (Refer to Show advanced element properties in Flow properties on page 223).

To change the flow properties

1. Inthe Flows pane, select the flow of which you want to change the properties.

Note: Make sure that none of the flow elements in the canvas are selected.
Otherwise, you might see the properties of the element, rather than the properties of
the flow.

The properties of the selected flow are displayed in the Properties pane.

2. Click the property you want to change.
Depending on the selected property, a text box, a button, or a drop-down menu appears.

3. Make the required changes:

If ... appears Do the following:

A text box Type the text in the displayed text field.

A drop-down Select the appropriate option.

menu

[3 1. In the the property editor dialog that pops up, update the field(s)
as required.
2. Click OK.

1. From the pop-up list, select one of the options.
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If ... appears Do the following:

Auko-managed
Inline value
Zhoose Folder

Depending on the selected option, an inline editor or a dialog
appears.

2. Configure the desired values.

For an overview of the properties and their meaning, see Flow properties on page 223.

Your changes are applied immediately.

Flow properties

The following properties are displayed in the Properties pane, when you select a particular flow.

Property Description
Name The name of the flow as it is shown in the Flows pane.
Description A description of, or comments about the flow; the text in this field may have

multiple lines. The creation date and time are filled in automatically (but can
be removed as required).

Background A PNG or JPG image to be shown in the background of the flow design.

'mage - The background image is placed at its effective resolution.

- Ifthe image is too small to fill the canvas, it is repeated (as tiles).

- When the flow is not editable (because it is locked or active), the
background image is darkened.

The background image is a kind of wallpaper on which the flow design is
drawn. Light colors or sober patterns work best.

Header image A PNG or JPG image to be shown in the upper-left corner of the flow
design, on top of the background image.

« The header image is placed at its effective resolution.
« The header image is not repeated to fill the canvas.
«  When the flow is not editable, the header image is not darkened.

The header image is intended to mark a flow with a company or brand logo.

Small images work best (avoiding overlap with the actual flow design).

Marker image If a flow marker is set: the name of the marker (e.g. Priority 4) or the name
(+path) of the uploaded custom image (e.g. /Users/<userX>/my_image.png).

If no flow marker is set: the value is None.
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Property Description

Show advanced | |f set to Yes, certain flow elements get extra properties:
element

properties + Nodejs scripts and apps get the following extra property:

+ Log debug messages:

- If set to Default, debug messages will only be shown if Log
debug messages is enabled in the Switch preferences (Switch
Preferences: Logging). See also Script element.

. If setto Yes, debug messages for this particular flow element will
be shown in the Messages overview, regardless of the value of
Log debug messages in the Switch preferences.

- Flow elements that can process jobs concurrently get two extra
properties that overrrule the performance settings in the Switch
Preferences (Switch preferences: Processing on page 43):

- Number of slots : Number of slots available for concurrent
processes.
- Idle after job (secs) : Idle time-out after each job.
For an overview of flow elements that support concurrent processing,
refer to Concurrent processing tasks.
- Node.js elements get the following extra property:

« Abort after (minutes): Number of minutes a Node.js script can run
after which it is aborted.

- If set to Default, the value of the global Abort processes after
(minutes) preference will be used.

. If setto O, the script will never be aborted.

Important: The value of Abort after (minutes) is ignored
when Enable debug mode is enabled for the same flow
element!

Note: In older versions of Switch (Switch 2020 and earlier), this
property was named "Allow advanced performance tuning". It only
affected the performance of the concurrent processing tasks.

Time-of-day If set to Yes, the flow will be active during a particular time of the day, as
window specified in the following properties (only available if Time-of-day window is
enabled):

« Allow from (hh:mm): Start time, for example: 09:00

« Allow to (hh:mm): End time, for example: 11:00

Day-of-week If set to Yes, the flow will be active during a couple of days of the week, as
window specified in the following properties (only available if Day-of-week window
is enabled):
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Property Description

« Allow from: Day of the week the flow will be activated, for example:
Tuesday

- Allow to: Day of the week the flow will deactivated, for example: Friday

Day-of-month If set to Yes, the flow will be active during a particular day of the month, as
window specified in the following properties (only available if Day-of-month window
is enabled):

« Day: Day of the month during which to keep the flow active. Use a
number between 1 and 31. For example, "1" (default) means the first or
the last day of the month (depending on the value in Relative to).

« Relative to: Choose between: Start/end of the month.

Note: If you have enabled the Time-of-day, Day-of-week or Day-of-month window, when

activating the flow manually, it will be preceded by a small icon @' This indicates that the
flow is scheduled and will be active during the time specified in the Flow properties.

4.2.5.3. Adding and removing flows

The Flows pane lists all flows known to Switch at the present time.

Adding flows
e
Mewi flow

See Creating a new blank flow on page 172 or Creating a new flow based on a
sample flow on page 173

Impert v See Importing a flow or a flow group on page 231

Duplicating flows
To make a copy of one or more existing flows
1. Select the flow(s) in the Flows pane.

2. Do one of the following: menu item, or

« Select Flow > Duplicate Flow(s).
- Right-click and select Duplicate Flow(s).
- Drag the selected flow(s) to a different location in the Flows pane.

You must hold down the appropriate modifier key to select and move multiple flows.

The suffix "[Copy]" is added to the names of the duplicated flows.
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Switch

Note: You can duplicate a flow even while it is active; the new copy will be inactive.

Deleting flows

To delete one or more flows

1.

In the Flows pane, select the flow(s) you want to delete.

Make sure the flows are inactive, as it is not possible to delete an active flow.
Do one of the following:

In the toolbar, click the Delete Flow button Delete flow
« From the menu, select Flow > Delete Flow.

In the Flows pane, click ‘_*/ and select Delete Flow.
+ Press the Delete key.

Confirm your choice.

Remember that deleting a flow is permanent and cannot be undone.

Saving and reverting flows

As long as a flow hasn't been saved, in the Flows pane, its name is displayed in italics and
followed by an asterisk. The unsaved changes are stored in the local cache on disk on the
Designer side.

Note: You can have several flows with unsaved changes in your design. It is also
possible to switch between flows without saving. However, if you want to exit the

application, or if you want to activate a flow, you will be asked to save your changes.

Saving flows

Before you can activate one or more flows, you must first save them. In the Flows pane, unsaved
flows are displayed in italics, followed by an asterisk.

Note: If you forget to save your flow, a warning pops up. Note that clicking Save, will

save all flows with unsaved changes. If you do not want to save all unsaved flows, click

Cancel and manually save the flows as required.

To save flows

1.

In the Flows pane, select the flow(s) you want to save.

2. Do one of the following:
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4.2.5.5.

| [
e
In the toolbar at the top of the screen, click 2=¥= flaw
- In the Flows pane, right-click and select Save Flow(s).
« From the menu, select Flow > Save Flow(s).

In the Flows pane, the flow names are no longer displayed in italics and the asterisk has
disappeared. You can now activate the flow(s) as required.

Reverting flows

As long as a flow hasn't been saved, you can go back to the previously saved version. You can
do this for one flow at a time, or for several flows at the same time.

To revert flows

1. Inthe Flows pane, select the unsaved flow(s) you want to revert.

Flows with unsaved changes are displayed in italics and followed by an asterisk.

2. Do one of the following:
e
In the toolbar at the top of the screen, click Revertflow

- In the Flows pane, right-click and select Revert Flow(s).
- From the menu, select Flow > Revert Flow(s).

A warning appears.

3. Click Yes to confirm.
In the Flows pane, the flow names are no longer displayed in italics and the asterisk has
disappeared. You can now activate the flow(s) as required.

Locking and unlocking flows

A flow in the Flows pane can be locked for editing.

When a flow is locked, the Flows pane shows the state icon when the flow is inactive and no
changes can be made to the flow design or to the flow's properties. The flow can still be activated
as usual. The icon is not visible when you activate the flow but the flow remains locked.

The locking status is preserved when the flow is exported and re-imported.

Locking flows without password

When a flow is locked without a password, it can be unlocked without providing a password (i.e.
no password is requested). This is useful to guard against accidental editing without protection
against interference by another user.

To lock one or more flows without password
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1. Inthe Flows pane, select the flows you want to lock.

2. Do one of the following:

«  From the menu, select Flow > Lock.
- In the Flows pane, right-click the selected flow(s) and choose Lock.

In the Flows pane, click ‘_v/ and select Lock.

Switch displays a dialog requesting a lock password.
3. Leave the password blank.

4. Click OK.

Locking flows with a password

When a flow is locked with a password, the password must be provided to unlock it. The
password is stored in the flow definition in an encrypted form.

Note: There is no way to recover the password when forgotten!

To lock one or more flows with a password
1. Inthe Flows pane, select the flow(s) you want to lock.
2. Do one of the following:

« From the menu, select Flow > Lock.
« In the Flows pane, right-click the selected flow(s) and choose Lock.

In the Flows pane, click ‘_"/ and select Lock.
Switch displays a dialog requesting a lock password.
3. Enter the same password twice.

4. Click OK.

Note: Certain Enfocus employees have access to a mechanism that bypasses the
password protection (because Switch defines the password encryption). While Enfocus
does not intend to open password-protected flows, and does not intend to publish the
bypass mechanism, the company does not legally guarantee that this will never happen. It
is important for flow designers to understand the limitations of the protection.

Unlocking flows
To unlock one or more flows
1. Inthe Flows pane, select the flow(s) you want to unlock.

2. Do one of the following:

«  From the menu, select Flow > Unlock.
« In the Flows pane, right-click the selected flow(s) and choose Unlock.
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In the Flows pane, click ‘_'/ and select Unlock.

If the flow is password protected, Switch displays a dialog requesting the password.
Otherwise, the flow is unlocked immediately.

3. Enter the password.

4. Click OK.

4.2.5.6. Activating and deactivating flows

A flow can be in different states:

« Aninactive flow is in "design mode": you can change the flow and the flow element
properties. An inactive flow cannot process jobs.

- An active flow is currently being executed by the Switch Server, that is, it is processing jobs.

An active flow cannot be edited. This state is indicated by the icon next to the flow name in
the Flows pane, and by the darkened background in the canvas.

For an overview, refer to Flows pane on page 86 (Table "State").

Activating flows

If you want a flow to start processing jobs, you must activate it. Note that you can activate several
flows in one go.

To activate flows
1. Inthe Flows pane, select the (inactive) flow(s) you want to start.
2. Do one of the following:

In the toolbar at the top of the screen, click Activate flow

In the Flows pane, click ‘_v/ and select Activate Flow(s).

« Inthe Flows pane, right-click and select Activate Flow(s).

« Inthe Flows pane, double-click the selected flow (only possible in case of a single flow).
« From the menu, select Flow > Activate Flow(s).

If you haven't saved your flow yet and you haven't enabled automatic flow saving in the user
interface preferences, a warning pops up. Note that clicking Save, will save all flows with
unsaved changes. If you do not want to save all unsaved flows, click Cancel and manually
save the flows as required.

The background of the flow is darkened. In the Flows pane, you can see an icon next to
the name of the flow. The flow is now active and waits for input jobs to appear.

Note: If the flow has been scheduled, an icon ® appears. The flow will become
active at the time specified in the Flow properties (See Flow properties on page
223).
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Deactivating flows

If you want a flow to stop processing jobs, you must deactivate it. Note that you can deactivate
several flows in one go.

To deactivate flows

1. Inthe Flows pane, select the (active) flow(s) you want to stop.

To select multiple flows, hold down the Ctrl or Shift key while selecting.

2. Do one of the following:
(2
0

In the toolbar at the top of the screen, click Stop flow

In the Flows pane, click ‘_v/ and select Stop Flow(s).
« Inthe Flows pane, right-click and select Stop Flow(s).
« From the application menu, select Flow > Stop Flow(s).

The processing is terminated. You can now edit the flow as required.

Importing and exporting flows

If you want to make a backup of your flows, or if you want to share them with someone else, you
can export the flows concerned. Likewise if you have an exported flow, you can import that flow
into your copy of Switch and have the flow appear in the Flows pane.

You can do this for single flows, but you can also import and export flow groups as a whole (to
maintain the hierarchy and the order of the flows).

Exported flows are saved as files with the "sflow" filename extension; exported flow groups have
the "sflows" filename extension.

Note: Flows cannot be exported to or imported from folders that are shared such as
the Desktop folder and the Downloads folder. This is also the case for folders that are
redirected from shared folders.

References to external files

If a flow which contains a link to an external file (for example an XSLT stylesheet) is exported,
both the location of this file and the file itself are stored inside the flow file.

When the flow is imported again, Switch will search for this file in the same location. However,
if the external file is not available (e.g. because the flow is imported on another system, which
doesn't have this file), Switch will use the file that is stored in the flow and link the value of the
property to that file.

Tip: To make sure flows are kept in sync on different computers, we recommend copying
all external files to all systems. This way, you don't have to worry about files stored in the
internal Switch structure.

For more details, refer to Compatibility considerations on page 233.
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Exporting a flow or a flow group

To export one or more flow or flow groups

1. Inthe Flows pane, select the flow(s) or flow group(s) concerned.
2. Do one of the following:

« From the menu, select Flow > Export Flow(s)...
« Right-click the selected flow(s) and choose Export Flow(s)...

Click | "| and select Export Flow(s)...

3. Choose a location and a name (in case of a single flow) or a destination folder (in case of flow
groups or if you selected more than one flow).
The selected flows and flow groups are exported and saved in the chosen location. If you
have exported several flows, the flows are saved in the destination folder, one file per flow,
and they are named after the flow. For example, a flow called DemoFlow will result in a file
called DemoFlow.sflow.

Flow groups are saved with file extension "sflows", for example CustomerXflows.sflows.

Exporting all flows in the Flows pane (for a backup)

Use this function if you want to create a quick backup of your flows, being sure that all flows are
exported.

To export all flows in the Flows pane
1. Do one of the following:

« From the menu, select Flow > Export all....

In the Flows pane, click | '| and select Export all....

2. Select a destination folder.
The flows are exported and saved in the chosen location. The grouping structure of the flows
in the Flows pane is not exported. There is no way to do this.

Importing a flow or a flow group

To import one or more flows from an external ".sflow" file (in case of single flows) or ".sflows" file
(in case of flow groups)

1. Determine where you want your flow(s) or flow group(s) to be placed in the Flows pane.

The flow(s) /flow group(s) will be placed at the same level as the flow that is have currently
selected. If no flows are selected, they will be placed at the root level (highest level).

2. Do one of the following:

« From the menu, click Flow > Import Flow....
« In the Flows pane, right-click somewhere and choose Import Flow....
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In the Flows pane, click ‘_'/ and select Import Flow....
3. Select the external file(s) you want to import.

You can select multiple files at the same time by holding down the Ctrl or Shift key.

4. Click Open.
If problems occur, a message will appear, for example to warn you about unsupported flow
elements (See Importing a flow with unsupported flow elements on page 232).
If everything goes well, the flow(s) or flow group(s) will appear in the Flows pane. The
hierarchy and the order of the flows in the the flow groups are preserved.

Alternative ways to import files:

Alternatively you can locate the external ".sflow(s)" file using the Windows Explorer (on Microsoft
Windows) or Finder (on Mac) and:

« Double-click the file; this will launch Switch if it is not yet running and import the flow or flow
group.

« Drag and drop the file onto the Flows pane in Switch; this will import the flow or flow group.

Importing a flow with unsupported flow elements

When you import a flow in which some of the flow elements are not supported by the current
configuration of Switch (for example, the flow element may belong to a module which you have
not licensed), the following message will be displayed:

® Switch Server

Problems found during flow(s) import. Press "Show" for details.

Warning : Flow object 'Word' of type 'Microsoft~Word' is invalid:
the required flow element is not loaded because 'Configurator
Module' is not licensed

Warning : Flow object 'Adobe lllustrator' of type 'lllustrator’ is
invalid: the required flow element is not loaded because
'Configurator Module' is not licensed

When you click Close in the above dialog box, the flow is imported along with the unsupported
flow elements, but the unsupported flow elements will display a small triangle with an
exclamation mark. When you hover your mouse over this triangle, a pop-up also displays the
message about the unsupported flow element.
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4.2.5.8.

Compatibility considerations
When exporting a flow, Switch stores a maximum amount of information in the exported flow file:

« The list of flow elements and connections as they are shown in the canvas, including the
geometry.

- The values of all properties, including references to backing folders and configuration files
- A copy of any referenced configuration files.

Sometimes a property value refers by name to configuration data stored internally by a third-party
application. In those cases it is not possible to include the configuration data itself (the reference
by name is still included).

When importing a flow, Switch ensures that all encountered flow elements and properties

are supported by this version of Switch. If not, any issues are reported to the user and the
unsupported items are omitted from the imported flow. Switch also copies configuration files from
the flow file being imported into a special location under its application data root, and changes
the corresponding references to point to these new copies.

Further validation of property values is performed when the flow is activated (for example,
ensuring that all backing folders have a valid path).

Auto-managed backing folders are automatically created where necessary. For user-managed
backing folders the original paths are preserved without change. In most cases this means that
you must create and assign new backing folders (i.e. unless the backing folders already exist
because you are importing a flow that was previously created on your own system).

Generating flow documentation

For a good overview of a flow and its flow elements, it may be handy to generate an HTML page
that contains all this information. You can afterwards save this HTML as PDF (using the print
function of your browser) as required.

To generate flow documentation

1. Inthe Flows pane, select the flow(s) for which you want to generate the documentation.

Note that it is also possible to generate documentation for all flows in one go. To do so, no
need to select anything, just select Flow > Document all.

2. Do one of the following:

In the toolbar at the top of the screen, click Pecument fiow
« Inthe Flows pane, right-click and select Document Flow(s).
« From the menu, select Flow > Document Flow(s).
The flow documentation is generated and shown immediately in your default browser. It
provides you with details of the flow itself (e.g. name and description, if a background image is
used, ...), a graphical representation of the flow (as shown on the canvas), and an overview of all

properties of all flow elements. Note that you can click the elements in the flow image, to see the
corresponding properties. The arrow allows you to return to the top of the HTML page.
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4.2.6. Monitoring flows

4.2.6.1. Viewing an active flow

Active flows are flows which have jobs that are currently being processed by the Switch Server.
The active state is indicated by the icon next to the flow name in the Flows pane, and by the

darkened background in the canvas. See Activating and deactivating flows on page 229 and
Flows pane on page 86.

While executing a flow the canvas provides visual feedback about the number of jobs residing in
each backing folder, and about problem jobs and problem processes, as described in this topic
below.

More extensive feedback about flow execution is provided elsewhere; for more information see:

« Viewing log messages on page 240
« Viewing processes in the Progress pane on page 247

« Viewing flow problems in the Dashboard pane on page 247

Number of jobs

When a flow is active, the canvas attaches a small rectangle to each flow element that has a
backing folder, as shown above. The number in the rectangle reflects the number of jobs residing
in the flow element's backing folder.

For performance reasons Switch stops counting at 100 jobs. When a backing folder contains 100
or more jobs, the rectangle displays the symbol for infinity.
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Scanning user-managed folders and checking Mail / FTP

Switch automatically scans the contents of user-managed folders and checks Mail and FTP
in an active flow at regular intervals. The interval between scans is governed by global user
preferences; see Switch preferences: Processing on page 43.

When testing a flow it is sometimes impractical to wait for the next interval scan. Therefore,
when a flow is active, you can use an option in the context menu to immediately scan the folders
concerned:

« The Scan now context menu for Folder and Submit hierarchy elements causes Switch to
immediately scan the corresponding folder.

« The Check now context menu for Mail Receive and FTP receive causes Switch to immediately
check for jobs arrived by mail or FTP .

« The Scan folders now context menu for the canvas causes Switch to immediately scan all
backing folders in the currently displayed flow.

« The Check FTP now context menu for the canvas causes Switch to immediately check for
arrived jobs with all FTP receive flow elements in this flow.

« The Check Mail now context menu for the canvas causes Switch to immediately check for
arrived jobs with all Mail receive flow elements in this flow.

Problem jobs

Problem jobs

When the Problem jobs flow element contains at least one problem job, it displays a red error
mark as shown above. This feedback is provided for both active and inactive flows.

See also Handling problem jobs on page 252.

Problem processes

ny

In Acrobat Professional Cut

When a flow is active, flow elements that correspond to a problem process display a red error
mark (as shown above for FTP send). This feedback is provided only for active flows since, by
definition, an inactive flow can't have problem processes.
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4.2.6.2.

See also Handling problem processes on page 253.

Putting connections on hold

Most connections offer a Hold property. If this property is enabled, jobs are not allowed to move
through the connection. This is mostly used to temporarily hold jobs (for example because there
is a problem with a process downstream).

The canvas displays connections on hold as an orange dashed line.

Although editing in the Properties pane is disabled while a flow is active (see Activating and
deactivating flows on page 229), the status of the Hold jobs property can be modified at any
time through the context menu of the connection.

Note: Note that, when the flow is running while you're putting a connection on hold, the
jobs that are already present in the folder just before the 'on hold' connection will still
move through the connection. The reason is that those jobs, although visually still present
in the folder, are already being moved by Switch in the background.

Putting a connection on hold

Sometimes it's useful to temporarily hold jobs, i.e. stop them from moving through the connection,
for example because there is a problem with a process downstream.

To put a connection on hold
1. Select the connection in the canvas.

2. Do one of the following

« Right-click the connection and select Hold.

Note: This works, even if the flow is active. Note that jobs already present in the
input folder (the folder just before the connection) when enabling this setting will
still move through the connection.

- Inthe Properties pane, set the value of the Hold jobs property to Yes.

Note: This does not work if the flow is active.

In some cases, a (partial) hold is not possible, for example because jobs are moved under
an external application's control. In other cases, if setting one connection on hold, all other
connections originating from the same tool are automatically set on hold as well.

For more information, refer to Examples of connections on hold on page 238.

Once put on hold, the connection is displayed in the canvas as an orange dashed line.
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(o]
L2 PDF Files
Input folder
(1)
s
»
Al other files

When the flow is active, the icon in the Flows pane that refers to the flow state will change from

to to indicate that one or more of the connections are put on hold. Refer to Flows pane on
page 86.

Releasing a connection

If a connection is set on hold, no jobs can move through the connection, until the connection is
released. The connection is displayed in the canvas as an orange dashed line.

To release a connection
1. Select a connection in the canvas.

2. Do one of the following

« Right-click the connection and select Release.

Note: This always works, even if the flow is active.

« Inthe Properties pane, set the value of the Hold jobs property to No.

Note: This does not work if the flow is active.

In some cases, if releasing one connection on hold, all other connections originating from
the same tool are automatically released as well. For more information, refer to Examples of
connections on hold on page 238.

The connection is displayed in the canvas as a continuous line. The color depends on the
color set in the Color property of the connection (blue in the image below). The default color
is gray.
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g Note: It is also possible to release all connections in one go, using the Release all option
in the context menu of the canvas.

Examples of connections on hold

Hold job example

In this example, the Hold job flow element is used to distribute jobs evenly across three printers.
The connections for printers A and B have been put on hold because the printers are temporarily
off line. This causes the Hold job to send all jobs to printer C.

Folders example
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Copy A

Input

Copy B

In this example, the connections are set up to duplicate the incoming job (one copy in each
output folder). When the first connection is put on hold, the copies for that connection are held
in the input folder until the connection is released. The copies for the other connection proceed
without interruption.

FTP receive example

o]
Folder 1
I-T;J
FTP receive
o]
Falder 2

In this example, file filters have been set up for the connections leading from the FTP receive tool.
PDF files are sent to Folder 1 and all other jobs are sent to Folder 2.

When the PDF files connection is put on hold, the other connection is automatically put on
hold as well, effectively disabling the FTP receive tool. The connections are linked in this respect
because implementing a "partial hold" on the remote connection would be tricky.

Once the connections are on hold, maintenance can happen on the FTP server without affecting
the rest of the flow.

Traffic light example
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Data

Pa

Input Export metadata

Logs

Traffic light connections carry data or log information for the same job, so it does not make sense
to put a single connection on hold independently. When one of the connections is put on hold,
all other connections are automatically put on hold as well, effectively disabling the originating
tool.

Generic application example

o)
Output A
2] D
Input Application
2]
QOutput B

In this example, the Generic application tool is used to integrate an external hot folder
application in the flow. The connections can't be put on hold because the jobs are moved under
the external application's control.

4.2.6.3. Viewing log messages

This topic describes how you can open the log messages overview from within Switch.
Alternatively, the message overview can be opened through the Switch Web Portal (see: Viewing
log messages through the Switch Web Portal on page 272).

To view the log messages
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In Switch, do one of the following:

« Click View > Messages.

« Press F6.

« Click the Messages button in the Switch toolbar.

Depending on the configuration in the User interface category of the Switch preferences,

the messages view will open either inside Switch Designer or outside Switch, in a browser
window. In both cases, the message overview contains the same information.

You can now show more messages or filter out the messages you're not interested in, or export
the messages to a csv file. Refer to Filtering log messages on page 244 and Exporting log
messages on page 246.

The Messages overview
This topic describes the Messages overview.
You can open this overview

« Through the Switch Web Portal.

« From within Switch, by clicking the Messages button in the toolbar of the Switch Designer.
Alternatively, you can press F6 or select View > Messages.

Note: If opened from within Switch, it's possible to have the messages shown inside
the Switch Designer (For more info, refer to User interface category of the Switch
preferences ("Render HTML in Designer")).

Buttons and menus

The table below explains the meaning of the main buttons, labels, icons and menus in the
Messages overview.

(5]
. -
Messages Vi ' '
. esterday v
.
1427
Message contains PitStop Server Message contaings ScriptExecutor
m - {:j Message ~ containg
Time Flew Jobs Element f+
':\n\ll.'hS:I'lpl'—_)t'Cl.'.O' process with 10 13112 has been '\Ilp:h!d because it has been inactve
133500 for 1846 seconds. PrOcessing 1S not affected: a new SWitehSoripiEsecutes prodess will be

Button/menu Description
Yesterday Indicates the date(s) on which the shown messages were
issued, and allows you to select a different date or date
range.

: Show messages of the previous day

: Show messages of the next day
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Button/menu Description

~ : Show messages of a particular date or date range.
You can also choose "Full history", i.e. all messages
since the last message cleanup (as defined in the Switch
preferences (Application data category)).

Indicates the time frame in which the shown messages were
issued. You can move the blue arrows to enlarge or reduce
the time frame.

1 i

[

The red vertical lines represent error messages. This way you
can immediately see when error messages were issued.

Message contains PitStop Server The applied filters are listed right above the Search field.
When two different filters are applied, all log messages
Message containg ScriptExecutor that match one of the strings are shown (in this example:

messages that have "PitStop Server" OR "ScriptExecutor" in
the description).

Message = contains ] This part of the overview allows you to configure filters, to
select messages that contain certain strings (in the message
itself, in the name of the flow, the name of the job, ...) Refer to
Filtering log messages on page 244.

ﬂ Opens a menu with the following options:

- Flow, Job, Module, Element, Prefix: Refers to the
columns in the overview. Click to hide or show columns as
required.

+ Reset view: Allows you to reset the columns to their
default size and position: only Flow, Job and Element are
shown by default.

« Export: Allows you to export the filtered log messages to
a .csv file. You can either open the file or save it locally.

« Clear all: Allows you to remove all log messages from the
log database. Note that there is no undo for this action!

o - | Error - | - | Message types, indicating the severity level of the message.

If colored, the messages of that type are displayed in the
overview, in a background with the corresponding color. In
the example, info, warning and error messages are shown,
whereas debug messages are hidden (default). You can click
a message type to switch from hidden to shown and vice
versa, or you can click the arrow to the right, to only show the
messages of that particular type.

Note: Info messages are displayed in a white and
gray background.

Note that the Debug button also shows or hides assert
messages. See also the table below (Message types).
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Button/menu Description

,:*J By default, the page refreshes automatically, so you always
have an up-to-date overview.

You can turn off this option by clicking the auto refresh button

r:_; , which will turn into a blue arrow "

Columns
The following table describes the columns in the Messages overview.

Remember that you can hide columns as required via the icon % just below the search field. It's
also possible to resize the columns.

Column Description

Time Time when the message was triggered.

Flow The name of the flow that triggered the message.

Job The name of the job for which this message was issued.

Module The Switch module (such as Control) or type of flow element (such as folder,

Mail receive, ...) that triggered the message.

Element The name of the flow element that triggered the message.

Prefix The unique name prefix of the job referred to in the message, or blank if there
is no unique name prefix.

Message The message itself.

Message types

The following table describes the different types of messages that can appear in the Type column
of the Messages overview.

Type Description

Info An informational message that has no other purpose than to inform the user of
a certain occurrence.

Info messages are always shown in the Messages overview (unless a filter is
applied).

The Messages overview displays all types of info messages (related to Switch
Server and to Switch Designer).

Warning A warning message that informs the user of a recoverable problem or non-fatal
error.

Warnings are always shown (in orange) in the Messages overview (unless a
filter is applied).
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Type Description

Error An error message that informs the user of a fatal error.

Errors are always shown (in red) in the Messages overview (unless a filter is
applied).

Debug An informational message solely intended for debugging purposes (often
generated by apps).

Debug messages are not shown by default. If the Log debug messages
preference is enabled, you can display them using the Debug message type
filter.

Refer to Switch Preferences: Logging.

Assert A message solely intended for debugging purposes that is issued only when a
coding error is discovered.

Assert messages are not shown by default. If the Log debug messages
preference is enabled, you can display them using the Debug message type
filter.

Refer to Refer to Switch Preferences: Logging.

Note: Scripters have access to all messages, to be able to debug their scripts.

Filtering log messages

By default, all info, warning, and error messages issued on the current date are shown in the
Messages overview. You can however change this and only display the messages you're
interested in.

To filter the log messages

1. Pick the date(s) of which you want to see the messages.

By default, today's messages are shown.

To ... Do the following ...
Show messages of the previous day Click
Show messages of the next day Click

Show messages of a particular date or
date range

Click ~

Show messages of a particular date or

Click » and select the appropriate option from
date range

the menu:

« Today

+ Yesterday
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To ... Do the following ...

+ Choose date(s): Opens a calendar. Click the
date you want to select. In case of a date range,
click the first and the last date.

- Full history: Displays all messages since the last
messages cleanup (as defined in the Switch
preferences (Application data category)).

2. Pick the appropriate time frame:

- To indicate the start time, click the blue indicator to the left of the slider and drag it to the
time of your choice.

- Toindicate the end time, click the blue indicator at the right of the slider and drag it to the
time of your choice.

By default, the messages of the current date are shown. The blue part indicates the currently
shown time. The red vertical lines indicate when time error messages were issued.

Note: If the end time is not the current time, the auto refresh is disabled and the auto
refresh button will turn into a blue arrow. If you click this blue arrow, auto refresh is
turned on again and the end time is reset to the current time.

3. Pick the type of messages you want to see in the overview:

« Click the name of the message type to show or hide it in the overview. If the name is
shown in a colored background, the messages are shown in the same background color, if
the name is shown in white, the messages are hidden. Note that info messages are shown
in a white and gray background.

« Click the small arrow next to the message type to open a menu with two options:

. Hide messages of this type
« Only show messages of this type

By default, all types except for debug messages are shown.

4. Set afilter as required:

a. Select the column in which you want to search for a particular string. If the column doesn't
matter, choose Any.

b. Inthe search field, enter one or more strings to only view the messages that contain
those strings. The case of the entered strings is not taken into account.
Press enter or click the button.

The filter is applied immediately. The messages that match the filter are shown, and the
filter definition is displayed just above the filter field.

Remarks:

- Alternatively, you can select a string somewhere in the overview and click Search this
(which appears automatically). The filter is configured and applied automatically.

Example:
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Switch

Search this

Switch5criptExecutar process with 1D 2785 has been

Resulting filter:

Message contains SwitchScriptExecutor ID 1383
To view messages that contain several strings in one entry (e.g. configurator AND
workflow), type those strings in one filter field.

Message contains configurator workflow

To view messages that contain either string x or string y (e.g. configurator OR workflow),
type those strings in two different filter fields (see screenshot).

Message contains configurator Message contains workflow

5. To clear a filter, click the cross button in the filter label.

Alternatively, to clear all filters at once, click the Messages : button and choose Reset
current filter.

The label is removed and the messages overview is updated immediately.

6. To save your filter, so you can reuse it later on, proceed as follows:

o0 T o

Note: This is not possible when you open the Messages overview in Designer (this is
a beta feature in the User interface category of the Switch preferences (last setting))

Click the  button.
Click Save current filter.
In the dialog that pops up, enter a meaningful name for the filter.

Click Save.
The new filter is added to the sidebar under "Messages". Note that you can delete it

anytime (via the button { next to the name of the selected filter).

Exporting log messages

Log messages can be exported to a CSV file for processing by third-party tools. If you have set
filters, these filters are taken into account; only the messages that are shown will be exported to a

file.

To export log messages

1. Open the Log messages overview.

2. Click the icon £ below the search field.
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4.2.6.4.

4.2.6.5.

3. Click Export.
A log.csv file is created.

Clearing log messages

Log messages are stored in a database on disk and thus remain available after quitting and
restarting Switch. The application data preferences determine for how long messages are
retained.

To permanently clear all log messages

1. Open the Log messages overview.
2. Click the icon & below the search field.

3. Click Clear all.
A confirmation dialog appears. If you click Clear, all messages will be removed from the log
database. Note that there is no undo for this action!

Viewing processes in the Progress pane

The Progress pane displays a list of currently executing processes (for all active flows) with their
progress information.

Concurrent processes

Depending on the value of the processing preferences, there may be more or less concurrent
processes.

Stopping and starting processing
« To cause the Switch Server to stop processing, choose File > Stop processing.
« To resume processing, choose File > Start processing.

When you stop processing, operation of all active flows is halted and flows are de-activated
temporarily. When you subsequently start processing, all active flows are simply resumed.

To stop processing is sometimes useful while designing and testing a flow that interacts with
a third-party application. Stopping processing suspends Switch's interaction with the external
application (and with the file system), so that you can, for example, change a setting in the
external application without the need for deactivating the flow.

When in doubt, deactivate and reactivate the flow rather than stopping and restarting processing.

Viewing flow problems in the Dashboard pane

The Dashboard pane (displayed by clicking View > Show panes > Dashboard) displays an
overview of current flow execution problems at any given time. This is in contrast with the
Messages overview, which provides an audit trail of what happened in the past.

Furthermore, the Dashboard allows relevant actions to be taken for certain problem types, such
as retrying a problem job.
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Wrap text

Switch

=] Dashboard
Time stamp ~  Module Flow Flow object Job prefix Job

v (B  Jobs-145
16/05/2022 1... | Folder Receive and ... | Al files 0OOMM Switeh |
16/05/2022 1...  Folder Receive and ... | All files OOOML Switch |
16/05/2022 1... | Folder Receive and ... | All files OOOMK Switch |
16/05/2022 1... | Folder Receive and ... | Al files 00oMJ Links
16/05/2022 1... | Folder Receive and ... | Al files 0OOMI Documit
16/05/2022 1...  Folder Receive and ... | All files OOOMH PitStop
16/05/2022 1... | Folder Receive and ... | All files COOMG PitStop
16/05/2022 1... | Folder Receive and ... | Al files OOOMF FitStop
16/05/2022 1... | Folder Receive and ... | Al files 000ME Links
16/05/2022 1... | Folder Receive and ... | Al files OOOMD Documt
16/05/2022 1... | Folder Receive and ... | Al files 000MC Links
16/05/2022 1... | Folder Receive and ... | Al files OOOME Documi
TRINARIZNIZ 1 | Faldar Recaiun and | All filae NONMA Raarein

Prograss

To display long messages on multiple lines (i.e. "wrapped" rather than chopped off), choose the
"Wrap text" menu item in the context menu of the Dashboard pane.

Problem categories

Switch distinguishes in the Dashboard pane between problem jobs (which cannot be processed
because of an issue with the job itself) and problem processes (where jobs cannot be processed
because of a general issue with the process). Processes are further divided in file transfers and

external processes.

Category

Description

Switch action

Problem job

A process failed to handle this job because
of an issue that does not affect other jobs;
human intervention is required for this
specific job but processing can continue for
other jobs.

Move the problem job to the
Problem jobs folder

See Handling problem jobs on
page 252

File transfer

A Mail, FTP or local network operation
cannot transfer any jobs because

there is a communication problem;

human intervention may be required, or
communication may be restored "by itself".

External
process

A built-in tool (such as Compress), a

script or a third-party application under
the control of an app cannot continue
processing jobs due to a problem with the
process; human intervention is most likely
required.

Make all jobs in front of the
process wait "inline" in the flow
until the problem is resolved

See Handling problem
processes on page 253

Information in the Dashboard pane

The information in the Dashboard pane is updated dynamically. A problem item appears as soon
as it is detected and disappears as soon as the problem is solved or handled.
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Rows

The Dashboard pane shows a header row for each problem category indicating the number of
items in the category. The triangle in front of the header row serves to expand or collapse the
category. The items in each category may be grouped per flow; grouping can be turned on and
off for all categories at the same time through the Grouping on menu item in the Dashboard
context menu.

Group nodes, if present, are sorted on flow name. The order in which items are sorted within
each group (or within the category if there are no groups) can be configured by clicking the
column headers in the table.

Columns

The following table describes the columns in the Dashboard pane. You can resize and reorder
the columns by dragging the column headers.

Column Description
Time stamp The moment in time when the problem was detected.
Module The Switch module (such as Control) or type of flow element from

which the problem originated.

Flow The name of the flow in which the problem originated (this column is
absent when grouping is turned on).

Flow element The name of the flow element from which the problem originated.

Job Prefix The unique name prefix of the job referred to in the message, or is left
blank if there is no unique name prefix.

Job The name of the problem job, or the name of the job for which the
process problem was detected, or blank if there is no job context.

Message A message that describes the problem.

Researching problems

The Dashboard pane offers assistance with researching a problem through the following context

menu items:

Context menu item Description

Show flow element Causes the canvas to select the flow and the flow element listed in the
selected problem item.

Show job Causes the canvas to select the flow and the flow element in which
the job listed in the selected problem item currently resides (i.e. a
problem jobs folder for the "jobs" category and a regular folder for the
other categories).
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Context menu item Description

Causes the files pane to show the backing folder of the previously
mentioned flow element, and to select the job under consideration.

Retrying problems

The Dashboard pane offers assistance with retrying a problem through the context menu items
described in the following table. For more information on retrying problems, refer to Handling
problem jobs on page 252 and Handling problem processes on page 253.

Context menu item Description
Retry item Retries the job or process associated with the selected row.
Retry group For a group row, retries all items in the associated group.

For an item row, retries all items in the group that contains the
selected row.

Retry category For a category row, retries all items in the associated category.

For a group or item row, retries all items in the category that
contains the selected row.

4.2.6.6. Viewing statistics

About Statistics in Switch

Switch allows you to collect information on how long jobs reside in certain folders or states while
being moved along a flow. This can be useful to identify performance bottlenecks.

There are two types of statistical data:

« Folder statistics calculate the average time jobs reside in a folder for which statistics have
been enabled.

. State statistics calculate the average time jobs reside in a particular state. A state can be
attached to a job folder via the Folder property "Attach job state", and allows you to combine
information about several folders having the same function, for example "coming in" or "in
progress".

Statistics are not limited to a single flow: Switch combines all statistics-enabled folders from all
active flows in a single set of statistics. If two or more folders (used in different flows) have the
same name, the statistics for these folders are combined in one single entry.

Tip: To receive meaningful results, we recommend calculating statistics only for folders
leading to heavy processes, i.e. processes forming a potential bottleneck for resources,
such as CPU time or communication bandwidth.

Setting up statistics

« To gather Folder statistics, you must enable the Show in statistics property of the folder
concerned.
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« To gather State statistics, you must fill out the Attach job state property of the folder
concerned.

You can only gather statistics for a folder that has outgoing connections. Folders at the end of the
flow do not have the Show in statistics and Attach job state property, because Switch has no
control over the time the jobs reside in such a folder.

Remark

« In case of Folder statistics, the calculated time is the queuing time between the moment the
job is detected and the the moment the job is handed over for processing on an outgoing
connection.

- In case of State statistics, this is the queuing and processing time between two different job
states. Note that, due to the fact that statistics are only logged when the job state changes,
it is necessary to introduce an extra dummy state (which will never be logged) at the end of
the last flow element of interest or just before the last folder of the flow (as the last folder has
no Attach job state property, hence the job state cannot change). In the following example,
the time spent in the "Set to MyState" includes the queuing time in the first folder and the
processing time in the generic application ("Process"). The second folder was introduced to
change the job state to a dummy value.

|

Set to MyState Process Set to Dummy Output

Note: The time during which a job is blocked (e.g. because the relevant flow was not
active or Switch was not running) is also included in the statistics.

Displaying statistics

m

To display the Statistics pane, click sat= in the Switch toolbar or go to View > Statistics.

Important: Do not forget to refresh the statistics ( by selecting View > Refresh Statistics
), to make sure the most recent information is displayed.

You can display up to three statistics panes (by clicking View > Show panes > Statistics 2 or
Statistics 3) at the same time. This allows you to display a second and third set of statistics (e.g.
sorted in a different way).

For more information about this pane, refer to Statistics pane on page 90.
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Resetting statistics

To remove the collected information, i.e. to set all counters to zero, go to View > Reset Statistics.
Switch will start gathering statistics from scratch.

4.2.7. Handling execution problems

4.2.7.1. Handling problem jobs

While executing a flow, Switch executes processes and moves jobs between processes
according to the specifications in the flow definition. However there are situations where a
process fails to handle a job properly and it no longer makes sense for the job to move along the
flow in its usual fashion. In those cases, Switch moves the job to the Problem jobs folder, a central
location for jobs that require human intervention.

Important examples of why a job may be moved to the Problem jobs folder include:

« The job has an invalid file format causing a third-party application to issue a fatal error
message.

« The job matches none of the file filters set on the outgoing connections of a particular folder.

Switch offers a number of facilities for handling problem jobs, from detecting their presence to re-
injecting them in the flow after the problem has been resolved.

Detecting problem jobs
There are various ways to detect the existence of problem jobs in Switch:

« The Problem alerts user preferences allow specifying that a notification email should be sent
to the system administrator when a job is moved to the Problems folder.

« The Problem jobs flow element can be placed on the canvas right inside a flow design; its icon
displays a red error mark when there are problem jobs present (see Viewing an active flow on
page 234).

« The Dashboard pane displays an overview of the current problem jobs at any given time. See
Viewing flow problems in the Dashboard pane on page 247.

Researching problem jobs
Switch assists with locating and researching problem jobs in various ways:

«  When you select the Problem jobs flow element in the canvas; the Jobs pane displays a list
of the problem jobs (for this flow or for all flows depending on how the Problem jobs flow
element is configured).

« The context menu for the Dashboard pane provides options to locate the flow element
causing the problem in the canvas, and to show the problem job in the Jobs pane. See
Viewing flow problems in the Dashboard pane on page 247.

« The Messages overview shows all messages issued by Switch and the processes under
its control; use the overview's filtering capabilities to pinpoint the messages issued for the
problem job or by the process(es) involved in the problem; this may provide some context
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in case the problem was really caused by an occurrence further upstream. See Viewing log
messages on page 240.

Retrying problem jobs

When Switch moves a job to the Problem jobs folder, it remembers the original location of the
job in its internal job ticket. This makes it possible to move the job back to the location where it
left the flow for another attempt at successful processing, without losing any of the job's history
(which is also stored in the internal job ticket). The process of moving the job back in the flow is
called retrying the job.

It is meaningful to retry a job only after you have fixed the problem (or at least believe you did) by
reconfiguring a process, adjusting the flow design, or tweaking the job itself.

Note: Leave the job in the Problem jobs folder and leave its file name intact (including
unique name prefix and file name extension); if you change the location or the file name
Switch may lose the connection with the job's internal job ticket and it can no longer retry
the job.

Retry flow

Switch offers various ways to retry a job:

«  When you select the Problem jobs flow element in the canvas (and if it contains problem
jobs), the Retry button in the tool bar is enabled. Click the Retry button to retry all jobs in the
selected Problem jobs flow element.

« The context menu for the Problem jobs flow element also offers a Retry all jobs option.

«  When the Jobs pane displays a list of problem jobs (because the Problem jobs Flow element is
selected), its contextual menu offers a Retry job option that retries only the selected job(s).

« The context menu for the Dashboard pane provides options to retry one or more of the listed
jobs. See Viewing flow problems in the Dashboard pane on page 247.

Handling problem processes

While executing a flow Switch causes processes to be performed and jobs to be moved between
processes according to the specifications in the flow definition. However there are situations
where a process is no longer able to continue processing jobs due to some problem with the
process itself. In those cases, Switch makes all jobs in front of the process wait "inline" in the flow
until the problem is resolved (it makes no sense to move these jobs to the problem jobs folder
since there is nothing wrong with the jobs).

Important examples of why a process may fail include:

- There is a network communication problem so jobs can no longer be transferred.
« A property for the process is set to an improper value (Switch attempts to detect invalid
properties when a flow is activated but this can never be foolproof in all cases).

Switch offers a number of facilities for handling problem processes, from detecting their presence
to re-enabling them once the problem has been resolved.
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Detecting problem processes
There are various ways to detect the existence of problem processes in Switch:

- The Problem alerts user preferences allow specifying that a notification email should be sent
to the system administrator when communication (Email, FTP, local network) is down for more
than a specified time, or when an external process fails.

« The flow element corresponding to a problem process is shown in the canvas with a red error
mark, providing obvious feedback on its problem state (see Viewing an active flow on page
234).

« The Dashboard pane displays an overview of the current problem processes at any given
time. See Viewing flow problems in the Dashboard pane on page 247.

Researching problem processes
Switch assists with locating and researching problem processes in various ways:

« The context menu for the Dashboard pane provides options to locate the flow element
causing the problem in the canvas. See Viewing flow problems in the Dashboard pane on
page 247.

« The Messages overview shows all messages issued by Switch and the processes under
its control; use the overview's filtering capabilities to pinpoint the messages issued for the
process(es) involved in the problem; this may provide some context in case the problem is
caused by interrelated processes. See Viewing log messages on page 240.

Retrying problem processes

The process of re-enabling a process (or at least attempting to do so) is called retrying the
process.

It is meaningful to retry a process only after you have fixed the problem (or at least believe you
did) by reconfiguring the process, adjusting the flow design, or resolving any relevant issues
outside of Switch.

Automatic retry

The Error handling user preferences allow automatically retrying a problem process after a
specified time interval. Separate values can be specified for different categories of processes.

Automatic retry is especially meaningful for communication processes since a network problem is
often resolved by external influences.

Manual retry
Switch offers various ways to manually retry a problem process:

«  When you select the flow element in the canvas that corresponds to a problem process, the
Retry tool button is enabled. Pressing the Retry tool button retries the process.

« The context menu for the flow element in the canvas that corresponds to a problem process
also offers a "Retry" menu item.
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« The context menu for the Dashboard pane provides options to retry one or more of the listed
processes. See Viewing flow problems in the Dashboard pane on page 247.

+  When you deactivate and reactivate a flow, all of its problem processes are implicitly retried.
« When you quit and restart Switch, all problem processes are implicitly retried.

4.2.8. Advanced topics for running flows

4.2.8.1. Scheduling jobs

Objectives for scheduling jobs

The Switch job scheduler has the following (sometimes conflicting) objectives, in order of
importance:

« Maximize overall throughput, that is, process as many jobs as possible in a given amount of

time.

« Allow users to specify individual job priorities: a task for a job with a higher priority should be
executed first. This can be used to "rush" a particular job through a flow, or to define a high-
priority flow (by assigning a priority to all jobs in the flow).

« Process jobs in order of arrival, that is, jobs should arrive at the end of a flow in the order they
were placed in the flow to begin with (FIFO = first-in/first-out).

These objectives are not absolute: enforcing some particular order of execution to the letter
would sacrifice throughput and/or overly complicate the implementation.

Internal job ticket
To support these objectives, the internal job ticket for each job stores the following fields:
- Job priority: a signed integer number that determines the priority of the job; a higher number

indicates a higher priority; the default priority is zero.

- Arrival stamp: an unsigned integer number that indicates the order in which this job first
arrived in a flow, as compared to other jobs.

Execution slots

The scheduler manages a number of slots in which tasks can be executed in parallel. The
maximum number of concurrent slots is determined for each category of tasks as described in the
following table.

Note: For an overview of the flow elements belonging to each of these categories, refer
to Switch performance tuning on page 443.
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Task category Task types in this category Maximum concurrent slots for
this category

Disk File handling tasks, such as copying & |5
moving jobs
Network Network transfer tasks, including Determined by the value of the
FTP send/receive, Mail send/receive, "Concurrent network transfer
Checkpoint via mail. tasks" preference (See Switch
preferences: Processing on page
43)
Processor File processing tasks, executed by Determined by the value of
apps and flow elements such as the "Concurrent processing
archive, unarchive, 'heavy' scripts,... tasks" preference (See Switch
Note that light scripts belong to a preferences: Processing on page
separate category (see paragraph 43)
below).
Light script Light scripts used in the Script element | S * value of the "Concurrent
(see paragraph below) processing tasks" preference

(See Switch preferences:
Processing on page 43)

Timer Any timerFired entry point invocation Minimum: 2

Maximum: twice the value of

the "Concurrent processing
tasks" preference (See Switch
preferences: Processing on page
43)

Webhook Any webhookTriggered entry point Minimum: 2

invocation . .
Maximum: twice the value of

the "Concurrent processing
tasks" preference (See Switch
preferences: Processing on page
43)

Flow stop Any flowStopTriggered entry point Minimum: 2

invocation . .
Maximum: twice the value of

the "Concurrent processing
tasks" preference (See Switch
preferences: Processing on page
43)

PitStop Server PitStop Server tasks, executed by the | petermined by the value of

PitStop Server configurators. the "Concurrent PitStop Server
tasks" preference (See Switch
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Task category Task types in this category Maximum concurrent slots for
this category

preferences: Processing on page
43)

Within each category concurrency is further limited by the serialization needs of each task type.
Thus even when a slot is available for a particular category, a task in that category may not match
the slot because, for example, another task of the same type is already executing and the task
type has the serialized execution mode.

Light and heavy scripts
Scripts include many of the tools built-in to Switch, and all third-party script packages.

Initially a script is heavy. If its entry points consistently complete quickly (in less than 1 second for
5 consecutive times) the script becomes light, until it violates this "trust" by not completing within
1second once — it then becomes heavy again.

Scheduling tasks

The scheduler removes tasks from the task queue and schedules them for execution in one of
the available slots. The scheduler attempts to schedule a task:

. Eachtime a new task is queued (because a slot may be available that does not match the
previously queued tasks).

. Each time an execution slot becomes available because a task has completed (because there
may be a queued task that matches this slot).

The scheduler selects a task for execution by narrowing down the set of queued tasks using the
following steps:

1. Start with the set of all tasks on the queue that match any available execution slot.
2. Narrow down to tasks for jobs that have the highest job priority in the task set.

3. Narrow down to the task that was placed on the queue first.

The selection process ends as soon as the result set contains a single task (in which case the
task is scheduled for execution) or is empty (in which case no action can be taken). The last step
selects a single task so the selection process always ends.

4.2.8.2. Job priorities

The internal job ticket for each job contains a field that determines the priority of the job.

Switch stores a job queue per element type and the scheduler lets each element type take turns
to schedule a next job. Therefore:

- Priority of a job will only have an effect on the order of how jobs are processed compared to
other jobs waiting before the same element.

« Priority has no effect on the processing order of that job compared to jobs currently waiting
in other elements in the flow i.e. jobs with a lower priority in other elements can still be
processed earlier.
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Priorities are remembered when the job moves to a next element. Therefore:

« Priority of a job will also have an effect on the order of how that job will be processed
compared to other jobs in the next elements, i.e. in each element where the job arrives
afterwards, it can skip the queue this way.

«  When jobs from different elements using a different magnitude (1, 10, 100, 100K?) to
set priorities arrive in the same folder later on, jobs coming from one element will take
precedence over jobs coming from the other element. So as script writer it's not possible to
know which number to set as priority to ensure that it will also get higher priority in the rest
of the flow or what the consequence will be for further processing in the flow when picking a
certain number as priority. For this reason predefined job priority values are available to use.
For more details, refer to the Job priority section in the Switch Scripting Guide (Node.js).

A job priority is a signed integer number (in the range that can be represented with 32 bits). A
higher number indicates a higher priority. The default priority is zero; relative to the default a
priority can be higher (positive numbers) or lower (negative numbers).

A job's priority can be set through one of the properties of the folder flow element and through
the scripting API.

Arrival stamps

The internal job ticket for each job contains a field that records the job's arrival stamp.

Unless job priorities dictate otherwise, Switch processes jobs in order of arrival (if there is a
matching execution slot). Switch uses the arrival stamp to determine which job arrived first. See
Scheduling jobs on page 255.

An arrival stamp is an unsigned integer number (in the range that can be represented with 32
bits). It indicates the order in which a job first arrived in a flow, as compared to other jobs. Switch
maintains a persistent and global arrival count that gets incremented each time a new arrival
stamp is handed out. Thus a higher number indicates a more recent arrival.

Several jobs may have the same arrival stamp. This happens when multiple jobs are generated
from the same original job, or when for some reason no arrival stamp was assigned to a job.

Stamping jobs

Switch assigns a new arrival stamp to a job when it first detects the job in a folder or submit
hierarchy, or when a producer (such as FTP receive or Mail receive) first injects the job into a flow.
A job's arrival stamp is not affected while the job is moving along a flow. Results generated for a
job (such as a preflight report, or a duplicate of the job) retain the original job's arrival stamp.

In certain situations a job's arrival stamp needs to be refreshed (that is, assigned a fresh stamp) so
that the job is not unduly processed before other jobs. For example, a Checkpoint refreshes the
arrival stamp when moving a job along one of its outgoing connections.
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4.3. Working with apps in Switch

Note: This chapter applies to apps that you can buy through the Enfocus Appstore. It
does not apply to default apps that are included in the default Switch installation. See also
Flow elements pane on page 81

4.3.1. About the Switch apps - an introduction

What are Switch apps?

Apps are small applications that can be used as flow elements in Switch. They are available
through the Enfocus Appstore.

Where to find apps?

You can search for Switch apps in the Enfocus Appstore (our webshop) or from within Switch,
through the search function in the Flow elements pane. The apps matching your search results
are displayed in the bottom part, together with a link to the Enfocus Appstore, where you can buy
them and immediately use them in your flows (even without restarting Switch!). For the detailed
procedure, see Finding apps on page 262.

Purchasing apps

Apps are sold through the Enfocus Appstore. Some apps are free, some are sold for a fixed
price (traditional/perpetual license), but for most apps you have to pay a subscription fee. See
Purchasing an app on page 263. If your subscription is about to expire, you'll receive an email
and a notification in Switch. Make sure to pay the subscription fee in time, so your flows remain
valid.

Not sure if a particular app suits your needs? You can download a free trial. See Trying an app for
free on page 262.

Note: Sometimes the people who buy apps are not the people who use them. Is this
the case for you? Make the person who buys the apps a "Switch manager" of the Switch
installation on which the app will be used. See Adding a Switch manager on page 267.

Using apps on different Switch installations

Apps are linked to a Switch installation. You can however assign an app to a different Switch and
use it there without having to buy an additional license. If you want to use your apps on different
Switch installations at the same time, you need of course multiple licenses.

For more details, refer to see Assigning an app to a different Switch installation on page 266.

New versions

As soon as there are new versions of the apps you have purchased, you'll receive a notification in
Switch and you're entitled to use this new version immediately. For the detailed procedure, see
Installing a new version of an app on page 264.
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Note that you're never obliged to switch to a newer version, and that you can go back to a
previous version as required.

Notifications

As soon as you start working with the Enfocus Appstore, you'll get notifications. They are
displayed in the top right corner of the application. They inform you about newly installed apps,
new versions, the status of your license (e.g. apps that are about to expire,...)

If a notification is available, you will see a "bell" icon. The number indicates the number of new
(unread) notifications that are waiting for you.

&

- Flow elements B X

E':l- json ) [_'] [g]

{Apps

Owverlay PDF

You can open the notifications by clicking the icon and closing them again by clicking anywhere
in Switch. However, if you don't want to see the message anymore, you should click the cross
icon, and the notification will disappear.

version 1.0) is available
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4.3.2. About the Enfocus Appstore

The Enfocus Appstore

The Enfocus Appstore is the Enfocus webshop where you can purchase apps for use in Switch,
developed by third-party app creators.

The Enfocus Appstore is available via https.//appstore.enfocus.com or from within Switch, by
clicking the Go to the Enfocus Appstore button in the Flow elements pane.

There you'll find an overview of all Switch apps currently available. For more information about
a particular app, simply click the logo or description. On the detail page, you can find detailed
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information about the way the app works, the required Switch version or platform, support info,
how much it costs,... Starting from this page, you can also install a free trial or buy the app.

My Apps

Information about the apps you have purchased and/or tried can be found on the Enfocus
customer portal. Just go to the Enfocus website and sign in with your Enfocus ID. You'll find 'My
Apps' in the sidebar, under Switch.

You can filter the apps by clicking the Show filters icon. Categories are:

« Unassigned apps are apps for which you have a valid license, but that are not assigned to a
particular Switch installation yet. Refer to Assigning an unassigned app on page 265.

« Assigned apps are apps that have been assigned to a Switch installation. You can assign
them to a different Switch if needed, see Assigning an app to a different Switch installation on
page 266.

« Active apps are apps that are currently in use on one of your Switch installations.

- Expired apps cannot be used anymore because the license has expired. You have to pay the
subscription fee in order to be able to use them again. To do so, click the Buy now button.

- Paying apps are apps you have purchased.

Note: The invoices for these payments can be found in the Account section, under
Billing. Just click 'Show filters' and select "AppStore".

« Free apps are free apps that you have installed.

- Trials are apps that you're trying (in that case you can see how many days of your trial are left)
or have tried in the past. ou have to pay the subscription fee in order to be able to use them
again. To do so, click the Buy now button.

My Switch

'My Switch' is another submenu of Switch. Here you can find information about the Switch
installation(s) linked to your Enfocus ID. There are two ways to link a Switch installation to an
Enfocus ID:

« When you sign into Switch using an Enfocus ID, that Switch installation is registered
automatically in the background. Note that the name mentioned in the list is determined by
the name set in the Switch preferences (Internal Communication).

« When another user wants to allow you to buy and assign apps to his/her Switch installation as
well, he can add you as a Switch manager for that Switch installation. In that case, that Switch
installation will also be linked to your Enfocus ID and you'll see it under My Switch.

Here you can also add extra Switch managers for your Switch installation: people allowed to
buy and assign apps to your Switch installation. You are automatically a Switch manager of your
own Switch (registered as such when you sign into your Switch), and you can add as many other
people as you want to, by adding their email addresses. Note that Switch managers have also
access to the Switch Insight Dashboard. See also Adding a Switch manager on page 267 and
The Switch Insight Dashboard on page 434.

The apps that can be used on your Switch are called "assigned apps". The apps that are installed
as part of the default Switch installation are called "default apps" (see Flow elements pane on
page 81). You can hide both types of apps from the overview if you want.

Note: On this page, you also find a Forget Switch installation link. Use this link only if
your Switch Server is no longer accessible, e.g. due to hardware issues and you cannot
uninstall the apps in Switch. Using this link, all apps will be uninstalled in one go and all
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flows using apps will stop running. Your apps will become available again under My apps,
and you can re-assign them to another Switch installation as required.

4.3.3. Finding apps

This topic describes how you can find an app using the search function in Switch.

Note: Alternatively, you can directly go to the Enfocus Appstore by clicking the blue Go
to the Enfocus Appstore button (at the bottom of the Flow elements pane).

To find an app in Switch

1. Inthe Flow elements pane, enter (part of) a keyword in the search field at the top of the pane.
The matching apps are shown at the bottom, in the Enfocus Appstore section.

2. To know what the listed apps can do, hover over the items in the Enfocus Appstore section
and check the tooltip.

3. For a detailed explanation, click the app in the list.
You're redirected to the Enfocus Appstore, where you get detailed information about the
app, for example a full description, compatibility and version info, the name of the author,
screenshots, the subscription fee, ... On this page, you can start a trial or buy a license. See
also Trying an app for free on page 262 and Purchasing an app on page 263.

Note: Enfocus does not offer support for apps that were developed by third-parties.
In case of problems, please contact the app creator (mentioned on the app detail
page in the Enfocus Appstore, under Support).

4.3.4. Trying an app for free

If you have found an app that is interesting to you, you can start a free one-month trial.
To start a trial

1. On the detail page of the app in the Enfocus Appstore, click the Try it for free button.
2. Sign in with your Enfocus ID and password as required.

3. Assign the app to the Switch installation that you will use to work with the app.

By default, if you have more than one Switch, the app is assigned to all your Switch
installations. If you don't want this, clear the checkbox(es) as required.

4. Click Start free trial.
The app is downloaded to the assigned Swith installation(s).

5. Do one of the following:

. If Switch is running, you can start using the app immediately by clicking the Refresh apps

button Igl in the top right corner of the Flow elements pane. This will install the app in
your local Switch.
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Note: If you don't click the Refresh apps button, the app will be installed
automatically next time you start Switch.

- If Switch is not running, next time you sign into Switch, the app is installed automatically in
the background. You don't have to do anything.

Note: If you start Switch without being signed in, the app will not be installed.

You'll find the new app in the Apps category of the Flow elements pane. Note that you'll
also get a notification to inform you that the app has been downloaded and installed on your
system.

| o | | e |
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You can now use the app just like any other flow element. You can use it in your flows, define
its properties, ... Apps also have a context menu that you can use to check the app details, to
manage your subscription, ... When your trial is about to expire, you'll get a notification. If you
want to continue using the app, you'll have to buy a license. See Purchasing an app on page
263.

4.3.5. Purchasing an app

Apps are sold through the Enfocus Appstore. Most apps are sold via yearly subscriptions, some
are free of charge.

To purchase an app

1. On the detail page of the app in the Enfocus Appstore, click the Buy now button.
2. Sign in with your Enfocus ID and password as required.

3. Follow the payment and registration instructions.

4. Assign the app to the Switch installation that you will use to work with the app.

Note:

- If you have bought several licenses for the same app, you can assign each license
seat to a particular Switch installation.
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- If you don't want to assign the app yet to a particular Switch, click .. or assign all
later. The app will not be installed locally (hence it cannot be used), but it remains
available in the Enfocus Appstore (under My apps).

5. Click Assign now.
The app is downloaded to the assigned Swith installation(s).

6. Do one of the following:

« If Switch is running, you can start using the app immediately by clicking the Refresh apps

button Igl in the top right corner of the Flow elements pane. This will install the app in
your local Switch.

Note: If you don't click the Refresh apps button, the app will be installed
automatically next time you start Switch.

- If Switch is not running, next time you sign into Switch, the app is installed automatically in
the background. You don't have to do anything.

You'll find the new app in the Apps category of the Flow elements pane. Note that you'll also
get a naotification in Switch to inform you that the app has been downloaded and installed on
your system.

| o | | e |
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You can now use the app just like any other flow element. You can use it in your flows, define its
properties, ... Apps also have a context menu that you can use to check the app details, to renew
your subscription, or to uninstall the app if you don't need it anymore. See also Uninstalling an
app on page 266.

4.3.6. Installing a new version of an app

If a new version is available, you can update the app for free (but you are not obliged to do so).
You can also downgrade as required.

Proceed as follows:

1. Do one of the following:
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«  When a new version of an app is available, you will get a notification in Switch. To get
more information about this new version, click the notification.

« Alternatively, go to the My Apps page on My Enfocus. Search the app concerned, and
click Change beside the version.

The Change Version page appears.

Select the version you would like to install.

Check the release notes and the compatibility section on the lower part of the page.
If you're sure you want to install the new version, click Change version.

Do one of the following:

If Switch is running, click the Refresh apps button ‘g/ in the top right corner of the Flow
elements pane. This will update the app in your local Switch.

- If Switch is not running, next time time you log into Switch, the app is updated
automatically in the background. You don't have to do anything.

In Switch, you'll see a dialog with information about the version change.
Click OK.

You can still cancel the update if necessary.

All flows are temporarily deactivated, the app is updated, and finally the flows are re-activated
automatically. You can go on using the updated version of the app.

4.3.7. Assigning an unassigned app

In order to use an app, it must be assigned to a Switch installation. Apps that were purchased
but not assigned to a Switch installation are "unassigned" apps. They remain available via your
account section on our website.

To start using them, proceed as follows

1.

o u & W N

Go to http://www.enfocus.com.

In the top right corner of the screen, click Sign in and sign in with your Enfocus ID.
In the sidebar, click Switch > My Apps.

Filter the apps by 'unassigned' and search the app you want to assign.

Select one of your Switch installations from the Assign to list.

Click Assign.
The app is downloaded and installed on the selected Switch device.

Do one of the following:

« Start the Switch installation selected in step 5 and sign in.

- If Switch (on the device selected in step 5) is running and you're signed in already, click
the Refresh apps button.
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The app is shown in the Apps category of the Flow elements pane.

4.3.8. Uninstalling an app

Uninstalling an app means that you remove the app from your local Switch. It will no longer be
shown in the Flow elements pane and it will no longer be assigned to your Switch device, but
it remains available in your account (under Switch > My Apps) (as long as you're paying the
subscription fee).

There may be several reasons to uninstall an app, for example:

You want to use the app on another Switch installation. In that case, you first have to unassign
it from one system and then reassign it to the other system.

You want to remove an expired app (displayed in gray in the Flow elements pane) from your
Switch.

To uninstall an app

1.

2
3.
4

Launch Switch on the device on which you don't want to use it anymore.
In the Flow elements pane, in the Apps category, search for the app you want to uninstall.
Open the context menu.

Click Uninstall.
A warning appears. Note that in case of an app bundle, all other apps belonging to that
bundle will be uninstalled as well. It's not possible to uninstall only part of the app bundle.

Click OK.
If the app is used in an active flow, the flow will be deactivated. It will not be possible
anymore to activate the flow (unless you remove the app from the flow).

4.3.9. Assigning an app to a different Switch installation

You can use an app with a different Switch installation than the one that it's currently assigned to.

To do so

1.

o u & W N

Uninstall the app you want to reassign..

The app will no longer be linked to the Switch installation on which they are currently used.
Go to http://www.enfocus.com.

In the top right corner of the screen, click Sign in and sign in with your Enfocus ID.

In the sidebar, click Switch > My Apps.

Filter the apps by Unassigned.

Assign the app you just uninstalled to the Switch installation of your choice.

Note: If it does not appear in the list, you are not a Switch manager for that
installation, so you don't have the right to assign apps. Ask the owner of the Switch
installation to add you as a Switch manager or sign into the Switch installation, to link
it to your Enfocus ID.
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7. Sign into the Switch installation selected in step 6.

If you were already logged in, make sure to click the Refresh apps button in the Flow
elements pane.

The app is listed in the Apps category and is ready for use.

4.3.10. Adding a Switch manager

If you want someone else to buy and install apps for you, you must make this person "Switch
manager" for your Switch installation.

Note that this user will also have access to the Insight Dashboard for your Switch (if enabled).

To add a Switch manager
1. Go to http://www.enfocus.com.
2. Inthe top right corner of the screen, click Sign in and sign in with your Enfocus ID.

3. Inthe sidebar, select Switch > My Switch.
Here you will see all information concerning the Switch installation(s) linked to your Enfocus
ID, such as the name, the Switch version and the Switch managers. Note that all users having
signed into the Switch installation concerned have been registered automatically as Switch
managers. You can add or remove Switch managers as required.

4. Beside Switch managers, click Edit.

5. Enter the email address of the person that should have the right to buy and assign apps to
your Switch installation.

6. Click Confirm.

The person that you have added as Switch manager will now see your Switch installation under
My Switch in the Enfocus Appstore. When this person buys apps in the Enfocus Appstore he will
be able to assign them to your Switch installation.

4.4. Using the Switch Web Portal

The Switch Web Portal allows users to access the Switch Server through a web browser. This
means that users can access the Switch Server from another computer than the one that is
running the Switch Server, without the need for a Switch Designer.

Currently, the following functionality is available:

« Viewing log messages issued by the Switch Server. This includes customizing the messages
overview (sorting, filtering, etc) and exporting and clearing messages as required.

- Viewing and finding jobs processed by the Switch Server. This includes creating your own job
board(s), which allows you to visualize the jobs present in certain flows and with certain flow
stages. If you have purchased a Reporting Module license, you can use the data on these job
boards to create dashboards with counters and graphs.

« Submitting and checking jobs, on condition that you have licensed the SwitchClient Module.

Note that users should be granted access via the Users pane.
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The connection can be encrypted as required (HTTPS); this can be configured through the user
preferences (Switch preferences: Web Services).

4.4.1. Signing in to the Switch Web Portal

To sign in to the Switch Web Portal

1. Do one of the following:

« To open the Web Portal from within Designer, click the Web Portal button in the Switch
toolbar or choose View > Web Portal. Note that this option is not available in Remote
Designer.

« To open the Web Portal in a browser, open the browser of your choice and enter the IP
address or the hostname of the computer running the Switch Server followed by ":" and
the port number for the Switch Web Portal (as set in the Switch Preferences (Web Services
category)). The default port number is 51089.

For example:

<« C A [11031.132.223:51089

Note: Google Chrome, Safari, Edge and Firefox are supported.

A login screen appears. The first time you'll see a banner stating that cookies on the site are
used to enhance the user experience.

2. Inthe banner, click Accept to allow Switch to save your preferences.
If you accept cookies, your preferences are saved by the browser. As a consequence, you
don't have to set your preferences next time you sign in; they are remembered. If you click Do
not use cookies, you can continue to work, but you will have to set your preferences again
next time you log in.

3. Enter your user name and password.

4. Optionally, select the Remember me checkbox.

This way, you don't have to log in each time you close your browser. If enabled, you remain
logged in for 24 hours.

5. Click Sign in.
The Switch Server must be running, otherwise you will not be able to sign in.
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The Switch Web Portal start page appears. What you can see and do, depends on your
permissions (as configured by the Switch administrator through the Users pane). Refer to The
Switch Web Portal page layout on page 269.

4.4.2. The Switch Web Portal page layout

The Web Portal page layout consists of 2 main parts: a sidebar menu with a number of views (1)
and a workspace (2) that shows the view that is selected and highlighted in the sidebar. In the
screenshot below, the Messages view is displayed.
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1. The sidebar menu

When you click one of the views in the sidebar menu, the sidebar expands automatically and
displays the submenu of the selected view. You can also expand or collapse the sidebar manually
(for example to have more space on your screen).
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Sidebar menu Description

@ 1. Switch logo and link to the homepage.

g Submit jobs 2. Buttons to display the different views (see below).
Check Jobs The submenu of the selected view is shown to
@ [=] the right of the buttons. In this example, the Jobs
Active:jobs view is selected (and highlighted in blue), giving
Alert jobs access to two (sub)views: Submit jobs (selected) and
_ e Check jobs. Active jobs, Alert jobs, ... are filters in
[P the Check jobs view.

My jobs

@ e Note: Your permissions determine which

(il

A and how many views you have on the
I Portal.

3. Buttons below the divider. The first one gives
access to the Admin view (only available for users
with admin rights), the second one provides extra

@ information.

° 4. Account info, displaying the first letter of your
username. Click this button if you want to change

@ « the language of the Portal or if you want to sign

out. For more information, refer to Changing the

language of the Switch Web Portal on page 271.

5. Arrow button to collapse the submenu.

2. The selected view

The view chosen in the sidebar menu determines what's shown in the right part of the screen. In
the table below you get more info about each of the views.

Through this | You can... More info
view
View the log messages issued by Switch Server. Viewing log
y — messages
? — through the
Switch Web
Portal on page
272
Messages
Manage job boards and/or dashboards. Finding Switch
S . Jjobs through
|:||:| Job boards provide info about the status of your jobs. the Switch
':L Dashboards provide info about the number of jobs being Web Portal on
processed, and these numbers are visualized by means of page 279.
widgets (counters, tables, graphs). If you don't have access .
Boards to this functionality, the button to create new dashboards is Managing
missing. dashboarqs
on the Switch
Web Portal on
page 289.
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Through this | You can... More info
view

Submit jobs remotely via a Switch Submit point and check jobs | Submitting

K that arrive in a Switch Checkpoint. and checking
[ 13].:P Jjobs through
Iy the Switch
) Web Portal on
page 312

Access the pages for administrators. Here you can: Using the

% «  Remotely start and stop your flows, view the flow design, %giﬁﬁf‘/{/
print the flow documentation, and add annotations.

. on page 338
« Get system info
« View the number and identity of active users
« Customize the logo on the Portal

Admin

Get access to:

@ « The Switch documentation on the website

« The Enfocus Support Portal (to report a problem)
« The Support page on the Enfocus website
Info « The Switch system requirements

Note: Each page on the Portal has a context menu button ! inthe top left corner, next to
the title of the page. When you click that button, you get a dialog with a number of page-
specific options. One of the options that is always available is 'Set as Homepage'. For
more information, refer to Setting a homepage on page 272.

9 Messages Messages [ i)
Connection errors Reset current filter
Messages about ... Save current filter
Set as Homepage
HDD Split multi-job err...

4.4.3. Changing the language of the Switch Web Portal

By default the language on the Switch Web Portal is determined by your system's local settings.

To select a different language (i.e. one of the Switch languages), proceed as follows:

1. Inthe bottom left corner of the sidebar menu, click the blue circle with the first letter of your
username.
A small blue dialog pops up.

2. Click Change Language.

3. Click the language of your choice.
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Possible languages:

« English (EN - English)

« Spanish (ES - Espafiol)

« French (FR - Francais)

+ German (DE - Deutsch)

« ltalian (IT - Italiano)

. Japanese (JA - Japanese)

. Portuguese (BR - Portugués)
« Chinese (CN - Chinese)

Your choice is remembered. Next time you sign in to the Web Portal (through the same browser),
the content will be displayed in the chosen language.

4.4.4. Setting a homepage

When you're often using the same page on the Switch Web Portal, you can bookmark that page
as your homepage.

To do so, proceed as follows:

1.

3.

Display the page you want to use as homepage, for example the Submit jobs view or a filter
on the Messages view.

Next to the name of the page, click the button .
A small dialog is displayed.

Click Set as homepage.

Next time you log in, the chosen homepage will be displayed as your start page. Clicking the
Switch logo (in the top left corner of the sidebar menu) also gives access to this homepage.

4.4.5. Viewing log messages through the Switch Web Portal

If you have the right permissions, you can view the log messages in a browser without having to
open a Switch Designer. The permissions are set through the Users pane.

To view the log messages

1.

Sign in to the Switch Web Portal.
See Signing in to the Switch Web Portal on page 268.

If the messages are not displayed, in the sidebar menu, click = > Messages.
The current date's log messages are displayed, in chronological order, most recent messages

at the top. If the auto refresh option is turned on (indicated by the auto refresh icon ':’ ), the
list is automatically renewed. Info, warning and error messages are shown by default, debug
messages are hidden. See also: The Messages overview on page 241.

If there are any saved message filters (listed under "Messages"), you can click them to
immediately apply the filter.
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4.4.5.1.

You can now show more messages or filter out the messages you're not interested in, or export
the messages to a csv file. Refer to Filtering log messages on page 244 and Exporting log
messages on page 246.

The Messages overview

This topic describes the Messages overview.
You can open this overview

« Through the Switch Web Portal.

« From within Switch, by clicking the Messages button in the toolbar of the Switch Designer.
Alternatively, you can press F6 or select View > Messages.

Note: If opened from within Switch, it's possible to have the messages shown inside
the Switch Designer (For more info, refer to User interface category of the Switch
preferences ("Render HTML in Designer")).

Buttons and menus

The table below explains the meaning of the main buttons, labels, icons and menus in the
Messages overview.

[
M ; 1 A
€ssages : Yesterday v e
r
a7
Message contaings PitStop Server Message contains ScriptExecutor
. [ - R
Time Flow Jabs Element E+
SwitchScriptExecuion process with 1012112 has been stopped because it has been inactve
1335:00 For 1846 Se0onds. Prooessing 1S not affected: & mew SwiEhSOrptEmecutos prodess will be
started when necessary

p Server POF2Image” element. Some

» Server FOF2Image” element. Same

Button/menu Description
Yesterday Indicates the date(s) on which the shown messages were
issued, and allows you to select a different date or date
range.

: Show messages of the previous day

: Show messages of the next day

“ : Show messages of a particular date or date range.
You can also choose "Full history", i.e. all messages
since the last message cleanup (as defined in the Switch
preferences (Application data category)).

o

MR R Indicates the time frame in which the shown messages were

issued. You can move the blue arrows to enlarge or reduce
the time frame.

gk

273



ENF@CUS Switch

Button/menu Description

The red vertical lines represent error messages. This way you
can immediately see when error messages were issued.

Message contains PitStop Server The applied filters are listed right above the Search field.
When two different filters are applied, all log messages
Message containg ScriptExecutor that match one of the strings are shown (in this example:

messages that have "PitStop Server" OR "ScriptExecutor" in
the description).

Message = contains ] This part of the overview allows you to configure filters, to
select messages that contain certain strings (in the message
itself, in the name of the flow, the name of the job, ...) Refer to
Filtering log messages on page 244.

I:I Opens a menu with the following options:

- Flow, Job, Module, Element, Prefix: Refers to the
columns in the overview. Click to hide or show columns as
required.

« Reset view: Allows you to reset the columns to their
default size and position: only Flow, Job and Element are
shown by default.

« Export: Allows you to export the filtered log messages to
a .csv file. You can either open the file or save it locally.

» Clear all: Allows you to remove all log messages from the
log database. Note that there is no undo for this action!

o - | Ervor - | Message types, indicating the severity level of the message.

If colored, the messages of that type are displayed in the
overview, in a background with the corresponding color. In
the example, info, warning and error messages are shown,
whereas debug messages are hidden (default). You can click
a message type to switch from hidden to shown and vice
versa, or you can click the arrow to the right, to only show the
messages of that particular type.

Note: Info messages are displayed in a white and
gray background.

Note that the Debug button also shows or hides assert
messages. See also the table below (Message types).

,r:, By default, the page refreshes automatically, so you always
have an up-to-date overview.
You can turn off this option by clicking the auto refresh button

r:_; , which will turn into a blue arrow "

Columns

The following table describes the columns in the Messages overview.
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Remember that you can hide columns as required via the icon ¥ just below the search field. It's
also possible to resize the columns.

Column Description

Time Time when the message was triggered.

Flow The name of the flow that triggered the message.

Job The name of the job for which this message was issued.

Module The Switch module (such as Control) or type of flow element (such as folder,

Mail receive, ...) that triggered the message.

Element The name of the flow element that triggered the message.

Prefix The unique name prefix of the job referred to in the message, or blank if there
is no unique name prefix.

Message The message itself.

Message types

The following table describes the different types of messages that can appear in the Type column
of the Messages overview.

Type Description

Info An informational message that has no other purpose than to inform the user of
a certain occurrence.

Info messages are always shown in the Messages overview (unless a filter is
applied).

The Messages overview displays all types of info messages (related to Switch
Server and to Switch Designer).

Warning A warning message that informs the user of a recoverable problem or non-fatal
error.

Warnings are always shown (in orange) in the Messages overview (unless a
filter is applied).

Error An error message that informs the user of a fatal error.
Errors are always shown (in red) in the Messages overview (unless a filter is
applied).

Debug An informational message solely intended for debugging purposes (often

generated by apps).

Debug messages are not shown by default. If the Log debug messages
preference is enabled, you can display them using the Debug message type
filter.

Refer to Switch Preferences: Logging.
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Type Description

Assert A message solely intended for debugging purposes that is issued only when a
coding error is discovered.

Assert messages are not shown by default. If the Log debug messages
preference is enabled, you can display them using the Debug message type
filter.

Refer to Refer to Switch Preferences: Logging.

Note: Scripters have access to all messages, to be able to debug their scripts.

4.4.5.2. Filtering log messages

By default, all info, warning, and error messages issued on the current date are shown in the
Messages overview. You can however change this and only display the messages you're
interested in.

To filter the log messages

1. Pick the date(s) of which you want to see the messages.

By default, today's messages are shown.

To ... Do the following ...
Show messages of the previous day Click
Show messages of the next day Click

Show messages of a particular date or
date range

Click w

Show messages of a particular date or

Click = and select the appropriate option from
date range

the menu:

. Today

- Yesterday

« Choose date(s): Opens a calendar. Click the
date you want to select. In case of a date range,
click the first and the last date.

« Full history: Displays all messages since the last
messages cleanup (as defined in the Switch
preferences (Application data category)).

2. Pick the appropriate time frame:

- To indicate the start time, click the blue indicator to the left of the slider and drag it to the
time of your choice.

- To indicate the end time, click the blue indicator at the right of the slider and drag it to the
time of your choice.

276



ENF@CUS Switch

By default, the messages of the current date are shown. The blue part indicates the currently
shown time. The red vertical lines indicate when time error messages were issued.

Note: If the end time is not the current time, the auto refresh is disabled and the auto
refresh button will turn into a blue arrow. If you click this blue arrow, auto refresh is
turned on again and the end time is reset to the current time.

3. Pick the type of messages you want to see in the overview:

« Click the name of the message type to show or hide it in the overview. If the name is
shown in a colored background, the messages are shown in the same background color, if
the name is shown in white, the messages are hidden. Note that info messages are shown
in a white and gray background.

« Click the small arrow next to the message type to open a menu with two options:

. Hide messages of this type
« Only show messages of this type

By default, all types except for debug messages are shown.

4. Set afilter as required:
a. Select the column in which you want to search for a particular string. If the column doesn't
matter, choose Any.

b. Inthe search field, enter one or more strings to only view the messages that contain
those strings. The case of the entered strings is not taken into account.

< Press enter or click the button.
The filter is applied immediately. The messages that match the filter are shown, and the
filter definition is displayed just above the filter field.

Remarks:

- Alternatively, you can select a string somewhere in the overview and click Search this
(which appears automatically). The filter is configured and applied automatically.

Example:

Search this

Switch5criptExecutor process with ID 2785 has been

Resulting filter:
Message contains SwitchScriptExecutor ID 1383
« To view messages that contain several strings in one entry (e.g. configurator AND

workflow), type those strings in one filter field.

Message contains configurator workflow
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5.

- To view messages that contain either string x or string y (e.g. configurator OR workflow),
type those strings in two different filter fields (see screenshot).

Message contains configurator Message contains workflow

To clear a filter, click the cross button in the filter label.
Alternatively, to clear all filters at once, click the Messages i button and choose Reset
current filter.

The label is removed and the messages overview is updated immediately.

To save your filter, so you can reuse it later on, proceed as follows:

Note: This is not possible when you open the Messages overview in Designer (this is
a beta feature in the User interface category of the Switch preferences (last setting))

Click the ¥ button.

Click Save current filter.

In the dialog that pops up, enter a meaningful name for the filter.

Click Save.

The new filter is added to the sidebar under "Messages". Note that you can delete it

o0 T o

anytime (via the button { next to the name of the selected filter).

4.45.3. Exporting log messages

4.4.54.

Log messages can be exported to a CSV file for processing by third-party tools. If you have set
filters, these filters are taken into account; only the messages that are shown will be exported to a

file.

To export log messages

1.

2.

3.

Open the Log messages overview.
Click the icon % below the search field.

Click Export.
A log.csv file is created.

Clearing log messages

Log messages are stored in a database on disk and thus remain available after quitting and
restarting Switch. The application data preferences determine for how long messages are
retained.

To permanently clear all log messages

1.

2.

3.

Open the Log messages overview.
Click the icon % below the search field.

Click Clear all.
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A confirmation dialog appears. If you click Clear, all messages will be removed from the log
database. Note that there is no undo for this action!

4.4.6. Finding Switch jobs through the Switch Web Portal

4.4.6.1. About job boards

Job boards are handy to follow up on the status of your jobs. No need to use a (Remote) Designer
to watch how your jobs move through the flows; instead you can open a browser on any
computer, log into the Switch Web Portal and create your own job board(s) with only those flows
and jobs that are of interest to you.

Job boards based on flows and stages

The basic job board is a job board that shows you, for certain flows, which jobs are in which
stage.

Below is an example of such a board. The jobs can also be grouped by flow or state, using the
Group jobs by field.

In this example, the thumbnails are very small.

Production jobs per stage § o :, :”r' - _.-., Upsiated IT =
= t =
Indsering i1 B Ry for prosd m Qualiny chisck
Q intoming @ correctons @ coerections
images. jpeg Ho FressRebrases.zip 1] PressReleaseszip
documentation_jron pitkup_ 0 documentation json_phckup_ 170
wide-Format-printers himl o s ] wide-format-prinfers. html L]
© wapiting

Erief doex o
sarmplejson mo
HealthyFood pdl w0
PitStop 2012 PRrip o i ]

Job boards based on advanced column filters

The advanced job board is a job board that allows you to display jobs based on custom filters.
These filters can be configured using any job info field available in Switch.

Below is an example of such a job board. The jobs on this board are grouped by file size (bigger
or smaller than 5MB); small files are further split up by file type. The thumbnails are medium-sized.
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Note that there is an extra filter (available via the menu of the auto refresh option), 'Include jobs
finished in the last x* hours', which allows you to determine how long finished jobs should remain

on the job board.

Include jobs finished in the last 0

S on|v

hours

Note: Access to job boards and dashboards is configured through the Users pane in
Switch, hence it's possible that you don't have access to this functionality or that you can
only view shared boards but not create new ones yourself.

* Remark for Switch administrators: Note that this value cannot be higher than the value of Keep
internal job tickets for (hours) in the Switch Application data preferences; if the internal job ticket
is removed, the job does not exist anymore in Switch, hence it cannot be shown anymore on a

job board.

The job info dialog

To get more detailed info about a job on a job board, you just have to click it. This will open a
new dialog with multiple tabs, depending on your user permissions. For example, users that have

no access to messages won't have a Messages tab.
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Switch

a. q
O‘,a Job Boards Job board 1
. squireljpeg [EE5E X
[ Process Info Messages Private data External metadata
[ Job name squirrel.jpeg
Processingld 0O0AC
State
[ Stage
In state since
Locked by
View
Status Alert
4 Lock
Type Ipeg
Size 379 KB
| Files 1
Pages
Dimensions 500°43%x
Modified 020272021 13:.44:40
Flow Submitpoints flow
User SwitchUser
Submitted to All source files
Initiated 2710/2021 09:48:20
Checkpoint Checkpoint 1
On alert since 27NM0/2021 09:48:29

ﬂ Note:

« SwitchClient users can process alerts jobs from within the job info dialog. For more

information about the options, refer to Processing one job at a time on page 334
(step 5-7).

+ Remember that job details and thumbnails are not updated automatically. If you want
that, you need to insert a Refresh job info element.

4.4.6.2. Creating a job board based on flows and stages

A job board on the Switch Web Portal can display the jobs of your choice. On a basic job board,
you can select the flows for which you want to display jobs and - if you want to - only show those
jobs that have a certain job status or that are in a certain job stage.

ﬂ Note: Job boards are linked to your user account. Other users can't see them, unless you
share them.

To create a job board (basic mode)

In the sidebar on the left, click Hg] (Boards).

2. Do one of the following:

« Ifit's your first board:
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1. Click the plus button (next to Boards in the top left corner of the screen)

2. Select Create Job Board.
- If you already have one or more boards:

Click Job Boards *~ or Dashboards “~(if not yet expanded).
Click one of the boards that are listed.

Click the button i beside the name of the selected board.

B wN

Click Manage Boards.
5. Inthe bottom right corner of the dialog that appears, click New job board.

3. Configure your board:

a. Enter a name for your board.

Next to the name, you can see the mode. By default, the Basic mode is selected. This
mode is meant for job boards based on flows and stages.

b. Click the blue Customize fields link and select or clear the checkboxes of the items that
you want to display or hide on the job cards. Note that you can change the order of the
selected items in the column on the right ("Selected"), by clicking the icon "L to the right
of the item you want to move and by dragging it to its new place. To close the dialog,
click Done.

For more information, refer to Job fields on page 329.

c. Click Manage Flows on Board.

d. Inthe dialog that appears, select the flows you want to see on your job board. To do so,
click Select all (if applicable) or click the flow name of the flows you want to select. Note
that you can also search for flows (click the magnifying glass to trigger the search
field).

Flow groups are shown in blue, flow names in gray. You can select all flows in a group by
clicking the group name.

Note: Make sure to select all flows you want to see on your job board; in the next
step you can divide these flows over different columns.

e. Click Done.

4. Configure the first column of your job board:
a. Enter a column name.
b. Select at least one flow.
c. Select the flow stages if applicable.
Problem jobs and No stage are by default available. If stages have been defined in the
selected flows, they will be added and can be shown as well.

If nothing is selected, all jobs are shown, regardless of their job stage.

5. To add another column, click +add column and proceed in the same way. You can add as many
columns as you need.

6. Click Save.
The jobs that match the set criteria are shown on the board you just created. Note that you
can display the jobs in large, medium or small card view via the buttons on the right, or if
you want it for each column differently, by clicking the three dots in the column header. You
can also further group them (by Flow, stage or state) and disable the auto refresh option as
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required. You can order the jobs by different criteria. If you need more info about a job, you
can simply click it, to get a job info dialog with all possible info.

4.4.6.3. Creating a job board based on job filters

A job board on the Switch Web Portal can display the jobs of your choice. You can configure
your own advanced job filters, based on any info fields in Switch, to determine which jobs are
displayed.

Note: Job boards are linked to your user account. Other users can't see them, unless you
share them.

To create a job board based on job filters

1. ]|
In the sidebar on the left, click U (Boards).

2. Do one of the following:
« Ifit's your first board:

1 Click the plus button (next to Boards in the top left corner of the screen)

2. Select Create Job Board.
« If you already have one or more boards:

Click Job Boards * or Dashboards *(if not yet expanded).

Click one of the boards that are listed.

Click the button i beside the name of the selected board.

Click Manage Boards.

5. Inthe bottom right corner of the dialog that appears, click New job board.

pwN

3. Configure your board:

a. Enter a name for your board.
b. Click the blue Customize fields link and select or clear the checkboxes of the items that
you want to display or hide on the job cards. Note that you can change the order of the

selected items in the column on the right ("Selected"), by clicking the icon "t to the right
of the item you want to move and by dragging it to its new place. To close the dialog,
click Done. For more information, refer to Job fields on page 329.

c. Click Advanced mode.
You'll get a warning that it's not possible to switch back from Advanced to Basic mode
again.

d. Click Proceed.

4. Configure the first column of your job board:

a. Click *add column

b. Enter a column name.
Below the name of the column, all filters that are available are displayed.

c. Do one of the following as required:

« To check the configuration of the available filters, click the name of the filter. You can
make changes if needed. Note that these changes may also affect other job boards
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where the filter is used. For more info about the syntax, refer to Creating a custom job
filter on page 331.

« To create a new filter, click Create. For more info about the syntax, refer to Creating a
custom job filter on page 331.

. Toremove, export, import or share filters, click Manage. For mor info, refer to
Managing custom job filters on page 332.
d. Select the filter that you want to use in this column.

5. To add another column, click +add column and proceed in the same way. You can add as many

columns as you need.

Click Save.

The jobs that match the filters are shown on the board you just created. Note that you can
display the jobs in large, medium or small card view via the buttons on the right, or if you want
it for each column differently, by clicking the three dots in the column header. You can also
further group them (by Flow, stage or state) and disable the auto refresh option as required.
You can order the jobs by different criteria. If you need more info about a job, you can simply
click it, to get a job info dialog with all possible info.

4.4.6.4. Managing a job board

This topic explains how to handle the custom job boards on the Switch Web Portal.

Proceed as follows:

1.

m
In the sidebar on the left, click U“" (Boards).

Open the Manage boards dialog as follows:
a. Click Job Boards  (if not yet expanded).
b. Click one of the job boards that are listed below Job Boards.

C. Click the button : beside the name of the selected job board.

d. Click Manage Boards.

The Manage boards dialog appears. This dialog gives an overview of the boards you have
access to. The boards without a value in the Sharing column are shared by other users; you
can view them, but you cannot make any changes. The other boards are your own boards
and are fully controlled by you.

3. Do one of the following as required:

Switch

To... Do the following:

To create a new job board | Click New job board (blue button in the bottom right corner).
See also Creating a job board based on flows and stages on
page 281 and Creating a job board based on job filters on
page 283

To show or hide a job Click the slider ™ in front of the job board you want to show

board in the sidebar menu | or hide. If the slider is blue, the job board is visible in the
below 'Job boards' sidebar.
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To... Do the following:

Note: This functionality is useful for job boards you
want to keep for later use or for job boards that you
want to use as dataset for a dashboard (for users of
the Reporting module).

To edit a job board Click the edit button Edl (which becomes visible when you
hover over the job board concerned).

Note: Alternatively, you can click the button i beside
the job board name. The menu that pops up also has
an Edit option.

You can now edit the board name and the columns:

« To show other items on the job cards or behind the info
icon, click the blue Customize fields link and select or
clear the fields of your choice.

Note:

. Custom fields are fields are configured in
Refresh job info. You can also show them on
your job board.

» To change the number of flows on board level (basic
mode), click the Manage flows on Board button and select
or clear the flows of your choice.

+ To add a new column, click *add column,

To move the columns to another position, click the icon
and drag the columns you want to move sideways.

- To update a filter (advanced mode), click the filter name
and make the required changes.

Note: Instead of dragging the sliders to make a
selection, you can just click the group, flow or stage
name to make a selection or to undo a selection.

To return to view mode, click the Save button (in the top left
corner, next to the name of the board).

To share a job board orto | Job boards can be shared with other members of the same
stop sharing it user group (as configured in Switch).

To share or stop sharing, in the Sharing column of the board
concerned:

1. Click Private/Shared.
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To... Do the following:

2. Inthe dialog that pops up, select or clear the checkbox
of the group(s) with whom you want to share your board.
If no dialog pops up, you cannot share the board (for
example because you're not configured as member of a

group).
Note: Shared boards can only be viewed (not
edited!) by other users.
To import or export a job Boards can be exported (and kept as a backup) and imported
board again if needed.
To export a board, click the export button next to the

board you want to export. A Switch board is saved with
extension .sboard. Note that the export button becomes
visible when you hover over the board concerned.

To import a board, click the Import button at the bottom of the
dialog and select the board (*.sboard) of your choice.

To permanently remove a

job board Click the remove button.ﬂ

4. To save the changes made in the Manage jobs dialog, click Apply.

4.4.6.5. Viewing and finding jobs on a job board

If you have the right permissions, you can view Switch jobs through the Switch Web Portal. The
permissions are set by the Switch administrator through the Users pane.

To find jobs on a job board

m
In the sidebar on the left, click U“" (Boards).
2. To display the available job boards (as required), click Job Boards *~ .

3. Select the job board you want to see.

Boards displayed in dark gray are owned by you, boards displayed in light gray are shared
boards (which cannot be edited by you).

The selected job board is displayed. The jobs are listed in columns. What is shown depends
on the configuration of the board.

4. To see other fields displayed on the job cards, click Customize fields and select or clear the
checkboxes of the fields that you want to show or hide. You can change the order of the
fields by dragging the icons in the column on the right to the preferred position. Click Done to
confirm.

Note: If you're not the owner of the job board, the selection is only applied to your
web session and stored in the cache of your web browser.
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5. To reorganize the overview, click the Group jobs by list field in the top right corner of the
screen, and select the option of your choice (Flow, Stage, State or None (which removes any
previous grouping)).

A group adds an extra level to a column.

For example, suppose one of the columns of your board lists all problem jobs of all flows.
With 'Group jobs by’ set to 'None', the jobs are put arbitrary one after the other. With ‘Group
jobs by' set to 'Flow', the Problem jobs column is divided into different sections per flow, so
you can easily see which problem job belongs to which flow.

To change the order of the displayed jobs, click Order job by and select the icon ( lz
ascending or i descending order) next to the field by which you want to order the jobs.

7. To switch to smaller or larger job cards, click the appropriate button.

From left to right: large, medium (=default) and small job cards. The currently selected view is
displayed in blue.

Tip: In small job card view, move your pointer over the info icon for extra information.
What is shown, depends on the configuration of the board. In small and medium view,
this field is shown by default.

Note: It's also possible to have different job card sizes per column. To change the
size of the job cards in a certain column, click the three dots in the column header
and select the size of your choice.

If the board has only one column, you can also switch between table and grid view.

B

From left to right: table, grid view. The currently selected view is displayed in blue.

8. To search for a particular job for example to see if it reached a particular flow stage, enter
(part of) the job name in the search field in the top right corner of the screen.

The search is limited to the file name (name and extension).

9. To display recently finished jobs (by default, they are not shown),

a. Make sure auto refresh is turned on.

s e
L

b. Click the arrow » beside the auto refresh button.
c. Enter avalue in the Include jobs finished in the last ... hours field.

10. To see the log messages, metadata or private data of a particular job on the board, simply
click the job concerned.

Note that this feature is only available if you have turned off the auto refresh option.
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11. To get detailed job information, click the job to get a job info dialog with all possible info.

Note:

« Problem jobs can easily be detected because the info icons and the stage name
("Problem jobs") are displayed in red. For Alert jobs the stage name is shown is
orange.

- Some jobs may have a label with the text 'Rush' on it. This label refers to jobs that will
be processed first. See also Rushing jobs on page 288.

4.4.6.6. Rushing jobs

If you want a certain job to be processed before all other jobs, you can 'rush' that job via a job
board. This can be handy in case of urgent jobs, or if you want to retry a problem job without
having to wait until other (already scheduled) jobs are processed.

Note:

« The rush job will take the next available slot, so it won't stop jobs that are being
processed. If there is no free slot, for example because the maximum number of slots
for concurrent elements has been reached, the rush job will have to wait until a slot
becomes available. If there are free slots but the rush job is still busy, other jobs will be
processed in the meantime.

« If you're rushing multiple jobs, they will be processed in the order in which they were
set to rush.

« Child jobs have the same rush job rank as parent jobs.

- "Rush job" is a property of a job and is stored as such in the job ticket of the job.

« Note that your rush job(s) may delay processing of jobs of other users and other flows
in Switch.

To rush a job, proceed as follows:

1. Find the job concerned on a job board.
See Viewing and finding jobs on a job board on page 286.

2. Do one of the following:

« Right-click the job on the job board, and on the context menu, click Rush job.
- Double-click the job, and on the opened job card, on the right, click Rush.

Note: If you do not have the Rush or Rush job option, you may not have the right
permissions. For more information, contact your Switch administrator.
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A label on the job card indicates that the job is rushed. Note that the color of the label can be

customized through the Admin section of the Portal. See Admin view: Customization on page
345.

3. If you change your mind, you can undo this in a similar way:

« Right-click the job on the job board, and on the context menu, click Unrush job.
- Double-click the job, and on the opened job card, on the right, click Unrush.

Note that you can see the order in which rush jobs will be processed, by ordering the jobs on
your job board by Rush job rank, in ascending (A-Z) or descending (Z-A) order.

4.4.7. Managing dashboards on the Switch Web Portal

4.4.7.1. About dashboards and widgets

As of Switch 2018 update 1, it is possible to create your own dashboards on the Switch Portal.
This requires a license for the Reporting Module.
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Dashboards on the Switch Web Portal can give you a quick overview of the number of jobs that
are being processed by the Switch Server. You can for example display a counter (how many jobs
failed, how many jobs are in a particular stage,...) or a graph with numbers per file type, flow,... It's
also possible to visualize historical job data (e.g. number of problem jobs per week over the past
3 months).

The graphs and counters are actually widgets that can be configured at wish. The input for these
widgets (i.e. the data that is visualized) comes from a job board. The widgets can be customized
to a certain level: you can for example add a frame around a widget in the color of your choice,
you can add a title, in case of a graph you have the choice between a bar, a donut or a pie
chart,...

Currently, six different widgets are available for use on the Switch Web Portal. They are listed
below. You can put the widgets in two different layouts: a Column layout (to put the widgets next
to each other) or a List layout (to put them under each other, in a vertical arrangement). Note they
can also be combined, you could for example have a column layout at the top and a list layout at
the bottom.

ﬂ Note: Access to job boards and dashboards is configured through the Users pane in
Switch, hence it's possible that you don't have access to this functionality or that you can
only view shared boards but not create new ones yourself.

Live counter

This widget displays a number, representing the amount of jobs currently present on the selected
job board.

Live counter

154

Total number of jobs in production

See also: Dashboard widgets - Live counter on page 298

Live graph

This widget counts both the total number of the jobs on the selected job board and the number
of jobs per column, and presents this data as a graph.
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Refreshed at 31/05/2018 09:02:11

B Quality check B Ready for production B Incoming B Waiting B To check

See also: Dashboard widgets - Live graph on page 299

Live table

This widget displays information about the jobs counted in a live graph on the same dashboard.

For example, if your graph gives an overview of the number of jobs per flow, the live table

displays detailed information about these jobs (job name, flow name, stage and state of the job).

Set # | Name Flow ~ Stage ~ | State

| filter column... I filter column... | filter c I filter column. | filter column
Jobs in production  20pp.ppp FlowB  Problem jobs Input

Jobs in production | switch_quickstar| FlowC | Problem jobs Praduction
Jaobs in production | switch_guickstar | FlowC Prablem jobs Production
Jobs in production | masked text 2.pc| FlowG Problem jobs Production
Jobs in production | masked text 2.pc| FlowC  Problem jobs Production
Jobs in production | Enfocus_Pricelis| FlowC | Problem jobs Praduction
Jobs in pmductir:m [Content_Types]. | FlowC Prablem _jr::hs Production
Jobs in production | Enfocus_Pricelis| FlowC | Problem jobs Production

See also: Dashboard widgets - Live table on page 301

Messages

This widget gives a real-time overview of messages based on a messages filter (that you have

configured yourself). You can choose the columns you want to display and the maximum number

of messages.
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~  Message "
filter column | filter column..
Emror when loading script package "Designherge Pro” AppleScript is not supported. Plea...
Error when loading seript package "S1wffit Deluxe”. AppleScript is not supported. Please u...
Receive and... Can't connect o the FTP sarver: error message: Unable to astablish a connaction with th_
Prepress Pa.. suffix done
Prepress Pa.. _check_probjob
Prepress Pa..
Receive and... Cannot connect to the FTP host. Error: Unable 1o establish a connection with the server
PitStop25wi.. Cannot connect to the FTP host. Error: Unable to establizsh a connection with the server
Failed to connect to the Enfocus Appstore: Error: getaddrinfo ENOTFOUND external-senvi...
Falled to get package information for Enfocus PitStop Server PDF2Image’ elerment. Som..,
Receive and... Cannot connect to the FTP host. Error: Unable to establish a connection with the server
Receive and... Cannot connect to the FTF host. Error: Unable to establish a connection with the server
PitStop2Swi.. Cannot connect to the FTP host. Error: Unable to establish a connection with the server
PitStop2Swi.. Cannot connect to the FTP host. Error: Unable 10 establish a connection with the server
Failed to get package information for Enfocus PitStop Server PDF2Image’ element. Som...
PitStop2Swi... Failed to connect to mail server imap.gmail_com; error message: [8] Exec formiat error
PitStop2Swi... Failed to connect to mail server imap.gmail.com; error message: [8] Exec format ernor
PitStop2Swi.. Falled to connect to mail server imap.gmail com; error message; (8] Exec format error

See also: Dashboard widgets - Messages on page 302

History graph

This widget visualizes the evolution of the number of jobs or the job size over a particular period

of time, for example the total number of problem jobs of the last month, grouped by week.

File types / week

149 w

=

21 AEW | —
B AEW £ —
gl fEW ¥l
gL B L2
gl fEW B2

M xlsx M Folders B txt M xml M opaque B docx M jpeg B pdf

See also: Dashboard widgets - History graph on page 303
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Custom HTML

This widget allows you to add a title, a logo, text and even a movie to your dashboard.

Dashboard Prepress

Prepress Manager: Ph Donovan

Prepress Operator: J Carstens

WWW.myprepress.com

See also: Dashboard widgets - Custom HTML on page 306

4.4.7.2. Creating a dashboard

A dashboard is an overview screen with one or more widgets that visualize job data.

Before you start, make sure to create a job board with the data you want to display on the
dashboard. Alternatively, you may use a shared job board. A job board to start from is necessary
for all widgets, except for the history graphs and custom HTML. For example, if you want your
dashboard to display the total number of problem jobs on the server, you need a job board that
collects all problem jobs.

ﬂ Note: Job boards and dashboards are linked to your user account. Other users can't see
them, unless you share them.

To create a dashboard

In the sidebar on the left, click H:‘p (Boards).

2. Do one of the following:
« Ifit's your first board:

1. Click the plus button . (next to Boards in the top left corner of the screen)

2. Select Create Dashboard.
« If you already have one or more boards:

Click Job Boards * or Dashboards *(if not yet expanded).
Click one of the boards that are listed.

Click the button } beside the name of the selected board.
Click Manage Boards.

s W

In the bottom right corner of the dialog that appears, click New dashboard.
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If you don't see the New dashboard button, you may not have the permission to create
boards.

3. Configure your board:
a. Enter a name for your board.
b. Configure the dashboard settings (in the right part of the screen):

Note: If the dashboard setttings are not shown, you can make them visible by
clicking the gear wheel button 23]

C. Click the plus button kd and drag and drop one or more widgets onto the column of your
choice (in case of a Column layout) or directly onto the dashboard and configure them as
required:

« Dashboard widgets - Live counter on page 298
« Dashboard widgets - Live graph on page 299

« Dashboard widgets - Live table on page 301

« Dashboard widgets - History graph on page 303

« Dashboard widgets - Custom HTML on page 306

You can also drag "layouts" onto the global layout of your dashboard, for example to
create a board with two columns (global Column layout) of which the first column is
further divided into 2 sub-columns (drag a Column layout on the first column), and the
second column has a list layout (drag a List layout on the second column). Available
layouts:

« Dashboard layouts - Column layout on page 307
« Dashboard layouts - List layout on page 311

Note that you can use the buttons E ¥ inthe top right corner of each widget and
each layout to duplicate, select or remove a widget. The widget you want to configure
must be selected in order to view or change its properties.

4. Click Save.
The dashboard is added to the sidebar menu.

Note that you can still make changes by clicking the button @ beside the name of the dashboard.
The dialog that opens has an Edit button.

4.4.7.3. Managing a dashboard

This topic explains how to handle the custom dashboards on the Switch Web Portal.
Remember that dashboards are only available if the Reporting Module is licensed.

Proceed as follows:

m
In the sidebar on the left, click U“" (Boards).
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2. Open the Manage boards dialog as follows:

a. Click Dashboards »~ (if not yet expanded).
b. Click one of the dashboards that are listed below Dashboards.

C. Click the button i beside the name of the selected dashboard.

d. Click Manage Boards.

The Manage boards dialog appears. This dialog gives an overview of the boards you have
access to. The boards without a value in the Sharing column are shared by other users; you
can view them, but you cannot make any changes. The other boards are your own boards
and are fully controlled by you.

3. Do one of the following as required:

To...

Do the following:

To create a new dashboard

Click New dashboard (blue button in the bottom right corner).
See also Creating a dashboard on page 293.

To show or hide a
dashboard in the navigation
area

Click the slider -# in front of the dashboard you want to
show or hide. If the slider is blue, the dashboard is visible in
the sidebar.

Note: This functionality is useful for dashboards you
want to keep for later use.

To edit a dashboard

Click the edit button (which becomes visible when you
hover over the dashboard concerned).

Note: Alternatively, you can click the button i beside
the job board name. The menu that pops up also has
an Edit menu option.

You can now add or remove widgets and make
changes to the widgets as required:

* To add a widget, click the kd button, select a widget, and
drag it onto the dashboard.

* Toremove a widget, click the remove button W in the
header of the widget.

* To duplicate a widget, click the duplicate button ' in the
header of the widget.

« To make changes to a widget, click the widget. This places
a check mark in the checkbox in the top right corner of the
widget and displays the properties on the right side of the
screen. You can nhow make the required changes.

Note: It's also possible to edit multiple widgets at
the same time. To do so, select the checkboxes
of all widgets you want to edit. In the pane on the
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To... Do the following:

right, you'll see 'Multiple blocks', the number of
widgets that are selected, and the properties that
can be edited.

Do not forget to save your changes, by clicking the Save
button (in the top left corner, next to the name of the
dashboard).

To share a dashboard or to | Dashboards can be shared with other members of the same
stop sharing it user group (as configured in Switch).

To share or stop sharing, in the Sharing column of the board
concerned:

1. Click Private/Shared.

2. Inthe dialog that pops up, select or clear the checkbox
of the group(s) with whom you want to share your board.
If no dialog pops up, you cannot share the board (for
example because you're not configured as member of a

group).
Note: Shared boards can only be viewed (not
edited!) by other users.
To import or export a Boards can be exported (and kept as a backup) and imported
dashboard again if needed.
To export a board, click the export button next to the

board you want to export. A Switch board is saved with
extension .sboard. Note that the export button becomes
visible when you hover over the board concerned.

To import a board, click the Import button at the bottom of the
dialog and select the board (*.sboard) of your choice.

To permanently remove a

dashboard Click the remove button.ﬂ

4. To save the changes made in the Manage jobs dialog, click Apply.

4.4.7.4. Viewing a dashboard

If you have the right permissions, you can create and view dashboards through the Switch Web
Portal. The permissions are set by the Switch administrator through the Users pane.

To view your (earlier created or shared) dashboards on the Switch Web Portal

m
In the sidebar on the left, click U“ (Boards).
2. To display the available dashboards (as required), click Dashboards ~ .

3. Click the dashboard you want to see.
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Boards displayed in dark gray are owned by you, boards displayed in light gray are shared
boards (which cannot be edited by you).

The selected dashboard is displayed. There may be several widgets present on the
dashboard. Some of the widgets show extra information when hovering or clicking the
legend. For more information, refer to the description of the widgets (Dashboard widgets
overview on page 298).

4.4.7.5. Dashboard settings

The dashboard settings determine the general layout of the dasboard. You can open the
dashboard settings by clicking the gear wheel button El in the blue border of the dashboard.

Dashboard 1

<4 Drag and drop widgets here. Click + to find all available widgets.

&

Setting Description

Dashboard Layout Options are:
- Default layout: The different widgets are placed one
below the other (vertical arrangement).

« Column layout: The widgets are placed next to each other
(horizontal arrangement with two or more columns).

Note: This setting is about the global layout of the
dashboard. You can drag another layout onto the
global layout, to further split up the screen parts. See
Dashboard layouts - Column layout on page 307
and Dashboard layouts - List layout on page 311

Spacing Space between two columns (Column layout) or two rows
(default layout).

Drag the slider to the right to increase, or to the left to reduce
the value in pixels (O px -50 px).

Note: To see the effect of this setting, drag a couple
of widgets onto the dashboard and change the
values.

Padding (only for the default Space between the widgets and the border of the dashboard.

layout) Drag the slider to the right to increase, or to the left to reduce

the value in pixels (O px -50 px).
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Setting Description

Note: To see effect of this setting, drag a couple of
widgets onto the dashboard and change the values.

Background Color Click the color patch to pick the color of your choice. Once
selected, the color patch gets the new color and the color
code is displayed as well.

4.47.6. Dashboard widgets overview

This is an overview of the widgets available for use on a Dashboard on the Switch Web Portal.

Dashboard widgets - Live counter

About the Live counter widget

This widget displays a number, representing the amount of jobs currently present on the selected
job board. Note that all jobs in all columns are taken together, resulting in one number, for
example the number of problem jobs.

This number can be linked with a color, for example, if the number of jobs remains below a
certain threshold, the background of the widget turns green; otherwise it turns orange or red.

The counter is updated at regular intervals (see properties), giving a live view on the Switch
server. If the value goes up, an upwards arrow is displayed next to the counter; if the value goes
down, a downwards arrow is displayed.

How to configure the Live counter widget

You can configure the properties listed in the table below.

Properties
Property Description
Configuration
Job board Job board data that will be used for the dashboard.
'None' is not a valid option.
Set By default, the data in all columns of the selected job board will be used ("All"),

unless you select one particular column.

Color and limits | Background color of the widget based on the value of the counter.

To change a value, click it and increase or decrease the value using the small
arrow buttons.

To change a color, click it to open the color picker and select the color of your
choice.

Note that there's also a small text field below the color patches. You can click it
and type the text of your choice. This text will be displayed below the counter.
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Property Description

Include jobs The value chosen here determines how long after finishing the jobs will be
finished in the |included in the live counter.

last (hours) If you enter '0', only jobs that are still moving through the flow and haven't

reached an output folder will be included.

If the widget doesn't behave as expected, contact your Switch administrator.
There may be a conflict with the Keep internal job tickets for (hours) in the
Switch Application data preferences.

Refresh This value indicates how often the number of jobs is recalculated.
interval (in
seconds)
Styling
Title Title. This is by default the widget type. If Show frame is selected, the title
will be shown in the title bar of the widget. You can leave this field empty as
required.
Height Height of the widget. Options are:
« Small
«  Medium
. Large
Show frame When selected, a thin frame is drawn around the widget and the following

additional properties are displayed:

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

Dashboard widgets - Live graph

About the Live graph widget

This widget counts both the total number of the jobs on the selected job board and the number
of jobs per column, and presents this info in a graph.

Note that this requires a job board with more than one column; each column is represented as a
separate section in the graph. You can choose between a pie, a bar and a donut chart.

How to configure the Live graph widget

You can configure the properties listed in the table below.

Properties
Property Description
Configuration
Chart Type of chart to be used. Options are:
- Pie
« Donut
. Bar
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Property Description

Tip: Use "Pie" and "Donut" to show how the parts (i.e. values per
column) compare to the whole (total number of jobs); use "Bar" to
show how the parts compare to each other or to show trends.

Job board Data that will be used for the dashboard. For this type of charts, you should
have a board with more than one column.

'None' is not a valid option.

Show grid lines | |f selected, grid lines are shown to make it easier to read the values.

("Bar" only)
Note: This option is not relevant (hence not available) for pie and
donut charts.

Include jobs The value chosen here determines how long after finishing the jobs will be

finished in the |included in the live graph.

last (hours) If you enter '0', only jobs that are still moving through the flow and haven't

reached an output folder will be included.

If the widget doesn't behave as expected, contact your Switch administrator.
There maybe a conflict with the Keep internal job tickets for (hours) in the
Switch Application data preferences.

Refresh This value indicates how often the values are recalculated.

interval (in

seconds)

Use column When selected the names of the columns are displayed on the graph.
names as

. Default: "<number of jobs> jobs" e.g. "15 jobs"

labels ("Pie" . . N : " " "
only) « This option enabled: "<column name>: <number of jobs>" e.g. "column1: 15
Pick custom When selected, you can change the default colors of each column that will be
colors used in the graph. To change a color, simply click the color page and then click
the color of your choice.
Styling
Title Title. This is by default the widget type. If Show frame is selected, the title
will be shown in the title bar of the widget. You can leave this field empty as
required.
Height Height of the widget. Options are:
+ Small
«  Medium
- Large
Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:
Frame color Color that will be used for the title bar and the frame around the widget.

Clicking the color patch will open a color picker dialog.
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How to use Live graphs

Smaller parts are not always easy to read, so when hovering over one particular part of
the chart, this part is highlighted and you get a small dialog with the column name and the
percentage value of the highlighted part.

When clicking an item in the legend, the corresponding part of the chart is disabled (grayed out
in the legend) and taken out of the chart. Clicking once more will bring it back.

Dashboard widgets - Live table

About the Live table widget

This widget displays information about the jobs counted in a live graph or a live counter on the
same dashboard. For example, if your graph gives an overview of the number of jobs per flow,
the live table can display detailed information about these jobs (job name, flow name, stage and
state of the job).

How to configure the Live table widget

You can configure the properties listed in the table below.

Properties
Property Description
Configuration
Parent Live graph or live counter that is used as dataset for the live table.
'None' is not a valid option.
Visible Enable the column(s) you want to see in the live table. Options are:
I
columns . Set
- Name
« Flow
. Stage
. State

At least one column must be selected.

Show header When selected, the columns in the table have a column header.

Styling
Title Title. This is by default the widget type. If Show frame is selected, the title
will be shown in the title bar of the widget. You can leave this field empty as
required.
Height Height of the widget. Options are:
+ Small
+  Medium
. Large
Show frame When selected, a thin frame is drawn around the widget and the following

additional properties are displayed:
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Property

Description

Frame color

Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

How to use live tables

To see the details of a particular part/category in the chart, e.g. one slice of the pie, just click
in the chart. Only the details of the corresponding jobs will be shown in the table. Clicking once
more will reset the table.

To search for a particular job/a set of jobs, you can filter the table by entering a key word in the
filter fields below the column headers. Note that these filter fields are not case sensitive.

To sort the list in ascending or descending order, click the column header of the column by
which you want to order it. Note that the small arrow in the column header will become a bit
darker, to indicate this.

Dashboard widgets - Messages

About the Messages widget

This widget displays log messages based on a saved messages filter. Refer to Filtering log
messages on page 244.

How to configure the Messages widget

You can configure the properties listed in the table below.

Properties

Property

Description

Configuration

Filter

Messages filter that is used as dataset for the live table. Note that you have to
create the filter and save it through the Messages view. Refer to Filtering log
messages on page 244.

'None' is not a valid option.

Note: If the messages filter is removed afterwards, the widget won't
work anymore... you'll get a warning ("Data could not be loaded").

Visible
columns

The columns of the Messages overview that will be shown in the widget.

Options:

.« Time

- Type

« Flow

« Job

- Module
« Element
«  Prefix

« Message
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Property Description

At least one column must be selected.
Number of Maximum number of messages to be shown.
messages

Options:

- 10

. 20

- 50

- 100
Refresh Indicates how often (e.g. every 10 seconds) Switch checks for new messages.
interval (in
seconds)

Show header

When selected, the columns in the table have a column header.

Styling

Title

Title. This is by default the widget type. If Show frame is selected, the title
will be shown in the title bar of the widget. You can leave this field empty as
required.

Height

Size of the table.
Options:

+ Small
«  Medium
- Large

Show frame

When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Frame color

Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

How to use the Messages widget

To search for a particular message/a set of messages, you can filter the table by entering a
key word in the filter fields below the column headers. Note that these filter fields are not case

sensitive.

To sort the list in ascending or descending order, click the column header of the column by
which you want to order it. Note that the small arrow in the column header will become a bit
darker, to indicate this.

Dashboard widgets - History graph

About the History graph widget

A history graph visualizes the evolution of the number of jobs or the job size over a particular

period of time, for example the total number of problem jobs of the last month, grouped by week.

A further subdivision is possible, you can for example further group the jobs by file type, flow,

stage or state.
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Note that this graph only counts jobs that are completely finished, meaning that they have left
the Switch flows. The maximum period of time to go back in the past is defined by the number of
days set in the Reporting preference, for example for 120 days.

How to configure the History graph widget

You can configure the properties listed in the table below.

Properties
Property Description
Configuration

Chart Type of chart to be used. Options are:

« Line

« Spline (curved line)

. Bar

« Pie

Show grid lines | |f selected, grid lines are shown to make it easier to read the values.

Note: This option is not relevant (hence not available) for pie charts.

Job board Job board to be used for the history graph.

'None' is a valid option for history graphs: if selected, all jobs on the Switch
server are taken into account!

Note: Currently, only basic job boards are supported, hence job
boards based on filters are not shown in the list. See About job boards
on page 279.

Set Column to be used.

If 'None' is selected as Job board, this option is not available.

Unit Determines what is counted and displayed:

«  Number of jobs
« Total size

Group by Determines how the values are grouped:

« None: no grouping; the total number of jobs or the total size is mentioned.
For example, 200 jobs on day1, 190 jobs on day 2, etc.

« Type: the total number or the total size is further divided by file type. For
example, 100 PDF files and 100 text files on day1, 90 PDF files and 100 text
files on day2, ...

- Stage: the total number or the total size is further divided by flow stage. For
example, 75 jobs in stage1 and 125 in stage2 on day1, 70 in stage1 and 120
in stage2 on day?2, ...
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Property Description

Note: Stages that were not selected on the job board are not
shown.

. State: the total number or the total size is further divided by job state. For
example, 33 jobs in state1 and 167 in state2 on day1, 22 in state1 and 168 in
state2 on day2, ...

« Flow: the total number or the total size is further divided by flow. For
example, 50 jobs in flow1, 50 in flow2 and 100 in flow3 on day1, 99 in flow, 1
in flow2 and 90 in flow3 on day?2, ...

Note: Flows that were not selected on the job board are not
shown.

- Element: the total number or the total size is further divided by flow
element. For example, 2 jobs have been put in the recycle bin, 7 jobs have
been processed by the Enfocus PitStop Server configurator, ... Note that
all elements in all flows are taken together, regardless of the name of the
instance in the flows. For example, even if the recycle bins in your flows
are called 'Trash?', 'Trash2', Trash3', in the graph you'll see 1 flow element
'recycle bin' (with all jobs collected in all 3 trash folders).

As for the folder element: only input folders are taken into account.
Intermediate and output folders nor problem folders are represented in the

graph.
Period Determines how the data will be grouped, i.e. which data will be taken
together.
. Day
+ Week
« Month

For example, if grouped by week, you'll get one value for all jobs of a particular
week (optionally further divided by flow, file type, etc.)

Note: This field is not available if the 'Pie' chart is chosen.

Days Refers to the time period that will be shown in the graph.

previously For example, if set to '200', the data of the last 200 days (= today minus 200

days) will be shown. Note that the maximum number of days that is possible is
determined by the Reporting preference (see higher).

Use group When selected, the names of the grouped items (see the Group by option) are
names as displayed on the graph.
labels ("Pie"

« Default: "<number of jobs> jobs" e.g. "15 jobs"

onl/
Y) « This option enabled:

«  Group by set to None: "Overall: <number of jobs>" e.g. "Overall: 15"
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Property Description

- Group by set to <item>: for each <item>, <name of the item>:<number of
jobs> e.qg. if grouped by 'Element': "Submit point: 9","Checkpoint: 6"....

Show target When selected, a line will be drawn at a given target value. This option triggers
line ("Spline” the following property:
and "Line"
only)
Target value Value that determines where the target line will be drawn on the spline or line
graph.
Styling
Title Title. This is by default the widget type. If Show frame is selected, the title
will be shown in the title bar of the widget. You can leave this field empty as
required.
Height Size of the table.
Options:
+ Small
«  Medium
. Large
Show frame When selected, a thin frame is drawn around the widget and the following

additional properties are displayed:

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

How to use history graphs

Smaller parts are not always easy to read, so when hovering over one particular part of the
chart, this part is highlighted and you get a small dialog with more information (for example the
number of jobs/the total size per group; if there is no grouping, the dialog mentions the "overall"
value).

When clicking an item in the legend, the corresponding part of the chart is disabled (grayed out
in the legend) and taken out of the chart. Clicking once more will bring it back.

Dashboard widgets - Custom HTML

About the Custom HTML widget

This widget allows you to add text, tables, pictures, movies and links to your dashboard. You can
use the text color and font of your choice, insert bullets, ...

How to configure the Custom HTML widget

You can type text in the text field and modify it using the tools in the editor.

An overview of shortcuts is available behind the question mark button.

Properties
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Property Description
Configuration
Entry field Content that will be displayed on the dashboard.
Styling
Background Click the color patch to pick the color of your choice. Once selected, the color
color patch gets the new color and the color code is displayed as well.

Add padding Adds extra space between the entered content and the border of the widget.

Title Title. This is by default the widget type. If Show frame is selected, the title
will be shown in the title bar of the widget. You can leave this field empty as
required.

Show frame When selected, a thin frame is drawn around the widget and the following

additional properties are displayed:

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

4.4.7.7. Dashboard layouts overview

Dashboard layouts - Column layout

About the Column layout

The Column layout allows you to place several widgets next to each other in columns, for a
horizontal arrangement. If no Column layout is chosen, the widgets will be placed one after the
other, in a vertical arrangement.

How to configure the Column layout
By default, two columns are available, but you can add more columns by clicking the duplicate

button 1 above one of the columns.

Note that we recommend first configuring the Column layout; afterwards you can drag the
widgets onto the layout.

Note that we recommend first configuring the List layout; afterwards you can drag the widgets
onto the layout.

Note: Make sure that the checkbox in the top right corner of the widget is selected.

&@)s

Drag and drop widgets here to start building Drag and drop widgets here to start building
= your dashboard, Click + to find all widgets =+ your dashboard. Click + to find all widgets
available available

307



ENF@CUS Switch

Properties

Property Description

Configuration

Configuration | Space between two columns.

Drag the slider to the right to increase, or to the left to reduce the value in
pixels (O px -50 px).

Note: To see the effect of this setting, drag a couple of widgets onto
the dashboard and change the values.

Allow wrap If Allow wrap is selected, ...

Collapsible If the Column layout is collapsible, a small arrow is displayed in the header of
the widget, which can be clicked to collapse the whole block.

Note: If you want to make it possible to collapse all columns
separately, you must enable this option on column level (see Column
properties below).

Styling

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty as
required.

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

Background Click the color patch to pick the color of your choice. Once selected, the color

color patch gets the new color and the color code is displayed as well.

Column properties

Each of the columns in a Column layout can be configured separately. You can as well configure
a number of columns at the same time. To do so, just select the checkbox of the column(s) you
want to configure.

Make sure to select the columns, and not the Column layout or the widgets inside the column! In
the example below, two of the three columns are selected.
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Jobs in Checkpoint

Approved  Rejected

Froblem jobs
Refreshed at 12/10/2020,
09:42:36

ﬂ Note: To remind you that you have selected multiple columns and that the configuration
only applies to that selection, the title of the configuration panel is "Multiple blocks"
followed by the number of blocks (columns in this example) concerned.

Property Description

Configuration

Column This property determines the column width.

ﬂ Note: If several columns are selected, the width values apply to all
selected columns. For example, if 2 columns are selected and the
width is set to 50 pixels, this means each of the selected columns will
have a width of 25 pixels!

Options are:

- Relative width (default): Width is expressed as a percentage of the total
column width. You must also specify the miminum column width (which can
be determined by the content or by a fixed number of pixels).

« Variable width: The column width can vary between a minimum and
maximum threshold. The minimum column width can be determined by the
width of the content, or by a set percentage or a set number of pixels. The
maximum width can be determined by a percentage of the total width or a
number of pixels. Note that you can switch between percentage and pixels

by clicking the arrows to the right of the entry field. **
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Property Description

- Fixed width: The column width is a fixed number of pixels.

« Content width: The column width adapts to the size of the content (i.e.
the widget). You must set the maximum column width (either a percentage
of the total width or a fixed number of pixels. Note that you can switch
between percentage and pixels by clicking the arrows to the right of the

entry field. **

Collapsible If a column is collapsible, a small arrow is displayed in the header of the
widget, which can be clicked to collapse the column.

Spacing Space between the selected column(s) and the other columns.

Drag the slider to the right to increase, or to the left to reduce the value in
pixels (O px -50 px).

Padding Space between the widget and the border of the column.

Drag the slider to the right to increase, or to the left to reduce the value in
pixels (O px -50 px).

Stretch items Determines how widgets inside a column are aligned:

. If Stretch items is selected, the widgets are divided over the column so that
the whole column is filled.

. If Stretch items is cleared, the widgets are placed one after the other.

This is a useful feature if widgets in columns have different heights. For
example, in the next screenshot, Stretch items is selected in the second
column, to add space between the Messages widget and the Live counter.
Otherwise they would stick together.

e e
F/\
| ?
Styling
Show frame When selected, a thin frame is drawn around the columns and the following

additional properties are displayed:

Title Text that will be shown in the title bar of the column. You can leave it empty as
required.
Frame color Color that will be used for the column title and the frame around the column.

Clicking the color patch will open a color picker dialog.
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Property Description
Background Click the color patch to pick the color of your choice. Once selected, the color
color patch gets the new color and the color code is displayed as well.

Dashboard layouts - List layout

About the List layout

The List layout allows you to place several widgets one after the other, in a vertical arrangement.

How to configure the List layout
By default, one row is available, but you can add more rows by clicking the duplicate button ' in
the top right corner of the widget.

Note that we recommend first configuring the List layout; afterwards you can drag the widgets
onto the layout.

Note: Make sure that the checkbox in the top right corner of the widget is selected.

()
== Drag and drop widgets here to start building your dashboard. Click + 1o find all widgets available.
Properties
Property Description
Configuration

Collapsible If the List layout is collapsible, a small arrow is displayed in the header of the
widget, which can be clicked to collapse the whole block.

Spacing Space between two rows (or widgets) in the List layout.
Drag the slider to the right to increase, or to the left to reduce the value in
pixels (O px -50 px).

Note: To see the effect of this setting, drag a couple of widgets onto
the dashboard and change the values.

Padding Space between the widgets and the border of the List layout.
Drag the slider to the right to increase, or to the left to reduce the value in
pixels (O px -50 px).

Styling

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty as
required.
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Property

Description

Frame color

Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

Background
color

Click the color patch to pick the color of your choice. Once selected, the color
patch gets the new color and the color code is displayed as well.

4.4.8. Submitting and checking jobs through the Switch Web

Portal

4.4.8.1.

Submitting and checking jobs through the Switch Web Portal is only possible if you have licensed
the SwitchClient Module or the Web Services Module.

Overview

An active SwitchClient/Switch Services Module gives access to the following functionality:

Connect to one or more Switch Servers on the local network/internet.

Submit jobs (files or job folders) and metadata describing these jobs to a Submit point in a
flow.

Review and act on jobs being held in a Checkpoint in a flow.
View progress information and the status of submitted jobs.
View log messages issued by processes on the server.

Good to know

Access to particular Submit points and Checkpoints can be restricted, by configuring access
rights at user or user group level.

Metadata information attached to a job can be used to make automated routing decisions or
to provide variable input to various tools and apps.

If you want to connect to more than one Switch Server at a time, you must open a browser
window per server and sign in to the Switch Web Portal for each server separately. The IP
address of the server is displayed in the URL.

Setup in Switch

Allowing users to submit and check jobs via the Switch Web Portal, requires some preparation in
Switch, usually done by a system administrator.

This includes:

Installing and activating Switch (this includes activating the SwitchClient Module)
Designing and activating one or more flows that will process the jobs submitted and
monitored through the Switch Web Portal.

Configuring user access rights (in the Users pane)
Configuring or checking the communication settings (through the Switch user Preferences)
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Installing and activating Switch and the SwitchClient Module

Licenses

A regular SwitchClient Module includes a license for up to five concurrent connections. If this
is not sufficient, you can purchase additional licenses. The number of licenses can be raised by
entering a new activation key in the Manage licenses dialog in Switch.

An active SwitchClient Module allows you access to the following flow elements:

«  Submit point
« Checkpoint
« Checkpoint via mail

If SwitchClient is not licensed, the above flow elements will not be available and you will not be
able to submit and check jobs through the Switch Web Portal.

How to proceed
Follow the guidelines and instructions described in the chapter on installing, activating and
starting Switch. :

1. Install Switch.
2. Activate Switch, including the SwitchClient Module.
3. Activate additional licenses if required.

Designing flows for use with the Switch Web Portal

Managing files through the Switch Web Portal requires a particular flow design in Switch.

About flows in Switch

To design a flow, the Switch user drags flow elements (such as Submit points, processors and
folders) on the canvas and connects them according to the desired job flow. After configuring
appropriate property values for each flow element (and in some cases, the connections), the
Switch user can activate the flow for execution. From then on, Switch automatically moves and
processes jobs along the flow.

If you're new to Switch, we recommend having a look at the Switch Quick Start Guide (available
on the Enfocus website).

Dedicated flow elements

Submit points and Checkpoints are flow elements designed for use with the Switch Web Portal.
For more information, refer to the description under Flow elements: overview > Communication.

Note:

« Make sure the flows you want to use with the Switch Web Portal are active. A user
with the appropriate access rights can access Submit points, Checkpoints and jobs in
inactive flows but the jobs will not move along the flow.

« The Switch Web Portal only interacts with the Switch Server, not with the Switch
Designer. Users can safely quit the Designer without disturbing the operations via the
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Portal as long as the Switch Server is running. For more info on the behavior of Switch
when exiting the flow designer, refer to the Switch user preferences (User interface).

Example flow

Here's a flow example as it is shown on the Switch canvas:

To PDF Enhancer

d (2] (2]

Creatives Input Wisial Proof Good Input Cutput Jobs To DAM system
Y
Henry Sel User Mame
To Proofer
Biad Input Archive

Since this example focuses on Web Portal features, there is a lot of interaction with human
operators and little automated processing (other than moving jobs around). Real-life flows would
probably include processing steps such as preflight or color conversion.

The Submit point on the left (Creatives) allows submitting jobs to the flow in a controlled way
using the Switch Web Portal. The user's name is automatically remembered; multiple users can
use the same Submit point since each user is identified to Switch through his/her user name and
password. The "Set User Name" script serves to add a user name for jobs submitted through a
regular hot folder (Henry).

The first Checkpoint (Visual Proof) holds the incoming jobs for inspection by a user through the
Switch Web Portal. The user will see the names of the output connections (Approve and Decline)
as buttons in the job card. Pressing one of these buttons moves a job along the corresponding
connection.

The second Checkpoint (Output Jobs) allows a Switch Web Portal user to decide how the jobs
will be stored or processed. This Checkpoint is configured to allow multiple outputs at the same
time; for example both "Store in DAM" and "Create Proof".

Setting up a Submit point

When setting up a Submit point (Creatives in the example flow), you can configure it in such a
way that the user must enter one or more data fields before submitting a job to this Submit point.
The entered values are associated with the job as metadata.

To enable this option, in the properties of the Submit point element:

1. Set Submit to Job and metadata or Metadata only (if the user should only submit a form,
without a job).

2. Inthe Metadata fields property, define the metadata fields for which the user should provide
a value, for example a Job ID and the date of submission.
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3. The Dataset name field is completed automatically. This is the name of the dataset that will
be created containing the contents of the metadata fields entered by the user.

4. Invalidate user metadata cache on login and Invalidate metadata cache condition have to
do with caching dynamic values, which can be useful to speed up processing.

For a full description, refer to 'Defining metadata fields' in the Switch Reference Guide.

The following screenshot shows how a user will have to enter the data (Job ID and Date)
configured in the Submit point.

Food.pdf > X

Metadata Info I

Job ID

Bk

v

[ Date

Note: It's also possible to set up a Submit point that triggers an Action. In that case, the
Submit point on the Switch Web Portal acts like a button: when a user clicks it, a dummy
job (*.dummy) moves through the Switch flow and (depending on the flow) this job can
start a process, call a database, ...

Setting up a Checkpoint

Similarly, when setting up a Checkpoint (Visual Proof and Output Jobs in the example flow), you
can ask Switch to display additional information about the job, and the user may be asked to
enter additional data fields before acknowledging a job. (This is the case if the Enter and display
metadata property is set).

Furthermore, the output connections of the Checkpoint determine which buttons will be shown
to the user for acknowledging a job.

For example, the Visual Proof Checkpoint in the example flow is configured in such a way that
the user will see two radio buttons ('‘Decline' and 'Approve’, named after the connections); clicking
one of the buttons causes the job to move along the corresponding connection. This is the
default behavior of a Checkpoint if two output connections are defined and no metadata has
been enabled.

Routejob to: () Approve () Decline

On the other hand, the Output Jobs Checkpoint in the example flow is configured in such a way
that the user can select more than one option, causing a duplicate of the job to be sent out over
each of those connections. This is possible if the Allow multiple outputs property is enabled.

In this example, the user that has to review the files will see 3 checkboxes (the names come from
the output connections in Switch) and can select one, two, or three checkboxes as required.
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Route jobto:  [] Create Low-Res [] create Proof [[] storein DAM

For an overview of all properties, refer to the description of the Checkpoint flow element.

Metadata in Submit points and Checkpoints - default values

When defining the default values for the metadata fields, you can use a number of variables that
automatically retrieve information from the computer that is used to submit or check jobs. As a
consequence, this information does not need to be entered explicitly by the user; it can even be
sent along with the job without being displayed.

The variables concerned are the so-called Connection variables:

« [Connection.Email]

« [Connection.FullUserName]
+ [Connection.IP]

« [Connection.UserName]

If you use those as default values for your metadata fields, they will be replaced automatically
with their actual values.

To make this happen, "bidirectional communication" is established between Switch and the
Switch Web Portal:

1. The Switch Web Portal requests the default value of the metadata fields, being a connection
variable.

2. Switch Server sends the connection variable e.g. [Connection.IP] to the Portal.

3. The Portal replaces the variable with its actual value and sends the actual value along with
the job back to Switch Server.

Use case: To keep track of the clients used to submits jobs, you could configure a metadata field
"IP address" and set the default to [Connection.IP]. When a file is submitted, the IP address of the

system used to submit this file is entered automatically and sent along with the job. It depends on
the metadata field properties whether or not this field (with the actual value) is shown to the user

and whether or not it can be changed.

Re-using metadata fields from a Submit point in a Checkpoint

Switch provides an easy way to re-use the metadata fields defined for Submit points in a
particular Checkpoint.

To re-use an existing metadata field, simply click the l_l button (instead of the green plus button)
in the Define metadata fields dialog. This will open a dialog like the one shown below.
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[ ] ® Choose metadata fields from SubmitPoints

Metadata Fields From SubmitPoints

Creatives
) JobID
) Date
Content
) Order number

Cancel OK

You can now select the metadata fields you want to re-use (based on the Submit points defined
for the current flow). Note that the added metadata fields have only two editable options: Read
only (yes/no) and Display metadata field (yes/no). The other options are grayed out and cannot
be changed.

Remark: Although all Submit points present in the flow are shown, you must keep in mind that
only the Submit point that is used for the job will send metadata. Refer to the example below:
since all jobs in Checkpoint 1 come from Submit point 1, it does not make sense to add metadata
from Submit point 2 to Checkpoint 1 (and vice versa).

If configured incorrectly, the connection variables (if used) will not be replaced with the actual
values (users will see e.g. [Connection.UserName]) and metadata fields for which there is no value
entered will be blank.

If configured correctly, when checking the Alert job on the Portal, the connection variables (if
used) will be replaced with the actual values (e.g. EAW13DL399 instead of the [Connection.IP])
and the metadata fields that were completed at the time of submission will show the entered
data.

» (2]

Submit point 1 Folder1 Chedkpaint 1

3 @)

Submit point2 Folder 2 Checkpoint 2
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4.4.8.2.

Configuring user access

How to proceed
Follow the guidelines and instructions described in the chapter "Configuring Switch users". :

1. Set up the appropriate users and configure their user name, password, email address,...
2. Give them access to the appropriate Submit points and Checkpoints.

Configuring the communication settings
To configure the communication settings for communication with the Switch Web Portal

1. Navigate to:

« On Windows: Edit > Preferences.
. On Mac OS: Enfocus Switch > Preferences.

The User preferences dialog appears.
2. Inthe left part of the dialog, click the Web services category.

3. Make sure the Port for the Switch Web Portal preference is set to 51089, unless there is a
good reason to change it.

4. Click OK.

The Submit Jobs view

The Submit jobs view allows you to submit jobs to the Switch Server. You can see all Submit
points that you have access to, based on your permissions (as set in the Users pane in Switch).
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Check Jobs . : P
A All Submit points & Hide inactive #

Q Submit Jobs §
=
[FU

Active jobs

Alert jobs 18 | Brochures Database
Completed jobs No description available No description available.
i Active Active

PMNGs E

Online Ads Submit files (GWG
Mo description available

Active Not running

° o oo

«

ﬂ Note: One of the Submit points ("Submit files (GWG..)") in the screenshot is slightly grayed
out, because the Switch flow is currently not running. As a consequence it is not possible
to submit jobs to that Submit point. You can hide these inactive Submit points by clicking
the Hide inactive button next to the search field.

Submit point types

There are four different types of Submit points. You can recognize them by the image and
text mentioned on the Submit point. It depends on the configuration in Switch which types are
available on the Portal.

Submit point Description

This Submit point only accepts job files and folders, no
- metadata.

n n V Click the first button u to upload separate files, click the

second button n to upload a folder (which can include
files and subfolders, taken from different locations). Note
that you can also drag and drop jobs onto the Submit
point (but in that case you cannot add extra job files or
folders afterwards).

ﬂ Note:

« If only files are accepted, you'll only see the
first button. If only folders are accepted, you'll
only see the second button.

« Certain file types may be disallowed; in that
case, you will get a warning, when trying to
submit such a file.
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Submit point Description

This Submit point accepts both job files and folders and
metadata (= extra information about the job that has to be
supplied when uploading a job).

Click the first button n to upload separate files, click the

second button n to upload a folder (which can include
files and subfolders, taken from different locations). Note
that you can also drag and drop jobs onto the Submit
point (but in that case you cannot add extra job files or
folders afterwards).

ﬂ Note:

- If only files are accepted, you'll only see the
first button. If only folders are accepted, you'll
only see the second button.

« Certain file types may be disallowed; in that
case, you will get a warning, when trying to
submit such a file.

Once you have uploaded the job(s), you can enter the
requested information on the Metadata tab of the Submit
jobs dialog.

This Submit point only accepts metadata. You need to fill
out a form.

KIETADATA

Click the button E to open the form and supply the
requested information.

This Submit point allows you to send a trigger.

When you click the button , a database is called, a
process is started, ... (depending on the configuration in
Switch). A notification will be shown to confirm that the
trigger was sent.

Favorite Submit points

You can mark your favorite Submit point(s) by clicking the star icon , So it turns blue * .
Favorites are displayed in a collapsible, separate section at the top of the page. The number of
favorites is mentioned in the header.

320



ENF@CUS

Switch

Process

Final version anly

Actvee

A All Submit points &

Hide inactive

Settings

List view

Eaarch Sikemit Baini
BT =W EHTIL PEHIRS: n

Print settings

Specifications

Process

dizplay descnplion

*

QA

QOnly fiur Chsnm

Via the menu in the top right corner, you can switch to List view (see further) and open the Submit
points management dialog (by clicking "Settings"). The table below lists what you can do through

this dialog.

Submit points management

Process
Submit PDF files

Submit reports

What you can do in the Submit points
management dialog:

How:

overview

Remove Submit points from the Favorites

Click the blue star icon * next to the Submit
point you want to remove. Note that it's only
removed from the Favorites section, not from
the All Submit points section.

Favorites overview

Change the order of the Submit points in the

Click the icon

preceding the Submit point
and drag and drop the Submit point upwards
or downwards as required.

List view

It's possible to display the Submit points in "list view", optionally even sorted by flow and flow

group.
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This view can be displayed via the gear wheel button next to the Search field.

All Submit points 27 Show inactive

/" Sort on flows/groups

W List view

~ My Flows

~ Sorting files

Metadata only

Mo description available.

Active

SortingProduction

Files (only PDF) and folders allowed.

Job folder Active

Separate file(s)

Trigger

Mo description available.

Extra options
Clicking the button i next to Submit Jobs gives access to a context menu with two options:

« Manage Submit points: This option opens the Manage Submit points URLs dialog, where you
can create direct links to one or more Submit points. Refer to Creating a shareable Submit
points URL on page 326.

ﬂ Note: This feature is only available if you're a Switch administrator.
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- Set as Homepage: When you click this option, the Submit jobs view will become your default
start page for the Switch Web Portal.

4.4.8.3. The Check Jobs view

This view allows you to view jobs submitted through a Submit point on the Switch Web Portal,
and to check and route jobs waiting in a Checkpoint.

It depends on your user permissions (set in the Users pane in Switch) which jobs you can see
and/or further process.

.
o Submit Jobs Check Jobs E| 2L obs v jobs Updued ) -
80 jobrs o by tizee by
Check Jobs L% 0N | Untrebesn OGO 1802 | ==
Active jobs
entity_notok.pdl wlinder.pdl switch reference
[ YT P - uide 10112021,
LU] Alert jobs BED g' ? 9
Q
Completed jobs o.%_
o =)
—
@j +5MB
.5 MB Status
5 MB (IPEG) Trp
e Size
@ -5 MB (PDF) ! fle
Checkpaint kpoint Submitted to
-5 MB (TXT) Updated 2022 154018 User
Metadata N Checkpalnt
° PressReleases Enfocus Magazine Archive 2
2021-web.pdl

This view, similar to the job boards view, has a couple of buttons that the Submit Jobs view
doesn't have:

Buttons Meaning

Check Jobs £ The button  beside Check Jobs gives access to a menu
with two options:

- Create Filter: This option enables you to create
custom filters, to display only a subset of the jobs you
have access to. Refer to Creating a custom job filter
on page 331.

- Set as Homepage: When you click this option, the
Check Jobs view will become your default start page
for the Switch Web Portal.

This link enables you to display or hide the fields of your
choice. See Job fields on page 329.

Customize

fields

Group By default, the jobs are not grouped, but you can group
jobs v them by flow, state or stage.

by Mone
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Buttons Meaning

Note: This option is only available in grid view.

Order This button allows you to change the sort order of the
jobs Updated |§ ~ jobs in the overview. In this example, the jobs are sorted
by in descending order (arrow down) by the date they were

last updated (= value of the field "Updated").

This search field enables you to quickly find the jobs you
need.

The auto refresh option can be turned off if needed.

Q

ON Last refresh: 06/05/2022 15:25:42

These buttons allow you to Switch between table view
E and grid view (the latter is shown in the screenshot):

- In table view, every row represents a job; the job
details are shown in the different columns.

« In grid view, every job card represents a job; the job
details are listed on this card.

The active button is shown in blue.

These buttons allow you to Switch between large,
] medium or small job cards.

The active button is shown in blue.

Filters

Below Check Jobs you find a number of pre-configured
filters (Active jobs, Alert jobs, Completed jobs and My
jobs) plus the custom filters you have created yourself (in
this example: Filter: only PDFs and Filter: only PNGS).

Check Jobs
Active jobs

HDD Alert jobs When you click a filter, it's applied immediately. Refer
= to Viewing jobs through the Switch Web Portal on page

Completed jobs 327.

Also, note the orange exclamation mark: it's a
My jobs notification that there is at least one alert job. This is

most useful when the sidebar menu is collapsed.
Filter: anly PDFs
A The counter next to Alert jobs indicates the number of

Filter: only PNGs jobs waiting to be processed.

4.4.8.4. Submitting jobs through the Switch Web Portal

It is possible to submit single files or multiple files, or files contained in a folder (for example a
page layout with its accompanying images and fonts or the individual pages in a book). A job
folder may contain nested subfolders (which can contain other files and folders, recursively).
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If the files are contained in a folder, they will be considered as one job with one dataset; it will not
be possible to enter metadata for each file separately.

It's also possible to submit metadata only (so a form without a job), or to send a trigger.

Note:

« Remember that the Switch Server must be running and that the Switch flow must be
activated. Otherwise, the jobs will not be processed.

« Some Submit points require that you install Switch Helper on your computer. If (the
appropriate version of) Switch Helper is not installed, you will get a warning and a
link to download this free tool from the Enfocus website. Note that the Switch Helper
tool does not function well when you're launching the Web Portal through an HTTPS
connection in Firefox or Safari (due to security constraints implemented in these
browsers), so we recommend using HTTP, or HTTPS but with a different browser (like
Google Chrome or Edge).

To submit a job to a particular Submit point:

1.

In the Switch Web Portal, in the sidebar menu, click > 3 > Submit Jobs.

You can see the Submit points you have access to. Note that not all Submit points accept all
types of jobs... the accepted type ("files", "'metadata”, "trigger") is mentioned on the Submit
point. Depending on the configuration, certain jobs may not be allowed. Refer to Submit jobs
view.

Do one of the following:
- To upload job files or folders, "drag and drop" the file(s) or folder(s) you want to submit
onto the Submit point of your choice. Alternatively, click n to upload one or more files

(for submission as separate jobs) or n to upload a job folder (and optionally add extra
files or subfolders from different locations). If it's not allowed to submit either files or
folders, the corresponding button will be missing.

Note: To select multiple files or folders, hold down the Ctrl key while selecting.

- To upload metadata only, click the "metadata only" Submit point and proceed to step 4 of
this procedure.

- To send a trigger, simply click the "trigger" Submit point. The trigger is sent immediately.
You're done!

If you have dropped multiple job files on a Submit point, you'll be asked whether or not the
jobs should be submitted as one job or as separate jobs.

« To move all files and/or folders along the flow as a single entity (or job collection), click
One job.

Note: If One job is enabled, the value of job.origin will be the origin of the first job
in the job collection.

- To move all files and/or folders along the flow as separate jobs, click Separate jobs.

If the Submit point has been configured to request additional information about the job
("metadata"), the Submit jobs dialog will contain or more entry fields on the Metadata tab.
Enter the requested information.
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The Info tab mentions the name of the flow and the name of the Submit point used to upload
the job.

5. Change the job name at the bottom of the dialog as required.

The chosen job name will replace the file name. For example, if the job name is "testjob", the
job file "customerX.pdf " will be renamed "testjob.pdf". The file extension remains the same.

In case of a job folder, the job name will replace the name of the folder. The files contained in
this folder will not be renamed.

In case of multiple files being submitted in one go, you cannot enter a job name, unless you
have chosen to process them as one job (see step 3); in that case, they are put in a folder and
the chosen job name will be the folder name. If no name is chosen, the name of the first job in
the list will be used as name for the folder.

6. Click Submit.

Note that the progress is displayed in the bottom right corner of the screen. The progress bar
shows which files have been submitted successfully, and which are still uploading.

Progress Bar v X
testFDF_0006. pdf 0%
testFDF_0005. pdf 0%
testFDF_0004. pdf a5%
testPFDF_0003. pdf GG%
testFDF_0002. pdf 95%

4.4.8.5. Creating a shareable Submit points URL

Submit point URLs are direct links to one or more Submit points. The URLs can easily be
distributed, for example via email.

Note that only Switch administrators (= Switch users registered as administrator in the Switch
Users pane) have the right to create shareable URLs.

To create a shareable Submit point URL

1. In the Switch Web Portal, in the sidebar menu, click > 3 > Submit Jobs.

If you don't see the +Manage link, you may not have the required user permissions.

2. (Click the button i beside Submit jobs.
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In the menu that is displayed, click Manage Submit points.

In the Manage Submit points URLs dialog, click New URL.
A row is added to the dialog. The first column is empty: the URL will be added after you have
selected the Submit point(s) and after having clicked Apply.

Enter a description.

Drag the slider to the left to disable the authentication option as required.

« Note that the authentication option is only available if the Web Services Module is
licensed. If that is not the case, users will always need to enter their credentials before
getting access to the Submit point(s).

- By default, authentication is enabled, meaning that the user needs to enter his Switch
credentials to get access to the Submit point(s). Note that the user's other permissions
are also taken into account. For example, if the user has no right to submit jobs, he won't
see the Submit jobs view, so he won't be able to use the URL. The other way around, if
the user has access to other functionality, or to more Submit points, he will have the same
options as when he had signed in through the regular Web Portal address.

- If authentication is disabled, everyone who clicks the link will have access to the selected
Submit point(s). No credentials will be required. Only the selected Submit points are
accessible, all other functionality on the Portal is hidden.

In the Submit points column, click Select to select the Submit point(s) concerned.

In the Expiration date column, click the None link to enter an expiration date as required.

The URL will become invalid as of the set date. The format in which the date is displayed, is
determined by your browser settings.

Click Apply.
The URL is added.

* To copy the URL (for distribution), click the Copy URL to clipboard icon.ffl—

You can later make changes to the configuration of the URL, for example add extra Submit points

or

change the authentication setting. This won't change the (probably already distributed) URL in

the first column. You can remove the URL by clicking the red cross button m that appears when
you move your pointer over the URL.

Note: The use of the shareable URLs is logged and can be found in the Messages
overview. This way it's possible to find out which jobs were submitted through which
(shareable) URL. For security reasons, only part of the URL is shown in the Messages.

4.4.8.6. Viewing jobs through the Switch Web Portal

To view Switch jobs through the Switch Web Portal

1.

In the Switch Web Portal, in the sidebar menu, click > 3 > Check Jobs.
You can see all jobs you are allowed to see based on your user permissions (set in the Switch
Users pane).

To view only a particular set of jobs, apply a filter.
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« Click one of the pre-configured filters in the sidebar menu below Check Jobs, for example
'My jobs'. Refer to Job filters on page 330.

« Create a filter yourself. Refer to Creating a custom job filter on page 331.

The jobs matching the selected filter (now highlighted in the sidebar menu) are shown. If you
don't see the jobs you expected to see, check if:

« The Switch Server is running.

« The information displayed is up-to-date. Refresh your browser window to update the
information from the Switch Server.

Note that you can stop filtering by returning to the Check Jobs view. In case of a custom filter,

you can remove the filter by clicking the button i next to the filter name. In the menu that
opens, click Delete.

3. To view the jobs presented in a different way, click the Table view or the Grid view button.

B

The first button enables table view, the second enables grid view.

View Example
Table Mame Updated ¥ | Stawus Initiated

view =" BoardingPass What's new,pef 09/05/2022 16:32:12 Processing 310172022 133225
viinder pif 05/05/2022 15:40:15 05/05/2022 15:40:15

Tricpdf O5/05/2022 15:31:15 231172021 15:17:33

Table-specific options:

« Every column represents a field. To hide a column, show an extra
column, or change the order of the columns, click the blue Customize
fields link at the top of the screen. See Job fields on page 329.

« To sort the overview, click the header of the column you want to use to
sort the overview. An upward arrow appears and the jobs are shown in
ascending order. If you want the jobs to be ordered in descending order,
click the arrow once more, so it turns into a downward arrow.

Grid view

BoardingPass Wh viinder.pat Tripaf
ats newpdf

vl
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For an overview of the other options that enable you to customize the Check Jobs view, refer
to The Check Jobs view on page 323.

4. To view the details of a job and eventually review and process the job:

« |n table view, click the row concerned.
- In grid view, click the Process button of the job you want to check and/or process.

See also: Reviewing and processing jobs through the Switch Web Portal on page 334.

Job fields

The following table gives an overview of the job fields that can be shown on the job cards on the
Switch Web Portal (both on job boards and the Check Jobs view).

Job fields Overview

Available fields Default fields:

These fields are shown by default, unless you hide them through
the Customize fields link.

+ Checkpoint

. Flow

» Initiated

+ Locked by

+ Metadata

. Size

« Status

« Submitted to
+ Type

- Updated

+ User

Other available fields:

« Dimensions

« Family
+ Files
+ In state since
+ Modified
« On alert since
. Pages
. Stage
+ State
Custom fields . Custom fields are fields configured in Refresh job info. You can

also show them on your job board.

- Large job cards can display up to 8 fields.

« The first field in the selection is shown when users hover over the info icon on the small job
cards.

- Fields for which there is no value will not be shown on the job cards.
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« You can hide or show fields through the Customize fields link on the Check Jobs view or on
the job boards. Note that you can change the order of the selected items in the column on

the right ("Selected"), by clicking the icon "t to the right of the item you want to move and by
dragging it to its new place.

- As the creator or owner of a job board, you predefine the fields to be shown, but other users
can define their own personal view if they want, which will be applied to their web session
and will be stored in the cache of their web browser. Choices are remembered among the
different browsers.

Job statuses

The following table gives an overview of the statuses a job can have on the Switch Web Portal.

Status

Meaning

Processing

element.

The job resides somewhere in the flow but not in a Checkpoint,
and it is not finished yet. This includes jobs in the Problem jobs flow

Alert

displayed in orange.

The job resides in a Checkpoint and is waiting for intervention by
an operator. The number of alert jobs is indicated by a counter in
the sidebar menu of the Web Portal. In table view, alert jobs are

Error

more information.

The job failed. You should contact your system administrator for

Completed

the flow.

The job has been processed and has arrived in the output folder of

Job filters

Default job filters

The table below provides an overview of the default, pre-configured filters in the Check jobs view
on the Switch Web Portal.

Filter

Displays:

Active Jobs

All jobs that are somewhere in the flow, but not in an end folder (that is, not
yet completed). This includes files that reside in the Problem jobs folder.

Note: This only applies to jobs that are visible to you.

Alert Jobs

All jobs waiting in a Checkpoint.

Note: You can only see the jobs in a Checkpoint that you are

allowed to access (as configured in the Users pane in Switch).

Completed Jobs

Displays all the jobs that reside in an end folder in Switch.
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Filter Displays:

Note: This only applies to jobs that are visible to you.

My Jobs All jobs submitted by you, i.e. the current user, regardless of their current
status (processing, alert, completed).

Custom job filters

You can as well create your own filters, for example you can create a filter to display all jobs in a
particular Submit point or Checkpoint, all jobs with a particular status, all jobs initiated before or
after a particular time, etc.

Refer to Creating a custom job filter on page 331.
Note that:

« These filters are not visible to other Switch users signing in to the Switch Web Portal.
« These filters can also be used to determine which jobs should be shown on your job boards.
Refer to Creating a job board based on job filters on page 283.

No filter applied

If no filter is applied, you can see all jobs you are allowed to manage.

Creating a custom job filter
In the Check jobs view on the Switch Web Portal, you can create your own, custom filters.

You could for example create a filter that displays all jobs with a certain status that were
submitted to a particular Submit point.

To create a custom filter
1. In the Switch Web Portal, in the sidebar menu, click > “J > Check Jobs.

2. Click the button  next to Check Jobs and choose Manage filters.
3. Click New filter (in the bottom right corner).

4. |Inthe dialog that pops up, beside the Close button, enter a meaningful name for the custom
filter.

Each filter needs to have a unique name.

5. Configure a filter rule: select the appropriate filter field, choose an operator and enter the
value of your choice.

Submitted to

4k
&

¥y =ubmit point 1 m

Example filter fields are: Checkpoint, On alert since, Files, Flow, ... "Familystarter" refers to the
first job in a job family, being a set of jobs that have been generated from the same original
job. For example, a PDF, its Preflight Report, the preflighted and the low res version, ... they all
belong to the same job family.
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Tip: User "is current user" is an interesting filter rule that allows re-using a particular
filter for all users on the Web Portal. For example, if you create a filter that shows all
alert jobs for the currently logged in user, you don't have to configure such a filter for
each user separately.

6. To configure a second rule or rule set, click the appropriate button:

« To add one rule, click the green Add rule button.

- To add several rules, which are related to each other (through an AND/OR relation), click
the green Add group button.

If you have made a mistake, you can remove the rule concerned by clicking the red Delete
button.

7. Once you have configured your rules, make sure to indicate the relation between the rules
and the rule groups, by clicking the appropriate button:

u means that for each job it is checked if all rules apply. For example, with Checkpoint
= Checkpoint 1 AND job status = alert only the jobs in Checkpoint 1 that have the alert
status will be shown.

n means that at least one of the rules should apply. For example, with Checkpoint =
Checkpoint 1 OR job status = alert, all jobs in Checkpoint 1 are shown (regardless of their
status) and all jobs that have the alert status (regardless of the Checkpoint they are in).
The And/Or option is only relevant if you're configuring more than one rule.

The following example results in a list of jobs submitted to Submit point 1 AND having a
certain status, which can be either Alert OR Error.

Submitted to = [Is 4 Submit point 1
Status | iz 5| | Alert ]
Status —IN | +| | Error y

8. Ifrequired, repeat step 5 until you have configured all rules you need.

9. Click Apply or Apply and save as required.

The newly created filter is displayed in the sidebar menu.

Managing custom job filters

This topic explains how to handle the custom filters in the Check jobs view on the Switch Web
Portal.

332



ENF@CUS Switch

The filters are listed in the sidebar menu below the pre-configured filters. They are sorted in
alphabetical order (A-Z); you cannot change the order.

1.

2.

In the Switch Web Portal, in the sidebar menu, click > 3 > Check Jobs
Open the Manage filters dialog as follows:

1. Click the button } next to Check Jobs.
2. Choose Manage filters.

Note: The custom job filters are listed. Pre-configured job filters are not listed in
the Manage filters dialog, as they cannot be edited, shared, exported/imported, or
removed.

Do one of the following as required:

To ... Do the following:

To create a new filter Click New filter (blue button in the bottom
right corner). See also Creating a custom job
filter on page 331.

To edit a filter Click the edit button Edl (which becomes
visible when you hover over the job filter
concerned).

Note: Alternatively, you can click

the button = beside the job filter
name. The menu that pops up also
has an Edit menu option.

You can now make changes as required.
See also Creating a custom job filter on page
331

To share a job filter or to stop sharing it Job filters can be shared with other members
of the same user group (as configured in
Switch).

To share or stop sharing, in the Sharing
column of the job filter concerned:

1. Click Private/Shared.

2. Inthe dialog that pops up, select or clear
the checkbox of the group(s) with whom
you want to share your job filter. If no
dialog pops up, you cannot share the job
filter (for example because you're not
configured as member of a group).

Note: Shared job filters can only
be viewed (not edited!) by other
users.
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To ... Do the following:

To import or export a job filter Job filters can be exported and imported
again if needed.

To export a job filter, click the export

button next to the job filter you want

to export. A Switch job filter is saved with
extension .sfilter. Note that the export button
becomes visible when you hover over the
job filter concerned.

To import a job filter, click the Import filter
button at the bottom of the dialog and select
the job filter (*.sfilter) of your choice.

To hide or show a job filter To hide a job filter, drag the slider in front of
the job filter name to the left, or click it. It will
turn gray and the job filter will no longer be
present in the sidebar.

To show a hidden job filter, drag the slider
in front of the job filter name to the right, or
click it. It will turn blue and the job filter will
again be present in the sidebar.

To permanently remove a job filter i ﬂ
Click the remove button. Note that the

remove button becomes visible when you
hover over the job filter concerned.

4. To save the changes made in the Manage filters dialog, click Apply.

4.4.8.7. Reviewing and processing jobs through the Switch Web

Portal

Checkpoints are intermediate folders in a flow where jobs that arrive are being held until they are
reviewed by an operator. Once reviewed, the operator indicates how they should move along the
flow.

You can review these jobs one by one, or in batch as described below.

Processing one job at a time

To review a job being held in a Checkpoint:

1. In the Switch Web Portal, in the sidebar menu, click > 3> Check Jobs.
All jobs that you have access to, regardless of their status, are displayed in the overview.

2. Click Alert jobs.

This is a pre-configured filter. Alert jobs are jobs waiting in a Checkpoint you have access to.
The counter indicates the number of alert jobs.
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Remember that you can switch between table and grid view as required (buttons at the
bottom of the screen).

Select the job you want to review and route:

- Intable view: Double-click the job concerned.
« In grid view: In the job card of the job concerned, click the Process button.

A dialog opens and displays more detailed information about the selected job.

Review the job as required, using the options in the right part of the dialog, below the
thumbnail of the job.

For an overview, refer to Review options on page 336.

On the Process tab, enter extra info ("metadata") if requested.

This depends on the setup in Switch.

Switch

Note: If you entered metadata before locking or replacing a job, you will be
requested to enter it again.

Route the job:
At the bottom of the dialog:

- If you see radio buttons, choose one of the options.
« If you see checkboxes, you can select more than one option if appropriate.

Click Push.
The dialog is closed automatically. The job will move along the chosen connection(s) in

Switch. The job status will change over 'processing' to ‘completed’, so it will no longer be

present in the Alert jobs overview.

Processing multiple jobs as one

This topic explains how you can process a number of alert jobs in one go.

Note that this is only possible for:

Alert jobs waiting in the same Checkpoint,
Which all need to be moved along the same output connection,
With the same metadata values.

To process multiple jobs proceed as follows:

1.

In the Switch Web Portal, in the sidebar menu, click > 3> Check Jobs.

All jobs that you have access to, regardless of their status, are displayed in the overview.

Click Alert jobs.

This is a pre-configured filter. Alert jobs are jobs waiting in a Checkpoint you have access to.

The counter indicates the number of alert jobs.

Remember that you can switch between table and grid view as required (buttons at the
bottom of the screen).

3. Click the checkboxes of the jobs you want to combine.
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In grid view, the checkboxes become visible when you hover over the job cards. As soon as
you have selected a job, the jobs waiting in a different Checkpoint are grayed out, because
you can only combine jobs that are waiting in the same Checkpoint.

4. Click Process multiple in the bottom right corner of the screen.
The number of jobs contained in the selection is shown.

5. To review the jobs one by one, use the arrows in the top left corner to navigate between
them.
For more information about the options in the right part of the dialog, below the thumbnail of
the job, refer to Review options on page 336.

6. On the Process tab, enter extra info ("metadata") if requested.
This depends on the setup in Switch. The metadata value should be valid for all jobs in the

selection; it's not possible to have a different value per job file.

7. Route the job:

- If you see radio buttons, choose one of the options.
« If you see checkboxes, you can select more than one option if appropriate.

Note that your choice applies to all jobs in the selection.

8. Click Push.
The dialog is closed automatically. The jobs will move along the chosen connection(s) in
Switch. The job status will change over 'processing' to ‘completed’, so it will no longer be
present in the Alert jobs overview.

Review options

This is an overview of the options that are available when you're reviewing a job that is held in a
Checkpoint.

Some of the options may be missing; this depends on the setup in Switch. For example, if editing
or report viewing are not allowed, these options do not show up.

Option Meaning

View Allows you to view the job file(s). The job is opened in the browser, if the
browser supports the job's file type (e.g. PDF, JPEG). If the browser cannot
open the file and also in case of a job folder, you will be asked to save the
file(s) or folder locally, or they will be downloaded. The behavior depends on
your browser settings.

When a job is being viewed, it cannot be modified or saved. The job is not
locked automatically, so it remains editable for other users, unless you lock it
by clicking the Lock option (see further).

Note: You may have to turn off pop-up blockers.

Replace Allows you to replace the current job file with another one. The uploaded
file(s) will be further moved along the Switch flow.
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Option Meaning

Note: If another user is trying to replace the job at the same time, a
warning is displayed. You can then either cancel your replacement
request or overrule the other user's replacement process and start
your own. This can be useful if the other user has left the computer
in the middle of a replacement request and cannot be reached, orin
case of a system crash.

Report Allows you to view a report with metadata, if there is one associated with the
job.

For more information, refer to the documentation on Checkpoints.

Lock / Unlock Lock: Allows you to lock the job, so that the job (and the report) cannot be
processed, edited, reverted or replaced by any other user.

Other users can still view the job, save a local copy and open the individual
job card, but they will get a message stating that the job is in use by another
user.

Unlock: Allows you to unlock jobs you have locked yourself.

Note: Users that belong to the administrator group can unlock all
jobs; group managers can unlock all jobs from users in their group.

Edit (in Allows you to edit the job file in the native application.
application) While a job is being edited, you can upload the changed job file or cancel
editing.

For the full procedure, refer to Editing a job in a Checkpoint (Switch Helper)
on page 337.

Note: This option is only available if you have installed the Switch
Helper (a small tool that you can download from the the Enfocus
website). If you haven't, you can also edit the job file, but you'll first
have to download and save it locally. Refer to Editing a job in a
Checkpoint (no Switch Helper) on page 338.

Editing a job in a Checkpoint (Switch Helper)

If you have installed the Switch Helper (a small tool that you can download from the the Enfocus
website), you'll have an Edit <in application> button.

Note: This option is not available if you're launching the Web Portal through an HTTPS
connection in Firefox or Safari (due to security constraints implemented in these
browsers).

To edit a job

1. Click the Edit button.
The file is opened in the native application, for example Adobe Acrobat. The Edit button on
the Portal is replaced with an Update and a Cancel button.

2. Make the required changes.
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3. Save the file in the native application.

4. Click the Update button to upload the changed version.

Editing a job in a Checkpoint (no Switch Helper)

This procedure is applicable if you're using Switch 2017 or if you haven't installed the Switch
Helper application.

To edit a job

1. Lock the job file(s), so no one else can make changes while you're busy with the file.
2. Save the job locally.

3. Make the required changes to your local copy.

4. Use the Replace button to upload the changed version.

4.4.9. Using the Web Portal Admin view

Switch administrators (i.e. users that are part of the Administrators group as set in the Users pane)
have an additional view: the Admin view. This view gives access to additional functions, such as
the option to start and stop flows remotely.
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D Flows

_ Flow Viewer
— System Info
]QD Logins

= Customization

0%

4491 Admin view: Flows

Administrators can remotely start and stop Switch flows through this view.

However it's not possible to edit the flow properties; to do that, you still need Switch Designer.
That's also the case if your flow is invalid or incorrectly configured.

Note that this view also gives a quick overview of all your flows, and shows which flows are
running and which flows are stopped.

Note: Starting or stopping flow groups (so a number of flows in one go) is not possible
through this view. That is only possible through the flow viewer.

4.4.9.2. Admin view: Flow viewer

Administrators have access to the flow viewer: a remote and read-only view on their Switch flows.

The flow viewer page layout

When you click the Flow viewer button in the Admin view, the flow viewer opens in a separate
tab. Below the screenshot, you can find a description of the flow viewer's page layout.
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= o Load balancing processes

Flows Annotations @ M

Q load balancing processes x

~ 3 Hold job
Output 1
Load balancing processes »
e
_D_ —_——
.
Elemnent "File Balancer"
— Input File Output 2
Balancer

File Balancer

Description

Job priority @
Default Output 3

Delay scheme
None @
Output order

Cyclic

Screen part Description

1. Title bar and menu button The title bar displays the name of the flow that is currently
selected in the Flows tab of the Flows panel (2). This

is also the flow that is displayed in the right part of the
screen.

The menu E has two options:

- Back to the Switch Portal
« Print View

2. Flows panel with two tabs The Flows tab gives an overview of the flow groups and
the flows on the Switch Server (similar to the Flows pane
in the Designer), in a tree structure. You can expand or
collapse the flow groups by clicking the arrows in front of
the flow group names.

The selected flow is shown in the right part of the screen.
Its properties are shown below the Flows panel.

Note the flow status icons:
F: The flow is running.
2 The flow is scheduled.

#: One or more flows (but not all) of the flow group are
running.
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Screen part Description

The three dots button (to the right of the flow/flow
group) enables you to stop or start the flow or the flow

group.
The Annotations tab displays the annotations added to

the selected flow. The content can be viewed by clicking
the annotation.

Clicking the icon @ in the top right corner of the panel
expands or collapses the side panel.

3. Properties panel This panel shows either the properties of the flow
(selected in the Flows tab) or the properties of a flow
element (selected in the right part of the screen).

4. Canvas with the flow design This is a read-only view of the flow selected in the Flows
panel.

Some tips to improve readability:

« Tozoom in and out: press CMD (CTRL on Windows)
and ||+|l Or ll_ll
« To move the flow on the canvas: click somewhere near

the flow until the cursor changes to ‘% and then drag
the flow to the place of your choice.

« To modify the size of big flows so they fit on the screen,
open the context menu and click Scale to fit.

Note: You can leave the flow viewer via the menu E in the top left corner; choose Back
to the Switch Portal.

Viewing flow and flow element properties

To view the properties of a flow and/or the properties of the flow elements through the Switch
Web Portal, proceed as follows:

1. Click > .fg\ > Flow Viewer.

2. Inthe Flows panel, with the Flows tab selected, select the flow of which you want to see the
properties.

« You can use the search field to quickly find the flow you need.
« Ifthe flow is part of a flow group, click the arrow icon to expand the flow group.

The flow properties are displayed below the Flows panel.

3. To view the properties of a particular flow element, click the element in the canvas.
The properties of the selected flow element are shown below the Flows panel.
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Note: To go back to the properties of the flow, click somewhere on the canvas (not
on a flow element), or click the flow name in the Flows panel.

Starting and stopping flows
To start and stop flows remotely, proceed as follows:

1 Click > A > Flow Viewer.

2. Inthe Flows panel, with the Flows tab selected, do one of the following:

- If you want to start or stop all flows in a flow group in one go, select the flow group.
- If you want to start or stop one single flow, select that flow.

3. Click the three dots button

4. Select the appropriate option from the menu that appears:

« In case of a flow group, click Start Group or Stop Group as required.
« In case of a single flow, click Start Flow or Stop Flow as required.

Note:

- If a flow cannot be activated (for example because the properties are not
configured correctly), a warning appears. It's not possible to make changes to a
flow via the Flow viewer, so you'll have to fix the flow in Switch Designer.

« If you start a flow group, but not all flows could be activated, an orange icon * is
shown next to the name of that flow group.

Adding annotations to a flow
To add an annotation to a flow in the flow viewer (admin only), proceed as follows:

1 Click > & > Flow Viewer.

2. Place your mouse pointer on the canvas, somewhere near the flow element about which you
have a remark or a question.

You can afterwards still move (click and drag) the annotation as required.
3. Open the context menu and choose Add Annotation.

4. Enter the requested info:

« Choose an icon. This icon will be visible on the canvas.

Icon Meaning

@ Info
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Icon Meaning

Warning

Question

@
@ Note

« Add a short description (mandatory)

« Add a more detailed description (optional)

5. Click Post.

The annotation is added to the canvas and to the Annotations tab in the Flows panel. You (and
any other Switch administrator) can view the content by clicking the corresponding icon on the
canvas or in the Anntotations tab. Note that the name of the user who created the annotation is
also mentioned, as well as the creation date and time.

Viewing, editing and deleting annotations

The small circles with an info, note, question or warning icon in the flow design on the canvas
represent annotations. You can view and edit your own annotations and those of the other Switch
administrators (if any).

® B O

To view the content of an annotation in the flow viewer (admin only), proceed as follows:

1. Click > & > Flow Viewer.

2. Select the flow of which you want to view the annotations.

3. Do one of the following:

- Switch to the Annotations tab in the Flows panel and click the annotation that you want to
view.

« Switch to flow design and click the annotation that you want to view.

The content of the annotation as well as the name of the author and the creation date and
time are shown.

4. To edit the annotation, proceed as follows:

. Click the 3 dots ¢ in the top right corner of the annotation.

b. From the menu that appears, choose Edit.
c. Make the required changes (all fields can be modified).
d. Click Post.
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The modification date or the name of the editor are not displayed.

5. To delete the annotation, proceed as follows:

8. Click the 3 dots  in the top right corner of the annotation.

b. From the menu that appears, choose Delete.
c. Click Delete to confirm.

A notification is shown in the top right corner of the screen (Success: "<annotation>"
deleted!)

Viewing and printing the flow documentation

Note: Via the print function you can also save the flow documentation as a PDF.

To view and print the flow documentation (including the annotations) through the Switch Web
Portal, proceed as follows:

1. Click > % > Flow Viewer.

2. Select the flow that you want to print in the Flows tab of the Flows panel.

In the top left corner of the screen, click the menu E and choose Print View.
The print documentation (the flow plus all properties) is shown in a separate dialog.

4. To save or print the documentation, click Print.

5. Do one of the following:

. To save the flow documentation: from the Destination list, select Save as PDF and click
Save.

« To print the flow documentation: from the Destination list, select the printer of your choice
and click Print.

4.4.9.3. Admin view: System info

In this view, administrators can find information about the Switch processes (CPU, memory, Pid,
time the process was started). A live graph shows the total Switch CPU usage and the Switch
memory usage.
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Switch CPU usage Switch memory usage
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The orange bars indicate that there is no information for that time period (e.g. because the
browser was minimized, or because you switched to a different tab etc.).

If you want more details about the data on the graph, just hover your mouse over the graph to
display a tooltip with the exact numbers (see screenshot).

4.49.4. Admin view: Logins

The Logins view gives administrators an overview of the active users (currently logged in), as well
as an overview of the users that logged in during the last 30 days.

4.49.5. Admin view: Customization

Here administrators can change the look and feel of the Web Portal, by uploading their
company's logo and by adjusting the colors to match their company's brand.

Logos
You can upload up to two logos:

- Large Logo: The image uploaded here will be used for for display on the Web Portal login
page.
Small Logo: The image uploaded here will be shown at the top of the navigation bar and in
the browser tab.

Note: The uploaded image must be a PNG or a SVG file. The size is adjusted
automatically; aspect ratio 1:1 (for example 400x400 px for the large logo) is preferred.

Colors
You can change the following colors in the Portal:

- Sidebar color: Color of the navigation sidebar.
« Sidebar font color: Color of the font used in the navigation sidebar.

« Accent color: Color of the font in the navigation sidebar that is used when you hover over the
elements in the sidebar, or when you select them.

« Rush job color: Color used to highlight rush jobs on job boards (i.e. the color of the label and
of the thin line on the left of the job card).
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Submit point
You can customize the display size of the Submit points.
« Submit point box height:

- Automatic: In this case, the height is adapted dynamically, based on the length of the

display description. As a consequence, not all Submit point boxes will have the same
height.

- Fixed (default): The default value is 270 px, but you can enter any other value between 150
and 400 px. Click Apply to confirm. All Submit point boxes will have the same height.

Reverting changes

The changes made here are applied immediately.

To revert your changes and bring back the original look and feel, click the button : beside
Customization (at the top of the page) and choose Reset to default.

Customization

Set as Homepage

L

Reset to default

4.5. Working with the additional Switch modules

This section discusses the Switch modules that can be added to the Switch Core Engine. It starts
with the feature matrix, which gives an overview of what you can do with each module.

Note that, in order to be able to use a particular module, you must have a valid license. For more
information on activating modules, refer to Installing, activating and starting Switch on page 9.

4.5.1. Feature matrix

The following table indicates what you can do in Switch, depending on the activated modules:

Feature Switch Core | Metadata Scripting Switch Reporting
Engine module module Client module
module

Switch Server and
Designer v

Flow design (canvas,
flows pane, elements v
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Feature

Switch Core
Engine

Metadata
module

Scripting
module

Switch
Client
module

Reporting
module

pane, properties
pane, ...)

Flow execution
(feedback on canvas,
messages overview,
dashboard pane,
statistics pane)

Built-in tools (see Flow
elements matrix on
page 168), apps

Hierarchy info and
email info (internal
metadata)

Variables and read-only
embedded metadata
(EXIF, IPTC, XMP)

Writing and updating
external Xpath-based
metadata (XMP)

External metadata
(XML, JDF) and writable
embedded metadata

Script expressions and
script elements

Script development
environment
(SwitchScripter)

Scripted plug-ins (if
licensed by Enfocus)

Setup for the Switch
Web Portal (users
pane, Submit point,
Checkpoint)
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Feature Switch Core | Metadata Scripting Switch Reporting
Engine module module Client module
module
Access to dashboards
on the Switch Web v
Portal

4.5.2. Metadata Module

The Metadata Module enhances the use of metadata in Switch flows: in addition to Switch-
specific metadata, it gives access to other types of metadata originating from other applications
or stored in other formats that are common in the graphical industry.

4.5.2.1. Getting started with the Metadata Module

Access to other types of metadata

Metadata is information about the job you are processing, such as its size, creation date, number
of pages, paper type, ... In Switch, this information can be used to route jobs, to rename them, to
make decisions, etc.

With the Metadata Module, you have - in addition to Switch-specific metadata - access to XMP
metadata (embedded in side the job and available in most jobs created with Adobe products) and
to metadata in external files (XML or JDF tickets) submitted with the job.

You can:

« Use metadata in Switch just like regular variables to process your jobs dynamically.

« Visualize metadata for jobs submitted through the Switch Web Portal or processed with a
Connector.

« Use the Metadata tools (listed below) to export metadata and convert XML information,
preflight logs and reports into other XML formats, HTML or human-readable information.

Metadata tools

With the Metadata Module, you get access to the tools in the Metadata category of the Flow
Elements pane:

« XML Pickup

« JDF Pickup

« JSON Pickup

«  XMP Pickup

«  XMP Inject

- Opaque pickup

«  Export metadata

Note: Want to know how these tools work? Take a look at the eLearning course about
this topic (for subscribers and maintenance users only).
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45.2.2.

Metadata variables

Once you have "picked up" the metadata set you need using one of the Metadata tools, you can
select the variable of your choice from the Metadata variables group. This group is only available
if you have an active license for the Metadata Module.

Metadata

Metadata overview

What is metadata

In the Switch context, metadata is descriptive information about a job (file or job folder) in a
structured electronic form. Metadata is often used to store administrative information associated
with a job, and to exchange such information between systems. Metadata can be distinguished
from the job contents proper, even if it happens to be embedded in the job.

Historically, metadata has been stored in various proprietary or standard formats. TIFF, EXIF and
IPTC tags (often found in image files) are classic examples. More recently, the industry has moved
to store metadata as XML, building on the strengths of this ubiquitous format. JDF and Adobe
XMP, two XML-based formats, are often used in the publishing industry in addition to generic
XML.

Metadata categories

Switch recognizes three categories of metadata depending on the storage mechanism used to
convey the information, as described in the following table.

Category Description

Internal Switch-specific information stored in the internal job ticket for each
job; for example hierarchy info and email info

Embedded Metadata that is embedded inside the job (as part of the file); for
example EXIF or IPTC tags, or an embedded Adobe XMP packet; see
Embedded metadata on page 394.

External Metadata that travels with the job but is stored as a distinct entity;
for example an XML or JDF file, or a standalone Adobe XMP packet
(possibly extracted from the job file); see External metadata on page

397.
Support for metadata
Switch supports working with metadata in various ways as defined in the following table.
Feature Benefits
Internal job ticket Maintaining hierarchy info, email info and other internal metadata
used by the Switch tools
Variables Read-only access to embedded metadata (EXIF, IPTC, XMP) and file
information
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Feature

Benefits

Pick-up and export

Picking up external metadata (XML, JDF, XMP) from foreign sources

and exporting it for external use

Scripting

Read-write access to embedded metadata and external metadata

Defining text with variables

Text properties that support variables can be edited with the Define single-line text with
variables property editor.

S Define single-line text with variables: Attach email addresses

Caonnection
Database
Dac

Ernail
Image
Ipkc

Job
Metadata
Phata
Skats
Switch

Emnail
FullUseriame

Role
UserMame

The email of the user who initiated
the conneckion

Text manipulations

Space |-

Case |—

After |

Before

Seqgment

Search |

Insert variable

Texk with variables

8] 4

l[ Cancel ]

The text field at the bottom contains the text being edited. Variables are simply mixed-in with
static text and enclosed in square brackets [ ] (see Variables on page 360). The list boxes and
text fields in the top portion of the property editor offer guidance for dealing with variables, as

explained below.

Arguments

The rightmost column shows any arguments relevant for the selected variable; for example:
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A list of the email addresses in the
email info assodated with the job

(¥ Index

{} Separator
Prefix

O Suffix

Text manipulations

Space

Case

After

Before

Segment

Search

Switch

Insert variable

See Data types on page 363, Formatting on page 364, Indexed variables on page 367, and
String manipulations on page 368.

Entering text

You can type constant text in the text field at the bottom at any time. You can also leave the
field empty and just insert one or more variables using the procedures explained in the following

sections.

If you understand variable syntax, you can enter or modify variables directly in the text field.
However, it makes more sense to let the Property editor assist you with inserting and updating
variables, as explained below.

Inserting a variable

Note: Switch interprets the opening square bracket ' as the beginning of a new variable.
To use the square bracket as static text, you need to double it: '[['. Note that there is no
need to double the closing square bracket.

Example:

Input: This the value of the [[Job.Name] variable: [Job.Name] (the first instance of
[Job.Name] is to be interpreted as static text; the second as a variable)

Result for a job with the name TestFile.pdf: This is the value of the [Job.Name]
variable: TestFile.pdf (only the second instance of [Job.Name] is replaced by the

actual job name)
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S Define single-line text with variables: Attach email addresses

Conneckion
Database
Crac

Ernail
Image
Ipkc

Job
Metadata
Photao
Skats
Swikch

Texk with variables

Counter

Dake

Elementame
FlowwMarne

Language
LarguageEnvironment
CukgaingMame
Servertlame

The current date and time including
milliseconds

Farmat

Texk manipulations

Space - ¥
Case ---- hd
After

Before

Seqgment

Search

Insert variable

Ok l [ Cancel

To insert a new variable in the text, proceed as follows:

1. Inthe text field at the bottom, place the text cursor in the location where you'd like to insert a
variable; make sure it is not inside a pair of square brackets [ ] that mark a variable; if the text
field is empty, just leave the cursor at the start of the field.

2. Select a variable group in the leftmost list ("Switch" in the example above); the list to the right
adjusts to list all the variables in this group.

3. Select a variable in the second list ("Date" in the example above); the text area to the right
adjusts to provide a brief description of the variable, the title bar indicates the variable's
data type, and the rightmost column shows any arguments relevant for this variable (see
Characteristics of variables on page 361).

4. |If the rightmost column contains any text fields, enter the appropriate values for the variable's
arguments (see Metadata on page 394); leave a field blank to use its default value.

5. Once you are satisfied with the selected variable and argument values, click the Insert
variable button.

Updating a variable

To update a variable that was previously inserted, proceed as follows:

1. Inthe text field at the bottom, place the text cursor inside the variable you would like to
update, that is, inside the pair of square brackets [ ] that mark the variable; the fields in the top
portion of the property editor automatically synchronize with the contents of the variable.
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2. Adjust the argument values for the variable in the text fields at the right, or select a new
variable (possibly in another group) as desired.

3. Once you are satisfied with the changes, click the Update variable button.

Defining a condition with variables

Conditional properties that support variables can be edited with the Define condition with
variables property editor. A conditional property has a Boolean result (true or false). For example,
the file filtering properties on connections are conditional properties.

The property editor discussed here offers a user interface to create comparison expressions with
support for locating a variable and entering its arguments.

Its more advantageous to compare variables from a job with other variables (for example: from
an external source like database or dataset). Therefore, Switch allows users to select multiple
variables when setting up a condition. Select one of the following three property editors in the
drop-down menu (highlighted in the screen given below):

« Inline value
« Text with variables...
« Script expression...

S Define condition with variables: Include these jobs

Condition
[Job.FileCount] E Equal to
AMD % | | [Job,ByteCount] E Less than
CR % | [Job Emaildddress] E Contains
— W

Operator precedence: () GR then AND (4 OR B} AND C
() AND then OR A OR (B AND C)

[ OF, l [ Cancel

The example condition is true if the job being tested contains a single file smaller than 1MB or if
one of the associated email addresses has the 'enfocus.com' domain.

Defining a condition

The property editor has two distinct parts:

- The main dialog box which allows defining one or more comparisons between a variable and
a constant value, forming the condition.

« The pop-up dialog box which serves to locate a variable and enter its arguments, similar to
defining text with variables.

The group and variable listboxes in the pop-up are synchronized with the corresponding
dropdown menus for the currently selected comparison in the main dialog box.
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Defining a single comparison

When the property editor for a certain property is displayed for the first time, a single comparison
row is shown. To define this comparison, proceed as follows:

" L]
Click this button beside the first textbox. The Define text with variables dialog box
appears.

2. Select a variable group in the first listbox. The second listbox adjusts to list all the variables in
this group. Select a variable in the second listbox.

« The text area to the right adjusts to provide a brief description of the variable, the title
bar indicates the variable's data type, and the rightmost column shows any arguments
relevant for this variable (see characteristics of variables).

3. Click Insert variable button.

- Define text with variables pop-up dialog box closes.

« The selected variable group and variable are inserted in the first textbox of the main
dialog box.

4. The dropdown menu next to the textbox adjusts to list the appropriate comparison operators
for the variable's data type. Select the desired comparison operator.

5. Inthe last dropdown menu, select the appropriate property editor. Enter or select the
appropriate values.

6. Once you are satisfied with the configuration, click the OK button.

Defining multiple comparisons

The property editor allows defining a condition that combines multiple comparisons. Each
comparison is represented as a separate row in the lower portion of the property editor. The
radio button in front of each row indicate which of the comparisons is currently synchronized with
the upper portion of the property editor; it is called the currently selected comparison.

The dropdown menu to the left of each row (starting with the second row) indicates the logical
operator (OR or AND) used to combine the consecutive comparisons. It is also used to add and
remove comparison rows.

« To add a new comparison:

1. Locate the dropdown menu at the bottom left (in front of an empty row) displaying "----".
2. Inthat dropdown menu, select the desired logical operator "AND" or "OR" instead; a new
comparison row is added.
« Toremove a previously added comparison:
1. Locate the dropdown menu at the start of the comparison row displaying the logical
operator "AND" or "OR".
2. Inthat dropdown menu, select "----" instead; the comparison row is removed.

You cannot remove the first condition since it does not have a logical operator dropdown
menu.

« To change the logical operator combining two comparisons:
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1. Locate the dropdown menu at the start of the second comparison row displaying the

logical operator

"AND" or "OR".

2. Inthat dropdown menu, select the other logical operator instead; be careful NOT to select
"----" because that would cause the comparison row to be removed.

Operator precedence

If three or more comparison rows are combined with different logical operators (that is, both
"AND" and "OR" are used), the meaning of the condition depends on the order in which the
logical operations are performed. Thus in that case the property editor displays an extra section
at the very bottom, allowing to select operator precedence:

« ORthen AND: the logical OR operations are performed first, then the logical AND operations.

« AND then OR: the logical AND operations are performed first, then the logical OR operations.

The following table provides some examples of conditions with their meaning for each choice of

operator precedence.

Condition OR then AND means AND then OR means
AORBANDC (AORB)AND C A OR (B AND Q)
AORBANDCORD (A OR B) AND (C OR D) AOR((BANDC)ORD
A AND BOR CANDD A AND BORC)AND D (A AND B) OR (C AND D)
AANDBORCORD A AND (B OR C OR D) (AANDB)ORCORD

Comparison operators

Variable data type

Comparison operators

Comparison value

Text

Equal to

Not equal to
Contains

Does not contain
Starts with

Does not start with

Any text string

Matches

Does not match

A regular expression

Boolean

True

False

None

Integer Rational

Equal to
Not equal to

Less than

A decimal integer or floating point number,
example, "-12" or "0.56"

A constant expression using + - */
operators; example:
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Variable data type

Comparison operators

Comparison value

Less than or equal

Greater than

+ 571024 * 1024

.« 2/3
Greater than or equal
.« 6.77+8.55
Date Equal to An ISO 8601 formatted date/time
(equivalent to format string "yyyy-MM-
Not equal to ddThh:mm:ss.zzz") or any portion thereof.
Earlier than If present, the date part of the string must
Earlier than or same have one of the following formats: "yyyy-
Later than MM-dd", "yyyy-MM" "yyyy".
For example, you may enter "yyyy-MM"
Later than or same for the format string and "2019-01" as the
comparison value to compare year and
month.
Sample jobs

Defining text with variables and Defining a condition with variables offer a mechanism to display
actual metadata variables derived from sample jobs while configuring the property value(s) in the
editor.

Limitations
A job can be a sample job only if it has a unique name prefix and a valid internal job ticket.

Sample jobs should be entered as live jobs into the flow being edited so that they can be
managed by Switch and variables can be tracked.

Working with sample jobs

To benefit from this feature, you should design a prototype of the desired flow and process one
or more sample jobs through the flow to the point where the jobs have accumulated the relevant
metadata.

Follow these steps to work with a sample job in your flow:
1. Create a valid prototype of the desired flow.
2. Activate the flow.

3. Putthe connections which are present at the end of the flow on hold to prevent jobs from
completing the flow. This allows Switch to detect all the variables that are available in the
sample job.

4. Place sample jobs in the flow and let them process to the desired stage.
5. Deactivate the flow.

6. Do one of the following:
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- Bring up the desired property editor that supports variables.
« Click the Inspect jobs button in the toolbar.
« Click the Flow > Inspect jobs menu option.

7. Inthe upper part of the dialog that pops up, select the job that you want to inspect.
Note that, in the top right corner, there is a search field where you can enter a string to

search for the sample job you need. Click the search button Q. and select the option of
your choice (Search sample job name / prefix / flow element).

If there are no sample jobs in the flow, this part of the dialog will be collapsed and the Show
sample jobs checkbox will be cleared. You may clear this checkbox yourself to improve

the speed, because loading a dialog with a huge amount of sample jobs may affect the
performance.

8. Select the variable you want to check by clicking the appropriate item in each column.
For example, if you want to check the date the job was processed by Switch (represented by
the Switch.Date variable):

« In the first column (Groups), select Switch.
« Inthe second column (Switch variables), select Date.
« In the third column, enter the format of your choice, e.g. dd.MM.yyyy

The sample value is shown in the lower part of the third column. If there's no value specified,
you'll see the string 'Sample value'. The variable is shown in the bottom right corner. You can
use the Copy to clipboard button to copy-paste it to the property editor where you want to
use it.

Building a location path

The "Build location path" dialog offers assistance with building location paths for the variables in
the Metadata group using picked up metadata by a sample job. The dialog supports the various
data models known in Switch.

See also XMP location path syntax on page 415.

Showing the dialog

The property editors Defining text with variables and Defining a condition with variables show
a button called Build location path when a variable in the Metadata group is selected and at least
one valid sample job is available (See Working with sample jobs on page 356).

When you click this button, the Build location path dialog is displayed. When you click the OK
button after some modifications, the selected Metadata variable is updated accordingly.
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[ ] [ ] Build location path
Show sample jobs Q. |
MName w Size Type Modified Job prefix Flow element
[£] Vtestpdf 927 KB pdf File 07/10/2020 ... 000H9 In
.| Demofile11.pdf 250 MB pdf File 02/03/2021... 000HA In
Metadata dataset Location path syntax
0 Embedded O XMP location path

The data selected by the specified location path will be interpreted as 'Rational”

XMP location path

XMP data tree

Dublin Core Properties (dc, http:/fpurl.org/dcfelements/1.1f)
http://ns.adobe.com(fxap/1.0/g/img/
http:/{ns.adobe.com/xap/1.0/sType/ResourceRef#
http://ns.adobe.com/illustrator/1.0f

XMP Paged-Text Properties (xmpoTPa. http:/ins.adobe.com/xap/1.0/t/pal)

Cancel OK

Metadata dataset

This section lists the various datasets associated with the job. You can select the embedded
dataset (which is always available, even if it is empty) or one of the external datasets associated
with the job (if any).

Location path syntax

The data model for the selected dataset determines the available options for the location path
syntax. Unavailable options are automatically disabled in the user interface.

The selected location path syntax determines the layout and behavior of the dialog's bottom
portion, as described in the following sections.
Location path

For the choices "XMP/XML/JDF location path" and "JSON Pointer" the bottom part of the dialog
displays the following two items:

« An editable text field labeled "xxx location path" or "JSON Pointer" respectively.
- Atree view representing the metadata in the sample document, labeled "xxx data tree".

You can expand and collapse the nodes in the tree view, but the tree is not otherwise editable.
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When you select a node in the tree view, the dialog displays the corresponding location path
(JSON pointer) in the editable text field (discarding anything that was already there).

Vice versa, when you modify the contents of the editable text field, and the contents represents a
valid location path (JSON Pointer) pointing to an existing node, the dialog selects that node in the
tree (and expands and scrolls the view to make it visible if needed).

For the JSON data model, the tree view uses different colors when showing the values to specify

the value types. In case of an array value, the array items indexes are shown in the 'Key' column
using the ltalic font style.

The OK button is enabled only if the location path (JSON Pointer) is valid and the selected node

is compatible with the selected result data type; otherwise an appropriate alert message is shown
at the bottom of the dialog.

® ® Build location path
Show sample jobs ( Q :Z'
MName w Size Type Modified Job prefix Flow eler
B package.json 622 bytes json File 11/02/2022 ... 000HS5 Folder 2
B bower.json 579 bytes json File 11/02/2022 ... 000H4 Folder 2
Metadata dataset Location path syntax
Embedded
© External

The data selected by the specified location path will be interpreted as "
© JSON Pointer

JSON Pointer
Jauthor

JSON data tree

Key Value
author T. Jameson Little <t.jameson.little@gmail.com=
dependencies
description BaseB4 encoding/decoding in pure JS
devDependencies
license MIT

Cancel 0K

XPath expression

For the choice "XPath expression" the bottom part of the dialog displays the following items:

- An editable text field labeled "XPath expression".
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« A read-only text field that displays the result type and value of the expression as it is evaluated
against the metadata, for example: "Integer: 5", "Boolean: false" or "Node set: 3 element
nodes"

« A control bar with buttons and checkboxes (see below).

« Aread-only multi-line text field that displays the XML for the sample metadata and highlights
the nodes in the result node set, if any.

When you modify the contents of the editable text field, and the contents represents a valid
XPath expression, the text fields are automatically updated to reflect the expression's result.

The control bar offers buttons to navigate between the nodes in a result node set, and two
checkboxes that affect the XML display:

« Auto-indent: when turned on, the XML is "pretty-printed" with nested indentation.
« Color-code: when turned on, each XML node type is displayed in a different color.

The OK button is enabled only if the XPath expression is valid and its data type is compatible with
the selected result data type; otherwise an appropriate alert message is shown at the bottom of
the dialog.

4.5.2.3. Metadata reference

Variables

Using variables

Switch allows the use of variables in the values of many text properties and for defining file filters.
A variable is a special, well-recognizable text string that gets replaced by a dynamic value when
the flow is being executed. The dynamic value is recalculated each time in the context of the job
being processed.

Variables provide access to run-time information about the flow environment and about a

job, including embedded metadata fields (and external metadata fields), without the need for
scripting. This lowers the barrier for accessing dynamic information in a flow definition since most
users will find it is much easier to use a variable than to create a script expression.

Entering Variables

Text properties

Variables in text properties are simply mixed-in with static text. Users can insert a variable in two
distinct ways:

« Directly type the variable with the appropriate syntax when entering the text; this requires
understanding variable syntax.

« Use the define text with variables property editor for locating the variable and entering its
arguments; the formatted variable is automatically inserted in the text.

Most users will prefer the second method; however in both cases the final result is regular

text (with variables). When the value of a text property that supports variables is needed while
executing a flow, Switch scans the text for variables and replaces them by their dynamic value in
the context of the current job. All text outside variables remains unchanged.
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Conditional properties

A conditional property has a Boolean result (true or false). For example, the file filtering properties
on connections are conditional properties.

A variable-based conditional property is entered through a special property editor that offers a
user interface to create basic comparison expressions with support for locating a variable and
entering its arguments. See defining a condition with variables.

When the value of a condition with variables is needed while executing a flow, Switch replaces
the variables by their dynamic value in the context of the current job and evaluates the
expression.

Using sample jobs

The variable-related property editors (Defining text with variables and Defining a condition with
variables) offer a mechanism to select a sample job and to display actual metadata values derived
from that job while you are configuring (portions of) the property value in the editor.

The Build location path dialog offers assistance with building location paths for the variables in
the Metadata group using actual metadata associated with a sample job.

List of variables

Switch offers a library of variables organized in groups, accessing Switch-specific flow and job
information, various types of metadata embedded in or a associated with a job, and statistics
derived from the file's contents.

See Known variables on page 369 for a complete list.
Characteristics of variables

Name

Each variable is identified by a name including the group name and the variable name proper. For
example: "Switch.Counter" or "Photo.ExposureTime".

See Basic syntax on page 362.

Arguments

Some variables can have arguments to help determine the dynamic value or the value's
formatting. For example, the "Switch.Counter" variable supports two arguments called "Width"
and "Id", and the "Switch.Date" variable supports an argument called "Format".

See Basic syntax on page 362, Formatting on page 364, Indexed variables on page 367,
String manipulations on page 368.

Data type

Each variable has a specific data type, which is indicated with the variable's description. The data
type is important for two reasons:

- For some data types, the formatting of the variable's text representation can be influenced by
specifying an appropriate argument for the variable.

«  When using a variable in a condition, the data type determines the type of comparison
performed.

See Data types on page 363, Formatting on page 364, String manipulations on page 368.
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Indexed variables

Some variables access a list of values rather than a single value. These variables are called
indexed variables. For example, the "Job.EmailAddress" variable accesses a list of all email
addresses associated with the job.

Depending on the arguments specified with it, an indexed variable may evaluate to a
concatenated list of all items (with a customizable separator) or to one particular item from the list.

See Indexed variables on page 367.

Basic syntax

Variable name

In its simplest form, a variable is specified as follows:

[Group.Variable]

The variable name is surrounded by square brackets. Whitespace is not allowed in the variable
specification.

Variable names contain two segments separated with a period. The first segment is the group
name; the second segment is the variable name within the group.

Arguments

Some variables can contain arguments that help determine the variable's dynamic value.
Arguments are specified as follows:

[Group.Variable:ArgumentNamel="Value", ArgumentName2="Value"]

In this example, two arguments are defined with names "ArgumentName1" and
"ArgumentName?2". If a variable has arguments, the variable name is followed by a colon which

is followed by the arguments. For each argument, the argument name is followed by an equal
sign and the value of that argument between single or double quotes. The value can contain
single quotes if it is double-quoted, or double quotes if it is single-quoted. A comma separates
the arguments if there is more than one. A variable specification must not contain any whitespace
except when required in a quoted argument value.

Nested variables

The Expression argument of the [Switch.Calculation] variable and the SQL arguments of Database
variables can contain nested variables. These variables are used to define the value of the
argument.

[Group.Variable:ArgumentNamel="[Variablel]"]

Nested variables have the same syntax as the regular variables and are always surrounded by
square brackets.

Some examples:

« [Switch.Calculation:Expression="[Job.Size]"]

- [Database.Textindexed:SQL="SELECT JobName FROM
Jobs",Connection="DBConnection",Separator=", "]
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[Database.Text:SQL="SELECT JobName FROM Files WHERE
FileName="[Job.Name]",Connection="DBConnection"]

Note: Nested variables are not allowed in other types of arguments. If you use them, they
will be ignored and treated as regular text.

Nesting can be multi-level, i.e. nested variables can contain other nested variables.

Example:

[Database.Text:SQL="SELECT PublisherName FROM Jobs WHERE
JobName="[Database.Text:SQL="SELECT JobName FROM Files WHERE
FileName="[Job.Name]",Connection="DBConnection"]",Connection="DBConnection"]

(where the nested variable [Job.Name] is included in the variable
[Database.Text:SQL="SELECT JobName FROM Files WHERE
FileName="[Job.Name]",Connection="DBConnection"])

Note: If used in an argument that supports nested variables, the opening square bracket
T"is interpreted by Switch as the beginning of a new variable. To use the square bracket
as static text, you need to double it: '[['. Note that there is no need to double the closing
square bracket.

Example:
- If there is a variable [Database.Text:SQL="SELECT [[JobName] FROM Files WHERE

FileName="TJob.Name]",Connection="DBConnection"]

- For a job with the name TestFile.pdf, the SQL request SELECT [JobName] FROM Files
WHERE FileName='TestFile.pdf will be executed.

See also:

Data types on page 363
Formatting on page 364
Comparing on page 366

Indexed variables on page 367
String manipulations on page 368

Data types

Each variable has a specific data type, which is indicated with the variable's description. The data
type is important for two reasons:

For some data types, the formatting of the variable's text representation can be influenced by
specifying an appropriate argument for the variable.

When using a variable in a condition, the data type determines the type of comparison
performed with the dynamic value.

The following table lists the supported data types for variables.

Data type Description

Text Text string

Alt Text Possibly localized text string (that is, there may be multiple language
versions)
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Data type Description
Switch always uses the default language; so this data type is
equivalent to Text
Text Indexed List of items of type Text (see indexed variables)
Boolean Boolean value true or false
Integer Integer number
Rational Rational number formed by division of two integers
Date A moment in time, including date and/or time information
See also:

« Basic syntax on page 362

« Formatting on page 364

« Comparing on page 366

« Indexed variables on page 367

« String manipulations on page 368

Formatting
The following table describes the formatting options for each data type, including:

- The default representation which is used when no formatting arguments are present.

« The supported formatting arguments, if any, and the corresponding representation.

Data type Description of data type / Representation as a text string
Formatting argument

Text Text string Text string

Alt Text Possibly localized text string | Text string (Switch always uses the default
language)

Text Indexed | List of items of type Text See indexed variables

Boolean Boolean value true or false "True" or "False" (or all-lower-case versions)

Integer Integer number Decimal representation (including minus sign if

needed; no plus sign; no leading zeros)

Rational Rational number formed by Decimal representation of the form: numerator,
division of two integers forward slash, denominator; example: "2/3" or
"-17/4"
Precision="integer" Decimal floating point representation with the

specified number of digits after the decimal
point (minimum precision is 1, max is 15)
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Data type

Description of data type / Representation as a text string
Formatting argument

Date

A moment in time, including String representation in the subset of the

date and/or time information | ISO 8601 format allowed in XMP Date fields
(see Adobe XMP specification, version dated

September 2005, page 75)

Equivalent to format string "yyyy-MM-
ddThh:mm:ss.zzz"

Format="format-string" String representation in the format specified by
the format string, which must conform to the

syntax described below

Date format string

The following format expressions are recognized and replaced in the date format string:

Expression

Output

d

the day as number without a leading zero (1to 31)

dd

the day as number with a leading zero (01to 31)

ddd

the abbreviated day name (example: 'Mon' to 'Sun’)

dddd

the long day name (example: 'Monday' to 'Sunday')

the month as number without a leading zero (1-12)

MM

the month as number with a leading zero (01-12)

MMM

the abbreviated month name (example: 'Jan' to 'Dec')

MMMM

the long month name (example: 'January' to 'December’)

yy

the year as two digit number (00-99)

yyyy

the year as four digit number

the hour without a leading zero (O to 23 or 1to 12 if AM/PM display)

hh

the hour with a leading zero (00 to 23 or 01to 12 if AM/PM display)

the hour without a leading zero (0 to 23, even with AM/PM display)

HH

the hour with a leading zero (00 to 23, even with AM/PM display)

the minute without a leading zero (O to 59)

the minute with a leading zero (00 to 59)
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Expression Output

s the second without a leading zero (0 to 59)

ss the second with a leading zero (00 to 59)

z the milliseconds without leading zeros (O to 999)

zzz the milliseconds with leading zeros (000 to 999)

AP or A use AM/PM display; AP will be replaced by either "AM" or "PM"

apora use am/pm display; ap will be replaced by either "am" or "pm"

t the timezone (for example "CEST")

" any sequence of characters enclosed in single quotes is treated as literal
text

See also:

« Basic syntax on page 362

« Data types on page 363

« Comparing on page 366

- Indexed variables on page 367

« String manipulations on page 368
Comparing

Type of comparison

A variable's data type determines the type of comparison performed in a condition involving the
variable. This is important because comparison semantics for numbers, strings and dates are very

different.

Variable data type Comparison semantics
Text String

Alt Text String

Text Indexed String

Boolean Boolean

Integer Number

Rational Number

Date Date
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Value used for comparison
When used in a condition, the variable's value is obtained in two steps:

- First the text representation of the variable is formatted as usual (see formatting); this allows
influencing the value in interesting ways, such as rounding a rational number or extracting a
date from a date/time.

- Then the value is converted to the data type appropriate for the comparison type (example:
string, number, ...); as indicated in the table above.

See also:

« Basic syntax on page 362

« Data types on page 363

« Formatting on page 364

« Indexed variables on page 367

« String manipulations on page 368

Indexed variables

Some variables access a list of values rather than a single value. These variables are called
indexed variables. All indexed variables support the indexing arguments described in this section.

In general, if an Index argument is provided for an indexed variable, the variable evaluates to a
single value from the list. Otherwise, the variable evaluates to a sequence that contains all values
in the list. The following table describes the indexing arguments and their effect in more detail.

Indexing arguments Description of result
provided(don't combine!)

None Concatenation of all values in the list separated by a
semicolon, all on the same line

If there are no values, the result is the empty string

Index="integer" The list value indicated by the specified one-based index
If the Index argument is provided, all other arguments are
ignored

Separator="separator-string" Concatenation of all values in the list separated by the

specified string, all on the same line
If there are no values, the result is the empty string

If the Separator argument is provided, the Prefix and Suffix
arguments are ignored

Prefix="prefix-string" Concatenation of all values in the list, each on a separate

) . ot S et
Suffix="suffix-string" line of the form: <prefix-string><value><suffix-string>

If there are no values, the result is the empty string

Examples
Text in a property value Evaluates to
[Job.EmailAddress:Index="1"] tvri@enfocus.com
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Text in a property value

Evaluates to

[Job.EmailAddress]

tvri@enfocus.com;tvr2@enfocus.com

[Job.EmailAddress:Separator=", "] | tvrl@enfocus.com, tvr2@enfocus.com

are:

The email addresses for this job

[Job.EmailAddress:Prefix="-"]

tvr2@enfocus.com

The email addresses for this job are: - tvril@enfocus.com -

See also:

« Basic syntax on page 362

« Data types on page 363

« Formatting on page 364

« Comparing on page 366

- String manipulations on page 368

String manipulations

Variables of data type Text, Alt Text and Text Indexed support additional arguments to perform
simple manipulations on the text value of the variable. For Indexed variables, the manipulation is
performed on each item in the list (that is, before the items are sequenced).

If multiple arguments are present, the manipulations are performed in the order as they are listed
in the table (regardless of the order in which they occur in the variable).

Argument

Value

Result

Space

One of "trim", "norm"

trim = leading and trailing white
space removed

norm = trimmed and consecutive
white space compressed to a single
space

Case

One of "upper", "lower", "first",
"word"

The string converted to the
specified case (first = first character
is upper case, word = first character
of every word is upper case)

After

Search string (non-empty)

The substring after (and not
including) the last occurrence of the
search string

Before

Search string (non-empty)

The substring before (and not
including) the first occurrence of the
search string

Segment

Start and end index (one-based)
separated by a comma or a hyphen;
if one of the indices is missing this

The substring between and
including the characters indicated
by the indices
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Argument Value Result

indicates the start or end of the

string
Search Regular expression (use anchors to | The first substring that matches the
match start or end of string) regular expression

See also:

« Basic syntax on page 362
« Data types on page 363
« Formatting on page 364
« Comparing on page 366

« Indexed variables on page 367

Known variables

Switch offers a library of variables organized in groups, as listed in the table below. Follow the
links in the first column in this table for a list of variables in each group, with corresponding
technical reference information.

A description for each variable is displayed in the property editors for defining text with variables
and defining a condition with variables. This description is not repeated in the help topics.

Group Type of information Source

Connection Client connection attributes like Switch settings, system
user name, IP... environment

Database Database fields Database (ODBC dataset)

Note: This group is only
available if you have an
active license for the Switch
Databases Module.

Doc Title, keywords, author(s), copyright | Embedded metadata:
terms XMP

Email Components of the email message | Mail receive flow element
through which this job was originally
delivered

Image Resolution, orientation, color mode |Embedded metadata:

EXIF (TIFF tags)

Iptc Contact, location, headline, Embedded metadata:
instructions IPTC

Job Filename, size, email info, hierarchy | File system, internal job
info, fail info, origin ticket
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Group Type of information Source

Metadata Arbitrary field in any dataset External metadata or
associated with the job embedded metadata

Office Microsoft Office variables, such Embedded Microsoft
as Application (Excel, PowerPoint, Office metadata
Word), Author, Description,
Presentation Format, ...

Photo Exposure time, aperture, focus, flash | Embedded metadata:

EXIF (EXIF tags)

Stats File format, number of pages, page | File format & contents
labels, colorants

Switch Flow element name, date/time, Flow definition, system
counter environment

Connection group

These variables are Switch-specific. They provide access to the attributes of the client
connection. The third column indicates the scripting API function that returns the variable's

dynamic value.

Variable name Data type Scripting API equivalent
Connection.Email Text ClientConnection.getEmail()
Connection.UserName Text ClientConnection.getUserName()
Connection.FullUserName Text ClientConnection.getFullUserName()
Connection.IP Text ClientConnection.getlP()

Note: The variables from this group are valid only in context of a client
connection. Please refer to the note in the description of the method

Environment.getClientConnection(). When used without an active client connection, the
Connection variables will return empty values. This amounts to the empty string for Text
variables and O for Integer variables.

Database variables

What are database variables?

Database variables are variables that at run-time are replaced with values from a database. These
variables can only be used if you have an active license for the Switch Databases Module.

You can use the database variables in the same way as the regular Switch variables:

- Use them as values for the tools and app properties.

« Use them as values for conditions, for example to filter jobs on a connection.

« Use them as values to fill a drop-down menu in the Submit point and Checkpoint metadata

properties.
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They are also accessible in the same way as other variables, i.e. via the Define Text/Condition
with Variables option in the properties of the Switch tools. They are collected in a separate
group: the "Database" variable group (see screenshot).

S Define text with variables

Sample jobs
Mame - Size Type Modified Jaob prefix Flow element ]
ﬂ Reportl,pdf 321 KB pdf File Fil16f2012 5:29: ... Input =
w
Groups Database variables Database Boolean (Boolean)
¥ : The arbitrary field as boolean in a
Database Date datahase Y 0L I:I
= Inkeger
Email Rational Zonneckion I:I
Irnage Text
Ipkc TextIndexed
Job
Metadata
Phota
Skats
Switch
Sample value
[ Insert variable ]

Texk with variables

Sample value | ]

L [o] 9 ][ Cancel ]

The table below lists the available data types.

Variable name Data type
Database.Text Text
Database.Textlndexed Text Indexed
Database.Boolean Boolean
Database.Integer Integer
Database.Rational Rational
Database.Date Date
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How to build an SQL statement?

After you have selected the Database group in the first column, and the data type in the second
column, you must create an SQL statement. The Build SQL statement dialog box (see screenshot)
will assist you in creating the SELECT statement and obtaining the appropriate values from the
database.

Tip: We recommend using a sample job, so you can see immediately if your SQL
statement is valid and correct.

S Build/SQL statement EJE|
Sample jobs

Mame Size Type Modified Job prefix Flows element

2 splash, pdf 61.4 KB pdf File 8/16/2011 11:25... 00044 Problem jobs

2 splash.pdf 61,4 KB pdf File gf16/2011 11:25... 00045 FDF Files

ODBC source Selection

Data Source

Table: | Column: -
Condition
M| = ™| |<Specify a value=

[] Manual editing

Configure ] [ Validate statement Define variables

Sample value

Ok ] [ Cancel

To build an SQL statement, proceed as follows:
1.

Click the button beside the SQL textbox and choose Build SQL statement.
2. Select a data source.

a. Click the Configure button.

b. Inthe ODBC data sources dialog, select a data source from the list of predefined data
sources (Refer to ODBC data sources for more information on how to define the data
sources).

Select a table and a column in the Table and the Column drop-down menus.

4. Select the Condition checkbox and specify or select the conditions in the first and the third
menu, choose the comparison operator in the middle drop-down menu and choose the AND
or OR logical operator in the last drop-down menu.

5. Alternatively, in order to choose more than one column or to choose a column from any
other table or not to choose any columns, select the Manual editing checkbox and enter the
statement manually.

w
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6. After setting the SQL statement, click the Validate statement button to check if the query
is valid. If the query returns any value or error, it is displayed on screen. The Sample value
menu displays the sample value for a query. If a query returns multiple values, they will be
listed in a comma separated list. For example: "valll,val12,val21,val22...".

7. Click the OK button to insert the statement.

Doc group

These variables access embedded metadata fields in the Adobe XMP format. The third column
indicates the XMP location path for the variable in the XMP data model.

The metadata fields accessed by the variables in this table can be viewed and edited using the
"File > File Info..." dialog in Adobe Creative Suite applications. The fourth column indicates the
label of the field that corresponds to each variable.

The "Alt Text" data type indicates a possibly localized text string (that is, there may be multiple
language versions). Switch always uses the default language; so this data type is equivalent to

Text.

Variable name Data type | XMP location path | Acrobat Photoshop File Info

Document label
Properties label
Doc.Application Text xmp:CreatorTool Application Description /
Application
Doc.Author Text dc:creator/"1] Description / Author
Doc.Authors Text dc:creator Author Description / Author
Indexed
Doc.AuthorTitle Text photoshop: Description / Author
AuthorsPosition Title
Doc.Category Text photoshop: Categories / Category
Category
Doc.City Text photoshop:City Origin / City IPTC
Image / City

Doc.Copyright Alt Text dcirights Description /

Notice Copyright Notice
Doc.Copyright Boolean xapRights: Marked Description /

Status Copyright Status
Doc.Copyright Alt Text xapRights: IPTC Status / Rights
Terms UsageTerms Usage Terms
Doc.Copyright Text xapRights: Description /

URL WebStatement Copyright Info URL
Doc.Country Text photoshop: Country IPTC Image / Country

373




ENF@CUS

Switch

Variable name Data type | XMP location path | Acrobat Photoshop File Info
Document label
Properties label
Doc.Created Date xmp:CreateDate Description / Created
Doc.Credit Text photoshop:Credit Origin / Credit IPTC
Status / Provider
Doc.DateCreated |Date photoshop: Created Origin / Date Created
DateCreated
Doc.Description Alt Text dc:description Subject Description /
Description
Doc.Description Text photoshop: Description /
Writer CaptionWriter Description Writer
Doc.Format Text dc:format Description / Format
Doc.Headline Text photoshop: Origin / Headline IPTC
Headline Content / Headline
Doc.Instructions Text photoshop: Origin / Instructions
Instructions IPTC Status /
Instructions
Doc.Keywords Text dc:subject Keywords Description /
Indexed Keywords
Doc.Modified Date xmp:ModifyDate Modified Description / Modified
Doc.Source Text photoshop: Source Origin / Source IPTC
Status / Source
Doc.State Text photoshop:State Origin / State-Province
IPTC Image / State
Doc. Text photoshop: Categories /
Supplemental Indexed Supplemental Supplemental
Categories Categories Categories
Doc.Title Alt Text dc:title Title Description /
Document Title
Doc. Transmission | Text photoshop: Origin / Transmission
Reference Transmission Reference IPTC
Reference Status / Job
Doc.Urgency Integer photoshop: Origin / Urgency
Urgency
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Email group

These variables access the components of the email message through which this job was
originally delivered. The values are empty if the job was not delivered via email or if the email
message did not contain the requested component.

The Mail receive flow element associates this information with the job as a metadata dataset.
Refer to Email message schema on page 403 for details on the format of this metadata. The
third column in the table lists the element name in this schema corresponding to each variable.

(*) See email message schema.

Variable name Data type Element name (*)
Email.Body Text body

Email.Cc Text cc

Email.Date Text date

Email.From Text from
Email.Messageld Text message-id
Email.ReplyTo Text reply-to
Email.Sender Text sender
Email.Subject Text subject

Email.To Text to

Image group

These variables access embedded metadata fields in the EXIF format (synchronized with Adobe
XMP). The third column indicates the hexadecimal TIFF tag corresponding to each variable.

Variable name Data type XMP location path TIFF tag
Image.Artist Text tiff:Artist & dc:creator/*[1] 0x013B
Image.ColorMode Integer photoshop:ColorMode -
Image.Copyright Alt Text tiff: Copyright & dc:rights 0x8298
Image.DateTime Date tiff:DateTime & 0x0132 &
xmp:ModifyDate 0x9290
Image.ICCProfile Text photoshop:ICCProfile -
Image.ImageDescription Alt Text tiff:lmageDescription & 0x010E
dc:description
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Variable name Data type XMP location path TIFF tag
Image.ImagelLength Integer tiff:lmageLength 0x0101
Image.ImageWidth Integer tiffimageWidth 0x0100
Image.Make Text tif:Make 0Ox010F
Image.Model Text tif:Model 0x0110
Image.Orientation Integer tiff:Orientation 0x0M12
Image.Photometric Integer tiff:Photometric Interpretation | 0x0106
Interpretation

Image.ResolutionUnit Integer tiff:ResolutionUnit 0x0128
Image.SamplesPerPixel Integer tiff:SamplesPerPixel 0x0115
Image.Software Text tiff:Software & xmp:CreatorTool | 0x0131
Image.XResolution Rational tiff:XResolution OxOMA
Image.YResolution Rational tiff:YResolution 0x011B

IPTC group

These variables access embedded metadata fields in the IPTC format (synchronized with Adobe
XMP). The third column indicates the XMP location path for the variable in the XMP data model.
The Iptc4xmpCore prefix has been omitted in the location paths.

The metadata fields accessed by the variables in this table can be viewed and edited using the
File > File Info... dialog box in Adobe Creative Suite applications. The fourth column indicates the
label of the field that corresponds to each variable.

(*) The Iptc4xmpCore prefix has been omitted in the location paths.

Variable name Data type XMP location path (*) Photoshop File Info label

Iptc.City Text photoshop:City IPTC Image / City

Iptc.ContactAddress | Text CreatorContactinfo/ IPTC Contact / Address
CiAdrExtadr

Iptc.ContactCity Text CreatorContactInfo/ IPTC Contact / City
CiAdrCity

Iptc.ContactCountry Text CreatorContactinfo/ IPTC Contact / Country
CiAdrCtry

Iptc.ContactEmail Text CreatorContactinfo/ IPTC Contact / E-mail(s)
CiEmailWork
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Variable name Data type XMP location path (*) Photoshop File Info label
Iptc.ContactPCode Text CreatorContactinfo/ IPTC Contact / Postal Code
CiAdrPcode
Iptc.ContactPhone Text CreatorContactinfo/ IPTC Contact / Phone(s)
CiTelWork
Iptc.ContactState Text CreatorContactinfo/ IPTC Contact / State-
CiAdrRegion Province
Iptc.ContactWebsite Text CreatorContactinfo/ IPTC Contact / Website(s)
CiUrlWork
Iptc.CopyrightNotice | Alt Text dcirights IPTC Status / Copyright
Notice
Iptc.Country Text photoshop:Country IPTC Image / Country
Iptc.CountryCode Text CountryCode IPTC Image /1ISO Country
Code
Iptc.Creator Text dc:creator/[1] IPTC Contact / Creator
Iptc.CreatorJobTitle Text photoshop:Authors IPTC Contact / Creator's Job
Position Title
Iptc.DateCreated Date photoshop:DateCreated IPTC Image / Date Created
Iptc.Description Alt Text dc:description IPTC Content / Description
Iptc.Description Writer | Text photoshop:CaptionWriter | IPTC Content / Description
Writer
Iptc.Headline Text photoshop:Headline IPTC Content / Headline
Iptc.Instructions Text photoshop:lnstructions IPTC Status / Instructions
Iptc.Intellectual Genre | Text IntellectualGenre IPTC Image / Intellectual
Genre
Iptc.JobID Text photoshop: IPTC Status / Job Identifier

TransmissionReference

Iptc.Keywords Text Indexed |dc:subject IPTC Content / Keywords
Iptc.Location Text Location IPTC Image / Location
Iptc.Provider Text photoshop:Credit IPTC Status / Provider
Iptc.RightsUsage Alt Text xmpRights:UsageTerms IPTC Status / Rights Usage

Terms

Terms
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Variable name Data type XMP location path (*) Photoshop File Info label
Iptc.Scene Text Indexed | Scene IPTC Image / IPTC Scene
Iptc.Source Text photoshop:Source IPTC Status / Source
Iptc.State Text photoshop:State IPTC Image / State-Province
Iptc.SubjectCode Text Indexed | SubjectCode IPTC Content / IPTC Subject
Code
Iptc.Title Alt Text dc:title IPTC Status / Title
Job group

These variables are Switch-specific. The third column indicates the scripting API function that
returns the variable's dynamic value.

Variable name

Data type

Scripting API equivalent

Job.ByteCount

Integer

Job.getByteCount()

Job.EmailAddress

Text Indexed

Job.getEmailAddresses()

Job.Extension

Text

Job.getExtension()

Job.FileCount

Integer

Job.getFileCount()

Job.Hierarchy

Text Indexed

Job.getHierarchyPath()

Job.IsFile Boolean Job.isFile()

Job.IsFolder Boolean Job.isFolder()

Job.JobState Text Job.getJobState()
Job.Name Text Job.getName()
Job.NameProper Text Job.getNameProper()
Job.Path Text Job.getPath()

Job.Priority Integer Job.getPriority()
Job.PrivateData Text Job.getPrivateData()
Job.Size Text --

Job.UniqueNamePrefix Text Job.getUniqueNamePrefix()
Job.UserEmail Text The user's email address associated

with the job (as entered in the Users
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Variable name Data type Scripting API equivalent

pane). If no user information has been
linked to the job, the variable remains
empty.

Job.getUserEmail()

Job.UserFullName Text The user's full name associated with

the job (as entered in the Users pane).
If no user information has been linked
to the job, the variable remains empty.

Job.getUserFullName()

Job.UserName Text Job.getUserName()

Job.FileCreationDate Date The creation date/time of the job file or
folder as taken from file system

File(job.getPath()).created

Job.EmailBody Text The email body text in the email info
associated with the job

Job.getEmailBody()

Job.NestedName Text Indexed A list of indented names (including
extension) for all files and folders in the
job; by default each level indents with
4 spaces; on a particular level names
are sorted alphabetically; see example
below

Indent=""

The Indent argument specifies the
string added for each indentation level
(default value is 4 spaces)

Script that recursively iterates over job
contents

Nested name example:

The variable [Job.NestedName:Prefix="->",Indent=". "] might be replaced by the following lines:

-> My job folder
-> . First.pdf

-> . Second.pdf
-> . Subfolder

-> . . Readme.txt
-> . Third.pdf

The following variables access a job's occurrence trail to provide information on the job's origin

and on why the job was sent to the problem jobs folder. Each of the variables access the most
recent occurrence of a particular type, as listed in the table.
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Variable name Data type Most recent Scripting API equivalent
occurrence of
type
Job.FailElement Text Failed Occurrence.getElement()
Job.FailFlow Text Failed Occurrence.getFlow()
Job.FailMessage Text Failed Occurrence.getLocalizedMessage()
Job.FailModule Text Failed Occurrence.getModule()
Job.FailTime Date Failed Occurrence.getTimeStamp()
Job.Origin Text Produced Occurrence.getOrigin()
Job.Origin

Use this variable to get the original location of the job before it was injected or submitted into
the flow:

« For a Submit point,

- If the Requires Switch Helper property property is set to Yes, this is the original upload
folder.

- If the Requires Switch Helper property property is set to No, this is the path to the backing
folder of the Submit point that was used to submit the job.

Note: If multiple jobs from different locations are submitted as part of one folder, the
Job.Origin of the job will be the path of the first job in the folder.

- For an FTP receive element, this is the path to the file on the FTP server that was used to
download the file.

« For a Mail receive element, this is the ‘From’ address of the email.

« For a Script element, this is the path that was passed into "createNewJob". Note that the
"createNewJob" function can be called with or without a path parameter, so it's up to the script
writer to provide the Job.Origin value or to leave it empty.

Note: For other elements, this variable is empty!

Metadata group

These variables allow access to an arbitrary field in any dataset associated with the job (external
metadata or embedded metadata).

There is a variable for each data type supporting the appropriate formatting and/or indexing
arguments. This enables the user to express the expected data type for the metadata value and
control its formatting.

Variable name Data type

Metadata.Text Text
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Variable name Data type

Metadata.Textindexed Text Indexed

Metadata.Boolean Boolean

Metadata.Integer Integer

Metadata.Rational Rational

Metadata.Date Date
Selecting a data field

The variables in the Metadata group support the following arguments for selecting a particular

metadata field from a particular dataset.

Argument

Value

Dataset

The name of the external dataset to be accessed, or empty/missing to indicate the

embedded dataset

Model

The data model used for querying the data set; when empty/missing the data
model is derived from the dataset; allowed values are "XML", "JDF", "XMP" or
"JSON".

This argument can be omitted except when forcing a JDF data model to be
queried using regular XML semantics (that is, using "evalToString" rather than
"getString")

Path

The location path or JSON pointer for selecting a field (or calculating a value)
using syntax appropriate for the data model:

« XML: XPath expression (which includes XPath location paths)
« JDF: JDF location path (which is really the same as an XPath location path)
«  XMP: XMP location path

« JSON: JSON Pointer

All prefixes used in the location path or expression must occur in the default
namespace map for the data set; there is no way to specify explicit mappings.

Make sure to use the correct prefix:

For the XML data model, use the prefix "dn", for example:

[Metadata.Text:Path="/dn:XML/dn:ResourcePool/dn:CustomerInfo/
@DescriptiveName", Dataset="Xml",Model="XML" ]

For the JDF data model, use the prefix "jdf", for example:

[Metadata.Text:Path="/jdf:JDF/jdf:ResourcePool/jdf:CustomerInfo/
@DescriptiveName",Dataset="Jdf",Model="JDF"]
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Argument |Value

For more information, refer to "XML data model" and "JDF data model" in the
Switch Scripting Guide, available on the Enfocus website.

Data type conversions

Switch does not guarantee that the value of a variable in the Metadata category conforms to the
string representation of its data type. The user is responsible for selecting the correct data type
by using the appropriate variable in the Metadata category.

The variable is always set to the string value of the query (for Text Indexed, each item in the list is
converted separately).

In other words:

For the JDF and XMP data models there is never a conversion, because the result of the query
is always a string (the text content of the node specified by the location path).

For the XML data model, the result of the XPath expression is converted to a string using
XPath semantics (unless it was a string to begin with).

For the JSON data model, the result of the JSON Pointer evaluation is a JSON value. The
value of the variable will be the string representation of this JSON value in case its data type is
string, number or boolean. If the JSON value data type is object, array or null then the variable
value will be an empty string. However for a Textindexed variable, the JSON Pointer can
evaluate to an array and then each array item is processed using the same rule: object, array
and null values become empty strings; other values will be represented by strings.

Office group

These variables access metadata fields embedded in Microsoft Office documents (Excel files,
Word documents, PowerPoint presentations).

Note: If a Microsoft Office document is password protected, Switch has no access to the
metadata, hence these variables cannot be used.

Variable name Data type | Description

Office.Application Text Name of the application that created the
document, for example: Microsoft Office
Word

Office.AppVersion Text Version of the application that created the

document; string of the form XX.YYYY (X
and Y representing numerical values), for
example: 14.0000

Office.Author Text Author of the document

Office.Category Text Category of the document

Office.Company Text Name of a company associated with the
document

Office.ContentStatus Text Status of the document content, for example:

Draft, Reviewed, Final, ...
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Variable name Data type | Description

Office.ContentType Text Type of document content, for example:
Whitepaper, Security Bulletin, Exam, ...

Office.Created Date Date and time when the document

was created, for example:
2014-02-05T10:10:36.000Z. You can modify
the format, for example: dd:MM.yy mm:ss
(UTC time zone) will result in 05:02:14 10:36

Office.Custom Text The metadata value selected from the
document using XPath expression provided
in the 'Path' argument. The argument

'Set' defines the metadata set where the
required value is searched for. The possible
values for the 'Set' argument are 'Core' and
'Extended' (used as the default value). For
more details, refer to the section below.

Office.Description Text Textual description of the document

Office.DocSecurity Integer Security level of the document:

« 0=None

« 1=Document is password protected

+ 2 =Documentis recommended to be
opened as read-only

« 4 =Document must be opened as read-
only

« 8 =Document is locked for annotation

Office.HyperlinkBase Text Base string used for evaluating relative
hyperlinks in this document

Office.HyperlinksChanged Boolean Indicates whether or not hyperlinks were
changed:

« True = One or more hyperlinks in this part
were updated exclusively in this part by a
producer

. False = No hyperlinks were updated

Office.ldentifier Text Identifier of the document

Office.Keywords Text Keywords that specify the topic of the
document

Office.Language Text Language of the document

Office.LinksUpToDate Boolean State of the hyperlinks in the document:

« True = Hyperlinks are up-to-date
« False = Hyperlinks are outdated

Office.Manager Text Name of a supervisor associated with the
document
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Variable name Data type | Description

Office.Modified Date Date and time when the document was last
modified

Office.ModifiedBy Text Author of the last modification in the
document

Office.NumberOfCharacters Integer Total number of characters in the document

Office.NumberOfCharacters Integer Last count of the number of characters

WithSpaces (including spaces) in this document

Office.NumberOfHiddenSlides Integer Number of hidden slides in the presentation

Office.NumberOfLines Integer Total number of lines in the document when

last saved by a conforming producer

Office.NumberOfMMClips Integer Total number of sound or video clips that are
present in the document

Office.NumberOfNotes Integer Number of slides in the presentation
containing notes

Office.NumberOfPages Integer Total number of pages in the document

Office.NumberOfParagraphs Integer Total number of paragraphs found in the
document

Office.NumberOfSlides Integer Total number of slides in the presentation

Office.NumberOfWords Integer Total number of words in the document

when the document was last saved

Office.PresentationFormat Text Intended format for the presentation, for
example a presentation intended to be
shown on video has PresentationFormat
Video, a presentation to be shown on
screen, could have On-screen (4:3), ...

Office.Printed Date Date and time when the document was last
printed

Office.Revision Integer Revision number

Office.ScaleCrop Boolean Display mode of the document thumbnail:

« True = Thumbnail is scaled to fit the
display

« False = Thumbnail is cropped to show
only sections that fit the display

Office.SharedDoc Boolean Indicates whether or not the document is

shared:
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Variable name Data type | Description

« True = Document is currently shared
between multiple producers
« False = Document is not shared

Office.Subject Text Subject of the document

Office.Template Text Name of an external document template
containing format and style information used
to create the document.

Office.Title Text Title of the document

Office.TotalTime Integer Total time that the document has been
edited. The default time unit is minutes.

Office.Version Integer Version number

Office.Custom

Use this variable if there is a metadata tag in your Office document that does not have a
dedicated Switch variable. The [Office.Custom] variable allows you to retreive the value of this
tag, on condition that you have the correct XPath expression. Note that the data type of this
variable is 'Text', so only text manipulation arguments are available for it.

The metadata value is selected from the document using the XPath expression provided in the
Path argument. All prefixes used in the expression must occur in the default namespace map for
the metadata XML file. There is no way to specify explicit mappings. The default namespace is
automatically available using prefix 'dn'.

The argument Set defines the metadata set where the required value is searched for. The
possible values are 'Core' and 'Extended' (used as the default value):

« The 'Core' set corresponds to the document properties (normally located in the file docProps/
core.xml). Normally, the XPath for this set will begin with '/cp:coreProperties'.

« The 'Extended' set contains extended properties (normally located in the file docProps/
app.xml). The XPath begins with '/dn:Properties' where 'dn' is the prefix for the default
namespace, automatically provided by Switch.

Examples

[Office.Custom:Path="/dn:Properties/dn:Application”] - This gives the same result as
[Office.Application]
[Office.Custom:Path="/dn:Properties/dn:TitlesOfParts/vt:vector/

vt:lpstr[l]",Set="Extended"] - The title of some document part
[Office.Custom:Path="/cp:coreProperties/dc:title", Set="Core"] - This gives the same
result as [Office.Title]

More information about the Office Open XML format and its metadata can be found here: http.//
en.wikipedia.org/wiki/Office_Open_XML_file_formats.

Photo group

These variables access embedded metadata fields in the EXIF format (synchronized with Adobe
XMP). The third column indicates the hexadecimal EXIF tag corresponding to each variable.
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Variable name Data type XMP location path EXIFF tag
Photo.ApertureValue Rational exif:ApertureValue 0x9202
Photo.BrightnessValue Rational exif:BrightnessValue 0x9203
Photo.ColorSpace Integer exif:ColorSpace OxA001
Photo.CompressedBitsPer Rational exif:CompressedBitsPerPixel 0x9102
Pixel
Photo.Contrast Integer exif:Contrast 0OxA408
Photo.CustomRendered Integer exif:CustomRendered 0xA401
Photo.DateTimeDigitized Date exif:DateTimeDigitized 0x9004 &
0x9292
Photo.DateTimeOriginal Date exif:DateTimeOriginal 0x9003 &
0x9291
Photo.DigitalZoomRatio Rational exif:DigitalZoomRatio 0xA404
Photo.ExposureBiasValue Rational exif:ExposureBiasValue 0x9204
Photo.Exposurelndex Rational exif:Exposurelndex OxA215
Photo.ExposureMode Integer exif:ExposureMode 0xA402
Photo.ExposureProgram Integer exif:ExposureProgram 0x8822
Photo.ExposureTime Rational exif:ExposureTime Ox829A
Photo.FlashEnergy Rational exif:FlashEnergy OxA20B
Photo.FlashFired Boolean exif:Flash/exif:Fired 0x9209 bits
Photo.FlashFunction Boolean exif:Flash/exif:Function 0x9209 bits
Photo.FlashMode Integer exif:Flash/exif:Mode 0x9209 bits
Photo.FlashRedEyeMode Boolean exif:Flash/exif:RedEyeMode 0x9209 bits
Photo.FlashReturn Integer exif:Flash/exif:Return 0x92009 bits
Photo.FNumber Rational exif:FNumber 0x829D
Photo.FocalLength Rational exif:FocalLength 0x920A
Photo.FocalLengthln35mm Integer exif:FocalLengthIn35mmFilm OxA405
Film
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Variable name Data type XMP location path EXIFF tag
Photo.FocalPlane Integer exif:FocalPlaneResolutionUnit | OxA210
ResolutionUnit

Photo.FocalPlaneX Rational exif:FocalPlaneXResolution OxA20E
Resolution

Photo.FocalPlaneX Rational exif:FocalPlaneYResolution OxA20F
Resolution

Photo.GainControl Integer exif:GainControl OxA407
Photo.ImageUniquelD Text exif:imageUniquelD OxA420
Photo.ISOSpeed Integer exif:ISOSpeedRatings/*{1] 0x8827
Photo.Lens Text aux:Lens -
Photo.LightSource Integer exif:LightSource 0x9208
Photo.MaxApertureValue Rational exif:MaxApertureValue 0x9205
Photo.MeteringMode Integer exif:MeteringMode 0x9207
Photo.PhotographicSensitivity Integer exifEX:PhotographicSensitivity | 0x8827
Photo.PixelXDimension Integer exif:PixelXDimension OxA002
Photo.PixelYDimension Integer exif:PixelYDimension OxA003
Photo.Saturation Integer exif:Saturation OxA409
Photo.SceneCaptureType Integer exif:SceneCaptureType 0xA406
Photo.SensingFunction Integer exif:SensingFunction OxA217
Photo.Sensitivity Type Integer exifEX:SensitivityType 0x8830
Photo.Sharpness Integer exif:Sharpness 0xA40A
Photo.ShutterSpeedValue Rational exif:ShutterSpeedValue 0x9201
Photo.SpectralSensitivity Text exif:SpectralSensitivity 0x8824
Photo.SubjectDistance Rational exif:SubjectDistance 0x9206
Photo.SubjectDistance Integer exif:SubjectDistanceRange 0xA40C
Range

Photo.UserComment Alt Text exif:.UserComment 0x9286
Photo.WhiteBalance Integer exif:WhiteBalance OxA403
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Stats group

Switch

These variables access statistics derived from the actual file contents for a number of supported
file formats. The values are empty for a job in an unsupported file format and for a job folder.

File format

For a list of supported file formats, please refer to the description of the FileStatistic class in the
Scripting documentation available on the Enfocus website.

Variable name

Data type

Scripting API equivalent

Stats.FileFormat

Text

FileStatistics.getFileFormat()

Content statistics

The Stats group includes an additional variable for each additional statistic supported by the
FileStatistics class (see Supported statistics). The variable has the same name and data type as
the statistic (where string maps to Text and string list maps to Text Indexed).

Variable name Data Supported | Description
type for

Stats.NumberOfPages Integer All The number of pages in the document (or
supported |a value of one if the format doesn't support
formats multiple pages)

Stats.SamplesPerPixel Integer JPEG, TIFF, | Number of components per pixel
PNG

Stats.PixelXDimension Integer JPEG, TIFF, | Valid image width, in pixels
PNG

Stats.PixelYDimension Integer JPEG, TIFF, | Valid image height, in pixels
PNG

Stats.ColorMode Integer JPEG, TIFF, | The color mode used: O = Bitmap; 1= Gray;
PNG 2 =Indexed color; 3=RGB; 4 = CMYK; 7 =

Multichannel; 8 = Duotone; 9 = Lab color

Stats.ColorSpace Integer JPEG, TIFF, | Color space information: 1= sRGB; 65535 =
PNG uncalibrated

Stats.ICCProfile Text JPEG, TIFF, | The name of ICC color profile used, if any
PNG

Stats.Colorants Text TIFF A list of the names of all colorants for

Indexed Duotone or Multichannel images; the list is
empty for all other color models
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Variable name Data Supported | Description
type for
Stats.CellWidth Integer TIFF The width of the dithering or halftoning

matrix used to create a dithered or
halftoned bilevel file

Stats.CellLength Integer TIFF The length of the dithering or halftoning
matrix used to create a dithered or
halftoned bilevel file

Stats.TileWidth Integer TIFF The width (number of columns) of each tile
Stats.TileLength Integer TIFF The length (humber of rows) of each tile
Stats.Colorintent Integer PNG The sRGB rendering intent:

0 = Perceptual, 1= RelativeColorimetric,
2 = Saturation, 3 = AbsoluteColorimetric

4 =invalid value

Stats.Version Text PDF The version of the file format (for example
ll1.6")
Stats.PageWidth Rational |PDF The width of the first page in the document

not taking into account page rotation and
scaling, in points (derived from the media
box)

Stats.PageHeight Rational |PDF The height of the first page in the document
not taking into account page rotation and
scaling, in points (derived from the media

box)
Stats.Pagelabels Text PDF A list of the page labels for all pages in
Indexed the document, or undefined if none of the

pages has a page label

Stats.Colorants Text PDF A list of the names of all colorants as
Indexed they appear in Separation and DeviceN
color spaces and in page separation info
dictionaries in the document

Stats.Fonts Text PDF A list of the names of all fonts (without
Indexed subsetting prefix) as they appear in font
dictionaries in the document

Stats.SecurityMethod Text PDF The method used to protect the document;
possible values: "None", "Password",
"Certificate", "LiveCycle"
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Variable name Data Supported | Description
type for
Stats.PageBoxesEqual Boolean |PDF True if all pages have identical page boxes;

false otherwise (verifies media, crop, bleed,
trim and art box).

Note: "True" doesn’t mean that
media, crop, bleed, trim and art
boxes are equal to each other

but it means that media boxes

on each page are the same, crop
boxes on each page are the same,
bleed boxes on each pages are the
same, trim boxes on each pages
are the same and art boxes on
each pages are the same. Also
note that pages with different lower
left origins are not considered
equal.

Stats.MediaBoxWidth Integer PDF The width of the media box for the first
page in the document not taking into
account page rotation and scaling, in points

This is a synonym for the ‘PageWidth'
statistic

Stats.MediaBoxHeight Integer PDF The height of the media box for the first
page in the document not taking into
account page rotation and scaling, in points

This is a synonym for the ‘Pageheight’
statistic

Stats.CropBoxWidth Integer | PDF The width of the crop box for the first page
in the document not taking into account

page rotation and scaling, in points

Stats.CropBoxHeight Integer | PDF The height of the crop box for the first page
in the document not taking into account

page rotation and scaling, in points

Stats.BleedBoxWidth Integer | PDF The width of the bleed box for the first page
in the document not taking into account
page rotation and scaling, in points

Stats.BleedBoxHeight Integer | PDF The height of the bleed box for the first
page in the document not taking into

account page rotation and scaling, in points

Stats.TrimBoxWidth Integer PDF The width of the trim box for the first page
in the document not taking into account
page rotation and scaling, in points

390



ENF@CUS Switch

Variable name Data Supported | Description
type for
Stats.TrimBoxHeight Integer PDF The height of the trim box for the first page

in the document not taking into account
page rotation and scaling, in points

Stats.ArtBoxWidth Integer | PDF The width of the art box for the first page in
the document not taking into account page
rotation and scaling, in points

Stats.ArtBoxHeight Integer | PDF The height of the art box for the first page
in the document not taking into account

page rotation and scaling, in points

Stats.PDFXVersionKey Text PDF The contents of the PDF/X version key in
the document, or the empty string if there
is no such key; one of the following values
may be returned:

- PDF/X-1a:2001
- PDF/X-3:2002
+ PDF/X-1a:2003
- PDF/X-3:2003
- PDF/X-4

. PDF/X-4p

The PDF/X version key indicates a claim
that the document conforms to the PDF/
X specification, but it does not offer any

guarantees
Stats.ColorSpaceFamilies | Text PDF A list of the names of all color space
Indexed families actually used in the document's
page contents; the following names may be
returned:

DeviceGray, DeviceRGB, DeviceCMYK,
CalGray, CalRGB, Lab, ICCBasedGray,
ICCBasedRGB, ICCBasedCMYK, Indexed,
Pattern, Separation, DeviceN.

For Indexed or Pattern, the underlying color
space families are also listed

Stats.TransparentColor Boolean |PDF True if the document's page contents uses
transparency for defining colors; false
otherwise

Stats.FontTypes Text PDF A list of the names of all font types actually

Indexed used in the document's page contents; the

following names may be returned:
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Variable name Data Supported | Description
type for
« TrueType
« Typel
« Type3

« MultipleMaster

. Composite

Stats.PageRotation Rational |PDF The rotation of the first page in the
document, in degrees

Note: The FileStatistics class allows reading both defined and effective values of PDF
page (and page boxes) width and height. The corresponding variables from the Stats
group support this by providing the "Type' argument with possible values 'Defined' and
'Effective’. 'Defined' means that page rotation and scaling are NOT taken into account,
contrary to 'Effective’.

Switch group

These variables are Switch-specific. The third column indicates the scripting API function that
returns the variable's dynamic value.

Variable name Data type Scripting API equivalent

Switch.Calculation Rational This allows you to use variables (that are by
default treated as text) to do calculations.

It is also possible to manually enter this
syntax while selecting other variables.
Therefore, you can perform calculations on
variables that result in a number anywhere
in the Switch application, provided you
have access to the variables pane from
there.

The ‘Expression’ argument specifies the
arithmetic expression to be calculated.
The expression may contain other Switch
variables, constant numbers, parentheses,
the arithmetic operators (‘+, -, *, ‘/’

and ‘%’) and the ‘round’ function. Note

that the behavior of the round() function
(which rounds the value of a number to the
nearest integer) is sometimes different from
Excel. For example, -10,5 is rounded to -10
(< >Excel: -1).

The values are stored as double-precision
floating point numbers. Therefore rounding
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Variable name Data type Scripting API equivalent

of values like 7.555 (p=2) -may be rounded
to 7.55.

Example of the Calculation variable
syntax : [Switch.Calculation:Expression
= "[Stats.PageHeight]
*0.352777778",Precission="1"] x
[Switch.Calculation:Expression

= "[Stats.PageWidth]
*0.352777778",Precission="1"]

Switch.Counter Text -- (see below)

Switch.Date Date -- (the current date/time)
Switch.ElementName Text Switch.getElementName()
Switch.FlowName Text Switch.getFlowName()

Switch.Language Text Environment.getLanguage()
Switch.LanguageEnvironment Text Environment.getLanguageEnvironment()
Switch.ServerName Text Environment.getServerName()
Switch.OutgoingName Text Indexed A list of names for the outgoing

connections in alphabetical order; if a
connection name is empty the target folder
name is used as a fallback; if the folder
name is empty as well, the connection is
not listed

Script that iterates over connections,
determines the (fallback) name and sorts
the list

Note:

« Switch.OutgoingName cannot be used to define metadata fields in Checkpoints and
Submit points.

Counter operation

The Switch.Counter variable evaluates to an automatically incrementing decimal integer with a
fixed number of digits. For example, if the variable has never been used before, it will evaluate to
"00001". Next time, it will evaluate to "00002" and so forth. After the counter reaches "99999" it
circles back to "00000".

The most recently used value of the counter is retained across multiple invocations of the Switch
Server.
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Counter: number of digits

The Width argument specifies the number of decimal digits in the number; leading zeros are
inserted when needed. The default value for width is 5; the minimum value is 1 and the maximum
value is 15. An invalid value is replaced by the nearest valid value.

The internal counter is always 15 digits wide; the Width argument specifies how many of the right-
most digits are actually shown.

Identifying counters

A counter variable refers to a particular physical counter through an identifier (ID). Switch uses
the same physical counter for all counter variables with the same ID, even if these variables are
used in properties of a different flow element or in a different flow (in the same Switch instance).
A physical counter is incremented each time a counter variable with its ID is evaluated, regardless
of where the variable occurred.

A counter variable can explicitly specify an ID or it can rely on the default value.

If the "ID" argument is present and has a non-empty value, this explicitly specifies the ID.
Otherwise a default ID is generated that is unique to the flow element in which the counter is
used. This makes the counter variable "local".

If a property uses the same counter variable more than once, each invocation of the variable is
deemed a new invocation and will cause the counter to be incremented. For example, assuming
no counters have been used yet in a flow element, the property value

Demo [Switch.Counter] - [Switch.Counter]

evaluates to

Demo 00001 - 00002

Metadata

Embedded metadata

Switch offers direct access to metadata embedded in a job in the EXIF, IPTC and Adobe XMP

formats, without the need for a separate "pick-up" action. Switch provides read-only access to
embedded metadata through variables and read-write access to embedded metadata through
scripting.

Also see "Metadata overview".

Embedded metadata formats

Switch supports the following embedded metadata formats:

Format Description Reference
EXIF A binary format designed to store Exif Version 2.2 specification
information about a photograph dated April 2002 (JEITA CP-3451)
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Switch

Format

Description

Reference

Generated by all digital cameras and used
by many desktop applications and asset
management systems

IPTC

A binary format designed to store news-
related information in photographs

Used by many applications including
asset management systems

IPTC — NAA Information
Interchange Model Version 4
dated July 1999

IPTC Core Schema for XMP
Version 1.0 Revision 8 dated
March 2005

XMP

An XML-based format defined by Adobe

Embedded in images or compound
documents; used by Adobe Creative Suite
and many other applications

Adobe XMP specification dated
September 2005

Also see "Supported file formats" below.

Read-only access through variables

Switch allows the use of variables in the values of many text properties and for defining file filters.
Variables provide access to run-time information about a job including embedded metadata

fields.

Examples of embedded metadata fields that can be accessed through variables include:
Group Type of information Metadata format

Doc Title, keywords, author(s), copyright terms | XMP

IPTC Contact, location, headline, instructions IPTC

Image Resolution, orientation, color mode EXIF (TIFF tags)

Photo Exposure time, aperture, focus, flash EXIF (EXIF tags)

Read-write access through scripting

Enfocus Switch offers complete access to embedded metadata through the scripting API:

« The Job.getEmbeddedDataset() function retrieves a dataset object representing the job's
embedded metadata.

« The XMP data model query functions allow reading fields in the embedded dataset.

« The XMP data model update functions allow writing or updating fields in the embedded
dataset for certain supported file formats.

Rather than providing separate data models for each embedded metadata format, Switch
synchronizes the binary EXIF and IPTC tags with the XMP properties — offering a unified view of
all metadata using the XMP data model. See Supported file formats on page 396.
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Supported file formats

The following table lists the embedded metadata capabilities for the supported file formats.

File format Metadata access | XMP packet EXIF & IPTC Image data
handling synchr. synchr.

JPEG, TIFF Read and write (*) | Smart read and For reading and | For reading
write (¥) writing (*)

Photoshop Read and write (*) | Smart read and For reading and |None
write (¥) writing (*)

PNG Read and write (*) | Smart read and None For reading
write (*)

PDF Read and write (*) | Smart read and None None
write (¥)

InDesign, Read-only Smart read-only | None None

PostScript

Other formats Read-only Generic read-only | None None

(*) Write access is available only through scripting

XMP packet handling
There are two distinct methods to locate XMP packets embedded in a file:

« Scan the complete file for the magic markers at the head and tail of a packet: this works for
any file format, but may possibly locate the wrong packet in case a composite document
contains multiple packets.

« Interpret the file format's structure to track down the packet: this guarantees that the correct
packet has been located and it is usually much faster, but it requires a specific algorithm for
each distinct file format.

As indicated in the table, Switch offers three levels of support for embedded XMP packets
depending on the file format:

« Smart read and write: interprets the file format to allow reading, updating and inserting an
XMP packet.

« Smart read-only: interprets the file format to locate the appropriate document-level XMP
packet but does not allow changes.

« Generic read-only: uses generic packet scanning to locate one of the XMP packets in the
document; does not allow changes.

EXIF and IPTC synchronization

As indicated in the table, for some file formats Switch performs two-way synchronization between
binary EXIF and IPTC tags on the one hand and XMP properties on the other hand, similar to the
behavior of the Adobe Creative Suite applications.

For supported file formats, when creating the embedded dataset for a job, Switch performs these
steps:
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« Locate the primary embedded XMP packet and parse it into an XMP object model; if there is
no XMP packet start with an empty XMP object model.

+ Read the appropriate binary EXIF and IPTC tags, if present and merge their values into the
XMP object model as the equivalent XMP properties.

« Offer access to the resulting unified XMP object model.

For supported file formats, when saving changes for a writable embedded dataset, Switch
performs these steps:

. If any changes were made to the dataset as compared to the original XMP packet, save the
complete unified XMP information in an updated or inserted XMP packet.

. If changes were made to one or more synchronized properties that are "user-editable", update
or insert the corresponding binary EXIF or IPTC tags. Properties that reflect characteristics of
the image (and thus should never be edited by a user) are not updated in the binary tags.

Image data synchronization

As indicated in the table, for some file formats Switch retrieves basic information about the image
from the image data itself and writes this information to the appropriate fields in the XMP packet.
This ensures that the following fields are always present for these formats:

Variable name XMP location path
Image.ColorMode photoshop:ColorMode
Image.ICCProfile photoshop:ICCProfile
Image.SamplesPerPixel tiff:SamplesPerPixel
Photo.ColorSpace exif:ColorSpace
Photo.PixelXDimension exif:PixelXDimension
Photo.PixelYDimension exif:PixelYDimension

Locating the backing file
The backing file for an embedded dataset is determined as follows:

« Ifthe job is an individual file, use it as the backing file.

« Otherwise if the job folder immediately contains a single Adobe InDesign file (that is, at the
uppermost level), use that InDesign file as the backing file.

« Otherwise use the job folder path for the backing file and return an empty read-only dataset.

External metadata

Switch offers substantial support for importing, exporting, transforming and using metadata
through a combination of:

« Standard tools for picking up and exporting metadata associated with a job.
« Complete access to metadata from the Switch scripting environment.

For example, using simple script expressions you can route a job and set its processing
parameters based on metadata provided with the job.

Also see metadata overview.
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Picking up metadata

Switch allows permanently associating metadata with a job moving through the flow (by storing
a reference to it in the job's internal job ticket). Each distinct set of metadata fields (for example,
a JDF job ticket or an XMP packet) are stored in a separate metadata dataset. Switch supports
several types of datasets, each with a specific data model that determines the semantics for
querying values from the dataset. See below for information on supported data models.

Metadata can originate from a number of different sources including a job ticket provided with a
job, an XMP packet embedded in a file, statistics derived from a file's contents and manual data
entry through the Switch Web Portal. Certain flow elements, including several built-in metadata
pickup tools, can associate a new metadata dataset with a job being processed through the
tool. Each dataset is given a unique name. Therefore, multiple datasets of the same type can be
associated with a job (for example: two JDF job tickets, each in its own dataset with a distinct
name).

To pickup metadata from a particular source, a flow designer must explicitly place the appropriate
pickup tool or app in the flow, at a location before the metadata is actually queried. See below for
a list of typical metadata sources and the corresponding Switch tools.

Using metadata

The Switch scripting API provides access to the contents of all metadata datasets already
associated with a job and offers the appropriate functions for querying metadata values in each
dataset, depending on its data model. Furthermore, the scripting API allows adding a new dataset
or replacing an existing one.

Using script expressions, a flow can route a job and set its processing parameters based on the
contents of metadata fields associated with the job. Script elements offer complete freedom for
importing, exporting, transforming and using metadata at will.

Variables in the Metadata group provide access to any external metadata field associated with a
job. Switch allows the use of variables in the values of many text properties and for defining file
filters.

Updating metadata

The datasets picked up in the manner described above are called external datasets, as opposed
to the embedded dataset which references information stored inside the file - see embedded
metadata.

Switch does not support updating the value of individual metadata fields within an external
dataset. This limitation does not apply to an embedded dataset (see Read-write access through
scripting on page 395) or to hierarchy info and email info (which is stored directly in the internal
job ticket and not in a metadata dataset).

Note that, despite this limitation, it is possible to replace an external dataset as a whole by a new
version.

Exporting and transforming metadata

Any metadata dataset associated with a job can be exported as a separate file (in the same
format) using the export metadata tool. The result can be further transformed to an appropriate
XML, HTML or text file using the XSLT transform tool.

Metadata data models

Switch supports the following metadata data models and corresponding querying mechanisms:
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Data model Description Query Scripting API
mechanism

XML Any well-formed XML file (with or XPath 1.0 Dataset
without XML namespaces); refer to the | expression and/ | functionality, XML
XML 1.0 specification or location path data model

JDF A JDF file conforming to the JDF 1.3 XPath 1.0 location | Dataset
specification path functionality, JDF

data model

XMP An Adobe XMP packet or file Adobe XMP Dataset

conforming to the Adobe XMP location path functionality, XMP

specification dated September 2005 | (subset of XPath) | data model

Opaque An arbitrary data file (allows None Dataset
associating information such as a functionality,
human readable report with a job) Opaque data

model

JSON A JSON file conforming to the RFC JSON Pointer Dataset
8259 (defined by RFC | functionality,

6901) JSON data model

Metadata resources

The following table lists various metadata sources and the corresponding metadata data models.
The default dataset name can be overridden in most cases to allow associating more than one
dataset of the same type with a job.

Source Pickup tool Data model Default
dataset name
Email message Mail receive XML Email
components
Manual entry in the | Fields defined in Submit point or XML Submit or
Switch Web Portal Checkpoint Check
Separate XML file XML pickup XML Xml
Separate JDF file JDF pickup JDF Jdf
Separate XMP file XMP pickup XMP Xmp
Embedded XMP XMP pickup XMP Xmp
packet
Any data file Opaque pickup Opaque Opaque
Adobe Acrobat JDF | Uncompress MIME file; then JDF pickup | JDF Jdf
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Source Pickup tool Data model Default
dataset name

QuarkXPress Job JDF pickup JDF Jdf
Jacket

PDF contents Apago PDFspy app XML Pdf
statistics

Preflight results Enfocus PitStop Server configurator XML Xml

(with XML report); then XML pickup

Text log or PDF Any app with outgoing traffic light Opaque Log
preflight report connections (set the "carry this type of
files" property to "data with log")

Pickup modes

The metadata pickup tools (XML pickup, JDF pickup, XMP pickup) allow associating metadata
from various sources as a metadata dataset with a job's internal job ticket. The tools support
several distinct mechanisms to locate the metadata source and its corresponding asset, as
described in the following subsections.

Terminology

+ Metadata source: the file (or sometimes the portion of a file) that contains the metadata to be
picked up.

- Asset: the file or job folder that is being described by the metadata and that will be moved
along in the flow after its internal job ticket has picked up the metadata.

« Pickup mode: a particular mechanism/algorithm to locate the metadata source and its
corresponding asset.

Metadata alongside asset

The metadata source (which is always a single file) and the corresponding asset (which may be

a file or a job folder) are both placed in one of the pickup tool's input folders (the same folder or
a different one) at the top level (that is, immediately under the input folder). Both have the same
name but a different filename extension. The supported filename extensions are defined through
flow element properties for the pickup tool.

The pickup tool waits until both the asset and the metadata source have arrived and then
performs the following steps:

« Create a new metadata dataset with a copy of the metadata source as its backing file.

- Associate this dataset with the asset's internal job ticket under the dataset name specified
through a flow element property for the pickup tool (replacing any existing association with
the same name).

«  Remove the metadata source.

«  Move the asset to the output folder.

Property Description

Metadata filename One or more file types or filename extensions that are recognized as
pattern metadata files
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Property Description
Orphan timeout The time delay after which an incoming metadata source or an incoming
(minutes) asset is considered orphaned because it can't be matched to a
counterpart
Orphaned jobs are moved to the problem jobs folder

Metadata in job folder asset

The asset (which is always a job folder) is placed in one of the pickup tool's input folders and
the metadata source (which is always a single file) resides inside the job folder. The pickup tool
provides flow element properties for locating the metadata source within the job folder (nesting
level and filename pattern).

The pickup tool waits until the job folder has fully arrived and then performs the following steps:
Locate the metadata source; if none is found the next two steps are skipped.

« Create a new metadata dataset with a copy of the metadata source as its backing file.

« Associate this dataset with the asset's internal job ticket under the dataset name specified
through a flow element property for the pickup tool (replacing any existing association with
the same name).

«  Move the job folder asset to the output folder.

Note that the metadata source is not removed in this case.

Property Description

Metadata file filters | File filter that determines which of the files in the job folder represents
the metadata; files are scanned starting at the topmost nesting level (at
each level the scan order is arbitrary); the file filter is evaluated in the
context of each file and the first file that matches is used as metadata
source

Search depth The number of nesting levels in which to look for the metadata; "1" means
the topmost level only

Metadata refers to asset

The metadata source (which is always a single file) is placed in one of the pickup tool's input
folders and it contains a reference to the asset (which may be a file or a job folder) in some other
location accessible through the file system. Thus the asset itself is never directly placed in a flow
input folder.

The pickup tool provides flow element properties for locating the asset reference inside the
metadata source (a location path) and for determining whether the original copy of the asset
should be removed or not.

When the pickup tool detects an incoming file, it expects it to be a metadata source and it
performs the following steps:

- Locate the asset reference in the metadata source, locate the asset, and ensure that it is
readable. If any of these steps fail, report an error and quit.

. Create a new metadata dataset with a copy of the metadata source as its backing file.
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« Associate this dataset with the asset's internal job ticket (which in fact is the metadata source's
job ticket) under the dataset name specified through a flow element property for the pickup
tool (replacing any existing association with the same name).

. Copy or move (depending on the property settings) the asset from its original location to the
output folder.

«  Remove the metadata source.

Property Description

Asset path A script expression or a single line text with variables that evaluates to
the file or folder path referring to the asset to be copied.

Delete asset Determines whether the original copy of the asset is deleted after it
has been copied into the flow; this can be an explicit value or a script
expression.

Disadvantages of using "Metadata refers to asset"

« The path has to be complete, and the file has to be locally accessible (that is: on your local
disk, or, if on a network drive, through a UNC path of the form \\server\volume\directory\file
rather than through a mapped drive). If for example only the filename is available, or the
reference to the asset is HTTP-based, this method cannot be used.

« The script expressions are evaluated before the incoming metadata has been picked up
(before the asset has been located), hence the script expressions cannot access any
metadata to calculate the return value.

A more recommended method therefore is to use XML pickup with pickup mode "Metadata is
asset". The dataset can then be used in the default app Inject job or the free app Inject Wildcard
for local files or in the default app HTTP request to inject an external file into the flow. Moreover
this method has better error handling and is more reliable than "Metadata refers to asset".

Metadata embedded in asset

The asset (which is always a single file) is placed in one of the pickup tool's input folders and the
metadata source is embedded in the asset file according to some format (which depends on the
pickup tool).

When the pickup tool detects an incoming file, it expects is to be an asset and it performs the
following steps:

« Extract the metadata source from the asset and store it into a standalone file; if the asset does
not contain embedded metadata of the appropriate type, the next two steps are skipped.

- Create a new metadata dataset with this standalone file as its backing file.

« Associate this dataset with the asset's internal job ticket under the dataset name specified
through a flow element property for the pickup tool (replacing any existing association with
the same name).

« Move the asset file to the output folder.

Property Description

Synchronize EXIF/ If set to "Yes", for supported file formats the values of binary EXIF and
IPTC fields IPTC tags are merged with the embedded XMP packet before it is picked
up (the packet embedded in the asset remains unchanged)
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Property Description

If set to "No", the embedded XMP packet is picked up without change - if
present

Metadata is asset

The pickup tool with a fourth pickup mode: "Metadata is asset" is used to implement for JDF, XML
and XMP pickup.

When a job (example: JDF) file is sent to a pickup tool using this feature, the resulting file is the
JDF file with its own content as JDF metadataset. So tools have only three properties: Name,
Dataset name and Pickupmode. There is no need for additional properties when this pickup
mode is selected.

Email message schema

The mail receive tool automatically picks up the contents of incoming email messages as
metadata. Specifically, for each incoming message the mail receive tool creates a metadata
dataset that contains the relevant components of the message, such as the sender, to, cc, and
reply-to addresses and the complete email body text. This dataset is then associated with the job
ticket for all files delivered by the message under the standard dataset name "Email".

Data model and schema
The email message dataset uses the XML data model with a simple schema without namespaces.

The XML document element name is "email". It contains an element for each message
component as described in the table below; each element contains the text of the corresponding
message component. If a message component is not present or it contains only white space, the
corresponding element is missing.

Leading and trailing white space is removed (except for the body text, where it may be
significant). Otherwise, no parsing or reformatting is performed. For example, a list of email
addresses (including its separators) is stored exactly as it was provided in the incoming message.

Element name Message component

message-id An identifier for the message (assigned by the host which generated
the message)

subject The subject line of the message

date The date and time when the message was sent (formatted as it
appeared in the message header)

from The email address(es) of the author(s) of the message

sender The single email address of the sender of the message; if there is a
single author the sender is identical to the author, otherwise the sender
should be one of the authors

reply-to The email addresses to which a response to this message should be
sent
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Element name Message component

to The email addresses of the primary recipients of this message

cc The email addresses of the secondary recipients of this message

body A plain-text rendition (without markup) of the body text of this message

Processing results schema

The FTP send and Mail send tools produce a log file with processing results. This log file is
carried along the outgoing log connections.

This log file can be associated with the job as a metadata dataset by using a "data with log"
connection (see the "Carry this type of files" property of traffic light connections).

Data model and schema

The processing results log file uses the XML data model with a simple schema without
namespaces.

The XML document element name is "ProcessingResults". It contains a sequence of elements
with a name and contents as described in the following table. If a data item is not applicable, the
corresponding element may be missing.

Element name Data type Description

Destination Text For FTP, the complete target URL for the job

For Mail, the list of destination email addresses

FlowElementName Text The name of the flow element that produced this log
file (as displayed in the canvas)

FlowElementType Text The type of the flow element that produced this log
file (e.g. "FTP send" or "Mail send")

FlowName Text The name of the flow (as displayed in the flows
pane) containing the flow element that produced
this log file

JobArrivalStamp Integer The arrival stamp for the processed job as an

unsigned integer number; a lower arrival stamp
indicates a job that arrived in the flow earlier (and
vice versa)

Several jobs may have the same arrival stamp, for
example when multiple jobs are generated from the
same original job

JobByteCount Integer The size in bytes of the processed job; if it is a job
folder, all files in subfolders are included in the
count, recursively
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Element name Data type Description

JobExtension Text The processed job's filename extension, or the
empty string if there is none

JobFileCount Integer The number of files in the processed job, including
all files in subfolders, recursively (folders and
subfolders themselves do not contribute to the

count)
JobFiles Sequence of A sequence of one or more "File" elements
"File" elements representing the files in the processed job in

arbitrary order; each File element has the Text data
type and contains the relative path of a file within
the job (using a forward slash as path separator)

Folders are NOT represented in this list

JoblsFile Boolean True if the processed job is a single file, false
otherwise

JoblsFolder Boolean True if the processed job is a folder, false otherwise

JobName Text The file or folder name for the processed job,

including filename extension if present, but
excluding the unique filename prefix

JobNameProper Text The file or folder name for the processed job
excluding filename extension and excluding the
unique filename prefix

JobOrigin Text An indication of the origin of the processed job
before it was injected in the flow; for example, a
Submit point writes the absolute path of the original
job (on the client computer) in this field

JobPath Text The absolute file or folder path for the processed
job as it resided in the input folder before being
processed, including unique filename prefix

JobPriority Integer The job priority assigned to the processed job as a
signed integer number

JobUniqueName Text The unique filename prefix used for the processed
Prefix job, without the underscores; for a job called
"_0G63D_myjob.txt" this would be "0G63D"

JobUserName Text The user name associated with the processed job, if
any

ProcessingEnded Date The date-time when the operation was completed
(in the ISO 8601 format also used for Switch date
variables)
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Element name Data type Description

ProcessingStarted Date The date-time when the operation started (in the ISO
8601 format also used for Switch date variables)

ServerAddress Text The name or IP address of the destination server

ServerLoginName Text The user name used to login at the destination
server

ServerPort Integer The port of the destination server

Defining metadata fields

The Submit point and the Checkpoint tools allow defining metadata fields which can be viewed
and/or edited by the Switch Web Portal user when submitting or routing a job. The values of
display-only fields are determined by evaluating a script expression so that they can depend
on metadata associated with the job. After a user submits a job or moves it along, the values of
editable fields (as entered by the user) are associated with the job as metadata (with the client

fields schema).

Defining metadata fields

S Define metadata fields: Metadata fields

Metadata Fields

Field Properties

= 0 Mame

Description

Parent walue

Dependent
Show if parent Equals
Data bype Single-line text

Drata Format
Default

Remember lask valug Mo

&) (=] (€]

Yalue is required Mo w

Read only Mo w

Display metadata field |Yes “
Ok, ] [ Cancel

X
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The property editor for editable metadata fields allows creating an ordered list of field definitions
(using the buttons under the listbox on the left-hand side). For each field definition, the property
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editor allows editing the properties described in the table below (using the edit fields and controls
on the right-hand side).

Property Description
Label The label shown in front of the field.
Description Description for this field shown as tool tip when user hovers over the

label or the data field in the Switch Web Portal.

Show if parent and Only available if the Metadata field has a parent. Dependencies are set
Parent value using the arrow keys in the field list.

These properties allow you to set a condition for showing the child. For
example, if the parent field is "Add Bleed?", the child field "Amount of
bleed" only needs to be displayed if the value of "Add Bleed?" is Yes
(So: Show if parent equals Yes).

Note: If you choose the "Matches" option for "Show if Parent”
property then regular expression will be used for all parent
values.

Data type The field's data type: Dropdown list (Single-line text, Password, Date,
Number, Hours and minutes, No-yes list, Dropdown list).

Data format Only available when "Data type" is set to single-line text or number.
Format the metadata field using a regular expression. Leave empty to
not set any special formatting (Single-line text, Regular expression).

Data values and Only available when "Data type" is set to "Dropdown list". Define the
Ignore duplicates drop down list (Edit multi-line text, Define multi-line text with variables,
Define script expression, Define values from dataset, Define values from
ODBC data source).

The Ignore duplicates option defines if a value can be shown twice in
the dropdown list.

Default The default value for the field (Single-line text, Single-line text with
variables, Condition with variables, Date and Script expression), i.e. the
value that is shown when the form is displayed to the user.

Using variables:

It is possible to use variables to define the default value for your
metadata field (Single-line text with variables, Condition with variables).
However, most variables (e.g. doc author, page height, number of
pages, ...) are not suited, as the requested information is only available
after the job has been submitted to the Switch Server. At the time of
submitting the job, only the variables of the Switch variables group (e.g.
date, flow name, server name, ...) are available and can be displayed to
the user.

Some examples:

« [Job.Size] as default value is invalid; this will result in see "O bytes" as
the job size is unknown as long as the job hasn't been submitted to
the Switch Server.
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Property Description

« [Switch.Date:TimeZone="UTC"] is valid and will show the current
date and time (= the date/time you're using the Switch Web Portal to
submit the file).

Mismatches:

In case "Data type" is Dropdown list with dynamically generated content,
this default value might not correspond with one of the list items. In this
case the "Default value" is empty in the Switch Web Portal.

In case the "Data type" format and the default values format do not
match, Switch tries to force the formatting of the data type property
(example, Data type is hour and minute and the Default value is a text
variable). If forcing is not possible, the Default value is empty in the
Switch Web Portal.

Remember last value | |f set to "Yes", the most-recently value entered by the user (in this field) is
displayed.

In case "Data type" is Dropdown list with dynamically generated content,
the previous value might become irrelevant. The previous value is
however stored so we can also compare it with the content of the list.

If the stored value matches one of the data values, then this value is
shown. If the stored value no longer appears in the list, no value is

shown.

Read only Set this to "Yes" to make this field read-only, so it cannot be edited by
the user.

Value is required If set to "Yes", the user must enter a non-blank value (relevant only if
Data type is string).

Display metadata If set to "Yes" this field is displayed to the user and when set to "No" it

field is hidden. See Using metadata on page 398 and Defining metadata
fields on page 406 for more information.

Cache dynamic This property determines if the dynamic metadata field values are

values calculated once and then stored in the cache (to save processing

time) or recalculated each time metadata is requested for the job or
Submit point. On the Switch Web Portal metadata is requested when
submitting and processing a job (= when the form for entering metadata
is displayed to the user).

Dynamic values are values that are calculated using script expressions,
defined using variables, or taken from a database. An example is a
metadata field "Product" that is defined as a dropdownlist with products
taken from a database. If cached, the products are retrieved from the
database only once; if not cached, Switch retrieves the products each
time metadata is requested.

Options are:

- Do not cache (default): The dynamic values are recalculated
whenever they are requested. This takes more time but is advised in
case of fast changing data (e.g. quickly changing database values,
the [Switch.Counter] variable, ...).
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Property

Description

« Cache per user: The dynamic values are calculated once and then
stored for each user separately. When a different user logs in,
the dynamic values are calculated again and stored in that user's
cache. This option is recommended if the dynamic values are
based on user names or email addresses, such as a variable like
[Connection.UserName].

« Cache for all users: The dynamic values are stored in a common
cache for all users. For example, when user 1 submits a job, the
dynamic metadata field values are calculated and stored in the
common cache. If user 2 submits a job, the stored values are re-
used (instead of recalculated). This option is recommended for job-
dependent variables or script expressions.

Note:

- Fixed or static values are always cached.

- Options to clear the cache (e.g. at user login or on a certain
condition) can be set in the properties of Submit points and
Checkpoints.

Note: For the Checkpoint tool, when a user selects "Define values from dataset" in

the Data Values field, the Build location path window appears using which XPath
expressions can be created. The regular variables from a dataset returns only one single
value where as the result of the XPath can be a list of values.

Note: For the Submit point and the Checkpoint tools, when a user selects the "Define
values from ODBC data source", Build SQL statement window appears. The regular
variables from database returns only one single record where as the result of the SQL
statement can be a list of records.

Note: Switch.OutgoingName cannot be used to define metadata fields in Checkpoints
and Submit points.

Note: Node.js script expressions are not yet supported in Checkpoints and Submit

points.

Update metadata

Click the button present below the Metadata fields list to access a dialog box which displays a
two level tree: first level table tree of all Submit points (level 1) and second level for their metadata

fields (level 2).

In the list, a Submit point can be checked (including all its fields) or an individual field can
be selected. The fields that are checked are added to the Metadata fields list. Possible
dependencies are preserved.

The fields from a Submit point are clearly marked (using color or some other mark). Therefore,
user can distinguish such fields from a newly added Checkpoint field. All properties from these
fields are grayed-out, except the Show if parent equals ... property, the Read only property and
the Display metadata field property.

409



ENF@CUS Switch

Behavior of updated fields in the Switch Web Portal
The metadata from the submit dataset is shown as the default value.

On the Switch Web Portal, users can read and change this data (if allowed). The new value is
written to the check dataset. So technically, this is not a real update from the data but a copy
from a field of one dataset (submit) to another (check). The Switch user can of course use the
same name for the submit and check dataset. In this case the first dataset is overwritten.

If metadata fields are changed or added on a Submit point, the user will probably wish to
update those fields in the Checkpoint too. Switch however does not offer an automatic update
mechanism, so the user has to delete the field and re-import it again.

If users delete a field from a Submit point, they are also responsible for deleting that field from the
Checkpoint metadata list as well. If a user does not remove the deleted field from the Checkpoint
metadata list, then the field is still shown but the default value will then be empty.

Defining display-only fields

S Define metadata fields: Metadata fields g|
Metadata Fields Field Properties
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The property editor for display-only metadata fields allows creating an ordered list of field
definitions (using the buttons under the listbox on the left-hand side). For each field definition, the
property editor allows editing the properties described in the table below (using the edit fields
and controls on the right-hand side).

Property Description

Label The label shown in front of the field
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Property Description

Description A hint displayed when the cursor hovers over the field

Data type The field's data type: Boolean or string

Calculated value A script expression that evaluates to the value of the metadata field; it
is evaluated in the context of the job being viewed by the user so that it
can use metadata associated with the job

Client fields schema

The Submit point and Checkpoint tools pickup metadata fields entered by the user when
submitting or routing a job through the Switch Web Portal.

Specifically, when a user submits a job and the list of field definitions in the Submit point's
"Metadata fields" property is not empty, the Submit point:

- Creates a metadata dataset containing the contents of the metadata fields entered by the
user.

« Associates this dataset with the job ticket for the submitted job under the dataset name
specified in the "Dataset name" property.

Similarly, when a user routes a job residing in a Checkpoint and the list of editable field
definitions in the Checkpoint's "Metadata fields" property is nonempty, the Checkpoint creates a
metadata dataset and associates it with the job's job ticket under the specified dataset name.

Note that a Checkpoint always creates a completely new dataset, i.e. it does not update or
modify an existing dataset (even if the job was previously moved through the same or another
Checkpoint). If the job already has dataset association with the same name, the reference to the
old dataset is removed and replaced by the new one.

Data model and schema
The client fields dataset uses the XML data model with a simple schema without namespaces.

The XML document element name is "field-list". It contains a "field" element for each item in the
list of editable metadata field definitions associated with the Submit point or Checkpoint under
consideration. The "field" elements occur in the same order as in the list of field definitions, and a
"field" element is present even if the corresponding field's value is empty.

Each "field" element in turn contains zero or one occurrence of each element listed in the table
below. Within the contents of those child elements leading and trailing white space is removed.

Element name Description of element contents Element is present

tag The field name; in the current implementation this is | Always
equal to the human-readable field label

type The field's data type; that is, "boolean", "string" or Always
"choice"

format A regular expression that matches the values If type is string and if
allowed for the field (relevant only if data type is regexp is not blank
string)
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Element name Description of element contents Element is present

required Equals "true" if the user is required to enter a non- | If type is string
blank value, "false" otherwise (relevant only if data
type is string)

value The value for the field: Always

« For boolean data types: "true" or "false"

« For string data types: the value entered by the
user after removing any leading and trailing
white space (may be the empty string unless
required is set to true)

items The field's possible choices if type is choice

Introduction to XPath 1.0

XPath 1.0 is used in the Switch scripting API for querying the contents of XML documents in the
XML and JDF data models and in the XML module.

Note: The current version of Switch does not support XPath 2.0.

Refer to the XPath 1.0 specification, the XML 1.0 specification, the XML namespaces specification,
and widely available literature for full details on XPath 1.0.

The remainder of this topic provides a brief introduction to a very small subset of XPath 1.0.

Expressions and location paths

XPath models an XML document as a tree of nodes. There are different types of nodes, including
element nodes, attribute nodes and text nodes. XPath defines a way to address specific nodes
in the node tree, to compute a string-value for each type of node and to perform more general
calculations with these values.

The primary construct in XPath is the expression. An expression is evaluated to yield an object,
which has one of the following four basic types:

« node-set (an unordered collection of nodes without duplicates).
« boolean (true or false).
« number (a floating-point number).

« string (a sequence of Unicode characters).

One important kind of expression is a location path. A location path selects a set of nodes. The
result of evaluating an expression that is a location path is the node-set containing the nodes
selected by the location path. Location paths can recursively contain expressions that are used to
filter sets of nodes.

Location paths

A location path is a sequence of one or more location steps separated by a slash. Each location
step in turn (from left to right) selects a set of nodes relative to the context node determined by
the previous step. The initial context node is determined by the location path's context (for the
data model queries in Switch this is always the document's root node; in the XML module it is the
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node being queried). A slash in front of a location path makes the location path absolute, that is,
the "/" refers to the root node of the document.

Here are some examples of location paths:

para

selects the para element children of the context node
*

selects all element children of the context node

text()

selects all text node children of the context node
@name

selects the name attribute of the context node

@*

selects all the attributes of the context node

para[1]

selects the first para child of the context node
para[last()]

selects the last para child of the context node

*/para

selects all para grandchildren of the context node
/doc/chapter[5]/section[2]

selects the second section element in the fifth chapter element in the doc document element
chapter//para

selects the para element descendants of the chapter element children of the context node
llpara

selects all the para descendants of the document root and thus selects all para elements in the
same document as the context node

[lolist/item

selects all the item elements in the same document as the context node that have an olist parent

selects the context node
Jlpara

selects the para element descendants of the context node

selects the parent of the context node

../@lang
selects the lang attribute of the parent of the context node

para[@type="warning"]
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selects all para child elements of the context node that have a type attribute with value warning
para[@type="warning"][5]

selects the fifth para child element of the context node that has a type attribute with value
warning

para[5][@type="warning"]

selects the fifth para child element of the context node if that child has a type attribute with value
warning

chapter[title="Introduction"]

selects the chapter child elements of the context node that have one or more title child elements
with string-value equal to Introduction

/ffield[name="JobID"]/value

selects all value elements in the document that have a parent field element and a sibling name
element with string-value equal to JobID

chapterftitle]
selects the chapter child elements of the context node that have one or more title child elements
employee[@secretary and @assistant]

selects all the employee child elements of the context node that have both a secretary attribute
and an assistant attribute

Expressions

The location paths listed in the previous section contain a few examples of simple expressions
used to filter nodes (such as @type="warning" to filter out elements with a particular attribute
value). Expressions can also stand on their own, and can be used to express calculations
based on the result of a location path. XPath provides a limited number of functions for use in
expressions.

Here are some examples of expressions:

para

evaluates to the text contents of the para element(s)
@type

evaluates to the text contents of the type attribute
(2+3)*4

evaluates to the number 20

number(@type) > 10

evaluates to true if the contents of the type attribute represents a number that is greater than 10;
and to false otherwise

count(//field)

evaluates to the number of field elements in the document, regardless of their position in the
node tree

count(/doc/chapter[5]/section)

evaluates to the number of section elements in the fifth chapter element in the doc document
element
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string-length(normalize-space(para))

evaluates to the number of characters in the text contents of the para element, after removing
leading and trailing white space and replacing sequences of white space characters by a single
space

Namespaces

The examples above assume that the XML document being queried does not use namespaces.
In practice however many XML documents do use namespaces to avoid conflicting element and
attribute names when information of a different type or origin is mixed.

A namespace is identified by a Unique Resource Identifier (URI) which resembles a web page
address but in fact is just a unique string (most URIs do not point to an actual web page). Rather
than repeating this URI each time, element and attribute names use a namespace prefix (a
shorthand) to refer to a namespace. The mapping between namespace prefixes and namespace
URIs is defined in namespace declarations in the XML file.

For example:

xml:lang

is the name of a standard xml attribute for indicating a natural language
jdf:node

is the name of a node element in the JDF specification, assuming that the jdf prefix is mapped to
the JDF namespace URI

Namespaces and XPath

If the XML file being queried uses namespaces, the XPath expressions and location paths must
use namespace prefixes as well. The mapping between those prefixes and the corresponding
namespace URIs must be passed to the query function separately, since this information can't be
expressed in XPath.

Note that namespace URIs must match between the XPath expression and the XML file; the
namespace prefixes may differ.

XPath does not have the concept of a default namespace. If the XML file being queried defines a
default namespace, the XPath expression must specify a namespace prefix to refer to elements in
that namespace. The default_switch_ns prefix can be used to specify elements using the default
namespace.

Introduction to Adobe XMP location paths

The Adobe XMP specification dated September 2005 defines the XMP data model (the abstract
node hierarchy represented by an XMP packet or file). Other Adobe publications define a
mechanism to address a specific node in the XMP data model, using a syntax that is a (very small)
subset of the XPath 1.0 location path syntax. In this documentation we refer to this mechanism as
XMP location paths.

XMP location path syntax

An XMP location path points to a specific node in an XMP node hierarchy (whether the node
exists or not).

An XMP location path is a series of one or more XMP location steps separated by a slash. Each
location step address the next child element, depending on the structure of the document.
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Each location step is one of the following:

« A prefixed field name
« An array index selector

- Alanguage selector

A language selector may occur only as the very last location step. The first location step is always
a prefixed field name.

Field name

A field name addresses a named element (also called a field).
For example:

xmp:SomeProperty

Addresses a field named "SomeProperty" in the namespace to which the "xmp" namespace prefix
is mapped.

Index selector

An index selector addresses an item in an array. Indices are one-based, that is, the first item in an
array has index 1. The last item in an array can be addressed with the special index "last()". In all
cases the index must be enclosed in square brackets and preceded by an asterisk.

For example:
*[1]

*[4]

*[last()]

Address the first, the fourth and the last item of an array, respectively.

Language selector

A language selector addresses an item in a collection with language alternatives (a collection
of strings with the same meaning but localized for different human languages). The language is
indicated by a 2-letter language code (ISO 639), optionally followed by a 2-letter country code
(ISO 3166). The special language code "x-default”" indicates the default language. The language
code must be embedded in special XPath syntax for addressing the xml:lang attribute.

For example:
*[@xml:lang="enUS'] *[@xml:lang="x-default']
Address U.S. English and the default language item, respectively.

Examples

The following examples address properties in the XMP Dublin Core schema, which is usually
associated with the "dc" prefix. Thus these examples assume that the "dc" prefix is mapped to the
Dublin Core namespace URI (http://purl.org/dc/elements/1.1/).

Examples:
dc:format
Addresses the top-level data format property.

dc:creator/*[1]
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Addresses the first item in the list of document creators, which by convention is the primary
author of the document.

dc:description/*[@xml:lang="x-default’]

Addresses the default item in the list of language alternatives for the document's description.

4.5.3. Scripting Module

4.5.3.1. Script element

If you have an active license for the Scripting Module, you have access to the Script element

in the Flow elements pane. This allows you develop your own scripts (using the SwitchScripter
application, which comes with Switch), for example to extend the capabilities of Switch. You can
also create your own apps using SwitchScripter, for interaction with third-party applications that
are not yet supported by Switch.

Note:

- When using Switch to automate a third-party application using apps, you should
make sure that you comply with the vendor’s End User License Agreement and have
obtained the appropriate software license.

- If you want to make your scripts available to other Switch users, you may consider
becoming an Enfocus app creator. By being an app creator you can turn scripts into
apps and make them available in the Enfocus Appstore for other users to purchase
or download. More information and our email to contact us can be found at https.//
www.enfocus.com/en/about-appstore.

For more information, refer to the Switch Scripting documentation on the Enfocus website. There
is also a guide with sample scripts available on the Enfocus website.

4.5.3.2. Script expressions

A script expression is a JavaScript program that gets evaluated in the context of a job (file or job
folder) to determine the value of a particular property of a flow element or connection. This allows
the property value to depend on the job or its associated metadata.

Both legacy JavaScript and Node.js TypeScript can be used in script expressions. Other
languages are not supported.

Associating a script expression with a property

Many flow element and connection properties in Switch offer an extra property editor that allows
entering a script expression.

For example, the "Subject" property of the Mail send flow element allows a script expression in
addition to a regular explicit value ("inline value") and single-line text with variables.
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(3 ] =) Properties

Property Value

Name Mail send

Description

Subject Inline value |
To addresses Define single-line text with variables

Include attached addr Define script expression
CC addresses

To associate a script expression with a property value, proceed as follows:

1. Click the arrow button next to the property that you want to define.
The menu options are shown.

2. From the list, select Define script expression.
The Define script expression dialog pops up. What you see, depends on the value of the
Render HTML in Designer preference. This preference determines whether the Node.js script
expression editor is shown in Designer or in a separate browser window.

« Render HTML in Designer set to Yes:

[ ] [ ] Define script expression: Subject

Legacy scripting

1 f/ Your imports here

]

// Do not remove calculateScriptExpression function. It must return §
async function calculateScriptExpression{s: Switch, : Flow

h

Cancel Save

« Render HTML in Designer set to No, so the editor will be shown in your default browser:
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[ ] Define script expression: Subject

Legacy scripting

3. Do one of the following:

- If you want to use legacy JavaScript, select the Legacy scripting checkbox and enter
your script expression in the text field. The value of a script expression's property is set to
the result of evaluating the main body of the script as an expression. The main body may
invoke functions defined in the script expression itself or provided as part of the Switch
scripting API. For more details, please check the Switch legacy scripting documentation.

- If you want to use Node.js TypeScript:

« If the script expression editor is opened in Designer, you can immediately write your
script expression.

- If the script expression editor is not yet active, click Edit. The script expression editor
will open in a separate browser window. You can now write your script expression in
the browser window. Access to the Switch Designer user interface will be blocked until
you're done.
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Script expression editor

Waiting for script editing to finish...
L ]

Cancel

In case of Node.js TypeScript, the script expression must be put as the body of the
calculateScriptExpression() entry point. The value of a script expression's property is set
to the result of evaluating the calculateScriptExpression() entry point. The entry point may
invoke functions defined in the script expression itself or provided as part of the Switch
scripting API. For more details, refer to the Switch Node.js scripting documentation. For
more information on the Node.js editor, refer to https.//microsoft.github.io/monaco-editor/.

4. To develop and test your script expression, save it, activate the flow and process some
sample jobs.

Note: Script expressions in legacy JavaScript can still be developed and tested in
SwitchScripter. Afterwards you just have to load them in the appropriate editor dialog
box.

Script expressions: examples

Note: Although some of the examples in this section use legacy JavaScript, we
recommend using Node.js TypeScript.

String value example

Script expression in Node.js TypeScript

async function calculateScriptExpression(s: Switch, flowElement: FlowElement, job:
Job) : Promise<string | number | boolean> ({
const theDefaultAddress = "addr@host.com";
const theEmailAddresses = await
job.getPrivateData ('EnfocusSwitch.emailAddresses');

if (typeof theEmailAddresses === "string" && theEmailAddresses === "") {
return theDefaultAddress;
}

return theEmailAddresses.join(";");

}
When this script expression is evaluated in the context of a job being processed, the script

expression will return the email addresses which are added to each job's email info as the job
passes through the folder (specified in the "Attach email addresses" property of the input folder).
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In the screenshot below, the script expression used to define the "To addresses" property of Mail
send.

® [ ] Define script expression: To addresses

Legacy scripting

1 async function calculateScriptExpression{s: Switch, : FlowElement, job: Job): Promise<string | number | boolean> {
2 const theDefaultAddress = "addrighost.com";

3 const theEmailAddresses = await job.getPrivateData('EnfocusSwitch.emailAddresses');

1

5 if (typeof theEmailAddresses === "string" && theEmailAddresses === "") {

6 return theDefaultAddress;

7 ¥

8 return theEmailAddresses.join(";"};

Cancel Save

Script expression in legacy JavaScript
job.getPrivateData ("Email Title");

When this script expression is evaluated in the context of the job being processed, the script
expression will return a string value (or a value that can be meaningfully converted to a string
under the JavaScript rules).

In the screenshot below, the script expression is used to define the "Subject" property of Mail
send, so the resulting value will be used as the subject line of the email that will be sent out for
the job.
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[ ] [ ] Define script expression: Subject

Enter a JavaScript expression that evaluates to a string value

Legacy scripting

1 Jjeb.getPrivateData("Email Title");

Line: 1 Col: 35
Open Save Save as...
Cancel OK

Boolean value example

Script expression in Node.js

async function calculateScriptExpression(s: Switch, flowElement: FlowElement, Jjob:
Job) : Promise<string | number | boolean> ({
return false;

This is an example of a Node.js script expression associated with the master property of a script
element or app.The master property contains a "No-yes list" (boolean property type) and "Script
expression" editors. The dependent property will be shown only if the master property equals
"NO".

Script expression in legacy JavaScript

job.getByteCount ()==(1024*10) ;
When this script expression is evaluated in the context of the job being considered as a possible
match for the filter, the script expression will return a Boolean value, i.e. true or false (or a value

that can be meaningfully converted to a Boolean under the JavaScript rules). If the resulting value
is true, the job will be considered to match the filter, otherwise it won't.
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This script expression could for example be associated with the Include these jobs property of a
connection leaving a folder.

Number value example

Script expression in Node.js

async function calculateScriptExpression(s: Switch, flowElement: FlowElement, job:
Job) : Promise<string | number | boolean> ({

return PdfDocument.getNumberOfPages (await job.get (AccessLevel.ReadOnly)) ;
}

When this script expression is evaluated in the context of the job being processed, the script
expression will return the number of pages in the PDF document associated with the job.

Array value example
Script expression in Legacy JavaScript

When the main editor is “Multi-line text with variables” the script element or app expects an array
in return, but in that case it works a bit differently. Instead of returning the array as is, a joined
version of it using \n as a separator should be returned:

var mailAddresses = [“123@abc.com”,”456@def.com”];
//mailAddress;//do not return just this
mailAddresses.join(“\n”);//but do it like this

In the script element or app, the return value can then be easily turned into an array again
by splitting the string based on \n. Note that not all existing scripts and apps implement this
behavior, so although we recommend this approach it may not always work as described here.

Note: If a script expression evaluates to a complex JavaScript object, then before
returning the value, the script expression code can convert the object to a string value
using the JSON.stringify() function. Later the flow element script code can convert it back
to the object using the JSON.parse() function. Both functions are available in legacy
JavaScript and Node.js TypeScript.

4.5.4. Database Module

The Database module is an advanced module that allows read/write access to databases
(through ODBC data sources) without the need for extensive scripting. With the database
module, business or job management software can be used in conjunction with Switch workflows
to further automate job decisions.

An active Database module license provides you with access to:

« The ODBC data sources option in the User preferences dialog (required to set up a database
connection and to use database variables).

« The Database connect flow element (available in the Database category of the Flow elements
pane). This flow element allows you to configure certain settings in databases without having
to script them.

« Database variables. This allows you to use any values from your database in Switch.

- Database values when defining metadata for a Submit point on page 121 on the Switch
Web Portal or a Connector in Connect ALL (see the Connect documentation on the Enfocus
website).
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4.5.4.1. Getting started with the Database Module

The Switch Database Module automates the communication between any database and Switch.

This means you can use database information in Switch, for example to make decisions based on
existing job or customer information. For example, if information about the paper type of a job is
available in your MIS system, you can attach this information to the job and use this information to
decide whether or not it should go to an Ink Optimizer.

Moreover, you can also change the information in your database from within your workflow to
store information obtained in the workflow, for example to indicate that the job is done or to store
preflight information. You can as well add or delete records in your database.

The illustration below shows how data from different types of databases (MIS/DAM/CRM
database) can communicate with Switch through ODBC data sources ("connections to the
database").

DAM

EDITORIAL

JOB DATA ASSET OATA CLUSTOMER
‘ | CWATA

*CREATE

*UPDUTE
*REMIVE
sSELECT

«FILTER

+RENAME
=« CREATE FOLDER

e ) SWITCH

If you're using the Switch Web Portal or Connect ALL to submit jobs to Switch, the Database
Module offers an extra feature, i.e. the possibility to present database values to the users and
give them the chance to attach the appropriate values to the job. For example, instead of asking
the users to type the correct customer ID (risk of typos!), you could show them a list of customer
IDs available in the database to choose from.

Database connect

An active license for the Database Module gives access to the Database connect flow element.
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This element allows you to establish a connection with the database of your choice (using ODBC
data sources) and to build an SQL statement to determine what data should be collected, added,
modified, filtered, changed...

When a job passes through this flow element, the SQL statement is executed. To keep an eye on
the changes, you can log the result of the SQL statement.

In the following example, when a job arrives in the Database connect flow element, Switch
connects to the MIS database and checks the paper type for the current job. Only if the job
matches the SQL statement, the job is “successful” and the job will be sent to the Ink Optimizer.
For each job, a log file is created and stored in a separate folder.

Log file

# 1
Input Database |:{|4,:}j-|ect Uncoated Send to Ink Optimizer

™

Database connect

MIS database
SQL == select paper type = uncoated

Coated

Database variables

Additionally, the Database Module gives access to an extra set of variables, e.g. the Database
variables which also retrieve data from your database but which can be used wherever variables
can be used in Switch (so not only in combination with the Database connect flow element).

Variables in Switch are “placeholders” - they are replaced with actual values when a job is being
processed. For example, if you want that the customer receives a notification whenever a job

is finished, you should use the [Job.EmailAddress] variable (in the Mail send element) to make
sure that the email is sent to the right email address (i.e. the address associated with the job).
However, if you have activated the Database Module, you can select (additional) email addresses
available in your database. The variable will start with "Database", e.g. [Database.Text:SQL="
SELECT Email FROM Customers"] (SQL statement to select records from the column "Email" in the
table "Customers").
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Database fields in the Switch Web Portal and Connect ALL

A Submit point (in Switch) or a Connector (created with Connect ALL) can be configured to ask

for metadata when a job is submitted. Metadata is additional information about the job, sent
along with the processed job in the background as an XML, TXT or CSV file (called Job Ticket).

It is often used to store administrative information associated with the job or to exchange such
information between systems.

Switch

If you have licensed the Database Module, you can define your metadata fields using values from
your database (again using an SQL statement).

B Define metadata fields: Metadata fields

Metadata Fields

[} Customer ID
[ date

Field Properties

Label Customer [D
Description
Data type [Dmpduwn list - ]

Edit multi-line text

Define multi-line text with vanables -

Value is required

Read only Mo -

Display metadata field |Yes

Note: It is only possible to visualize content from the database, for example the possible
values for a particular field. It is NOT possible to extract the correct value for a particular
job; the operator who submits a job to a Submit point or a Connector has to select it

manually.

4.5.4.2. Database Module - Setup

To able to use the features of the Database Module, make sure to:

Activate your license for the Database Module

Set up your ODBC database connection.
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About ODBC data sources in Switch

Guidelines
Please take into account the following guidelines when accessing ODBC data sources in Switch:

Before you set up the connection to the data source, you should have defined your database
(i.e. the Database Source Name (DSN)) in the DSN settings of your operating system. Read the
documentation of your database to learn how to set up the DSN.

Windows users can find more information on the Microsoft website: http://msdn.microsoft.com/en-
us/library/ms710252%28v=VS.85%29.aspx

Mac users should install an ODBC Administrator, for example http://www.odbcmanager.net/, to
be able to set up ODBC connections on Mac.

Note: Switch allows you to use both User and System DSN on Windows and Mac
platforms.

Make sure to install a 64-bit ODBC driver.

- Example Windows OS: In case of MySQL database, the ODBC driver installer mysq|l-
connector-odbc-5.1.8-winx64.msi is used. When you launch this installer and choose the
Custom installation, you will see that two drivers are available: 32-bit and 64-bit. Install the
64-bit driver and preferably disable the 32-bit driver, to avoid mix-up of driver versions in the
future. This will guarantee that Switch uses the correct driver.

For more information on ODBC drivers and data sources, refer to http://msdn.microsoft.com/en-
us/library/ms710285%28v=VS.85%29.aspx .

- Example Mac OS X: In the MySQL database, two versions of Mac OS X ODBC drivers are
available: 32-bit and 64-bit. You must use the 64-bit version (mysql-connector-odbc-5.2.7-
0sx10.7-x86-64bit.dmg).

Make sure to use the 64-bit version of the ODBC Administrator tool to configure your data
sources (DSNs).

On 64-bit Windows computers, two ODBC Administrator tools are available:
. 32-bit version: ..\windows\sysWOW&64\odbcad32.exe

«  64-bit version: ..\windows\system32\odbcad32.exe
Use the 64-bit version from \windows\system32\odbcad32.exe to configure your DSNs for Switch.

« If you install only the 64-bit ODBC driver and then launch the 32-bit version of the tool, you will
not be able to configure any DSNs, because the 32-bit version of the tool does not show the
64-bit ODBC drivers.

« If you have installed the 32-bit ODBC drivers, then in the 32-bit version of the tool you will see
the 32-bit driver and you will be able to configure DSNs for that driver. However, Switch will
not work with these DSNs and you will get the error message The specified DSN contains an
architecture mismatch between the Driver and Application".

For more information on managing data sources, refer to http://msdn.microsoft.com/en-us/library/
ms712362%28v=VS.85%29.aspx .
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Using the INGRES database in combination with Switch?
You should set the following flag (in the INGRES database):

return NULL for SCHEMA columns in ODBC catalog function result sets

Otherwise, you will get an error ("invalid table") when setting up SQL statements.

Setting up an ODBC database connection

If you want to use Switch with an ODBC data source (and you have licensed the Database
module), you must set up a connection to the preferred database.

Note:

- If you have more than one database, you can configure different database
connections as required.
« The database engine can run on a different computer than Switch.

To configure an ODBC database connection
1. In Switch, navigate to Edit > User Preferences > ODBC data sources.

2. Do one of the following:

Select the ODBC data source information field and click E]
« Double-click the ODBC data source information field.

The ODBC data sources dialog appears.

To add and configure an ODBC data source, click EII}'
The ODBC sources field now contains one data source, temporarily called Data Source. You
can rename it in the next step of this procedure.

L ] @ ODBC data sources
QDBC sources Properties
i Data_source

Data source Data_source

Description  dsdsadas

DS dBase Files

Username

Password

Query codec  UTF-8 [
Data codec UTF-8 [

Test connection
@2
Cancel QK

428



ENF@CUS Switeh

45.43.

45.4.4.

4. Inthe Properties pane, in the Data Source text field, provide a name for the data source.

5. In the Description text field, provide a small definition for the data source.

To select the DSN (Database Source Name) from the library, click [:]

The DSN must be defined in the DSN settings of your operating system. For more
information, refer to About ODBC data sources in Switch on page 53.

7. Provide a Username and Password.

These two fields can also be left blank if username and password are not required, or if they
have already been defined for the DSN.

8. From the drop-down menus, select the appropriate Query codec and Data codec, if required.

9. To test the database connection, click Check connection.
If the connection succeeded, a message box appears displaying the message Connection

successful.

Note: In case of problems, you will see an error message generated by the ODBC
tool of your operating system.

10. To close the message, click OK.
If you have more than one database, repeat step 3 to 10 and add as many data sources as
you have databases.

11. To close the ODBC data sources dialog, click OK once more.

Database connect

I

This default Switch app helps in configuring certain settings in the databases (like selecting
Datasource, adding SQL statement etc) without the use of scripting. It is only available if you have
licensed the Database module.

Drag and drop the Database Connect to the workspace.

For more information about this app, refer to the app documentation on the Enfocus Appstore.

Database variables

What are database variables?

Database variables are variables that at run-time are replaced with values from a database. These
variables can only be used if you have an active license for the Switch Databases Module.

You can use the database variables in the same way as the regular Switch variables:

- Use them as values for the tools and app properties.
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« Use them as values for conditions, for example to filter jobs on a connection.

« Use them as values to fill a drop-down menu in the Submit point and Checkpoint metadata

properties.

They are also accessible in the same way as other variables, i.e. via the Define Text/Condition
with Variables option in the properties of the Switch tools. They are collected in a separate
group: the "Database" variable group (see screenshot).

S Define text with variables

Sample jobs

Mame
E] Report1 . pdf

Size Type
321 KB pdf File

Modified Job prefix Flow element
Fllefz0lz 5:29: .. Input

Database

r,

Email
Irnage
Ipkc

Job
Metadata
Phota
Skats
Switch

Dhate

Inkeger
Rational
Texk

TextIndexed

The arbitrary field as boolean in a
database

Sample value

s [ [
Connection I:I

Insert variable ]

Texk with variables

Sample value |

[o] 9 H Cancel ]

The table below lists the available data types.

Variable name

Data type

Database.Text

Text

Database.Textindexed

Text Indexed

Database.Boolean Boolean
Database.Integer Integer
Database.Rational Rational
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Variable name Data type

Database.Date Date

How to build an SQL statement?

After you have selected the Database group in the first column, and the data type in the second
column, you must create an SQL statement. The Build SQL statement dialog box (see screenshot)
will assist you in creating the SELECT statement and obtaining the appropriate values from the
database.

Tip: We recommend using a sample job, so you can see immediately if your SQL
statement is valid and correct.

S Build 50QL statement

Sample jobs
Mame Size Type Modified Job prefix Flows element
Z splash, pdf 61.4 KB pdf File 8/16/2011 11:25... 00044 Problem jobs
E splash.pdf 61,4 KB pdf File gf16/2011 11:25... 00045 FDF Files
ODBC source Selection
Table: | v| Calurnn: | -
Condition
| V| |= V| |<Specify avalue= | =

[] Manual editing

Configure ] [ Validate statement Define variables

Sample value | ]

Ok H Cancel ]

To build an SQL statement, proceed as follows:
1.

Click the button beside the SQL textbox and choose Build SQL statement.
2. Select a data source.

a. Click the Configure button.

b. Inthe ODBC data sources dialog, select a data source from the list of predefined data
sources (Refer to ODBC data sources for more information on how to define the data
sources).

3. Select a table and a column in the Table and the Column drop-down menus.

431



ENF@CUS Switeh

4. Select the Condition checkbox and specify or select the conditions in the first and the third

menu, choose the comparison operator in the middle drop-down menu and choose the AND
or OR logical operator in the last drop-down menu.

Alternatively, in order to choose more than one column or to choose a column from any
other table or not to choose any columns, select the Manual editing checkbox and enter the
statement manually.

After setting the SQL statement, click the Validate statement button to check if the query

is valid. If the query returns any value or error, it is displayed on screen. The Sample value
menu displays the sample value for a query. If a query returns multiple values, they will be
listed in a comma separated list. For example: "valll,val12,val21,val22...".

Click the OK button to insert the statement.

4.5.5. SwitchClient Module

SwitchClient is a Switch module allowing users to access the Switch Server remotely, via Submit
points (to submit jobs) and Checkpoints (to monitor jobs).

With an active license of the SwitchClient Module, users can for example:

Connect to one or more Switch Servers on the local network/internet.

Submit jobs (files or job folders) and metadata describing these jobs to a Submit point in a
flow.

Review and act on jobs being held in a Checkpoint in a flow.

View progress information and the status of submitted jobs.

Access the REST API and build a custom Job Client.

Good to know

Access to particular Submit points and Checkpoints can be restricted, by configuring access
rights at user or user group level. For more information, refer to Configuring Switch users on
page 63.

Metadata information attached to a job can be used to make automated routing decisions or
to provide variable input to various tools and apps.

SwitchClient comes with a documented REST API, which enables our customers to build their
own Switch client tailored to their specific needs. The API can be accessed without a licensed
Web Services module for limited, internal usage. Note that currently there are two limitations

of SwitchClient module, which can be solved by using the Switch Web Services module:

« The Switch Web Services module allows an unlimited amount of client users, while
SwitchClient module, by default, allows only 5, and then you can buy extra client
connections keys.

« The Switch Web Services module allows anonymous access (users don't have to provide
any credentials, they just need to know a link) to shared Submit points.

4.5.6. Switch Web Services

The Switch Web Services is a REST-based development tool designed to create custom Switch
client interfaces within existing applications or web-based interfaces. This can be useful for
external users when they need access to jobs or workflows, or in cases where access to jobs
needs to be built into existing application interfaces.
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Note that an active Switch Web Services license gives access to the functionality to submit and
check jobs through the Switch Web Portal.

For more information on the Switch Web Services, please contact your local Enfocus reseller or
contact Enfocus directly.

4.5.7. Reporting Module

The Reporting Module allows you to create, display and share dashboards on the Switch Web
Portal. You can configure the data you want to use (by defining job boards) and choose from
different widgets to display live data or historical data (to get statistics).

For more information, refer to the chapter on Managing dashboards on the Switch Web Portal on
page 289.

4.6. Stopping the Switch Server

For maintenance reasons, it may be necessary to shut down the Switch Server.

To stop the Switch Server
1. Launch Switch with a local Designer.

2. From the File menu, select Stop Switch Server.

Note: Note the difference with the option Stop processing, which only causes the
Switch Server to stop processing flows.

The Switch Server is terminated and the Designer is closed. Remote Designers will not be able to
connect to the Switch Server. Connecting with a local Designer will restart the Server.

4.7. Quitting Switch

Quitting Switch means exiting the Switch Designer.

The behavior of the Switch Server (whether or not it is stopped when quitting) depends on the
setting of When exiting the flow designer in the Switch preferences: User interface on page 35.

To quit Switch

Do one of the following:

Click the Close button (@) in the top right corner of the application.
« (Windows) From the File menu, select Quit Switch.
« (Mac) From the Enfocus Switch menu, select Quit Enfocus Switch.
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5. The Switch Insight Dashboard

The Switch Insight Dashboard is a dashboard that allows you to visualize the usage of your
Switch. The charts on this dashboard will for example show you:

« How many files were processed by the Switch Server.
«  How many problem jobs were found.

«  Which flows and flow elements were used most.

«  Which file types were processed most.

« Which production times were busy and which weren't.
. etc

The Switch Insight Dashboard is free for maintenance users. Note however, that you should
explicitly opt in via the Insight Dashboard menu option in Switch (see Enabling your Switch Insight
Dashboard on page 434). Otherwise, the Switch Insight Dashboard won't be made available.

Once you have opted in, you can consult your Switch Insight Dashboard from within Switch or
via the account section on enfocus.com (see Consulting your Switch Insight Dashboard on page
435).

Note that this Dashboard is visible to all Switch managers:

- Anyone who has signed in at least once to the Switch Designer.
« Anyone who has been added as Switch manager via the account section on enfocus.com (see
Adding a Switch manager on page 267).

5.1. Enabling your Switch Insight Dashboard

Enfocus provides a free, personal Switch Insight Dashboard with weekly statistics, exclusively for
its Switch maintenance customers.

To make use of this feature, proceed as follows:

1. Make sure you're signed into Switch with your Enfocus ID.
You can sign in through the About Enfocus Switch dialog (Sign in tab):

« On Windows, go to Help > About Switch

« On Mac, go to Enfocus Switch > About Enfocus Switch

This is necessary because your Switch Insight Dashboard will be linked to your Enfocus ID
(and Switch Server).

2. Click Insight Dashboard > Opt in/Opt out.

3. Read the information and click Yes, I'd like my Dashboard.

Your personal Dashboard is prepared and will be available the next day. Note that you can opt
out whenever you want (via the same menu).
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5.2. Consulting your Switch Insight Dashboard

Once you have enabled your Switch Insight Dashboard, you have access to charts and statistics
about your usage of Switch. There are two ways to consult your Insight Dashboard:

«  From within Switch: Click Insight Dashboard > My Switch Insight Dashboard.
« Via the Enfocus website:

Go to http://www.enfocus.com.

In the top right corner, click Sign in.

Enter your Enfocus ID and password and click Sign in.
Click your username to open the account section.

5. Click My Dashboards > My Switch Insight Dashboard.

pwN S

Note that you can make your Switch Insight Dashboard visible to other users, by making them
manager of your Switch (see Adding a Switch manager on page 267). Remember however that
this also gives them other permissions (e.g. to buy apps).
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6. Advanced topics

6.1. Managing application data

About the Switch application data
Switch stores a lot of application-specific data, such as:

+ Flow definitions (defined or imported with the flow designer).
« Auto-managed backing folders (and their contents, i.e. jobs being processed through flows).
- Internal job tickets pointing to jobs being processed.

« Log messages.

All this data is stored in a nested folder hierarchy under a single root folder, which is called the
application data root.

The location of the application data root can be found in the Application data preference.
Administrator tools

We provide Switch administrators with two tools related to the application data:

« The Application Data Root Tool allows you to back up, restore and/or change the application
data root. Note that changing the data in the application data root is not allowed!

« The Data Collecting Wizard allows you to collect application data for the Enfocus Support
team (when they need more information on your Switch setup).

6.1.1. The Application Data Root Tool

About the Application Data Root Tool
The Application Data Root Tool allows you to:

« Create a backup of all your Switch data. We recommend doing this before upgrading or
downgrading Switch. It's also needed when you want to move your Switch installation to a
different computer.

« Restore a previous version (on condition you have made a backup), for example in case of
problems with a newer installation.

- Determine a new location for the Switch application data. This is a way to keep data of
multiple Switch versions/installations on one and the same system, for example for beta
testing.

The tool can be found in the Switch installation directory:

- Windows: C:\Program Files\Enfocus\Enfocus Switch\ApplicationDataRootTool.exe

. Mac OS: /Applications/Enfocus/Enfocus Switch/ApplicationDataRootTool.app
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Use case 1: Moving your Switch installation to a different computer

Note: This new computer may have a different operating system as well,as switching
between operating systems is supported (Mac to Win or vice versa).

If you want to move your Switch installation to a different computer, these are the steps to take:

1. Make a backup of your Switch application data root location (using the Application Data Root
Tool). Make sure to include all info about active jobs (select the checkbox!) and do not forget
to make a backup of your user-managed folders yourself.

2. Copy the backup to the new computer.

3. Install Switch on the new computer.

4. Restore the backup of the application data root tool (using the Application Data Root Tool).
Include the active jobs.

Use case 2: Using different data application root folders for (beta) testing
Best practice:

1. Install the test version (do not launch Switch Designer!).

2. Set a new Switch application data root location (using the Application Data Root Tool). Do not
move any existing data.

3. Start Switch Designer and test the new version. All data used for testing will be stored in the
new data root location.

4. When testing is finished, change the application data root location back to the original
location (using the Application Data Root Tool).

6.1.1.1. Making a backup of your Switch installation

This procedure explains how you can make a backup of your Switch application data using

the Application Data Root Tool. The backup includes all data related to flows, properties,
preferences, etc. and (optionally) information about active jobs. Note however that data in user-
managed folders is never stored via the Application Data Root Tool! If you want to keep this data,
make sure to keep it somewhere safe yourself.

Important: You must be logged in with the user account that was used to start Switch
Server. On Windows, you can select the appropriate user via the backup tool; on Mac,
you must make sure to be logged in with the correct user before starting up the tool.

Proceed as follows:

1. Make sure Switch is not running.

Remember that you can stop all Switch processes via the Switch Designer, by clicking File >
Stop Switch Switch Server.

Ideally, you make a backup before installing a new version of Switch, or right after it, just
before opening the Switch Designer for the first time

2. Launch the Application Data Root Tool.

The tool can be found in the Switch installation directory:

- Windows: C:\Program Files\Enfocus\Enfocus Switch\ApplicationDataRootTool.exe

- Mac OS: /Applications/Enfocus/Enfocus Switch/ApplicationDataRootTool.app

3. On Windows, select the user account that was used to start the Switch Server.
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6.1.1.2.

- If the required user is not in the list, you can add it yourself. Note you will be asked to
enter this user's password.

« Depending on the configuration of your system, it may be necessary to run the Application
Data Root Tool as an administrator or with elevated permissions.

« Roaming user profiles and users with an empty password are not allowed to select
another user; instead, they should start the Application Data Root Tool using the user
account concerned.

4. Select the Create a backup of the current Switch application data root radio button.

The current application data root folder is mentioned at the top of this dialog. This is relevant
if you have multiple folders with Switch data on your system. If you want a backup of a
different application data root folder, you must first change the application data root folder
(last option in the tool) to the one you want to back up.

Select a backup location.

If applicable, clear Include jobs in auto-managed folders and info related to all active jobs
in the flows

This option is selected by default and makes sure that job data, such as job tickets, datasets,
global data, ... of jobs in auto-managed folders is included in the backup. This is the preferred
option if you're moving Switch data to another location (so you still need this data). If you only
want to take a backup and restore it later after running production for a couple of weeks,

you probably won't need the job info, because the jobs concerned will have been processed
already by that time. Note that this also means that the historical data for this period will be
lost.

7. Click Proceed.

The Switch data root folders are copied to the new location and can be used to restore the
current version as required.

Restoring a previous version of your Switch installation

If you have made a backup of your Switch installation, you can easily restore it to go back to a
previously installed version of the software. Note that the data in the application data root will be
overwritten, so it may be good to first make a backup.

Important: You must be logged in with the user account that was used to start Switch
Server. On Windows, you can select the appropriate user via the Application Data Root
Tool; on Mac, you must make sure to be logged in with the correct user before starting up
the tool.

Proceed as follows:

1.

Make sure Switch is not running.

Remember that you can stop all Switch processes via the Switch Designer, by clicking File >
Stop Switch Switch Server.

Launch the Application Data Root Tool.

The tool can be found in the Switch installation directory:

- Windows: C:\Program Files\Enfocus\Enfocus Switch\ApplicationDataRootTool.exe
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« Mac OS: /Applications/Enfocus/Enfocus Switch/ApplicationDataRootTool.app

On Windows, select the user account that was used to start the Switch Server.

« Ifthe required user is not in the list, you can add it yourself. Note you will be asked to
enter this user's password.

- Depending on the configuration of your system, it may be necessary to run the Application
Data Root Tool as an administrator or with elevated permissions.

« Roaming user profiles and users with an empty password are not allowed to select
another user; instead, they should start the Application Data Root Tool using the user
account concerned.

Select the Restore a backup of the Switch application data root to the current Switch
application data root location radio button.

If you are not happy with the current application data root location (mentioned at the top of
the dialog), you should first change it by selecting the last option in this dialog.

Select the location where the backup was stored.

Optionally select Restore jobs in auto-managed folders and info related to all active jobs in
the flows.

Obviously, job data can only be restored if it has been included in the backup (refer to Making
a backup of your Switch installation on page 437).

Remember that jobs in user-managed folders are not included in the backup.

Click Proceed.

Note that all data in the current data root location will be overwritten.

Read the warning and click Yes to confirm.

6.1.1.3. Changing the application data root

If you want to easily switch between Switch installations, you can use different locations for the
application data. For example, you could move to another data root for testing a new version, and
afterwards move back to the original version.

Important: You must be logged in with the user account that was used to start Switch
Server. On Windows, you can select the appropriate user via the Application Data Root
Tool; on Mac, you must make sure to be logged in with the correct user before starting up
the tool.

Proceed as follows:

1.

Make sure Switch is not running.

Note that you can stop all Switch processes via the Switch Designer, by clicking File > Stop
Switch Switch Server.

Launch the Application Data Root Tool.

The tool can be found in the Switch installation directory:

- Windows: C:\Program Files\Enfocus\Enfocus Switch\ApplicationDataRootTool.exe
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7.

« Mac OS: /Applications/Enfocus/Enfocus Switch/ApplicationDataRootTool.app

On Windows, select the user account that was used to start the Switch Server.

« Ifthe required user is not in the list, you can add it yourself. Note you will be asked to
enter this user's password.

- Depending on the configuration of your system, it may be necessary to run the Application
Data Root Tool as an administrator or with elevated permissions.

« Roaming user profiles and users with an empty password are not allowed to select
another user; instead, they should start the Application Data Root Tool using the user
account concerned.

Select the Set new Switch application data root location radio button.

Click Browse to select the new application data root folder.

This should be an empty folder on your local system. (Note that only for upgrade installations
(upgrade from Switch 2018 or earlier) it's still possible (but not recommended) to use a
network location).

If applicable, clear Move data from the current Switch application data root to the new
location

This option is selected by default but can be cleared as required, for example if you want a
clean installation.

Click Proceed.

Next time Switch is started, the new location will be used to store the Switch application data.
Note that you can double-check the location of the application data root in the Application data
preference in Switch Designer.

6.1.2. The Data Collecting Wizard

About the Data Collecting Wizard

The Data collecting wizard is a tool that automatically collects the Switch data files, which are
requested by the Enfocus Support team when they need more information on your Switch setup.

The tool collects the following data:

Flows

Preference files

Job tickets

logs .db3 file (ServerLogs.db3)

Information about the Switch files installed on the user's system (layout, name, size,
modification date)

Relevant registry/plist records

Information from the Support tab in the About dialog box

Job datasets

The tool creates a zip package that can be sent to the Enfocus Support team.
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6.1.2.1.

Note: As the file size might be an issue (the .db3 files may be a few GB in size and the
jobtickets may be a 100MB or more), you can as a user exclude certain data files from the
collection.

Two versions
The Data Collecting Wizard is provided in two versions:

- A stand-alone version (SwitchDataCollector.exe or SwitchDataCollector.app), available in
the Switch installation folder.

«  Windows: C:\Program Files (x86)\Enfocus\Enfocus Switch
«  Mac OS: /Applications/Enfocus/Enfocus Switch
« A built-in version, available from within Switch through the File menu (File > Collect

application data).

The main difference between the two versions, is the way the flows are collected. Flows in a
Switch installation are a combination of XML and Property sets in various folders. When a user
chooses "Export" in the Designer Ul, the XML and Property sets are combined in a file with
extension .sflow. As this logic is difficult to extract outside Server, the stand-alone version does
not offer the .sflow files (only the raw XML and Property sets). Besides, in the stand-alone version
you have to collect either all or none of the .sflow files. You cannot make a selection.

Apart from that, only the stand-alone version allows you to collect data if Switch is not launched
or cannot be launched anymore for any reason. If Switch is running, you are asked to quit.
Using the Data Collecting Wizard

Refer to Collecting application data on page 441.

Collecting application data
To collect the Switch application data
1. Do one of the following:

« Locate the SwitchDataCollector in the Switch installation directory (make sure Switch is
closed!).
- In Switch, choose File > Collect application data.

For more information about the difference, refer to The Data Collecting Wizard on page
440.

The Switch Data Collecting Wizard Welcome screen appears.
2. Click Next.

3. Select the data you want to include in the resulting zip package.

You have the following choices:

« Logs: Server logs in a .db3 file (entire folder "<app_data_root>\logs")
- Preferences: Switch preferences XML (entire folder "<app_data_root>\settings")

- Datasets: Jobs datasets (entire folder "<app_data_root>\datasets")
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- Application settings: Switch settings extracted from the registry (on Windows) or plist files
(on Mac). The extracted data is put into an ApplicationSettings.txt file. On Mac, actual plist
files are also included in the zip. This checkbox cannot be cleared.

« Layout description: Description of Switch installation files, saved into a file called
‘Report.txt'. It includes a listing of all files and folders with their attributes (size, modification
date, permissions etc.) from the Switch installation folder. This checkbox cannot be
cleared.

- Internal log messages: Internal log files for all processes with a more detailed description
of errors and operations. This checkbox cannot be cleared.

Note: If the file size becomes too big or if collecting files takes too much time, you
may want to exclude certain data types.

4. Choose a destination for the resulting zip package and click Next.

You can as well change the name of the zip package as required. The default name has the
following format: "Switch Data "<current date> <nn-nn-nn>.zip", e.g. Switch Data 2015-09-14
10-29-30.zip.

5. Select the flows you want to collect and click Next.
If you're using the stand-alone version of the tool, you must either select all flows or none; it's

not possible to select a subset.

if you're using the Designer version, all flows are displayed in alphabetical order. They are
selected by default, but you can clear the ones you don't need. Note that advanced features
(like grouping, sorting, flags etc) are not supported.

A summary of the chosen options is shown. You can still make changes as required by
clicking the Back button.

6. Click Commit.
The data collection starts.

Note:

« If the wizard is launched from the Switch Designer, it deactivates all active flows,
before collecting the data. Afterwards, the flows are re-activated.

« You can stop the data collection (for example if it takes too much time) by clicking
Abort. However, aborting can be performed only between steps, for example:
between collecting flows and exporting logs. The Wizard will wait until the
previous step is finished and will only then abort the collection process.

7. Once the zip package has been created, click Close.
The zip package is placed in the location chosen in step 4. The structure is very simple: each
data part is placed in a separate subfolder, e.g. Application Data, ExportedFlows, Report, and
Settings. The content of the Application Data subfolder mirrors the contents of the actual
Switch application data root.

If the wizard was launched from Switch, the Report folder will contain a file named
"AboutDialog.txt, which contains information extracted from the About box in Designer.
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6.2. Switch performance tuning

The performance of Switch is affected by the processes that are being executed, such as file
handling, network transfers and external processes.

To avoid that Switch slows down because too many processes are running at the same time,
there are limits set to the number of concurrent processes. Changing these limits allows you to
tune the Switch performance.

Note: Do not forget that other aspects, such as computer specifications and network
speed can also affect overall performance.

File handling tasks

Handling files, such as copying or moving files and folders is limited to 5 simultaneous tasks (see
Execution slots on page 255). It is not possible to change this number of concurrent file transfers.

Flow elements involved:

. Export metadata

- Job dismantler

- Recycle bin

« XML pickup, JDF pickup, XMP pickup, Opaque pickup
« Problem jobs

« Submit hierarchy

«  Submit point

« Checkpoint

« Generic application
«  XSLT Transform

« Archive hierarchy

« File type

. Folder element

Network transfer tasks

The number of concurrent network file transfers can be set in the Switch preferences
(Preferences > Processing > Concurrent network transfer tasks). The default is set to 2 and the
maximum limit is 100.

Flow elements involved:

« FTPsend
« FTP receive
« Mail send

« Mail receive
« Checkpoint via mail

File processing tasks

The number of tasks required to process files by using one of the flow elements listed below
simultaneously can be set in the Switch preferences (Preferences > Processing > Concurrent
processing tasks).
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By default this preference is set to 4 simultaneous processes (that is the maximum available with
a regular Switch Core Engine license), but licensing additional processes can expand this limit to

a maximum of 100.
Flow elements involved:

« All flow elements in the Apps section

« Excluding the PitStop Server configurators
« The following elements in the Basics section:

« Set hierarchy path
. Ungroup job

- Split multi-job

« Assemble job

« Execute command

« The following elements in the Tools section:

« Sort by preflight state

« Archive

« Unarchive
- Split PDF

« Merge PDF
« Hold job

« Inject job

« Rename job

. Sortjob

+ Logjob info

« Sortfilesin job

« The Script element in the Scripting section:

Custom scripts are affected by the "Concurrent processing tasks" preference as soon as

the script is a "heavy script". A script is considered to be "heavy", if it takes longer than one

second to execute.

Light scripts, timerFired, webhookTriggered and flowStopTriggered calls belong to separate

categories and these processes are calculated in a different way. For more details, see

Execution slots on page 255.

« The following elements in the Communication section:

« HTTP request

. Pack job

« Unpack job

« Monitor confirmation

« The XMP inject element in the Metadata section.
- The Database connect element in the Database section.
« The following elements in the Legacy section:

. Compress
« Uncompress

PitStop Server tasks

The number of concurrent PitStop Server tasks can be set in the Switch preferences (Preferences

> Processing > Concurrent PitStop Server tasks). The default is set to Automatic, which is
based on the hardware configuration of the server. You can set this value manually up to 99

concurrent tasks.
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Flow elements involved:

. Enfocus PitStop Server
« Enfocus PitStop Server PDF2Image

Accumulative limitation

Each task listed has its own upper limit. In addition to this, Switch is limited to an upper limit of
200 for all simultaneous tasks. This is the accumulation of File Handling, Network Transfers and
External processes.

For more information on Switch Preferences see User Preferences.

For more information on tuning performance for file processing tasks, see Changing flow
properties.

6.3. HTTPS with self-signed certificates

HTTPS servers use certificates to prove their identity. For example, if you try to connect to
https://example.com, a certificate allows the web client to be sure, that it has connected to the
intended website and that the connection has not been intercepted by an attacker.

Whether a web client can trust the certificate or not is dependent on whether the certificate

was signed by a trusted central authority (CA), such as DigiCert Inc, Let's Encrypt, Google, ...
They are already trusted on your system by default and they provide certificates for public-facing
domains.

However, in case you want to have a certificate for a service in your internal network (like a
VPN or just LAN), you would need to use your own trusted CA, or, in the simplest of cases, use
self-signed certificates. With this setup you need to explicitly configure web clients to trust that
CA or certificate.

With this in mind, if you use Switch Web Service with HTTPS enabled and a self-signed certificate
for its identity, you will encounter issues when using Remote Designer or Switch Helper, as they
will not trust that certificate by default. To avoid this, you must make your certificates trusted on a
client system as described further.

6.3.1. Making your self-signed certificate trusted (Windows)

« Make sure to download your certificate to the client machine. You can either download it from
the Server itself or via browser when connecting to the Switch Web Portal (see your browser
documentation on how to do that).

« The certificate file should have the .crt extension - this will simplify the process.

To enable trust, you must install the certificate in the Trusted Root Certification Authorities Store.
Proceed as follows:

1. Double-click the certificate file.
This opens a dialog with certificate information.
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@ Certificate >

General Details Certification Path

.tﬁjﬁ Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: Default Company Ltd

Issued by: Default Company Ltd

Valid from 2021-04-05 to 2022-04-05

Install Certificate... | | Issuer Statement

QK

2. Click Install Certificate.
This opens the Certificate Import Wizard.

Select Current User as Store Location and click Next.
Select Place all certificates in the following store and click Browse....
Select Trusted Root Certification Authorities and click OK.

Click Next and then Finish.

N o o W

You will get a security warning, telling you to make sure you trust the certificate you are
adding. Click Yes to confirm.

The certificate is now a trusted certificate. If you double-click the certificate file again, it will no
longer show warnings.
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Important: If the private key used to sign the certificate, is compromised, you can no
longer trust the certificate. In that case, you must remove the certificate from the trusted
storage, otherwise it will compromise your system security!

6.3.2. Making your self-signed certificate trusted (Mac)

« Make sure to download your certificate to the client machine. You can either download it from
the Server itself or via browser when connecting to the Switch Web Portal (see your browser
documentation on how to do that).

« The certificate file should have the .crt extension - this will simplify the process.

Proceed as follows

1. Double-click the certificate file.
This opens the Keychain Access app and automatically adds the certificate into your login

keychain.
ene + @ Q
Kayehaing

- = Default Company Ltd

o login e | self-signed rest certificate

@' Local ems | Expires: Tugsday, April 5, 2022 st 7:36:36 PM Moscow Standard Time

@ System T tificat 18 fied by a third party

) System Roots

MName Kind Date Modified Expires Keycha
£, iz container...go-protoction-key  application password  Jun O, 2020 at B3 PM -« legin

.. i buiid-of-u.entity-generation tion password  Jun 9, 2020 3P -

Iegin

Category Bl Default Company Lid = Ape 5, 2022 at 7:36:36 PM
A Al ems {.. com.apple.sc..okmarksagentape  3pp password Jun 9, 2020 at §:21:08 PM - login
£, Passwords J, comappleids.eZlacd-AuthToken application password  Jun O, 2020 &t T1B:32PM -~ [
Securs Noles (. com.appie.gs. thentication.token  application password  Jun 9, 2020 at $:33:44 PM -~ legin
] My Certificates £ com.appiegs..thentication.token  application password  Jun 9, 2020 at 9:3344PM - legin
D Keys £, comappegs sation token application password  Jun 0, 2020 ot 03344 PM - leginy
5 Ceriificates COM.appie.gs.... ication.token  application password  Jun D, 2020 at 3344 PM -~ legin

2. Find your certificate in the list and double-click it.
This opens a dialog with certificate information.
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Default Company Ltd
1w ptioant = s
o > Self-signed root certificate
- Expires: Tuesday, April 5, 2022 at 7:36:36 PM Moscow Standard Time
& This certificate has not been verified by a third party
¥ Trust
¥ Details
Issuer Name

Country or Region XX
Locality Default City
Organization Default Company Ltd

Serial Number 00 85 6110 BF DC AR EC 61
Version 1
Signature Algorithm SHA-256 with RSA Encryption { 1.2.840.113549.1.1.11)
Parameters Mone

Subject Name
Country or Region XX
Locality Default City
Organization Default Company Ltd

Mot Valid Before Monday, April 5, 2021 at 7:36:36 PM Moscow Standard Time
Mot Valid After Tuesday, April 5, 2022 at 7:36:36 PM Moscow Standard Time

Expand the Trust section and set the following options to Always Trust:

« Secure Sockets Layer (SSL)

. X.509 Basic Policy
Close the certificate dialog.

In the confirmation dialog that appears, confirm your changes:

a. Enter your password.
b. Click Update Settings.

The certificate is now a trusted certificate.

storage, otherwise it will compromise your system security!

Important: If the private key used to sign the certificate, is compromised, you can no
longer trust the certificate. In that case, you must remove the certificate from the trusted
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/. Need more help?

1. Consult the product documentation

Documentation | Description Where to find?

Quick Start Guide | Switch basic information Go to the Switch manuals on the Enfocus
website. Alternatively, to go there

from within the application, select the
Help > Online resources > Online
documentation menu.

Consult this guide if you're new
to Switch.

Reference Guide | Switch detailed information and | Go to the Switch manuals on the Enfocus
advanced topics website. Alternatively, to open the help
from within the application, press F1 or
select the Help > Switch help menu.

Switch Scripting | Switch scripting reference Go to the Switch manuals on the Enfocus
Documentation website. Alternatively, to go there

from within the application, select the
Help > Online resources > Online
documentation menu.

2. Consult the Solution articles in the Enfocus knowledge base

The Enfocus knowledge base provides answers to frequently asked questions, workarounds, and
tips and tricks.

To access the knowledge base, go to: https.//enfocus.my.site.com/customers/s/topiccatalog.

Note: Alternatively, you can go there from within Switch, by selecting the Help > Solution
articles menu.

3. Visit the Enfocus Community

The Enfocus Community is a forum where you can exchange ideas with other users of Enfocus
software.

URL: http.//forum.enfocus.com/

4. Contact your reseller

A list of authorized resellers is available on the Enfocus website (https.//www.enfocus.com/en/
resellers).

5. Contact Enfocus customer support

If you cannot find the answer to your question in Switch help or on the web, create a case on the
website at https.//enfocus.my.site.com/customers/s/cases.
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3. Copyrights

© 2025 Enfocus BV all rights reserved. Enfocus is an Esko company.
Certified PDF is a registered trademark of Enfocus BV.

Enfocus PitStop Pro, Enfocus PitStop Workgroup Manager, Enfocus PitStop Server, Enfocus
BoardingPass, Enfocus Connect YOU, Enfocus Connect ALL, Enfocus Connect SEND, Enfocus
StatusCheck, Enfocus CertifiedPDF.net, Enfocus PDF Workflow Suite, Enfocus Switch, Enfocus
SwitchClient, Enfocus SwitchScripter, Enfocus TestDrive, Enfocus SwitchScriptTool, Enfocus
Browser, PitStop Library Container, Enfocus Griffin, Enfocus Review, Enfocus FastLane and
Enfocus Appstore are product names of Enfocus BV.

Adobe, Acrobat, Distiller, InDesign, lllustrator, Photoshop, FrameMaker, PDFWriter, PageMaker,
Adobe PDF Library™, the Adobe logo, the Acrobat logo and PostScript are trademarks of Adobe
Systems Incorporated.

Datalogics, the Datalogics logo, PDF2IMG™ and DLE™ are trademarks of Datalogics, Inc.

Apple, Mac, macOS, Macintosh, iPad and ColorSync are trademarks of Apple Computer,
Inc. registered in the U.S. and other countries. Windows and Windows Server are registered
trademarks of Microsoft Corporation.

PANTONE® Colors displayed here may not match PANTONE-identified standards. Consult
current PANTONE Color Publications for accurate color. PANTONE® and other Pantone, Inc.
trademarks are the property of Pantone, Inc. ®Pantone, Inc., 2006.

OPI is a trademark of Aldus Corporation.

Quark, QuarkXPress, QuarkXTensions, XTensions and the XTensions logo among others, are
trademarks of Quark, Inc. and all applicable affiliated companies, Reg. U.S. Pat. & Tm. Off. and in
many other countries.

Docker and the Docker logo are trademarks or registered trademarks of Docker, Inc. in the
United States and/or other countries. Docker, Inc. and other parties may also have trademark
rights in other terms used herein.

This product and use of this product is under license from Markzware under U.S.Patent No.
5,963,641.

Other brand and product names may be trademarks or registered trademarks of their respective
holders. All specifications, terms and descriptions of products and services are subject to change
without notice or recourse.
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9. Third-Party License Information

The third-party applications included in Switch are listed below. Additional information about
third-party licenses can be found in the Resources > Licenses subfolder of the Switch installation
folder.

This product includes lzw-ab.

Copyright (c) David Bryant
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Conifer Software nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes Botan.

Copyright (C) 1999-2023 The Botan Authors
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
ColourKit Profiler Suite (www.colourprofiling.com)
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This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol (R) and
SWOP (R) are all registered trademarks of IDEAlliance(C).

This product includes PANTONE Color Libraries.

PANTONE® and other Pantone trademarks are the property of Pantone LLC.
Pantone is a wholly owned subsidiary of X-Rite, Incorporated.

This product includes curl.
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1996 - 2023, Daniel Stenberg, <daniel@haxx.se>, and many
contributors, see the THANKS file.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose
with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and

its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR

ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
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OF THIS SOFTWARE.

This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType
Project (www.freetype.org) licensed under the Freetype License.
All rights reserved.

This product includes Google Breakpad.

Copyright (c) 2006, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2004 Unicode, Inc.
Disclaimer

This source code is provided as is by Unicode, Inc. No claims are
made as to fitness for any particular purpose. No warranties of any
kind are expressed or implied. The recipient agrees to determine
applicability of information provided. If this file has been
purchased on magnetic or optical media from Unicode, Inc., the

sole remedy for any claim will be exchange of defective media
within 90 days of receipt.

Limitations on Rights to Redistribute This Code

Unicode, Inc. hereby grants the right to freely use the information
supplied in this file in the creation of products supporting the
Unicode Standard, and to make copies of this file in any form

for internal or external distribution as long as this notice
remains attached.

This product includes gSOAP.
EXHIBIT B.
Part of the software embedded in this product is gSOAP software.
Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen,

Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
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MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of

this software and associated documentation files (the "Software"), to deal in
the

Software without restriction, including without limitation the rights to use,

copy, modify, merge, publish, distribute, and/or sell copies of the Software,
and

to permit persons to whom the Software is furnished to do so, provided that the

above copyright notice(s) and this permission notice appear in all copies of the

Software and that both the above copyright notice(s) and this permission notice

appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes 1iODBC.

i0ODBC Driver Manager

Copyright (C) 1995 Ke Jin <kejin@empress.com>

Copyright (C) 1996-2021 OpenLink Software <iodbc@openlinksw.com>
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name of OpenLink Software nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS

"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS

BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,

OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

This product includes JBIG2Lib.

Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
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This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
All Rights Reserved.

This software is based in part on the work of the Independent JPEG Group.

This product includes Little CMS.

Little CMS
Copyright (c) 1998-2020 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject

to the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes libxml2.
Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN

THE SOFTWARE.

This product includes mongodb.
Copyright (c) 2018 MongoDB, Inc.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY

APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT

HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM TABAS ISTAS WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM

IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF

ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

This product includes IP*Works!.

Copyright (c) 2017 /n software inc. - All rights reserved.
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DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE
USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS
OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS
TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL
OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE
A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY
ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-

TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE
CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS
IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS,
AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE
FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR
SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS
SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH
RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,

IN NO EVENT WILL /N SOFTWARE'S TOTAL AGGREGATE AND CUMULATIVE LIABILITY TO YOU FOR
ANY AND ALL CLAIMS OF ANY KIND ARISING HEREUNDER EXCEED THE AMOUNT OF LICENSE FEES
ACTUALLY PAID BY YOU FOR THE LICENSED SOFTWARE GIVING RISE TO THE CLAIM IN THE TWELVE
MONTHS PRECEDING THE CLAIM. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO
LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF
USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING,
IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS

BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION,
ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY
PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE
SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT
ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS
MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE
SEVERABLE.

This product includes IP*Works! SSH.
Copyright (c) 2017 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE
USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS
OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS
TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL
OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE
A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY
ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-

TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE
CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS
IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS,
AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE
FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR
SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS
SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH
RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,

IN NO EVENT WILL /N SOFTWARE'S TOTAL AGGREGATE AND CUMULATIVE LIABILITY TO YOU FOR
ANY AND ALL CLAIMS OF ANY KIND ARISING HEREUNDER EXCEED THE AMOUNT OF LICENSE FEES
ACTUALLY PAID BY YOU FOR THE LICENSED SOFTWARE GIVING RISE TO THE CLAIM IN THE TWELVE
MONTHS PRECEDING THE CLAIM. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO
LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF
USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING,
IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS

BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION,
ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY
PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE
SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT
ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS
MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE
SEVERABLE.
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This product includes sglite3.

Copyright (c) MapBox
All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or
other materials provided with the distribution.

- Neither the name "MapBox" nor the names of its contributors may be
used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes javascript-obfuscator.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL <COPYRIGHT HOLDER> BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenJPEG.

The copyright in this software is being made available under the 2-clauses
BSD License, included below. This software may be subject to other third
party and contributor rights, including patent rights, and no such rights
are granted under this license.

Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2014, Professor Benoit Macqg

Copyright (c) 2003-2014, Antonin Descampe

Copyright (c) 2003-2009, Francois-Olivier Devaux

Copyright (c) 2005, Herve Drolon, FreelImage Team

Copyright (c) 2002-2003, Yannick Verschueren

Copyright (c) 2001-2003, David Janssens

Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France

All rights reserved.

Redistribution and use in source and binary forms, with or without
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modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS'
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (c) 1998-2019 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this
software must display the following acknowledgment:
"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
endorse or promote products derived from this software without
prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment:
"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "~ "AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.
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Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software
must display the following acknowledgement:
"This product includes cryptographic software written by
Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the rouines from the library
being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from
the apps directory (application code) you must include an acknowledgement:
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG " "AS IS'' AND

ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. 1IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

This product includes Enfocus PDF technology.

"Convert fill to stroke" Action, Patent Pending

This product includes Qt Script for Applications (QSA).

Copyright (C) 1992-2007 Trolltech AS. All rights reserved.

This software is provided AS IS with NO WARRANTY OF ANY KIND, INCLUDING THE
WARRANTY OF DESIGN, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

This product includes Qt.

2019

(WwWw .

The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C)
The Qt Company Ltd.

Portions of this software are copyright (C) 2006-2015 The FreeType Project
freetype.org). All rights reserved.

Copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.
This software is based in part on the work of the Independent JPEG Group.

Secure Hash Algorithm SHA-3 - brg endian
Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

LICENSE TERMS

The redistribution and use of this software (with or without changes)
is allowed without the payment of fees or royalties provided that:

1. source code distributions include the above copyright notice, this
list of conditions and the following disclaimer;

2. binary distributions include the above copyright notice, this list
of conditions and the following disclaimer in their documentation;

3. the name of the copyright holder is not used to endorse products
built using this software without specific written permission.

DISCLAIMER

Switch
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This software is provided 'as is' with no explicit or implied warranties
in respect of its properties, including, but not limited to, correctness
and/or fitness for purpose.

This product includes QtActiveQt.
Copyright (C) 2022 The Qt Company Ltd.

Redistribution and use in source and binary forms, with or without
modification,

are permitted provided that the following conditions are met: *
Redistributions of

source code must retain the above copyright notice, this list of conditions
and the

following disclaimer. * Redistributions in binary form must reproduce the

above

copyright notice, this list of conditions and the following disclaimer in the

documentation and/or other materials provided with the distribution. * Neither
the

name of The Qt Company Ltd nor the names of its contributors may be used to
endorse

or promote products derived from this software without specific prior written

permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT

SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED

TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN

ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH

DAMAGE .

This product includes QtDeclarative.

The Qt Toolkit is Copyright (C) 2019 The Qt Company Ltd.

This product includes QtShaderTools.

The Qt Toolkit is Copyright (C) 2019 The Qt Company Ltd.

This product includes QtSingleApplication.

Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).
Contact: http://www.gt-project.org/legal

This file is part of the Qt Solutions component.
You may use this file under the terms of the BSD license as follows:

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.
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* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
of its contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes QtWebChannel.

The Qt Toolkit is Copyright (C) 2019 The Qt Company Ltd.

This product includes QtWebEngine.

The software uses QtWebEngine, licensed under LGPL v3. The Qt Toolkit is
Copyright (C) 2019 The Qt Company Ltd.

This product includes chromium.
Copyright 2015 The Chromium Authors. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and

its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.
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THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR

ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE

OF THIS SOFTWARE.

This product includes UnRAR.
Copyright (c) 1993 Alexander Roshal

THE RAR ARCHIVER AND THE UNRAR UTILITY ARE DISTRIBUTED "AS IS".
NO WARRANTY OF ANY KIND IS EXPRESSED OR IMPLIED. YOU USE AT
YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING
OR MISUSING THIS SOFTWARE.

This product includes XMP Toolkit.
Copyright (c) 2020, Adobe
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes zlib.
(C) 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software
in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.
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